Click the links to the left for information on the features, options, and operation of your printer. For information on other documentation included with your printer, see "Finding Information."
<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Standard 250-sheet tray</td>
</tr>
<tr>
<td>2</td>
<td>Optional 550-sheet feeder</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> Your printer allows for a maximum of 3 trays (standard 250-sheet tray, optional 550-sheet feeder, and multipurpose feeder).</td>
</tr>
<tr>
<td>3</td>
<td>Multipurpose feeder</td>
</tr>
<tr>
<td>4</td>
<td>Side button</td>
</tr>
<tr>
<td>5</td>
<td>Belt unit</td>
</tr>
<tr>
<td>6</td>
<td>Front cover</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> The front cover opens by pushing the side button.</td>
</tr>
<tr>
<td>7</td>
<td>Optional duplexer</td>
</tr>
<tr>
<td>8</td>
<td>Operator panel</td>
</tr>
<tr>
<td>9</td>
<td>Power switch</td>
</tr>
<tr>
<td>10</td>
<td>Control board</td>
</tr>
<tr>
<td>11</td>
<td>Control board cover</td>
</tr>
</tbody>
</table>

To order replacement print cartridges or supplies from Dell:

1. Double-click the icon on your desktop.

2. Visit Dell's website, or order Dell printer supplies by phone.

    **www.dell.com/supplies**

    For best service, have your Dell printer Service Tag available.

    For help locating your Service Tag number, see "Express Service Code and Service Tag number."

---

**Notes, Notices, and Cautions**

**NOTE:** A **NOTE** indicates important information that helps you make better use of your printer.
This software and documentation are provided with RESTRICTED RIGHTS. Use, duplication or disclosure by the Government is subject to restrictions as set forth in subparagraph (c)(1)(ii) of the Rights in Technical Data and Computer Software clause at DFARS 252.227-7013 and in applicable FAR provisions: Dell Inc., One Dell Way, Round Rock, Texas, 78682, USA.

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC rules.

August 2007 Rev. A02
# Finding Information

<table>
<thead>
<tr>
<th>What are you looking for?</th>
<th>Find it here</th>
</tr>
</thead>
<tbody>
<tr>
<td>· Drivers for my printer</td>
<td><em>Drivers and Utilities CD</em></td>
</tr>
<tr>
<td>· My User's Guide</td>
<td></td>
</tr>
</tbody>
</table>

The *Drivers and Utilities CD* contains documentation and drivers for your printer. You can use the CD to uninstall/reinstall drivers or access your documentation.

Readme files may be included on your CD to provide last-minute updates about technical changes to your printer or advanced technical reference material for experienced users or technicians.

| · Safety information     | *Owner's Manual* |
| · How to use my printer  |              |
| · Warranty information   |              |

⚠️ **CAUTION:** Read and follow all safety instructions in your *Owner's Manual* prior to setting up and operating your printer.

<table>
<thead>
<tr>
<th>How to set up my printer</th>
<th><em>Setup diagram</em></th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Troubleshooting Guide</th>
<th><em>Troubleshooting Guide</em>:</th>
</tr>
</thead>
<tbody>
<tr>
<td>· User Settings</td>
<td>- User Settings</td>
</tr>
<tr>
<td>· Configuration</td>
<td>- Configuration</td>
</tr>
<tr>
<td>· Troubleshooting Instructions</td>
<td>- Troubleshooting Instructions</td>
</tr>
<tr>
<td>· Other Problems</td>
<td>- Other Problems</td>
</tr>
</tbody>
</table>
Express Service Code and Service Tag number

The Express Service Code and Service Tag numbers are located inside the front door of your printer.

<table>
<thead>
<tr>
<th>Latest drivers for my printer</th>
<th>Dell Support Website</th>
</tr>
</thead>
<tbody>
<tr>
<td>Answers to technical service and support questions</td>
<td>The Dell Support Website provides several online tools, including:</td>
</tr>
<tr>
<td>Documentation for my printer</td>
<td>· Solutions - Troubleshooting hints and tips, articles from technicians, and online courses</td>
</tr>
<tr>
<td></td>
<td>· Upgrades - Upgrade information for components, such as memory</td>
</tr>
<tr>
<td></td>
<td>· Customer Care - Contact information, order status, warranty, and repair information</td>
</tr>
<tr>
<td></td>
<td>· Downloads - Drivers</td>
</tr>
<tr>
<td></td>
<td>· Reference - Printer documentation and product specifications</td>
</tr>
</tbody>
</table>

You can access Dell Support at [support.dell.com](http://support.dell.com). Select your region on the WELCOME TO DELL SUPPORT page, and fill in the requested details to access help tools and information.
Dell Printer Configuration Web Tool

Using the Dell Printer Configuration Web Tool

One of the features of the **Dell Printer Configuration Web Tool** is the E-Mail Alert Setup, which sends you, or the key operator, an e-mail when the printer needs supplies or intervention.

If you fill out printer inventory reports requiring the asset tag number of all of the printers in your area, use the Printer Information feature in the **Dell Printer Configuration Web Tool**. Just type the IP address of each printer on the network to display the asset tag number.

The **Dell Printer Configuration Web Tool** feature also lets you change printer settings and keep track of printing trends. If you are a network administrator, you can easily copy the printer's settings to one or all printers on the network – right from your Web browser.

To launch the **Dell Printer Configuration Web Tool**, just type your network printer's IP address in your Web browser.

If you do not know what your printer's IP address is, print a printer settings page, which lists the IP address:

1. Press **Menu**.
2. Press ▼ until **Report/List** appears, and then press ✔.
3. **Printer Setting** is displayed. Press 🔄.

The printer settings page is printed.

If the IP address shows 0.0.0.0 (the factory default), an IP address has not been assigned. To assign one for your printer, see "Assign an IP Address."

Use the **Dell Printer Configuration Web Tool** for:

### Printer Status

Get immediate feedback on printer supply status. When print cartridge is running low, click the **Order Supplies** link on the first screen to order additional print cartridges.

### Printer Jobs

The **Printer Jobs** menu contains information on **Job List** page and **Completed Jobs** page. These pages show the details of the status regarding each protocol or the print jobs.

### Printer Settings

Change printer settings and view the operator panel remotely.

### Print Server Settings

Use the **Print Server Settings** menu to set the type of printer interface and necessary conditions for communications.

### Copy Printer Settings

Quickly copy the printer's settings to another printer or printers on the network just by typing each printer's IP address.

**NOTE:** You must be a network administrator to use this feature.

### Print Volume

Keep track of printing trends, such as paper usage and types of jobs being printed, and limit which users use the color mode and the maximum number of pages they can print.

### Printer Information

Get the information you need for service calls, inventory reports, or the status of current memory and engine code levels.
**Tray Settings**

Get the information about the paper type and size for each tray.

**E-Mail Alert**

Receive an e-mail when the printer needs supplies or intervention. Type your name or the key operator’s name in the e-mail list box to be notified.

**Set Password**

Lock the operator panel with a password so that other users don’t inadvertently change the printer settings you selected.

**NOTE:** You must be a network administrator to use this feature.

**Online Help**

Click **Online Help** to visit the Dell web page, and see the *User’s Guide* on that page to verify configured settings.

**Order Supplies at:**

www.dell.com/supplies

**Contact Dell Support at:**

support.dell.com

---

**Using the Dell Printer Configuration Web Tool**

**Environment Settings for Web Browsers**

Dell recommends configuring the environment settings for your Web browsers, before using the Dell Printer Configuration Web Tool.

**NOTE:** The EWS pages may be displayed unreadable if you browse the pages that were configured by using the browser of which language setting is different with your browser’s.

**For Internet Explorer 6.0/7.0**

**Setting Up the Display Language**
1. Select **Internet Options** from **Tools** on the menu bar.

2. Select **Languages** in the **General** tab.

3. Specify the display language in order of preference in the **Language in order of preference** list.

   For example:
   - Italian (Italy) [it]
   - Spanish (Traditional Sort) [es]
   - German (Germany) [de]
   - French (France) [fr]
   - English [en] or English (United States) [en-us]

**Setting the Printer's IP Address to Non-proxy**

1. Select **Internet Options** from **Tools** on the menu bar.

2. Select **Proxy server** under **LAN Settings** in the **Connections** tab.

3. Do either of the following.
   - Clear the **Use a proxy server for you LAN** check box.
   - Click **Advanced**, and then specify the printer's IP address in the **Do not use proxy server for addresses beginning with** field under **Exceptions**.

When you have finished setting the language and proxy, type `http://nnn.nnn.nnn.nnn/` (the printer's IP address) in the URL entry field of the browser to activate the Dell Printer Configuration Web Tool.

**For Netscape Communicator 7.1**

**Setting Up the Display Language**

1. Select **Preferences** from **Edit** on the menu bar.

2. Select **Languages** under the **Navigator** group.

3. Specify the display language in order of preference in the **Language in order of preference** list.

   For example:
   - English [en] or English/United States [en-us]
   - German [de]
   - French [fr]
   - Italian [it]
   - Spanish [es]

**Setting the Printer's IP Address to Non-proxy**

1. Select **Preferences** from **Edit** on the menu bar.

2. Select **Proxies** under **Advanced** of the **Navigator** group.
3. Select either Direct connection to the Internet or Manual proxy configuration. When you select Manual proxy configuration, specify the printer's IP address in the No Proxy for: box.

When you have finished setting the language and proxy, type http://nnn.nnn.nnn.nnn/ (the printer's IP address) in the URL entry field of the browser to activate the Dell Printer Configuration Web Tool.

For Firefox 1.5 or Later

Setting Up the Display Language

1. Select Options from Tools on the menu bar.
2. Click Advanced on the Options dialog box.
3. Click Edit Languages in the General tab.
4. Specify the display language in order of preference in the Language in order of preference list.

For example:

English [en] or English/United States [en-gb]
Italian [it]
Spanish [es]
German [de]
French [fr]

Setting the Printer's IP Address to Non-proxy

1. Select Options from Tools on the menu bar.
2. Click General on the Options dialog box.
3. Click Connection Settings.
4. Do one of the following.
   - Select the Direct connection to the Internet check box.
   - Select the Auto-detect proxy settings for this network check box
   - Select the Manual proxy configuration check box, and then enter the printer's IP address in the No Proxy for edit box.
   - Select the Automatic proxy configuration URL check box

When you have finished setting the language and proxy, type http://nnn.nnn.nnn.nnn/ (the printer's IP address) in the URL entry field of the browser to activate the Dell Printer Configuration Web Tool.
Page Display Format

The layout of the page is divided into three sections.

Top Frame

Located at the top of all pages is the Top Frame. When Dell Printer Configuration Web Tool is activated, the current status and specifications of the printer are displayed in the Top Frame on every page.

The following items are displayed in the Top Frame.

<table>
<thead>
<tr>
<th><strong>Dell Color Laser 3110cn</strong></th>
<th>Displays the printer product name.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>IP Address:</strong></td>
<td>Displays the printer's IP address.</td>
</tr>
<tr>
<td><strong>Location:</strong></td>
<td>Displays the printer's location. The location can be changed in Basic Information on the Print Server Settings page.</td>
</tr>
<tr>
<td><strong>Contact Person:</strong></td>
<td>Displays the printer's administrator's name. The name can be changed in the Basic Information on the Print Server Settings page.</td>
</tr>
<tr>
<td><strong>Printer Console</strong></td>
<td>Displays the status of the printer operator panel display and indicators. This is automatically refreshed at the set interval. The interval can be changed in the Basic Information on Print Server Settings page.</td>
</tr>
<tr>
<td><strong>Help</strong></td>
<td>Links to the Dell web page. See the User's Guide on that page.</td>
</tr>
<tr>
<td><strong>Printer Bitmap</strong></td>
<td>Shows the printer bitmap. The Printer Status menu appears in the Right Frame by clicking the image.</td>
</tr>
</tbody>
</table>

Left Frame

Located at the left side of all pages is the Left Frame. The titles of menus displayed in the Left Frame are linked to corresponding menus and pages. You can go to the corresponding page by clicking their characters.

The following menus are displayed in the Left Frame.
<table>
<thead>
<tr>
<th></th>
<th>Links to the menu.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Printer Status</strong></td>
<td>Links to the Printer Status menu.</td>
</tr>
<tr>
<td><strong>Printer Jobs</strong></td>
<td>Links to the Printer Jobs menu.</td>
</tr>
<tr>
<td><strong>Printer Settings</strong></td>
<td>Links to the Printer Settings Report menu.</td>
</tr>
<tr>
<td><strong>Print Server Settings</strong></td>
<td>Links to the Print Server Reports menu.</td>
</tr>
<tr>
<td><strong>Copy Printer Settings</strong></td>
<td>Links to the Copy Printer Settings menu.</td>
</tr>
<tr>
<td><strong>Print Volume</strong></td>
<td>Links to the Print Volume menu</td>
</tr>
<tr>
<td><strong>Printer Information</strong></td>
<td>Links to the Printer Status menu.</td>
</tr>
<tr>
<td><strong>Tray Settings</strong></td>
<td>Links to the Tray Settings menu.</td>
</tr>
<tr>
<td><strong>E-Mail Alert</strong></td>
<td>Links to the Print Server Settings menu.</td>
</tr>
<tr>
<td><strong>Set Password</strong></td>
<td>Links to the Other Features menu.</td>
</tr>
<tr>
<td><strong>Online Help</strong></td>
<td>Links to the Dell web page. See the User’s Guide on that page.</td>
</tr>
<tr>
<td><strong>Order Supplies at:</strong></td>
<td>Links to the Dell web page.</td>
</tr>
<tr>
<td><strong>Contact Dell Support at:</strong></td>
<td>Links to the Dell support page. Web address: <a href="http://support.dell.com/">http://support.dell.com/</a></td>
</tr>
</tbody>
</table>

**Right Frame**

Located at the right side of all pages is the Right Frame. The contents of the Right Frame correspond to the menu that you select in the Left Frame. For details on the items displayed in the Right Frame, see “Details of Menu Items.”

**Buttons on the Right Frame**

**Refresh Button**

Receives the current printer configuration and updates the latest information in the Right Frame.

**Apply New Settings Button**

Submits new settings made on the Dell Printer Configuration Web Tool to the printer. The old printer settings will be replaced by the new settings.

**Restart printer to apply new settings Button**

Submits new settings made on the Dell Printer Configuration Web Tool to the printer and reboots the printer. The old printer settings will be replaced by the new settings.

**Restore Settings Button**

Restores the old settings from before changes made. New settings will not be submitted to the printer.

**Changing the Settings of Menu Items**
Some menus allow you to change the printer settings through the **Dell Printer Configuration Web Tool**. When you are accessing these menus, the authentication dialog appears on the screen. Type a user name and password for the printer’s administrator by following the prompts displayed in the dialog box.

The default user name is **admin**, and the default password is left blank (NULL). You can change only the password in the **Set Password** page in the **Print Server Settings** menu. The user name cannot be changed. See “Set Password” for more information.

### Details of Menu Items

<table>
<thead>
<tr>
<th>&quot;Printer Status &quot;</th>
<th>&quot;Printer Status &quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>&quot;Printer Events &quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Printer Information &quot;</td>
</tr>
</tbody>
</table>

| "Printer Jobs " | "Job List " |
|                | "Completed Jobs " |

<table>
<thead>
<tr>
<th>&quot;Printer Settings &quot;</th>
<th>&quot;Printer Settings Report &quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Menu Settings &quot;</td>
<td>&quot;Reports &quot;</td>
</tr>
<tr>
<td>&quot;System Settings &quot;</td>
<td>&quot;Parallel Settings &quot;</td>
</tr>
<tr>
<td>&quot;Network Settings &quot;</td>
<td>&quot;*4&quot;</td>
</tr>
<tr>
<td>&quot;USB Settings &quot;</td>
<td>&quot;*4&quot;</td>
</tr>
<tr>
<td>&quot;PCL Settings &quot;</td>
<td>&quot;PS Settings &quot;</td>
</tr>
<tr>
<td>&quot;Panel Settings &quot;</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>&quot;Printer Maintenance &quot;</th>
<th>&quot;Paper Density &quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>&quot;Adjust BTR &quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Adjust Fuser &quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Auto Registration Adjustment &quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Color Registration Adjustments &quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Adjust Altitude &quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Reset Defaults &quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Clear Storage &quot;</td>
</tr>
</tbody>
</table>

*1: Indicates a menu that requires administrative access.
*4: Indicates a menu that is available in the network configuration mode.
"Non-Dell Toner"
"Initialize PrintMeter"
"Web Link Customization"

"Print Server Settings"
"Print Server Reports"
"Print Server Setup Page"
"NetWare Setup Page "*2
"E-Mail Alert Setup Page"

"Print Server Settings"
"Basic Information"
"Port Settings"
"Wireless LAN "*3
"TCP/IP"
"NetWare "*2
"SMB "*2
"AppleTalk "*3
"E-Mail Alert"
"Bonjour (mDNS) "*4
"SNMP"

"Other Features"
"Set Password"
"Security"
"IPsec "*2
"Reset Print Server"

"Copy Printer Settings"
"Copy Printer Settings"
"Copy Printer Settings Report"

"Print Volume"
"Print Volume"
"Dell ColorTrack"

"Tray Settings"
"Tray 1 Paper Type"
"Tray 1 Paper Size"
"Tray 1 Custom Size - Y"
"Tray 1 Custom Size - X"
<table>
<thead>
<tr>
<th>Tray 2 Paper Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tray 2 Paper Size</td>
</tr>
<tr>
<td>Tray 2 Custom Size - Y</td>
</tr>
<tr>
<td>Tray 2 Custom Size - X</td>
</tr>
<tr>
<td>MPF Mode</td>
</tr>
<tr>
<td>Display Popup</td>
</tr>
<tr>
<td>MPF Paper Type</td>
</tr>
<tr>
<td>MPF Paper Size</td>
</tr>
<tr>
<td>MPF Custom Size - Y</td>
</tr>
<tr>
<td>MPF Custom Size - X</td>
</tr>
</tbody>
</table>

*1 This item is only available when the RAM disk is set to on.
*2 This item is only available when the optional multi protocol card is installed.
*3 This item is only available when the optional wireless printer adapter is installed.
*4 This item is only available with the printer using the postscript driver.
*5 This item is only available when the optional 550-sheet feeder is installed.

**Printer Status**

Use the **Printer Status** menu to check the status of consumables, hardware, and specifications of the printer.

The following pages are displayed in the **Printer Status** menu.

**Printer Status**

**Purpose:**

To check the status of remaining consumables and trays.

**Values:**
Cyan Cartridge Level
Magenta Cartridge Level
Yellow Cartridge Level
Black Cartridge Level

Displays the percent of toner remaining in each print cartridge. When a cartridge is empty, a message appears. The text *Print Cartridge* is linked to the Dell Printer Supplies website.

<table>
<thead>
<tr>
<th>Consumables Status</th>
<th>n%</th>
<th>Indicates the toner remaining in each print cartridge as %. &quot;n&quot; is a number.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Empty</td>
<td>Indicates that consumables are used up.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Paper Trays Status</th>
<th>OK</th>
<th>Indicates that there is some paper in the tray but the quantity is unknown.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Add Paper</td>
<td>Indicates that there is no paper in the tray.</td>
</tr>
<tr>
<td></td>
<td>Capacity</td>
<td>Displays the maximum capacity of the paper tray.</td>
</tr>
<tr>
<td></td>
<td>Size</td>
<td>Displays the size of paper in the tray.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Output Tray Status</th>
<th>OK</th>
<th>Indicates that the tray is available.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Full</td>
<td>Indicates that the tray is not available.</td>
</tr>
<tr>
<td></td>
<td>Capacity</td>
<td>Displays the maximum capacity of the paper tray.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Cover Status</th>
<th>Closed</th>
<th>Indicates that the cover is closed.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Open</td>
<td>Indicates that the cover is open.</td>
</tr>
</tbody>
</table>

| Printer Type | Displays the type of printing for the printer. *Color Laser* is displayed normally. |

| Printing Speed | Displays the printing speed for the printer. |

**Printer Events**

**Purpose:**
When printer faults occur such as *running out of paper* or *running out of print cartridge* , the details of all alerts or indications of faults are displayed in the **Printer Events** page.

**Values:**

<table>
<thead>
<tr>
<th>Location</th>
<th>Displays the location where the printer fault occurred.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Details</td>
<td>Displays the details of the printer fault.</td>
</tr>
</tbody>
</table>

**Printer Information**

**Purpose:**
To verify the printer details such as hardware configuration and software version. This page can also be displayed by clicking **Printer Information** in the Left Frame.
Values:

<table>
<thead>
<tr>
<th>Dell Service Tag Number</th>
<th>Displays Dell's service tag number.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asset Tag Number</td>
<td>Displays the printer's asset tag number.</td>
</tr>
<tr>
<td>Printer Serial Number</td>
<td>Displays the printer's serial number.</td>
</tr>
<tr>
<td>Memory Capacity</td>
<td>Displays the memory capacity.</td>
</tr>
<tr>
<td>Processor Speed</td>
<td>Displays the processing speed.</td>
</tr>
<tr>
<td>Printer Revision Levels</td>
<td>Firmware Version</td>
</tr>
<tr>
<td></td>
<td>Network Firmware Version</td>
</tr>
</tbody>
</table>

**Printer Jobs**

The **Printer Jobs** menu contains information on the **Job List** and **Completed Jobs** pages. These pages show the details of the status regarding each protocol or the print jobs.

**Job List**

**Purpose:**

To confirm the print jobs that are being processed. Click the **Refresh** button to update the screen.

**Values:**

<table>
<thead>
<tr>
<th>ID</th>
<th>Displays the job id.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Job Name</td>
<td>Displays the file name of the job being printed.</td>
</tr>
<tr>
<td>Owner</td>
<td>Displays the job owner's name.</td>
</tr>
<tr>
<td>Host Name</td>
<td>Displays the name of the host computer.</td>
</tr>
<tr>
<td>Job Status</td>
<td>Displays the status of the job being printed.</td>
</tr>
<tr>
<td>Host I/F</td>
<td>Displays the status of the host interface.</td>
</tr>
<tr>
<td>Job Submitted Time</td>
<td>Displays the date the print job was submitted.</td>
</tr>
</tbody>
</table>

**Completed Jobs**

**Purpose:**

To check the completed print jobs. Up to the last 22 print jobs are displayed. Click the **Refresh** button to update the screen.

**Values:**
<table>
<thead>
<tr>
<th>Id</th>
<th>Displays the job id.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Job Name</td>
<td>Displays the file name of the completed print job.</td>
</tr>
<tr>
<td>Owner</td>
<td>Displays the job owner's name.</td>
</tr>
<tr>
<td>Host Name</td>
<td>Displays the name of the host computer.</td>
</tr>
<tr>
<td>Output Result</td>
<td>Displays the status of completed print jobs.</td>
</tr>
<tr>
<td>Impression Number</td>
<td>Displays the number of pages in the print job.</td>
</tr>
<tr>
<td>No. of Sheets</td>
<td>Displays the number of sheets in the print job.</td>
</tr>
<tr>
<td>Host I/F</td>
<td>Displays the status of the host interface.</td>
</tr>
<tr>
<td>Job Submitted Time</td>
<td>Displays the date the print job was submitted.</td>
</tr>
</tbody>
</table>

**Printer Settings**

Use the **Printer Settings** menu to display the printer settings report and to configure printer settings.

The following tabbed pages are displayed at the top of the Right Frame.

**Printer Settings Report**

The **Printer Settings Report** tab includes the **Menu Settings** and **Reports** pages.

**Menu Settings**

**Purpose:**

To display the current settings of the operator panel menus.

**Values:**

<table>
<thead>
<tr>
<th>System Settings</th>
<th>Power Saver Timer Mode 1 *1</th>
<th>Displays the amount of time before the printer enters the power saver timer mode 1 after it finishes a print job.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Power Saver Timer Mode 2 *1</td>
<td>Displays the amount of time before the printer enters the power saver timer mode 2 after it finishes a print job.</td>
</tr>
<tr>
<td></td>
<td>Alert Tone</td>
<td>Displays whether the printer sounds an alarm when an error occurs.</td>
</tr>
<tr>
<td></td>
<td>Time-Out</td>
<td>Displays specify the amount of time the printer waits to receive additional bytes of data from the computer.</td>
</tr>
<tr>
<td></td>
<td>Panel Language</td>
<td>Displays the language of the text on the operator panel screen.</td>
</tr>
<tr>
<td></td>
<td>Auto Log Print</td>
<td>Displays whether the printer outputs logs automatically.</td>
</tr>
<tr>
<td></td>
<td>Print ID</td>
<td>Displays a location where the user ID is printed.</td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>Print Text</td>
<td>Displays whether the printer outputs PDL data, which is not supported by the printer, as text when the printer receives it.</td>
<td></td>
</tr>
<tr>
<td>Banner Sheet Insert Position</td>
<td>Displays the position of banner sheet.</td>
<td></td>
</tr>
<tr>
<td>Banner Sheet Specify Tray</td>
<td>Displays the tray in which the banner sheet is loaded.</td>
<td></td>
</tr>
<tr>
<td>RAM Disk</td>
<td>Displays whether to allocate memory to the RAM disk file system for the Secure Print and Proof Print features. This item is only available when the 256 MB, or higher, optional memory card is installed.</td>
<td></td>
</tr>
<tr>
<td>Substitute Tray</td>
<td>Displays whether or not to use another size paper when the paper that is loaded in the specified tray does not match the paper size settings for the current job.</td>
<td></td>
</tr>
<tr>
<td>mm/inch</td>
<td>Displays the measurement unit on the operator panel screen.</td>
<td></td>
</tr>
<tr>
<td>Parallel Settings</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ECP</td>
<td>Displays the ECP communication mode of the parallel interface.</td>
<td></td>
</tr>
<tr>
<td>Adobe Protocol</td>
<td>Displays PostScript communication protocol for each interface.</td>
<td></td>
</tr>
<tr>
<td>Network Settings</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Adobe Protocol</td>
<td>Displays PostScript communication protocol for each interface.</td>
<td></td>
</tr>
<tr>
<td>USB Settings</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Adobe Protocol</td>
<td>Displays PostScript communication protocol for each interface.</td>
<td></td>
</tr>
<tr>
<td>PCL Settings</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Paper Tray</td>
<td>Displays the input tray.</td>
<td></td>
</tr>
<tr>
<td>Paper Size</td>
<td>Displays the default paper size.</td>
<td></td>
</tr>
<tr>
<td>Custom Size - Y</td>
<td>Displays the length of paper.</td>
<td></td>
</tr>
<tr>
<td>Custom Size - X</td>
<td>Displays the width of paper.</td>
<td></td>
</tr>
<tr>
<td>Orientation</td>
<td>Displays how text and graphics are oriented on the page.</td>
<td></td>
</tr>
<tr>
<td>2 Sided</td>
<td>Displays whether to do duplexing as the default for all print jobs. This item is only available when the optional duplexer is installed.</td>
<td></td>
</tr>
<tr>
<td>Font</td>
<td>Displays the default font from the registered fonts in the printer.</td>
<td></td>
</tr>
<tr>
<td>Symbol Set</td>
<td>Displays a symbol set for a specified font.</td>
<td></td>
</tr>
<tr>
<td>Font Size</td>
<td>Displays the font size for scalable typographic fonts.</td>
<td></td>
</tr>
<tr>
<td>Font Pitch</td>
<td>Displays the font pitch for scalable monospaced fonts.</td>
<td></td>
</tr>
<tr>
<td>Form Line</td>
<td>Displays the number of characters in a line.</td>
<td></td>
</tr>
<tr>
<td>Quantity</td>
<td>Displays the number of copies you want for the printer default value.</td>
<td></td>
</tr>
<tr>
<td>Image Enhancement</td>
<td>Displays whether to perform the image enhancement feature.</td>
<td></td>
</tr>
<tr>
<td>Hex Dump</td>
<td>Displays whether the Hex Dump feature is on or off.</td>
<td></td>
</tr>
<tr>
<td>----------</td>
<td>-----------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>Draft Mode</td>
<td>Displays whether to print in the draft mode.</td>
<td></td>
</tr>
<tr>
<td>Line Termination</td>
<td>Displays whether to set the line termination.</td>
<td></td>
</tr>
<tr>
<td>Default Color</td>
<td>Displays the color mode setting.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>PS Settings</th>
<th>PS Error Report</th>
<th>Displays whether the printer outputs error contents for a PostScript error.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>PS Job Time-Out</td>
<td>Displays the execution time for one PostScript job.</td>
</tr>
<tr>
<td></td>
<td>Paper Select Mode</td>
<td>Displays the tray that is selected in the PostScript printing.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Panel Settings</th>
<th>Panel Lock</th>
<th>Displays whether the panel is locked by a password.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Paper Density</th>
<th>Plain</th>
<th>Displays the paper density for the plain paper.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Displays the paper density for the label.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Adjust BTR</th>
<th>Plain</th>
<th>Displays the voltage settings of the transfer roller for plain paper.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain Thick</td>
<td>Displays the voltage settings of the transfer roller for thick plain paper.</td>
<td></td>
</tr>
<tr>
<td>Transparency</td>
<td>Displays the voltage settings of the transfer roller for transparencies.</td>
<td></td>
</tr>
<tr>
<td>Covers</td>
<td>Displays the voltage settings of the transfer roller for cover paper.</td>
<td></td>
</tr>
<tr>
<td>Covers Thick</td>
<td>Displays the voltage settings of the transfer roller for thick cover paper.</td>
<td></td>
</tr>
<tr>
<td>Label</td>
<td>Displays the voltage settings of the transfer roller for labels.</td>
<td></td>
</tr>
<tr>
<td>Coated</td>
<td>Displays the voltage settings of the transfer roller for coated paper.</td>
<td></td>
</tr>
<tr>
<td>Coated Thick</td>
<td>Displays the voltage settings of the transfer roller for thick coated paper.</td>
<td></td>
</tr>
<tr>
<td>Envelope</td>
<td>Displays the voltage settings of the transfer roller for envelopes.</td>
<td></td>
</tr>
<tr>
<td>Recycled</td>
<td>Displays the voltage settings of the transfer roller for recycled paper.</td>
<td></td>
</tr>
<tr>
<td>JPN Coated</td>
<td>Displays the voltage settings of the transfer roller for Japanese coated paper.</td>
<td></td>
</tr>
<tr>
<td>JPN Postcard</td>
<td>Displays the voltage settings of the transfer roller for Japanese postcards.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Adjust Fuser</th>
<th>Plain</th>
<th>Displays the temperature settings of the fuser for plain paper.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Setting</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>Plain Thick</td>
<td>Displays the temperature settings of the fuser for thick plain paper.</td>
<td></td>
</tr>
<tr>
<td>Transparency</td>
<td>Displays the temperature settings of the fuser for transparencies.</td>
<td></td>
</tr>
<tr>
<td>Covers</td>
<td>Displays the temperature settings of the fuser for cover paper.</td>
<td></td>
</tr>
<tr>
<td>Covers Thick</td>
<td>Displays the temperature settings of the fuser for thick cover paper.</td>
<td></td>
</tr>
<tr>
<td>Label</td>
<td>Displays the temperature settings of the fuser for labels.</td>
<td></td>
</tr>
<tr>
<td>Coated</td>
<td>Displays the temperature settings of the fuser for coated paper.</td>
<td></td>
</tr>
<tr>
<td>Coated Thick</td>
<td>Displays the temperature settings of the fuser for thick coated paper.</td>
<td></td>
</tr>
<tr>
<td>Envelope</td>
<td>Displays the temperature settings of the fuser for envelopes.</td>
<td></td>
</tr>
<tr>
<td>Recycled</td>
<td>Displays the temperature settings of the fuser for recycled paper.</td>
<td></td>
</tr>
<tr>
<td>JPN Coated</td>
<td>Displays the temperature settings of the fuser for Japanese coated paper.</td>
<td></td>
</tr>
<tr>
<td>JPN Postcard</td>
<td>Displays the temperature settings of the fuser for Japanese postcards.</td>
<td></td>
</tr>
<tr>
<td>Auto Registration Adjustment</td>
<td>Displays whether to adjust the color registration automatically.</td>
<td></td>
</tr>
<tr>
<td>Non-Dell Toner</td>
<td>Displays whether to use a refilled print cartridge.</td>
<td></td>
</tr>
<tr>
<td>Web Link Customization</td>
<td>Displays the URL that <a href="http://accessories.us.dell.com/sna">Order Supplies at</a> links to in the left frame.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Regular <a href="http://accessories.us.dell.com/sna">http://accessories.us.dell.com/sna</a></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Premier <a href="http://premier.dell.com">http://premier.dell.com</a></td>
<td></td>
</tr>
<tr>
<td>Tray Settings</td>
<td>Displays the type of paper loaded in the standard 250-sheet tray.</td>
<td></td>
</tr>
<tr>
<td>Tray 1 Paper Type</td>
<td>Displays the size of paper loaded in the standard 250-sheet tray.</td>
<td></td>
</tr>
<tr>
<td>Tray 1 Custom Size - Y</td>
<td>Displays the length of paper loaded in the standard 250-sheet tray.</td>
<td></td>
</tr>
<tr>
<td>Tray 1 Custom Size - X</td>
<td>Displays the width of paper loaded in the standard 250-sheet tray.</td>
<td></td>
</tr>
<tr>
<td>Tray 2 Paper Type</td>
<td>Displays the type of paper loaded in the optional 550-sheet feeder.</td>
<td></td>
</tr>
<tr>
<td>Tray 2 Paper Size</td>
<td>Displays the size of paper loaded in the standard 550-sheet feeder</td>
<td></td>
</tr>
<tr>
<td>-------------------</td>
<td>----------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>Tray 2 Custom Size - Y</td>
<td>Displays the length of paper loaded in the optional feeder.</td>
<td></td>
</tr>
<tr>
<td>Tray 2 Custom Size - X</td>
<td>Displays the width of paper loaded in the optional feeder.</td>
<td></td>
</tr>
<tr>
<td>MPF Mode</td>
<td>Displays the paper size and type when paper is loaded in the multipurpose feeder.</td>
<td></td>
</tr>
<tr>
<td>Display Popup</td>
<td>Displays a popup menu when paper is loaded in the multipurpose feeder.</td>
<td></td>
</tr>
<tr>
<td>MPF Paper Type</td>
<td>Displays the type of paper loaded in the multipurpose feeder.</td>
<td></td>
</tr>
<tr>
<td>MPF Paper Size</td>
<td>Displays the size of paper loaded in the multipurpose feeder.</td>
<td></td>
</tr>
<tr>
<td>MPF Custom Size - Y</td>
<td>Displays the length of paper loaded in the multipurpose feeder.</td>
<td></td>
</tr>
<tr>
<td>MPF Custom Size - X</td>
<td>Displays the width of paper loaded in the multipurpose feeder.</td>
<td></td>
</tr>
</tbody>
</table>

*3 All changes made on the Printer Settings, Copy Printer Settings, Dell ColorTrack, and Tray Settings menus on the Dell Printer Configuration Web Tool are discarded if they are made while the printer is in power saver mode. Exit the mode to change the settings.

Reports

Purpose:
To print various types of reports and lists.

Values:

<table>
<thead>
<tr>
<th>Printer Settings</th>
<th>Click the Start button to print the printer settings page.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Panel Settings</td>
<td>Click the Start button to print the panel settings page.</td>
</tr>
<tr>
<td>PCL Fonts List</td>
<td>Click the Start button to print the PCL fonts list.</td>
</tr>
<tr>
<td>PCL Macro List</td>
<td>Click the Start button to print the PCL Macro list.</td>
</tr>
<tr>
<td>Job History</td>
<td>Click the Start button to print the job history report.</td>
</tr>
<tr>
<td>Error History</td>
<td>Click the Start button to print the error history report.</td>
</tr>
<tr>
<td>PS Fonts List</td>
<td>Click the Start button to print the PS fonts list.</td>
</tr>
<tr>
<td>Print Meter</td>
<td>Click the Start button to print the print volume report.</td>
</tr>
<tr>
<td>Color Test Page</td>
<td>Click the Start button to print the color test page.</td>
</tr>
</tbody>
</table>
Stored Documents
Click the **Start** button to print the stored documents list. This item is only available when the Ram disk is set to on.

### Printer Settings

The **Printer Settings** tab includes System Settings, Parallel Settings, Network Settings, USB Settings, PCL Settings, PS Settings, and Panel Settings pages.

#### System Settings

**Purpose:**
To configure the basic printer settings.

**Values:**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Power Saver Timer Mode 1</strong></td>
<td>Specifies the amount of time before the printer enters the power saver timer mode 1 after it finishes a print job in minutes between 5 and 60.</td>
</tr>
<tr>
<td><strong>Power Saver Timer Mode 2</strong></td>
<td>Specifies the amount of time before the printer enters the power saver timer mode 2 after it finishes a print job in minutes between 1 and 6.</td>
</tr>
<tr>
<td><strong>Alert Tone</strong></td>
<td>Specifies whether the printer sounds an alarm when an error occurs.</td>
</tr>
<tr>
<td><strong>Time-Out</strong></td>
<td>Specifies the amount of time the printer waits to receive additional bytes of data from the computer. When this timeout expires, the print job is canceled.</td>
</tr>
<tr>
<td><strong>Panel Language</strong></td>
<td>Determine the language of the text on the operator panel screen.</td>
</tr>
<tr>
<td><strong>Auto Log Print</strong></td>
<td>Specifies whether the printer outputs logs automatically.</td>
</tr>
<tr>
<td><strong>Print ID</strong></td>
<td>Specifies a location where the user ID is printed.</td>
</tr>
<tr>
<td><strong>Print Text</strong></td>
<td>Specifies whether the printer outputs PDL data, which is not supported by the printer, as text when the printer receives it.</td>
</tr>
<tr>
<td><strong>Banner Sheet Insert Position</strong></td>
<td>Specifies the position of banner sheet.</td>
</tr>
<tr>
<td><strong>Banner Sheet Specify Tray</strong></td>
<td>Specifies the tray in which the banner sheet is loaded.</td>
</tr>
<tr>
<td><strong>RAM Disk</strong></td>
<td>Specifies whether to allocate memory to the RAM disk file system for the Secure Print and Store Print features. This item is only available when the 256 MB, or higher, optional memory card is installed.</td>
</tr>
<tr>
<td><strong>Substitute Tray</strong></td>
<td>Specifies whether or not to use another size paper when the paper that is loaded in the specified tray does not match the paper size settings for the current job.</td>
</tr>
<tr>
<td><strong>mm/inch</strong></td>
<td>Specifies the measurement unit on the operator panel screen as either mm or inches.</td>
</tr>
</tbody>
</table>

#### Parallel Settings
Purpose:
To configure the parallel interface.

Values:

<table>
<thead>
<tr>
<th>ECP</th>
<th>Specifies the ECP communication mode of the parallel interface.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adobe Protocol</td>
<td>Specifies PostScript communication protocol for each interface.</td>
</tr>
</tbody>
</table>

Network Settings

Purpose:
To Specify the PostScript communication protocol for this printer.

Values:

| Adobe Protocol | Specifies PostScript communication protocol for each interface. |

USB Settings

Purpose:
To change printer settings affecting a USB port.

Values:

| Adobe Protocol | Specifies PostScript communication protocol for each interface. |

PCL Settings

Purpose:
To change printer settings that only affect jobs using the PCL emulation printer language.

Values:
<table>
<thead>
<tr>
<th>Paper Tray</th>
<th>Specifies the input tray.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paper Size</td>
<td>Specifies the default paper size.</td>
</tr>
<tr>
<td>Custom Size - Y</td>
<td>Specifies the length of paper. The available range is from 98 mm (3.89 in.) to 355 mm (13.98 in.).</td>
</tr>
<tr>
<td>Custom Size - X</td>
<td>Specifies the width of paper. The available range is from 77 mm (3.03 in.) to 220 mm (8.66 in.).</td>
</tr>
<tr>
<td>Orientation</td>
<td>Specifies how text and graphics are oriented on the page.</td>
</tr>
<tr>
<td>2 Sided</td>
<td>Sets duplexing as the default for all print jobs. This item is only available when the optional duplexer is installed.</td>
</tr>
<tr>
<td>Font</td>
<td>Specifies the default font from the registered fonts in the printer.</td>
</tr>
<tr>
<td>Symbol Set</td>
<td>Specifies a symbol set for a specified font.</td>
</tr>
<tr>
<td>Font Size</td>
<td>Specifies the font size for scalable typographic fonts.</td>
</tr>
<tr>
<td>Font Pitch</td>
<td>Specifies the font pitch for scalable monospaced fonts.</td>
</tr>
<tr>
<td>Form Line</td>
<td>Specifies the number of characters in a line.</td>
</tr>
<tr>
<td>Quantity</td>
<td>Sets the number of copies you want for the printer default value.</td>
</tr>
<tr>
<td>Image Enhancement</td>
<td>Specifies whether to perform the image enhancement feature.</td>
</tr>
<tr>
<td>Hex Dump</td>
<td>Specifies whether to help isolate the source of a print job problem. With Hex Dump selected, all data sent to the printer is printed in hexadecimal and character representation. Control codes are not executed.</td>
</tr>
<tr>
<td>Draft Mode</td>
<td>Specifies whether to print in the draft mode.</td>
</tr>
<tr>
<td>Line Termination</td>
<td>Sets the line termination.</td>
</tr>
<tr>
<td>Default Color</td>
<td>Specifies the color mode to <strong>Color</strong> or <strong>Black</strong>. This setting is used when the color printing mode setting is not specified for the print job that is sent to the printer.</td>
</tr>
</tbody>
</table>

**PS Settings**

**Purpose:**

To change printer settings that only affect jobs using the PostScript emulation printer language.

**Values:**

<table>
<thead>
<tr>
<th>PS Error Report</th>
<th>Specifies whether the printer outputs error contents for a PostScript error.</th>
</tr>
</thead>
<tbody>
<tr>
<td>PS Job Time-Out</td>
<td>Specifies the execution time for one PostScript job.</td>
</tr>
<tr>
<td>Paper Select Mode</td>
<td>Specifies the way to select the tray for the PostScript mode.</td>
</tr>
</tbody>
</table>
Panel Settings

Purpose:
To set or change the password to limit access to the menus from the operator panel.

Set the password of the **Dell Printer Configuration Web Tool** from **Set Password** in **Print Server Settings**.

Values:

<table>
<thead>
<tr>
<th>Panel Lock</th>
<th>Specifies whether to limit access to the menus.</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Password</td>
<td>Sets a password to limit access to the menus.</td>
</tr>
<tr>
<td>Re-enter Password</td>
<td>Type the new password again to confirm.</td>
</tr>
</tbody>
</table>

**NOTE:** This menu sets a password to lock the operator panel. When changing the password for the **Dell Printer Configuration Web Tool**, click **Set Password** on the left frame and set the password.

Printed Maintenance

The **Printed Maintenance** tab includes **Paper Density**, **Adjust BTR**, **Adjust Fuser**, **Auto Registration Adjustment**, **Color Registration Adjustments**, **Adjust Altitude**, **Reset Defaults**, **Clear Storage**, **Non-Dell Toner**, **Initialize PrintMeter**, and **Web Link Customization** pages.

Paper Density

Purpose:
To specify the paper density.

Values:

<table>
<thead>
<tr>
<th>Plain</th>
<th>Light</th>
<th>Normal</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Light</td>
<td>Normal</td>
</tr>
</tbody>
</table>

Adjust BTR

Purpose:
To specify the reference voltage settings for the transfer roller.

Values:
Plain | Sets the reference voltage settings for the transfer roller for plain paper.
---|---
Plain Thick | Sets the reference voltage settings for the transfer roller for thick plain paper.
Transparency | Sets the reference voltage settings for the transfer roller for transparencies.
Covers | Sets the reference voltage settings for the transfer roller for cover paper.
Covers Thick | Sets the reference voltage settings for the transfer roller for thick cover paper.
Label | Sets the reference voltage settings for the transfer roller for labels.
Coated | Sets the reference voltage settings for the transfer roller for coated paper.
Coated Thick | Sets the reference voltage settings for the transfer roller for thick coated paper.
Envelope | Sets the reference voltage settings for the transfer roller for envelopes.
Recycled | Sets the reference voltage settings of the transfer roller for recycled paper.
JPN Coated | Sets the reference voltage settings of the transfer roller for Japanese coated paper.
JPN Postcard | Sets the reference voltage settings of the transfer roller for Japanese postcards.

**Adjust Fuser**

**Purpose:**
To specify the temperature settings value for the fuser.

**Values:**

<table>
<thead>
<tr>
<th>Plain</th>
<th>Sets the temperature settings for the fuser for plain paper.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain Thick</td>
<td>Sets the temperature settings for the fuser for thick plain paper.</td>
</tr>
<tr>
<td>Transparency</td>
<td>Sets the temperature settings for the fuser for transparencies.</td>
</tr>
<tr>
<td>Covers</td>
<td>Sets the temperature settings for the fuser for cover paper.</td>
</tr>
<tr>
<td>Covers Thick</td>
<td>Sets the temperature settings for the fuser for thick cover paper.</td>
</tr>
<tr>
<td>Label</td>
<td>Sets the temperature settings for the fuser for labels.</td>
</tr>
<tr>
<td>Coated</td>
<td>Sets the temperature settings for the fuser for coated paper.</td>
</tr>
<tr>
<td>Coated Thick</td>
<td>Sets the temperature settings for the fuser for thick coated paper.</td>
</tr>
<tr>
<td>Envelope</td>
<td>Sets the temperature settings for the fuser for envelopes.</td>
</tr>
<tr>
<td>Recycled</td>
<td>Sets the temperature settings of the fuser for recycled paper.</td>
</tr>
<tr>
<td>JPN Coated</td>
<td>Sets the temperature settings of the fuser for Japanese coated paper.</td>
</tr>
<tr>
<td>JPN Postcard</td>
<td>Sets the temperature settings of the fuser for Japanese postcards.</td>
</tr>
</tbody>
</table>
Auto Registration Adjustment

Purpose:
Specifies whether to adjust the color registration automatically.

Values:

<table>
<thead>
<tr>
<th>Auto Registration Adjustment</th>
<th>Specifies whether to adjust the color registration automatically.</th>
</tr>
</thead>
</table>

Color Registration Adjustments

Purpose:
To print the color registration chart and to adjust the color registration by using the chart.
This function is required after the printer is set up or moved.

Values:

<table>
<thead>
<tr>
<th>Auto Correct</th>
<th>Click Start to adjust color registration automatically.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color Regi Chart</td>
<td>Click Start to print the color registration chart.</td>
</tr>
<tr>
<td>Enter Number</td>
<td>Yellow specifies the values that are found in the color registration chart.</td>
</tr>
<tr>
<td></td>
<td>Magenta</td>
</tr>
<tr>
<td></td>
<td>Cyan</td>
</tr>
</tbody>
</table>

Adjust Altitude

Purpose:
To adjust the height of the installation location of the printer.

Values:

| 0 meter | Select the value close to the height of the installation location of the printer. |
| 1000 meters |
| 2000 meters |
| 3000 meters |

Reset Defaults

Purpose:
To initialize the NV (non-volatile) memory. After executing this function and rebooting the printer, all the menu parameters are reset to their default values.
Reset Defaults and restart printer. Click Start to initialize the NVM memory.

Clear Storage

Purpose:
To clear all files that are stored as Secure and Proof Print in the RAM disk. This item is only available when the RAM disk is set to on.

Values:

| Clear Storage | Click Start to clear all files stored in the RAM disk. |

Non-Dell Toner

Purpose:
Specifies whether to use the refilled print cartridge or not. When this setting is on, you can use print cartridges provided by other companies.

Values:

| Non-Dell Toner | Overrides factory print cartridge setting. Non-Dell-brand print cartridges may disable some printer features, reduce print quality and reduce the reliability of your printer. Dell recommends only new Dell-brand print cartridges for your printer. Dell does not provide warranty coverage for problems caused by using accessories, parts, or components not supplied by Dell. |

Initialize PrintMeter

Purpose:
To initialize the print meter of the printer. Executing this function restarts the printer.

Values:

| Initialize PrintMeter | Click Start to initialize the print meter. |

Web Link Customization

Purpose:
To configure the link used for ordering supplies.

Values:
Select Reorder URL | Specifies the URL that Order Supplies at links to in the left frame.
---|---
Regular | http://accessories.us.dell.com/sna
Premier | http://premier.dell.com

**Print Server Settings**

Use the Print Server Settings menu to set the type of printer interface and necessary conditions for communications.

The following tabbed pages are displayed in the top of the Right Frame.

**Print Server Reports**

The Print Server Reports tab includes Print Server Setup Page, NetWare Setup Page, and E-Mail Alert Setup Page.

**Print Server Setup Page**

**Purpose:**

To verify the current settings of TCP/IP protocol and printing ports. On this page, you can only verify the settings of items. If you want to change the settings, go to the pages in the Print Server Settings tab.

**Values:**

<table>
<thead>
<tr>
<th>Ethernet * 1</th>
<th>Ethernet Settings</th>
<th>Displays the current settings of Ethernet transmission rate and the duplex settings.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Current Ethernet Settings</td>
<td>Displays the current Ethernet settings.</td>
</tr>
<tr>
<td></td>
<td>MAC Address</td>
<td>Displays the printer’s MAC address.</td>
</tr>
<tr>
<td>Wireless Settings * 2</td>
<td>SSID</td>
<td>Displays the name that identifies the network.</td>
</tr>
<tr>
<td></td>
<td>Network Type</td>
<td>Displays the network type from either the Ad-Hoc or Infrastructure mode.</td>
</tr>
<tr>
<td></td>
<td>MAC Address</td>
<td>Displays the MAC address of the wireless printer adapter.</td>
</tr>
<tr>
<td></td>
<td>Link Channel</td>
<td>Displays the channel number of the connection.</td>
</tr>
<tr>
<td></td>
<td>Link Quality</td>
<td>Displays the quality of the connection.</td>
</tr>
<tr>
<td>TCP/IP Settings</td>
<td>IP Mode</td>
<td>Displays the IP mode.</td>
</tr>
<tr>
<td></td>
<td>Host Name</td>
<td>Displays the host name.</td>
</tr>
<tr>
<td></td>
<td>IPv4</td>
<td>IP Address Mode</td>
</tr>
<tr>
<td></td>
<td></td>
<td>IP Address</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Subnet Mask</td>
</tr>
<tr>
<td>Gateway Address</td>
<td>Displays the gateway address.</td>
<td></td>
</tr>
<tr>
<td>IP6 Use Manual Address</td>
<td>Displays whether to set the IP address manually.</td>
<td></td>
</tr>
<tr>
<td>IP6 Manual Address</td>
<td>Displays the IP address.</td>
<td></td>
</tr>
<tr>
<td>Stateless Address 1-3</td>
<td>Displays the stateless addresses.</td>
<td></td>
</tr>
<tr>
<td>Link Local Address</td>
<td>Displays the link local address.</td>
<td></td>
</tr>
<tr>
<td>IP6 Manual Gateway Address</td>
<td>Displays the gateway address.</td>
<td></td>
</tr>
<tr>
<td>IP6 Auto Configure Gateway Address</td>
<td>Displays the gateway address.</td>
<td></td>
</tr>
</tbody>
</table>

| DNS * 3 | IPv4 Get DNS Server Address from DHCP | Displays whether to automatically get a DNS (Domain Name System) server address from the DHCP (Dynamic Host Configuration Protocol) server. |
| DNS * 3 | Current DNS Server Address | Displays the DNS server address. |
| IP6 Get DNS Server Address from DHCPv6-lite | Displays whether to automatically get a DNS server address from the DHCPv6-lite server. |
| IP6 Current DNS Server Address | Displays the DNS server address. |

| DNS Dynamic Update (IPv4) * 2 | Displays the status of the DNS Dynamic Update feature. |
| DNS Dynamic Update (IPv6) * 2 | Displays the status of the DNS Dynamic Update feature. |
| Auto Generate Search List | Displays whether to automatically generate a search list. |
| Search Domain Name | Displays the search domain name. |
| Time-out | Displays the time-out period. |
| Priority to IPv6 DNS Name Resolution | Displays whether to use the DNS Name Resolution feature. |

<p>| WINS * 3 | WINS Mode | Displays the setting of how to get the WINS server address. |
| WINS Primary Server | Displays the primary WINS server address. |
| WINS Secondary Server | Displays the secondary WINS server address. |
| LPD | Port Status | Displays the port status. |
| LPD Connection Time-Out | Displays the connection timeout period. |</p>
<table>
<thead>
<tr>
<th>Port9100</th>
<th>Port Status</th>
<th>Displays the port status.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Port Number</td>
<td>Displays the port number.</td>
</tr>
<tr>
<td></td>
<td>Connection Time-Out</td>
<td>Displays the connection timeout period.</td>
</tr>
<tr>
<td>IPP * 3</td>
<td>Port Status</td>
<td>Displays the port status.</td>
</tr>
<tr>
<td></td>
<td>Printer URI</td>
<td>Displays the printer URI.</td>
</tr>
<tr>
<td></td>
<td>Connection Time-Out</td>
<td>Displays the connection timeout period.</td>
</tr>
<tr>
<td></td>
<td>Port Number</td>
<td>Displays the port number.</td>
</tr>
<tr>
<td></td>
<td>Maximum Sessions</td>
<td>Displays the maximum number of connections received simultaneously by the client.</td>
</tr>
<tr>
<td>WSD * 3</td>
<td>Port Status</td>
<td>Displays the WSD port status.</td>
</tr>
<tr>
<td></td>
<td>Port Number</td>
<td>Displays the WSD port number.</td>
</tr>
<tr>
<td></td>
<td>Receive Time-Out</td>
<td>Displays the receive timeout period.</td>
</tr>
<tr>
<td></td>
<td>Notification Time-Out</td>
<td>Displays the notification timeout period.</td>
</tr>
<tr>
<td></td>
<td>Maximum Number of TTL</td>
<td>Displays the maximum number of TTLs.</td>
</tr>
<tr>
<td></td>
<td>Maximum Number of Notification</td>
<td>Displays the maximum number of notifications.</td>
</tr>
<tr>
<td>HTTP</td>
<td>Port Status</td>
<td>Displays the port status.</td>
</tr>
<tr>
<td></td>
<td>Port Number</td>
<td>Displays the port number.</td>
</tr>
<tr>
<td></td>
<td>Simultaneous Connections</td>
<td>Displays the number of connections received simultaneously by the client.</td>
</tr>
<tr>
<td></td>
<td>Connection Time-Out</td>
<td>Displays the connection timeout period.</td>
</tr>
<tr>
<td>FTP</td>
<td>Port Status</td>
<td>Displays the port status.</td>
</tr>
<tr>
<td></td>
<td>Connection Time-Out</td>
<td>Displays the connection timeout period.</td>
</tr>
<tr>
<td>SMB * 3</td>
<td>Port Status</td>
<td>Displays the port status.</td>
</tr>
<tr>
<td></td>
<td>Host Name</td>
<td>Displays the host name.</td>
</tr>
<tr>
<td></td>
<td>Workgroup</td>
<td>Displays the workgroup name.</td>
</tr>
<tr>
<td></td>
<td>Maximum Sessions</td>
<td>Displays the maximum number of connections received simultaneously by the client.</td>
</tr>
<tr>
<td></td>
<td>Unicode Support</td>
<td>Displays the status of the Unicode Support feature.</td>
</tr>
<tr>
<td></td>
<td>Auto Master Mode</td>
<td>Displays the status of the Auto Master Mode feature.</td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>Encrypt Password</td>
<td>Displays the status of the Encrypt Password feature.</td>
<td></td>
</tr>
<tr>
<td>Job Time-Out</td>
<td>Displays the timeout period.</td>
<td></td>
</tr>
<tr>
<td>Connection Time-Out</td>
<td>Displays the connection timeout period.</td>
<td></td>
</tr>
<tr>
<td>AppleTalk * 3</td>
<td>Port Status: Displays the port status.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Printer: Displays the printer name used in AppleTalk.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>AppleTalk Zone: Displays the AppleTalk zone name.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>AppleTalk Type: Displays the AppleTalk type.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Delay Start Time: Specifies the print start time period in second.</td>
<td></td>
</tr>
<tr>
<td>Bonjour (mDNS) * 3</td>
<td>Port Status: Displays the port status.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Host Name: Displays the host name.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Printer Name: Displays the printer name.</td>
<td></td>
</tr>
<tr>
<td>SNMP Agent</td>
<td>Port Status: Displays the port status.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Trap Notification 1–4: Displays the status of the Trap Notification feature and IP address.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Authenticate Error Trap: Displays the status of the Authenticate Error Trap.</td>
<td></td>
</tr>
<tr>
<td>IPsec Settings</td>
<td>Protocol: Displays the protocol status.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>IKE: Displays to use a preshared key for IKE authentication.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>IKE SA Lifetime: Displays the lifetime for IKE SA.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>IPsec SA Lifetime: Displays the lifetime for IPsec SA.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>DH Group: Displays the DH group.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>PFS: Displays the PFS status.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Remote peers IPv4 address: Displays the IP address to connect to.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Remote peers IPv6 address: Displays the IP address to connect to.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Non IPsec communication policy: Displays the status of the Non IPsec communication policy feature.</td>
<td></td>
</tr>
<tr>
<td>IP Filter (IPv4) * 4</td>
<td>Access List: Displays the list of IP addresses that are permitted or denied access to the printer.</td>
<td></td>
</tr>
</tbody>
</table>

*1 The Ethernet settings are not displayed when the optional wireless printer adapter is installed.

*2 An optional wireless printer adapter is required to display the item.
An optional multi protocol card is required to display the items.

This item is only available for LPD or Port9100.

**NetWare Setup Page**

**Purpose:**

To verify the current settings of IPX/SPX and Netware. In this page, you can only verify the settings of items. If you want to change the settings, go to the pages in the **Print Server Settings** tab.

**Values:**

<table>
<thead>
<tr>
<th>IPX/SPX Settings</th>
<th>Frame Type</th>
<th>Displays the active frame type.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Current Frame Type</td>
<td>Displays the current frame type.</td>
</tr>
<tr>
<td></td>
<td>Network Address</td>
<td>Displays the IPX network address.</td>
</tr>
<tr>
<td><strong>NetWare</strong></td>
<td>Port Status</td>
<td>Displays the port status. When NetWare is implemented, the status of IPX/SPX and TCP/IP is also displayed.</td>
</tr>
<tr>
<td></td>
<td>Device Name</td>
<td>Displays the printer name.</td>
</tr>
<tr>
<td></td>
<td>Active Mode</td>
<td>Displays the current mode for Active Mode.</td>
</tr>
<tr>
<td></td>
<td>Tree Name</td>
<td>Displays the tree name.</td>
</tr>
<tr>
<td></td>
<td>Context Name</td>
<td>Displays the context name of the Print Server Object.</td>
</tr>
<tr>
<td></td>
<td>File Server Name</td>
<td>Displays the file server name.</td>
</tr>
<tr>
<td></td>
<td>Polling Interval</td>
<td>Displays the time interval.</td>
</tr>
<tr>
<td></td>
<td>NCP Packet Burst</td>
<td>Displays the status, and whether to use NCP packet burst.</td>
</tr>
<tr>
<td></td>
<td>Status Information</td>
<td>Displays messages according to the conditions of the printer.</td>
</tr>
<tr>
<td><strong>SLP</strong></td>
<td>Active Discovery</td>
<td>Displays whether active discovery is enabled.</td>
</tr>
</tbody>
</table>

**NOTE:** An optional multi protocol card is required to display the **NetWare Setup** page.

**E-Mail Alert Setup Page**

**Purpose:**

To verify the current settings of SMTP/POP used for the e-mail feature and E-Mail Alerts feature. In this page, you can only verify the settings of items. If you want to change the settings, go to the pages in the **Print Server Settings** tab.

**Values:**
<table>
<thead>
<tr>
<th>E-Mail Server Settings</th>
<th>Port Status</th>
<th>Displays the port status.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Primary SMTP Gateway</td>
<td>Displays the primary SMTP gateway.</td>
</tr>
<tr>
<td></td>
<td>SMTP Port Number</td>
<td>Displays the SMTP port number.</td>
</tr>
<tr>
<td></td>
<td>E-Mail Send Authentication</td>
<td>Displays the authentication method for outgoing e-mail.</td>
</tr>
<tr>
<td></td>
<td>POP3 Server Address</td>
<td>Displays the POP3 server address.</td>
</tr>
<tr>
<td></td>
<td>POP3 Port Number</td>
<td>Displays the POP3 port number.</td>
</tr>
<tr>
<td></td>
<td>Reply Address</td>
<td>Displays the IP address of servers connected with SMTP protocol when data is incoming.</td>
</tr>
<tr>
<td></td>
<td>SMTP Server Connection</td>
<td>Displays the status of the SMTP server connection.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>E-Mail Alert Settings</th>
<th>E-Mail List 1</th>
<th>Displays the acceptable e-mail addresses for the E-Mail Alert feature specified in E-mail List 1.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Alerts for List 1</td>
<td>Supplies Alerts</td>
<td>Displays the status, and whether to receive an E-Mail Alert for consumables.</td>
</tr>
<tr>
<td></td>
<td>Paper Handling Alerts</td>
<td>Displays the status, and whether to receive an E-Mail Alert for paper handling.</td>
</tr>
<tr>
<td></td>
<td>Service Call</td>
<td>Displays the status, and whether to receive an E-Mail Alert for Service Calls.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>E-Mail List 2</th>
<th>Displays the acceptable e-mail addresses for the E-Mail Alert feature specified in E-mail List 2.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Alerts for List 2</td>
<td>Supplies Alerts</td>
</tr>
<tr>
<td></td>
<td>Paper Handling Alerts</td>
</tr>
<tr>
<td></td>
<td>Service Call</td>
</tr>
</tbody>
</table>

**Print Server Settings**

The Print Server Settings tab includes Basic Information, Port Settings, Wireless LAN, TCP/IP, NetWare, SMB, AppleTalk, E-Mail Alert, Bonjour(mDNS), and SNMP pages.

**Basic Information**

**Purpose:**

To configure the printer's basic information.

**Values:**
### System Settings

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Printer Name</td>
<td>Specifies the name of the printer up to 31 alphanumeric characters.</td>
</tr>
<tr>
<td>Location</td>
<td>Specifies the location of the printer up to 63 alphanumeric characters.</td>
</tr>
<tr>
<td>Contact Person</td>
<td>Specifies the contact name, number, and other information of the printer administrator and service center up to 63 alphanumeric characters.</td>
</tr>
<tr>
<td>Administrator E-Mail Address</td>
<td>Specifies the contact address of the printer administrator and service center up to 63 alphanumeric characters.</td>
</tr>
<tr>
<td>Asset Tag Number</td>
<td>Enter the asset tag number for the printer.</td>
</tr>
</tbody>
</table>

### EWS Settings

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto Refresh</td>
<td></td>
</tr>
<tr>
<td>On</td>
<td>Refreshes the contents of the status display pages automatically.</td>
</tr>
<tr>
<td>Off</td>
<td>Does not refresh the status display pages automatically.</td>
</tr>
<tr>
<td>Auto Refresh Interval</td>
<td>Sets the time interval for refreshing the contents of the status display pages automatically from 15 to 600 seconds.</td>
</tr>
</tbody>
</table>

**NOTE:** The auto refresh feature is effective for the contents of the Top Frame, Printer Status page, Job List page, and Completed Jobs page.

### Port Settings

**Purpose:**
To specify whether to enable or disable printing ports and management protocol features.

**Values:**

<table>
<thead>
<tr>
<th>Ethernet Settings</th>
<th>Auto</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ethernet * 1</td>
<td>Auto</td>
<td>Detects Ethernet transmission rate and the duplex settings automatically.</td>
</tr>
<tr>
<td>10BASE-T Half-Duplex</td>
<td>Selects 10Base-T Half-Duplex as the default value.</td>
<td></td>
</tr>
<tr>
<td>10BASE-T Full-Duplex</td>
<td>Selects 10Base-T Full-Duplex as the default value.</td>
<td></td>
</tr>
<tr>
<td>100BASE-TX Half-Duplex</td>
<td>Selects 100Base-T Half-Duplex as the default value.</td>
<td></td>
</tr>
<tr>
<td>100BASE-TX Full-Duplex</td>
<td>Selects 100Base-T Full-Duplex as the default value.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Current Ethernet Settings</th>
<th>Displays the current settings of Ethernet.</th>
</tr>
</thead>
<tbody>
<tr>
<td>MAC Address</td>
<td>Displays the printer's MAC address.</td>
</tr>
<tr>
<td>Protocol</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>IPP *2</td>
<td>Select the check box to enable the IPP port.</td>
</tr>
<tr>
<td>WSD</td>
<td>Select the check box to enable the WSD port.</td>
</tr>
<tr>
<td>FTP</td>
<td>Select the check box to enable the FTP port.</td>
</tr>
<tr>
<td>SMB *2</td>
<td>Select the check box to enable the SMB. You can also configure the transport protocol to be used. TCP/IP and NetBEUI can be selected simultaneously as the transport protocol.</td>
</tr>
<tr>
<td>NetWare *2</td>
<td>Select the check box to enable the NetWare port. You can also configure the transport protocol to be used. IPX/SPX and TCP/IP can be selected simultaneously as the transport protocol.</td>
</tr>
<tr>
<td>AppleTalk *2</td>
<td>Select the check box to enable the AppleTalk port.</td>
</tr>
<tr>
<td>Bonjour (mDNS) * 2</td>
<td>Select the check box to enable the Bonjour(mDNS) feature.</td>
</tr>
<tr>
<td>E-Mail Alert</td>
<td>Select the check box to enable the E-Mail Alert feature.</td>
</tr>
<tr>
<td>SNMP Agent</td>
<td>Select the check box to enable the SNMP. You can also configure the transport protocol to be used. UDP and IPX can be selected simultaneously as the transport protocol. IPX is only available when the multi protocol card is installed.</td>
</tr>
</tbody>
</table>

*1 The Ethernet settings are not displayed when the optional wireless printer adapter is installed.

*2 An optional multi protocol card is required to display the item.

**NOTE:** The settings in the Port Settings page will be valid only when the printer is rebooted. When you change or configure the settings, click the **Restart printer to apply new settings** button to apply new settings.

**Wireless LAN**

**Purpose:**

To configure the detailed setting for the wireless network.
<table>
<thead>
<tr>
<th><strong>Wireless Settings</strong></th>
<th><strong>SSID</strong></th>
<th>Specifies the name that identifies the wireless network. Up to 32 alphanumeric characters.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Network Type</strong></td>
<td></td>
<td>Specifies the network type from either <em>Ad-Hoc</em> or <em>Infrastructure</em>.</td>
</tr>
<tr>
<td><strong>MAC Address</strong></td>
<td></td>
<td>Displays the MAC address of the printer's wireless network adapter.</td>
</tr>
<tr>
<td><strong>Link Channel</strong></td>
<td></td>
<td>Displays the channel number of the printer's wireless connection.</td>
</tr>
<tr>
<td><strong>Link Quality</strong></td>
<td></td>
<td>Displays the quality of the printer's wireless network connection.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Security Settings</strong></th>
<th><strong>Encryption</strong></th>
<th>Select the security method from the list.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>WEP Key Code</strong></td>
<td>Select the WEP key code from either <em>Hex</em> or <em>Ascii</em>.</td>
</tr>
<tr>
<td></td>
<td><strong>WEP Key (Password)</strong></td>
<td>Specifies the WEP key set used through the wireless network only when <em>WEP 128bit</em> or <em>WEP 64bit</em> is selected for <em>Encryption</em>.</td>
</tr>
<tr>
<td></td>
<td><strong>Transmit Key (Index)</strong></td>
<td>Specifies the transmit key from the list.</td>
</tr>
<tr>
<td></td>
<td><strong>Pass Phrase (Password)</strong></td>
<td>Specifies the pass phrase from 8 to 63 alphanumeric characters only when <em>WPA-PSK AES</em> or <em>WPA-PSK TKIP</em> is selected for <em>Encryption</em>.</td>
</tr>
</tbody>
</table>

**NOTE:** To set WPA2-PSK, select WPA-PSK AES.

**NOTE:** An optional wireless printer adapter is required to display the **Wireless** page.

**TCP/IP**

**Purpose:**

To configure the IP address, subnet mask, and gateway address of the printer.

**Values:**

<table>
<thead>
<tr>
<th><strong>TCP/IP Settings</strong></th>
<th><strong>IP Mode</strong></th>
<th>Specifies the IP mode.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Host Name</strong></td>
<td></td>
<td>Specifies the host name.</td>
</tr>
<tr>
<td><strong>IPv4</strong></td>
<td><strong>IP Address Mode</strong></td>
<td>Selects the IP address mode.</td>
</tr>
<tr>
<td></td>
<td><strong>Manual IP Address</strong></td>
<td>Sets the IP address.</td>
</tr>
<tr>
<td></td>
<td><strong>Manual Subnet Mask</strong></td>
<td>Sets the subnet mask.</td>
</tr>
<tr>
<td></td>
<td><strong>Manual Gateway Address</strong></td>
<td>Sets the gateway address.</td>
</tr>
<tr>
<td><strong>IPv6</strong></td>
<td><strong>Use Manual Address</strong></td>
<td>Select the check box to set the IP address manually.</td>
</tr>
<tr>
<td><strong>Manual Address</strong></td>
<td>Sets the IP address.</td>
<td></td>
</tr>
<tr>
<td>--------------------</td>
<td>---------------------</td>
<td></td>
</tr>
<tr>
<td><strong>Manual Gateway Address</strong></td>
<td>Sets the gateway address.</td>
<td></td>
</tr>
<tr>
<td><strong>DNS</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>DNS Domain Name</strong> * 1</td>
<td>Specifies the domain name of the domain name server. Up to 255 alphanumeric characters, periods, and hyphens can be used. If you need to specify more than one domain name, separate them using a comma or semicolon.</td>
<td></td>
</tr>
<tr>
<td><strong>IPv4</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Get DNS Server Address from DHCP</strong></td>
<td>Select the check box to get the DNS server address automatically from the DHCP server.</td>
<td></td>
</tr>
<tr>
<td><strong>Manual DNS Server Address</strong></td>
<td>Sets the DNS server address.</td>
<td></td>
</tr>
<tr>
<td><strong>IPv6</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Get DNS Server Address from DHCPv6-lite</strong></td>
<td>Select the check box to get the DNS server address automatically from the DHCPv6-lite server.</td>
<td></td>
</tr>
<tr>
<td><strong>Manual DNS Server Address</strong></td>
<td>Sets the DNS server address.</td>
<td></td>
</tr>
<tr>
<td><strong>DNS Dynamic Update (IPv4)</strong> * 1</td>
<td>Select the check box to enable dynamic updates to DNS.</td>
<td></td>
</tr>
<tr>
<td><strong>DNS Dynamic Update (IPv6)</strong> * 1</td>
<td>Select the check box to enable dynamic updates to DNS.</td>
<td></td>
</tr>
<tr>
<td><strong>Auto Generate Search List</strong> * 1</td>
<td>Select the check box to automatically generate the search list.</td>
<td></td>
</tr>
<tr>
<td><strong>Search Domain Name</strong> * 1</td>
<td>Specifies the search domain name. Up to 255 alphanumeric characters, periods, and hyphens can be used. If you need to specify more than one domain name, separate them using a comma or semicolon.</td>
<td></td>
</tr>
<tr>
<td><strong>Time-out</strong> * 1</td>
<td>Specifies the time-out period between 1 and 60 seconds.</td>
<td></td>
</tr>
<tr>
<td><strong>Priority to IPv6 DNS Name Resolution</strong></td>
<td>Select the check box to enable the DNS Name Resolution feature.</td>
<td></td>
</tr>
<tr>
<td><strong>WINS</strong> * 1</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>WINS Mode</strong></td>
<td>Select the check box to get the WINS server address automatically from the DHCP server.</td>
<td></td>
</tr>
<tr>
<td><strong>WINS Primary Server</strong></td>
<td>Sets WINS server address in the <code>nnn.nnn.nnn.nnn</code> format. Each section of <code>nnn.nnn.nnn.nnn</code> is a value between 0 and 254. Note that values 127 and 224 to 254 are not valid for the first three-digits.</td>
<td></td>
</tr>
<tr>
<td><strong>WINS Secondary Server</strong></td>
<td>Sets a back up WINS server address in the <code>nnn.nnn.nnn.nnn</code> format. Each section of <code>nnn.nnn.nnn.nnn</code> is a value between 0 and 254. Note that values 127 and 224 to 254 are not valid for the first three-digits.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Connection Time-Out</td>
<td>Sets the connection timeout period from 1 to 1000 seconds.</td>
</tr>
<tr>
<td>------------</td>
<td>---------------------------</td>
<td>----------------------------------------------------------</td>
</tr>
<tr>
<td>IP Filter (IPv4)</td>
<td>To set the IP Filter settings, click <strong>IP Filter</strong>. The <strong>IP Filter</strong> page is displayed.</td>
<td></td>
</tr>
<tr>
<td>Port9100</td>
<td>Port Number</td>
<td>Sets the port number from 9000 to 9999.</td>
</tr>
<tr>
<td></td>
<td>Connection Time-Out</td>
<td>Sets the connection timeout period between 1 and 1000 seconds.</td>
</tr>
<tr>
<td></td>
<td>IP Filter (IPv4)</td>
<td>To set the IP Filter settings, click <strong>IP Filter</strong>. The <strong>IP Filter</strong> page is displayed.</td>
</tr>
<tr>
<td>IPP*¹</td>
<td>Printer URI</td>
<td>Displays the printer URI.</td>
</tr>
<tr>
<td></td>
<td>Connection Time-Out</td>
<td>Sets the connection timeout period from 1 to 1000 seconds.</td>
</tr>
<tr>
<td></td>
<td>Port Number</td>
<td>Displays the port number for receiving requests from the client.</td>
</tr>
<tr>
<td></td>
<td>Maximum Sessions</td>
<td>Displays the maximum number of connections received simultaneously by the client.</td>
</tr>
<tr>
<td>WSD</td>
<td>Port Number</td>
<td>Sets the port number from 8000 to 9999.</td>
</tr>
<tr>
<td></td>
<td>Receive Time-Out</td>
<td>Sets the receive timeout period from 1 to 65535 seconds.</td>
</tr>
<tr>
<td></td>
<td>Notification Time-Out</td>
<td>Sets the notification timeout period from 1 to 60 seconds.</td>
</tr>
<tr>
<td></td>
<td>Maximum Number of TTL</td>
<td>Sets the maximum number of TTL from 1 to 10.</td>
</tr>
<tr>
<td></td>
<td>Maximum Number of Notification</td>
<td>Sets the maximum number of notifications from 10 to 20.</td>
</tr>
<tr>
<td>HTTP</td>
<td>Port Number</td>
<td>Sets the port number to 80 or from 8000 to 9999.</td>
</tr>
<tr>
<td></td>
<td>Simultaneous Connections</td>
<td>Displays the maximum number of connections received simultaneously by the client.</td>
</tr>
<tr>
<td></td>
<td>Connection Time-Out</td>
<td>Sets the connection timeout period from 1 to 255 seconds.</td>
</tr>
<tr>
<td>FTP</td>
<td>Password</td>
<td>Sets whether to enable or disable the password. And also specifies the password value up to 7 characters.</td>
</tr>
<tr>
<td></td>
<td>Connection Time-Out</td>
<td>Sets the connection timeout period from 1 to 1000 seconds.</td>
</tr>
<tr>
<td>IP Filter (IPv4) *²</td>
<td>Address</td>
<td>Sets the address in the address field. Enter a numeric value between 0 and 255 in each field of &quot;aaa.bbb.ccc.ddd.&quot; However, 127 and 224 to 254 cannot be used to &quot;aaa.&quot;</td>
</tr>
<tr>
<td></td>
<td>Address Mask</td>
<td>Sets the Subnet Mask in the Mask field. Enter a numeric value between 0 and 255 in each field.</td>
</tr>
<tr>
<td>Active Mode</td>
<td>Reject</td>
<td>Rejects printing from specified network address.</td>
</tr>
<tr>
<td>-------------</td>
<td>--------</td>
<td>-------------------------------------------------</td>
</tr>
<tr>
<td>Permit</td>
<td>Permits printing from specified network address.</td>
<td></td>
</tr>
<tr>
<td>Disabled</td>
<td>Disables the IP Filter feature for the specified IP address.</td>
<td></td>
</tr>
</tbody>
</table>

*1 An optional multi protocol card is required to display the item.

*2 This item is only available for LPD or Port9100.

**NetWare**

**Purpose:**

To configure detailed settings for IPX/SPX and NetWare.

**Values:**

<table>
<thead>
<tr>
<th>IPX/SPX Settings</th>
<th>Frame Type</th>
<th>Auto</th>
<th>Specifies the active frame type automatically.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Ethernet II</td>
<td>Selects Ethernet II frame type.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Ethernet 802.3</td>
<td>Selects IEEE802.3 frame type.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Ethernet 802.2</td>
<td>Selects IEEE802.2 frame type.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Ethernet SNAP</td>
<td>Selects SNAP frame type.</td>
<td></td>
</tr>
</tbody>
</table>

**Current Frame Type**

Displays the current frame type.

**Network Address**

Displays the IPX network address.

<table>
<thead>
<tr>
<th>NetWare</th>
<th>Device Name *1</th>
<th>Specifies the printer name up to 47 alphanumeric characters. For PServer Mode, set the Print Server Name (Print Server Object Name). The original setting remains valid if no input is made.</th>
</tr>
</thead>
</table>

**Active Mode**

**Directory: PServer Mode**

Selects this option when using in Directory: PServer Mode.

**Bindery: PServer Mode**

Selects this option when using in Bindery: PServer Mode.

**Tree Name *1**

Specifies the tree name up to 32 alphanumeric characters. Configure this item only when Directory: PServer Mode is selected.

**Context Name**

 Specifies the context name of the Print Server Object up to 255 alphanumeric characters. Configure this item only when Directory: PServer Mode or Directory: RPrinter Mode is selected.
### File Server Name

Specifies the file server name up to 47 alphanumeric characters. Configure this item only when **Bindery: PServer Mode** is selected.

### Polling Interval

Sets the time interval from when print data enters the print queue until printing starts. The setting range is from 1 to 1000 seconds. The original setting remains valid if no input is made. Configure this item only when **Bindery: PServer Mode** or **Directory: PServer Mode** is selected.

<table>
<thead>
<tr>
<th>NCP Packet Burst</th>
<th>On</th>
<th>Uses NCP packet burst.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Off</td>
<td>Does not use NCP packet burst.</td>
</tr>
</tbody>
</table>

### Password

Sets the print server password up to 32 alphanumeric characters. Configure this item only when **Binary: PServer Mode** or **Directory: PServer Mode** is selected.

### Confirm Password

Enter the password again.

### Status Information

Displays the status of NetWare.

### SLP

Active Discovery

Select the check box to enable **Active Discovery**.

---

*1 The following are illegal characters: semicolon (;), colon (:), asterisk (*), question mark (?), period (.), comma (,), yen mark (¥), back slash (\), double quotation ("), comparison symbols (< >), brackets ([ ]), operation symbols (+, =, or ~), pipe (|), slash (/), and space ( ).

**NOTE:** The settings in the **NetWare** page will be valid only when NetWare or the printer is rebooted. Click the **Restart printer to apply new settings** button to apply new settings.

**NOTE:** An optional multi protocol card is required to display the **NetWare** page.

---

**SMB**

**Purpose:**

To configure detailed settings for SMB.

**Values:**
<table>
<thead>
<tr>
<th>Host Name</th>
<th>Specifies the host name up to 15 alphanumeric characters. The original setting will remain valid if no input is made.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workgroup</td>
<td>Specifies the workgroup name up to 15 alphanumeric characters. The original setting will remain valid if no input is made.</td>
</tr>
<tr>
<td>Administrator Name</td>
<td>Specifies the administrator name up to 20 alphanumeric characters. The original setting will remain valid if no input is made. The default name is admin .</td>
</tr>
<tr>
<td>Administrator Password</td>
<td>Specifies the administrator password up to 14 alphanumeric characters. The original setting will remain valid if no input is made. The default password is password .</td>
</tr>
<tr>
<td>Confirm Administrator Password</td>
<td>Allows you to confirm the configured administrator password by re-entering the same password.</td>
</tr>
<tr>
<td>Maximum Sessions</td>
<td>Displays the maximum sessions.</td>
</tr>
</tbody>
</table>
| Unicode Support | On Notifies the host name and workgroup name in Unicode characters.  
Off Does not notify the host name and workgroup name in Unicode characters. |
| Auto Master Mode | On Enable the Auto Master Mode.  
Off Disable the Auto Master Mode. |
| Encrypt Password | On Encrypts the password.  
Off Does not encrypt the password. |
| Job Time-Out | Sets the timeout period from 60 to 3600 seconds. |
| Connection Time-Out | Sets the connection timeout period from 60 to 3600 seconds. |

**NOTE:** The settings in the SMB page will be valid only when the printer is rebooted. Click the Restart printer to apply new settings button to apply new settings.

**NOTE:** An optional multi protocol card is required to display the SMB page.

**AppleTalk**

**Purpose:**

To configure the detailed settings for AppleTalk.

**Values:**
### AppleTalk

<table>
<thead>
<tr>
<th><strong>AppleTalk</strong></th>
<th><strong>Printer</strong></th>
<th>Specifies the printer name in the AppleTalk network up to 32 alphanumeric characters and symbol sets.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>AppleTalk Zone</strong></td>
<td></td>
<td>Specifies the AppleTalk zone name up to 32 alphanumeric characters and symbol sets.</td>
</tr>
<tr>
<td><strong>AppleTalk Type</strong></td>
<td></td>
<td>Displays the AppleTalk type.</td>
</tr>
<tr>
<td><strong>Delay Start Time</strong></td>
<td></td>
<td>Specifies the delay start time between 1 and 255 seconds. A zero (0) value specifies no delay.</td>
</tr>
</tbody>
</table>

**NOTE:** An optional multi protocol card is required to display the AppleTalk page.

### E-Mail Alert

**Purpose:**
To configure detailed settings for E-Mail Alert. This page can also be displayed by clicking **E-Mail Alert** in the Left Frame.

**Values:**

<table>
<thead>
<tr>
<th>E-Mail Server Settings</th>
<th><strong>Primary SMTP Gateway</strong></th>
<th>Sets the primary SMTP gateway.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>SMTP Port Number</strong></td>
<td>Specifies the SMTP port number. This must be 25 or between 5000 and 65535.</td>
</tr>
<tr>
<td></td>
<td><strong>E-Mail Send Authentication</strong></td>
<td>Specifies the authentication method for outgoing e-mail.</td>
</tr>
<tr>
<td></td>
<td><strong>SMTP Login User</strong></td>
<td>Specifies the SMTP login user. Up to 63 alphanumeric characters, periods, hyphens, under bars, and at symbols (@) can be used. If specifying more than one address, separate them using commas.</td>
</tr>
<tr>
<td></td>
<td><strong>SMTP Login Password</strong></td>
<td>Specifies the SMTP account password up to 31 alphanumeric characters.</td>
</tr>
<tr>
<td></td>
<td><strong>POP3 Server Address</strong>¹</td>
<td>Specifies the POP3 server address in IP address format of &quot;aaa.bbb.ccc.ddd&quot; or as a DNS host name up to 63 characters.</td>
</tr>
<tr>
<td></td>
<td><strong>POP3 Port Number</strong>¹</td>
<td>Specifies the POP3 server port number. This must be 110 or between 5000 and 65535.</td>
</tr>
<tr>
<td></td>
<td><strong>POP User Name</strong>¹</td>
<td>Specifies the POP3 account user name. Up to 63 alphanumeric characters, periods, hyphens, under bars, and at symbols (@) can be used. If specifying more than one address, separate them using commas.</td>
</tr>
<tr>
<td></td>
<td><strong>POP User Password</strong>¹</td>
<td>Specifies the POP3 account password up to 31 alphanumeric characters.</td>
</tr>
<tr>
<td></td>
<td><strong>Reply Address</strong></td>
<td>Designates the reply e-mail address sent with each E-mail Alert.</td>
</tr>
<tr>
<td>SMTP Server Connection</td>
<td>Displays the status of the SMTP server connection.</td>
<td></td>
</tr>
<tr>
<td>------------------------</td>
<td>--------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>E-Mail Alert Settings</td>
<td></td>
<td></td>
</tr>
<tr>
<td>E-Mail List 1</td>
<td>Sets acceptable e-mail addresses for the E-Mail Alert feature up to 255 alphanumeric characters.</td>
<td></td>
</tr>
<tr>
<td>Select Alerts for List 1</td>
<td>Supplies</td>
<td></td>
</tr>
<tr>
<td>Alerts</td>
<td>Select the check box to receive an E-Mail Alert for consumables.</td>
<td></td>
</tr>
<tr>
<td>Paper Handling Alerts</td>
<td>Select the check box to receive an E-Mail Alert for paper handling.</td>
<td></td>
</tr>
<tr>
<td>Service Call</td>
<td>Select the check box to receive an E-Mail Alert for Service Calls.</td>
<td></td>
</tr>
<tr>
<td>E-Mail List 2</td>
<td>Sets acceptable e-mail addresses for the E-Mail Alert feature up to 255 alphanumeric characters.</td>
<td></td>
</tr>
<tr>
<td>Select Alerts for List 2</td>
<td>Supplies</td>
<td></td>
</tr>
<tr>
<td>Alerts</td>
<td>Select the check box to receive an E-Mail Alert for consumables.</td>
<td></td>
</tr>
<tr>
<td>Paper Handling Alerts</td>
<td>Select the check box to receive an E-Mail Alert for paper handling.</td>
<td></td>
</tr>
<tr>
<td>Service Call</td>
<td>Select the check box to receive an E-Mail Alert for Service Calls.</td>
<td></td>
</tr>
</tbody>
</table>

* 1 Available when **POP before SMTP** for **E-Mail Send Authentication** is selected.

**Bonjour (mDNS)**

**Purpose:**
To configure the detailed settings for Bonjour.

**Values:**

<table>
<thead>
<tr>
<th>Bonjour (mDNS)</th>
<th>Host Name</th>
<th>Specifies the host name up to 63 alphanumeric characters and &quot;-&quot; (dash). The original setting will remain valid if no input is made.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Printer Name</td>
<td>Specifies the printer name up to 63 alphanumeric characters and symbol sets. The original setting will remain valid if no input is made.</td>
<td></td>
</tr>
</tbody>
</table>

**NOTE:** An optional multi protocol card is required to display the **Bonjour (mDNS)** page.

**SNMP**

**Purpose:**
To configure the detailed settings of SNMP.

**Values:**

| SNMP | |
|------|---

### SNMP Agent

| **Community Name (Read only) *1** | Specifies the community name to access (read only) the data up to 31 alphanumeric characters. The original setting will remain valid if no input is made. Characters entered for community name in previous settings will not be displayed on the screen. The default Read/Write Community is public. |
| **Community Name (Read/Write) *1** | Specifies the community name to access (read and write) the data up to 31 alphanumeric characters. The original setting will remain valid if no input is made. Characters entered for community name in previous settings will not be displayed on the screen. The default Read/Write Community is private. |
| **Community Name (Trap) *1** | Specifies the community name used for trap up to 31 alphanumeric characters. The original settings will remain valid if no input is made. Characters entered for Community Name (Trap) in previous settings will not be displayed on the screen. The default Trap Community is " " (NULL). |

### Trap Notification 1-4

Select the check boxes to notify trap occurrence. In this case, specify the IP address and IP socket in the following format:

- **IPv4**
  - Specify the IP address and IP socket in the nnn.nnn.nnn.nnn:nnnnnnn format. Each section of "nnn" is a variable value between 0 and 255. Note that values 127 and 224-254 are not valid for the first three-digits only. IP socket nnnnnn is a variable value between 0 and 65535.

- **IPv6**
  - Specify the IP address and IP socket in the xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:nnnnnnn format. Each section of "xxxx" is a hexadecimal variable value between 0 and ffff. IP socket nnnnnnn is a variable value between 0 and 65535.

- **IPX**
  - Specify the IPX address in the nnnnnnn.nnnnnnnn:nnnnnnnnn.llll format. IP network nnnnnnn is a hexadecimal variable value between 0 and ffffffff, IPX node nnnnnnnnnnn is a hexadecimal value between 0 and ffffffff and IPX socket llll is a hexadecimal variable value between 0 and ffff.

### Authenticate Error Trap

Select the check box to notify Authenticate Error Trap.

---

*1 The default value of each items can be changed by using Dell Printer Configuration Web Tool.

*2 An optional multi protocol card is required to display the item.

### IP Filter (IPv4)

**Purpose:**

To configure the detailed settings for the IP Filter used for LPD and Port9100.

**Values:**
<table>
<thead>
<tr>
<th>Address</th>
<th>Sets the address in the address field. Enter a numeric value between 0 and 255 in each field of &quot;aaa.bbb.ccc.ddd.&quot; However, 127 and 224 to 254 cannot be used to &quot;aaa.&quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address Mask</td>
<td>Sets the Subnet Mask in the mask field. Enter a numeric value between 0 and 255 in each field.</td>
</tr>
<tr>
<td>Active Mode</td>
<td>Reject</td>
</tr>
<tr>
<td></td>
<td>Permit</td>
</tr>
<tr>
<td></td>
<td>Disabled</td>
</tr>
</tbody>
</table>

When you make the settings for the filter, enter the IP address of the IP Filter in the **Address** field and the Subnet Mask in the **Address Mask** field. Enter a numeric value between 0 and 255 in each field. "*" is appended to the current value.

**Setup Procedure**

You can set up to a maximum of five items and the first item takes priority. Enter the shortest address first before proceeding to the next longer address when setting multiple filters.

The following section explains how the **IP Filter** operates.

**IP Filter Procedure**

- Enabling Printing From a Specified User

The following describes the procedure to enable printing only from the "192.168.100.10" IP address.

**Procedures:**

1. Click the first column of **Access List** row 1.
2. Enter "192.168.100.10" in the **Address** field and "255.255.255.255" in the **Address Mask** field.
3. Select **Permit**.
4. Click **Apply New Settings**.

- Disabling Printing From a Specified User

The following describes the procedure to disable printing only from the "192.168.100.10" IP address.

**Procedures:**

1. Click the first column of **Access List** row 1.
2. Enter "192.168.100.10" in the **Address** field and "255.255.255.255" in the **Address Mask** field.
3. Select **Reject**.
4. Click the first column of **Access List** row 2.
5. Enter "0.0.0.0" in the **Address** field and "0.0.0.0" in the **Address Mask** field.

6. Select **Permit**.

7. Click **Apply New Settings**.

- Enabling and Disabling Printing from Network Addresses

You can enable printing from the "192.168" network address and disable printing from the "192.168.200" network address. However, the example below describes how to enable printing from the "192.168.200.10" IP address.

**Procedures:**

1. Click the first column of the **Access List row 1**.

2. Enter "192.168.200.10" in the **Address** field and "255.255.255.255" in the **Address Mask** field.

3. Select **Permit**.

4. Click the first column of the **Access List row 2**.

5. Enter "192.168.200.0" in the **Address** field and "255.255.255.0" in the **Address Mask** field.

6. Select **Reject**.

7. Click the first column of the **Access List row 3**.

8. Enter "192.168.0.0" in the **Address** field and "255.255.0.0" in the **Address Mask** field.

9. Select **Permit**.

10. Click **Apply New Settings**.

**Other Features**

The **Other Features** tab includes **Set Password**, **Security**, **IPsec** and **Reset Print Server** pages.

**Set Password**

**Purpose:**

To set or change the password that is required to access the printer setup parameters from the **Dell Printer Configuration Web Tool**.

Set the password of the operator panel from **Panel Settings** in the **Printer Settings**. This page can also be displayed by clicking **Set Password** in the Left Frame.

**NOTE:** To restore the password to default (NULL), initialize the NVM memory.

**Values:**
<table>
<thead>
<tr>
<th><strong>Administrator Password</strong></th>
<th>Sets the password up to 10 alphanumeric characters. The password will appear as asterisks (*) in the field when it is entered.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Confirm Administrator Password</strong></td>
<td>Enter the password again to confirm it.</td>
</tr>
</tbody>
</table>

**Security**

**Purpose:**

To specify the settings for the SSL encryption communication to the printer.

**Values:**

<table>
<thead>
<tr>
<th><strong>HTTPS</strong></th>
<th>Display the port status.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Port Number</strong></td>
<td>Specifies the port number, which is not identical with that of HTTP for TCP/IP. This must be 443 or between 8000 and 9999.</td>
</tr>
<tr>
<td><strong>Generate Self-Signed Certificate</strong></td>
<td>Click to display Generate Self-Signed Certificate page and to create a security certification from the page.</td>
</tr>
</tbody>
</table>

**IPsec**

**Purpose:**

To specify the Security Architecture settings for Internet Protocol (IPsec) for encrypted communication to the printer.

**Values:**

<table>
<thead>
<tr>
<th><strong>Protocol</strong></th>
<th>Select the check box to enable the protocol.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>IKE</strong></td>
<td>Use a preshared key for IKE authentication.</td>
</tr>
<tr>
<td><strong>Pre-Shared Key</strong></td>
<td>Specifies a shared key.</td>
</tr>
<tr>
<td><strong>Re-enter Pre-Shared Key</strong></td>
<td>Enter the shared key again to confirm it.</td>
</tr>
<tr>
<td><strong>IKE SA Lifetime</strong></td>
<td>Sets the lifetime for IKE SA from 5 to 28800 minutes.</td>
</tr>
<tr>
<td><strong>IPsec SA Lifetime</strong></td>
<td>Sets the lifetime for IPsec SA from 5 to 2880 minutes.</td>
</tr>
<tr>
<td><strong>DH Group</strong></td>
<td>Selects the DH group.</td>
</tr>
<tr>
<td><strong>PFS</strong></td>
<td>Selects the check box to enable the PFS setting.</td>
</tr>
<tr>
<td><strong>Remote peers IPv4 address</strong></td>
<td>Specifies the IP address to connect to.</td>
</tr>
<tr>
<td><strong>Remote peers IPv6 address</strong></td>
<td>Specifies the IP address to connect to.</td>
</tr>
<tr>
<td><strong>Non IPsec communication policy</strong></td>
<td>Selects whether or not to communicate with a device which does not support IPsec.</td>
</tr>
</tbody>
</table>
NOTE: If IPsec is enabled with incorrect settings, you must disable it using the Reset IPsec menu on the operator panel.

Reset Print Server

Purpose:
To initialize NVRAM for the network feature and reboot the printer. You can also initialize the printer's NVRAM from Reset Defaults in the Printer Settings menu.

Values:

<table>
<thead>
<tr>
<th>Initialize NIC NVRAM and restart printer</th>
<th>Click the Start button to initialize NVRAM. Network settings will revert to the factory default settings and reboot the network capability.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Restart Printer</td>
<td>Click the Start button to reboot printer.</td>
</tr>
</tbody>
</table>

Copy Printer Settings

The Copy Printer Settings menu includes the Copy Printer Settings and Copy Printer Settings Report pages.

Copy Printer Settings

Purpose:
To copy the printer settings to one or more of the same model of printer.

To copy the settings to another printer, specify the IP address and password of the printer to which the settings are copied in the IP Address text box and Password text box. Then, click the Copy the settings to the Host in the above list button. Copying the settings is complete. The connection time-out period is 60 seconds. After that, you can check whether settings were copied or not on this page. And you need to check the Copy the settings to the Host in the above list and reboot the machine menu of the Dell Printer Configuration Web Tool in the destination printer to verify if settings were actually copied or not.

If the settings can be copied but printer configuration is different, the settings of only the same items are copied. Printer settings are simultaneously copied to printers of up to 10 IP addresses.

Copy Printer Settings Report

Purpose:
To verify the histories of copying after turning on the printer.

Print Volume

The Print Volume menu includes the Print Volume and Dell ColorTrack pages.

Print Volume

Purpose:
To verify the number of printed pages. This page can also be displayed by clicking **Print Volume** in the Left Frame.

**Values:**

<table>
<thead>
<tr>
<th>Printer Page Count</th>
<th>Displays the total number of pages printed since the printer was shipped from the factory.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paper Used</td>
<td>Displays the number of pages for each paper size.</td>
</tr>
</tbody>
</table>

**Dell ColorTrack**

**Purpose:**

To specify which users have access to color printing and to limit print volume per user.

**Values:**

<table>
<thead>
<tr>
<th>Print User Limitation</th>
<th>Select the check box to restrict users from using the printer.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Permit printing without specifying user</td>
<td>Select the check box to use the printer without user limitations.</td>
</tr>
<tr>
<td>User Registration</td>
<td>Displayed when <strong>Print User Limitation</strong> is enabled. To register a user, click <strong>Edit User Registration</strong> to open the <strong>Edit Print User Registration</strong> page, and then specify <strong>User Registration No.</strong> and click <strong>Edit</strong> to open the <strong>Print User Settings</strong> page.</td>
</tr>
</tbody>
</table>

**Tray Settings**

Use the **Tray Settings** menu to set the printer media types and sizes for trays respectively.

**Values:**
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tray 1 Paper Type</td>
<td>Sets the type of paper loaded in the standard 250-sheet tray.</td>
</tr>
<tr>
<td>Tray 1 Paper Size</td>
<td>Sets the size of paper loaded in the standard 250-sheet tray.</td>
</tr>
<tr>
<td>Tray 1 Custom Size - Y</td>
<td>Sets the length of paper loaded in the standard 250-sheet tray.</td>
</tr>
<tr>
<td>Tray 1 Custom Size - X</td>
<td>Sets the width of paper loaded in the standard 250-sheet tray.</td>
</tr>
<tr>
<td>Tray 2 Paper Type</td>
<td>Sets the type of paper loaded in the optional 550-sheet feeder.</td>
</tr>
<tr>
<td>Tray 2 Paper Size</td>
<td>Sets the size of paper loaded in the optional 550-sheet feeder.</td>
</tr>
<tr>
<td>Tray 2 Custom Size - Y</td>
<td>Sets the length of paper loaded in the optional 550-sheet feeder.</td>
</tr>
<tr>
<td>Tray 2 Custom Size - X</td>
<td>Sets the width of paper loaded in the optional 550-sheet feeder.</td>
</tr>
<tr>
<td>MPF Mode</td>
<td>Sets the paper size and type when paper is loaded in the multipurpose feeder.</td>
</tr>
<tr>
<td>Display Popup</td>
<td>Sets the paper size and type when paper is loaded in the multipurpose feeder.</td>
</tr>
<tr>
<td>MPF Paper Type</td>
<td>Sets the type of paper loaded in the multipurpose feeder.</td>
</tr>
<tr>
<td>MPF Paper Size</td>
<td>Sets the size of paper loaded in the multipurpose feeder.</td>
</tr>
<tr>
<td>MPF Custom Size - Y</td>
<td>Sets the length of paper loaded in the multipurpose feeder.</td>
</tr>
<tr>
<td>MPF Custom Size - X</td>
<td>Sets the width of paper loaded in the multipurpose feeder.</td>
</tr>
</tbody>
</table>
About Your Printer

The following illustrations show the standard Dell™ Color Laser Printer 3110cn, with an optional 550-sheet feeder and duplexer.
<table>
<thead>
<tr>
<th>Standard printer</th>
<th>Printer with options</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Standard 250-sheet tray</td>
<td>7 Optional 550-sheet feeder</td>
</tr>
<tr>
<td>2 Multipurpose feeder</td>
<td>8 Optional duplexer</td>
</tr>
<tr>
<td>3 Side button</td>
<td></td>
</tr>
<tr>
<td>4 Belt unit</td>
<td></td>
</tr>
<tr>
<td>5 Operator panel</td>
<td></td>
</tr>
<tr>
<td>6 Front cover</td>
<td></td>
</tr>
</tbody>
</table>

**NOTE:** Your printer allows for a maximum of 3 trays (standard 250-sheet tray, optional 550-sheet feeder, and multipurpose feeder).

**NOTE:** When you use the printer with the multipurpose feeder opened, do not locate the printer in direct sunlight. Doing so may cause a malfunction or unnatural screen image.

Leave enough room to open the printer trays, covers, and options. It is also important to allow space around the printer for proper ventilation.
Installing the Print Cartridges

CAUTION: Before performing any of the following procedures, read and follow the safety instructions in your Owner’s Manual.

NOTICE: To protect the drums of the print cartridges against bright light, close the front cover within 5 minutes. If the front cover remains open for more than 5 minutes, print quality may deteriorate.

NOTICE: Make sure nothing touches or scratches the surface (black-colored film) of the belt unit. Scratches, dirt, or oil from your hands on the film of the belt unit may reduce print quality.

Installing the Print Cartridges

1. Push the side button and open the front cover.

2. Pull up the tag to remove the seal from the unit belt.
3. Pull up the tag to remove the seal from the fuser.

NOTE: Make sure to lock both levers at ends of the fuser, after removing the seal.

4. Hold one print cartridge firmly and shake it 5 or 6 times to distribute the toner evenly.
5. Remove the print cartridge from its packaging.

NOTE: To protect the drum against bright light, do not remove the orange protective cover of the print cartridge before the cartridge is inserted into its slot in the printer.

6. Completely remove the seal from the print cartridge by pulling the tab on the end of the print cartridge.

NOTE: Pull the seal out straight. Pulling the seal diagonally may tear it.

7. Grasp both handles of the print cartridge with the label facing up and slide the cartridge into the same color slot. Make sure the cartridge is fully inserted.
8. Repeat steps 4, 5, 6, and 7 to install the other print cartridges.

9. Remove the orange protective covers of the each of the installed print cartridges.

10. After installing all of the print cartridges, close the front cover.
Connecting Your Printer

**Choosing the Right Cable**

**Connecting the Printer Locally**

**Connecting the Printer to the Network**

---

## Choosing the Right Cable

Your Dell™ Color Laser Printer 3110cn interconnection cable must meet the following requirements:

<table>
<thead>
<tr>
<th>Connection type</th>
<th>Connection specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parallel</td>
<td>IEEE 1284</td>
</tr>
<tr>
<td>USB</td>
<td>USB 2.0</td>
</tr>
<tr>
<td>Ethernet</td>
<td>10 Base-T/100 Base-TX</td>
</tr>
<tr>
<td>Wireless</td>
<td>IEEE802.11b/802.11g</td>
</tr>
</tbody>
</table>
## Connecting the Printer Locally

A local printer is a printer attached to your computer using a USB or parallel cable. If your printer is attached to a network instead of your computer, skip this step and go on to "Connecting the Printer to the Network."

Microsoft® Windows® 2000, XP, Server 2003, XP x64, Server 2003 x64, Vista and Mac® OS X or later operating systems support USB connections. Some UNIX® and Linux computers also support USB connections. See your computer operating system documentation to see if your system supports USB.

To attach the printer to a computer:

1. Make sure the printer, computer, and any other attached devices are turned off and unplugged.
2. Connect the printer to the computer using a USB or parallel cable.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Parallel port</td>
</tr>
<tr>
<td>2</td>
<td>USB port</td>
</tr>
<tr>
<td>3</td>
<td>Ethernet port</td>
</tr>
<tr>
<td>4</td>
<td>Optional wireless printer adapter socket</td>
</tr>
</tbody>
</table>
A USB/parallel port requires a USB/parallel cable. Be sure to match the USB/parallel symbol on the cable to the USB/parallel symbol on the printer.

Plug the other end of the cable into a USB or parallel port on the back of the computer. For a USB cable, do not plug it into the USB keyboard.

**Turn On the Printer**

1. Plug one end of the printer power cable into the socket at the back of the printer and the other end into a properly grounded outlet.
CAUTION: Do not use extension cords or power strips.

CAUTION: The printer should not be plugged into a UPS system.

2. Turn on the computer and the printer.

---

**Connecting the Printer to the Network**

To attach the printer to a network:

1. Make sure the printer, computer, and any other attached devices are turned off and unplugged.

2. Connect the printer to the network using an Ethernet cable or the wireless printer adapter.
   To use a wireless printer adapter, you must install the Multi Protocol Card first. To install the card, see "Installing the Dell Multi Protocol Card".
To connect the printer to the network, plug one end of an Ethernet cable into the Ethernet port on the back of the printer, and the other end into a LAN drop or hub. For a wireless connection, insert the wireless printer adapter into the wireless printer socket on the back of the printer.

**Turn On the Printer**

1. Plug one end of the printer power cable into the socket at the back of the printer and the other end into a properly grounded outlet.

⚠️ **CAUTION:** Do not use extension cords or power strips.
CAUTION: The printer should not be plugged into a UPS system.

2. Turn on the computer and the printer.

Print and Check the Printer Settings Page

Print a printer settings page to verify the network connection. This page also provides important information that helps you configure for network printing.

NOTE: Depending on the network configuration, the printer may not be provided an IP address immediately. If the Printer Settings page does not show an assigned IP address, wait 5 minutes and try again.

1. Press **Menu**.

2. Press ▼ until **Report/List** appears, and then press ✔.

3. **Printer Setting** is displayed. Press ✔.

   The printer settings page is printed.

4. If the IP address shows anything other than 0.0.0.0 (the factory default) or 169.254.xx.xx, the printer has an IP address assigned and stored. Go to "Verify the IP Settings."

Assign an IP Address

NOTE: When you assign an IP address manually in **IPv6 Mode**, use the Dell Printer Configuration Web Tool. To open the Dell Printer Configuration Web Tool, use the link local address. (To check a link local address, see "Print and Check the Printer Settings Page".)

An IP address is a unique number that consists of four sections that are delimited by a period and can include up to three digits in each section, for example, 111.222.33.44.

Assigning an IP address already in use can cause network performance issues.

NOTE: Assigning an IP address is considered as an advanced function and is normally done by a system administrator.

For more information on using your operator panel, see "Operator Panel."

1. Turn on the printer.

   The Ready to Print appears.
2. Press **Menu**.

3. Press ▼ until **Admin Menu** appears, and then press ✓.

4. Press ▼ until **Wired Network** appears, and then press ✓.

5. Press ▼ until **TCP/IP** appears, and then press ✓.

6. Press ▼ until **IP Address** appears, and then press ✓.

7. The cursor is located at the first digit of the IP address. Press ▲ ▼ to enter the numbers for the IP address.

8. Press ►.

   The cursor moves to the next digit.

9. Repeat steps 7 and 8 to enter all of the digits in the IP address, and then press ✓.

10. Press ◀.

11. Press ▼ until **Subnet Mask** appears, and then press ✓.

12. Repeat steps 7 to 8 to set **Subnet Mask**, and then press ✓.

13. Press ◀.

14. Press ▼ until **Gateway Address** appears, and then press ✓.

15. Repeat steps 7 to 8 to set **Gateway Address**, and then press ✓.

16. Turn off the printer, and then turn it on again.

The IP address is assigned to your printer. To verify the setting, open the web browser on any computer connected to the network and enter the IP address into the address bar on the browser. If the IP address is set up correctly, the **Dell Printer Configuration Web Tool** displays in your browser.

You can also assign the IP address to the printer when installing the printer drivers with installer. When you use the **Network Installation** feature, and the **Get IP Address** is set to **AutoIP** on the operator panel menu, you can set the IP address from 0.0.0.0 to the desired IP address on the printer selection window.

**Verify the IP Settings**

1. Print another printer settings page.

2. Look under the **TCP/IP** heading on the printer settings page to make sure the IP address, netmask, and gateway are what you expected.
or

Ping the printer and verify that it responds. For example, at a command prompt on a network computer, type ping followed by the new printer IP address (for example, 192.168.0.11):

```
ping 192.168.0.11
```

If the printer is active on the network, you will receive a reply.
Enterprise Console Management Modules

The following enterprise console management modules and user's manuals are available on your *Drivers and Utilities* CD:

- IBM Tivoli® NetView®
- CA Unicenter®
- HP OpenView®

To use the modules, go to the following directory on your CD and run each `.exe` file or `.chm` file.

IBM Tivoli: `\Utilities\SnapIns\IBM Tivoli`

CA Unicenter: `\Utilities\SnapIns\CA Unicenter`

HP OpenView: `\Utilities\SnapIns\HP OpenView`
Installing Optional Modules

You can make the printer more functional by installing the options. This chapter describes how to install the printer's options such as the duplexer and 550-sheet feeder.

- Installing the Optional 550-Sheet Feeder
- Installing a Duplexer
- Installing a Memory Card
- Installing the Dell Multi Protocol Card
- Installing the Dell Wireless Printer Adapter 3310 USB

Installing the Optional 550-Sheet Feeder

⚠️ CAUTION: If you are adding an optional 550-sheet feeder after setting up the printer, be sure to turn off the printer, unplug the power cable, and disconnect all cables from the back of the printer before completing these tasks.

1. Place the optional 550-sheet feeder in the location that the printer is located.
2. Make sure that the printer is turned off.
3. Lift the printer and align the four guide pins of the 550-sheet feeder with the holes at the bottom of the printer. Gently lower the printer onto the optional 550-sheet feeder.

⚠️ CAUTION: To lift the printer safely, lift it with two people facing the front and back. Never try to lift the printer while facing its right and left sides.
**NOTICE:** Be careful not to pinch your fingers when lowering the printer onto the optional 550-sheet feeder.

4. Pull the tray out of the printer until it stops. Hold the tray with both hands, lift the front slightly, and remove it from the printer.

5. Join the 550-sheet feeder and the printer by tightening the two screws provided with the feeder with a coin or similar object.
6. Insert the tray into the printer, and push until it stops.

7. Turn on the printer.

**NOTE:** The printer will automatically detect the attached tray but will not detect the paper type.

8. Print a printer settings page to verify that the optional 550-sheet feeder is installed correctly.
   a. Press **Menu**.
   b. Press ▼ until **Report/List** appears, and then press ✓.
   c. **Printer Setting** is displayed. Press ✓. The printer settings page is printed.
   d. Verify **550 Sheet Feeder** is listed in the printer settings under **Printer Options**.
If the tray module is not listed, turn off the printer, unplug the power cable, and reinstall the optional 550-sheet feeder.

9. After loading paper in the installed tray, specify the paper type from the printer operator panel.
   a. Press **Menu**.
   b. Press ▼ until **Tray Settings** appears, and then press ✓.
   c. Press ▼ until the installed tray appears, and then press ✓.
   d. Press ▼ until **Paper Type** appears, and then press ✓.
   e. Press ▼ until the paper type for the installed tray appears, and then press ✓.
   f. Confirm that the selected paper type is marked with an asterisk(*), and then press **Menu**.

10. If you installed the optional 550-sheet feeder after installing the printer driver, update your driver by following the instructions for each operating system. If the printer is on a network, update the driver for each client.

**When Using PCL Driver**

**Windows Vista™**

1. Click **Start → Control Panel → Hardware and Sound → Printers**.
2. Right-click this printer icon and select **Properties**.
3. Click the Options tab, and then select **Get Information from Printer**.
4. Click **Apply**, and then click **OK**.
5. Close the **Printers** folder.

**Windows XP/XP x64/Server 2003/Server 2003 x64**

1. Click **Start → Printers and Faxes**.
2. Right-click the printer and select **Properties**.
3. Click the **Options** tab, and then select **Get Information from Printer**.
4. Click **Apply**, and then click **OK**.
5. Close the **Printers and Faxes** dialog box.
Windows 2000/NT 4.0

1. Click Start → Settings → Printers.
2. Right-click the printer and select Properties.
3. Click the Options tab, and then select Get Information from Printer.
4. Click Apply, and then click OK.
5. Close the Printers dialog box.

If the printer information is not updated automatically after clicking Get Information from Printer, follow these steps:

1. Click the Options tab, and then select 550 Sheet Feeder in the Items list box.
2. Select Available for the 550-sheet feeder setting.
3. Click Apply, and then click OK.
4. Close the Printers and Faxes (or Printers) dialog box.

When Using PS Driver

Windows Vista

1. Click Start → Control Panel → Hardware and Sound → Printers.
2. Right-click the printer that is using the PS driver, and then select Properties from the displayed list.
3. Click the Device Settings tab, and then select 2-Tray Module for the Paper Tray Configuration item under Installable Options.
4. Click Apply, and then click OK.
5. Close the Printers dialog box.

Windows XP/XP x64/Server 2003/Server 2003 x64

1. Click Start → Printers and Faxes.
2. Right-click the printer that is using the PS driver, and then select Properties from the displayed list.
3. Click the Device Settings tab, and then select 2-Tray Module for the Paper Tray Configuration item under Installable Options.
4. Click Apply, and then click OK.
5. Close the Printers and Faxes dialog box.
Windows 2000/NT 4.0

1. Click **Start → Settings → Printers**.
2. Right-click the printer that is using the PS driver, and then select **Properties** from the displayed list.
3. Click the **Device Settings** tab, and then select **2-Tray Module** for the **Paper Tray Configuration** item under **Installable Options**.
4. Click **OK**.
5. Close the **Printers** dialog box.

Mac OS X

1. Select the printer from the **Printer List** screen in **Print Center** (or **Printer Setup Utility**).
2. Click **Printers** on the **Print Center** (or **Printer Setup Utility**) menu bar, and select **Show Info**.
3. Select **Installable Options**, and select the options that have been installed on the printer, and then click **Apply Changes**.

Installing a Duplexer

**NOTICE:** To protect the drums of the print cartridges against bright light, close the front cover within 5 minutes. If the front cover remains open for more than 5 minutes, print quality may deteriorate.

**NOTICE:** Make sure nothing touches or scratches the surface (black-colored film) of the belt unit. Scratches, dirt, or oil from your hands on the film of the belt unit may reduce print quality.

1. Make sure that the printer is turned off.
2. Remove all packaging from duplex module.
3. Push the side button and open the front cover.
4. Pull up on the belt release levers and rotate the belt unit up as shown in the illustration.

5. Remove the connector cap.
NOTE: The connector cap in your printer may look different from illustration.

6. With the connector of the duplexer toward the slot, push the duplexer into the slot.
NOTE: Make sure that the duplexer is correctly connected to the printer with connectors and cannot be moved easily.

7. Close the belt unit by pulling it down.

8. Close the front cover.
9. Turn on the printer.

10. Print a printer settings page to verify that the optional duplexer is installed correctly.
    a. Press Menu.
    b. Press ▼ until Report/List appears, and then press ✓.
    c. Printer Setting is displayed. Press ✓.
       The printer settings page is printed.
    d. Verify Duplexer is listed in the printer settings under Printer Options.
       If the duplexer is not listed, turn off the printer, unplug the power cable, and reinstall the optional duplexer.

11. If you installed the optional duplexer after installing the printer driver, update your driver by following the instructions for each operating system. If the printer is on a network, update the driver for each client.

When Using PCL Driver

Windows Vista

1. Click Start → Control Panel → Hardware and Sound → Printers.
2. Right-click this printer icon and select Properties.
3. Click the Options tab, and then select Get Information from Printer.
4. Click Apply, and then click OK.
5. Close the Printers folder.
**Windows XP/XP x64/Server 2003/Server 2003 x64**

1. Click **Start** → **Printers and Faxes**.
2. Right-click the printer and select **Properties**.
3. Click the **Options** tab, and then select **Get Information from Printer**.
4. Click **Apply**, and then click **OK**.
5. Close the **Printers and Faxes** dialog box.

**Windows 2000/NT 4.0**

1. Click **Start** → **Settings** → **Printers**.
2. Right-click the printer and select **Properties**.
3. Click the **Options** tab, and then select **Get Information from Printer**.
4. Click **Apply**, and then click **OK**.
5. Close the **Printers** dialog box.

If the printer information is not updated automatically after clicking **Get Information from Printer**, follow these steps:

1. Click the **Options** tab, and then select **Duplexer** in the **Items** list box.
2. Select **Available** for the duplexer setting.
3. Click **Apply**, and then click **OK**.
4. Close the **Printers and Faxes** (or **Printers**) dialog box.

**When Using PS Driver**

**Windows Vista**

1. Click **Start** → **Control Panel** → **Hardware and Sound** → **Printers**.
2. Right-click the printer that is using the PS driver, and then select **Properties** from the displayed list.
3. Click the **Device Settings** tab, and then select **Available** for the **Duplexer** item under **Installable Options**.
4. Click **Apply**, and then click **OK**.
5. Close the **Printers** dialog box.
Windows XP/XP x64/Server 2003/Server 2003 x64

1. Click Start → Printers and Faxes.
2. Right-click the printer that is using the PS driver, and then select Properties from the displayed list.
3. Click the Device Settings tab, and then select Available for the Duplexer item under Installable Options.
4. Click Apply, and then click OK.
5. Close the Printers and Faxes dialog box.

Windows 2000/NT 4.0

1. Click Start → Settings → Printers.
2. Right-click the printer that is using the PS driver, and then select Properties from the displayed list.
3. Click the Device Settings tab, and then select Available for the Duplexer item under Installable Options.
4. Click OK.
5. Close the Printers dialog box.

Mac OS X

1. Select the printer from the Printer List screen in Print Center (or Printer Setup Utility).
2. Click Printers on the Print Center (or Printer Setup Utility) menu bar, and select Show Info.
3. Select Installable Options, and select the options that have been installed on the printer, and then click Apply Changes.
4. Click Apply, and then click OK.

Installing a Memory Card

Your printer supports 256 MB, 512 MB, and 1024 MB additional memory cards.

1. Make sure that the printer is turned off.
2. Turn the screw on the control board cover in a counterclockwise direction and open the cover.
3. With the connector of the memory card toward the slot, insert the memory card at an angle into the slot.

4. Push the memory card into the slot firmly.
5. Pivot the memory card downward until it clicks into place.

**NOTE:** Make sure that the memory card is firmly fixed in the slot and cannot be moved easily.

6. Close the control board cover and turn the screw clockwise.
7. Turn on the printer.

8. Print a printer settings page to verify that the additional print memory is installed correctly.
   a. Press Menu.
   b. Press ▼ until Report/List appears, and then press ✓.
   c. Printer Setting is displayed. Press ✓.
      The printer settings page is printed.
   d. Verify the capacity of the installed memory listed in the printer settings under General.
      If the memory capacity has not increased, turn off the printer, unplug the power cable, and reinstall the memory card.

9. If you installed the additional print memory after installing the printer driver, update your driver by following the instructions for the operating system you are using. If the printer is on a network, update the driver for each client.

When Using PCL Driver

Windows Vista

1. Click Start → Control Panel → Hardware and Sound → Printers.
2. Right-click this printer icon and select Properties.
3. Click the Options tab, and then select Get Information from Printer.
4. Click Apply, and then click OK.
5. Close the Printers folder.

Windows XP/XP x64/Server 2003/Server 2003 x64

1. Click Start → Printers and Faxes.
2. Right-click the printer and select **Properties**.
3. Click the **Options** tab, and then select **Get Information from Printer**.
4. Click **Apply**, and then click **OK**.
5. Close the **Printers and Faxes** dialog box.

### Windows 2000/NT 4.0

1. Click **Start → Settings → Printers**.
2. Right-click the printer and select **Properties**.
3. Click the **Options** tab, and then select **Get Information from Printer**.
4. Click **Apply**, and then click **OK**.
5. Close the **Printers** dialog box.

If the printer information is not updated automatically after clicking **Get Information from Printer**, follow these steps:

1. Click the **Options** tab, and then select **Memory Capacity** on the **Items** list box.
2. Select the total amount of the installed print memory for the memory capacity setting.
3. Click **Apply**, and then click **OK**.
4. Close the **Printers and Faxes** (or **Printers**) dialog box.

### When Using PS Driver

#### Windows Vista

1. Click **Start → Control Panel → Hardware and Sound → Printers**.
2. Right-click the printer that is using the PS driver, and then select **Properties** from the displayed list.
3. Click the **Device Settings** tab, and then select the total amount of the installed print memory for the **Memory Capacity** item under **Installable Options**.
4. Click **Apply**, and then click **OK**.
5. Close the **Printers** dialog box.

#### Windows XP/XP x64/Server 2003/Server 2003 x64

1. Click **Start → Printers and Faxes**.
2. Right-click the printer that is using the PS driver, and then select **Properties** from the displayed list.

3. Click the **Device Settings** tab, and then select the total amount of the installed print memory for the **Memory Capacity** item under **Installable Options**.

4. Click **Apply**, and then click **OK**.

5. Close the **Printers and Faxes** dialog box.

---

**Windows 2000/NT 4.0**

1. Click **Start** \rightarrow **Settings** \rightarrow **Printers**.

2. Right-click the printer that is using the PS driver, and then select **Properties** from the displayed list.

3. Click the **Device Settings** tab, and then select the total amount of the installed print memory for the **Memory Capacity** item under **Installable Options**.

4. Click **OK**.

5. Close the **Printers** dialog box.

---

**Mac OS X**

1. Select the printer from the **Printer List** screen in **Print Center** (or **Printer Setup Utility**).

2. Click **Printers** on the **Print Center** (or **Printer Setup Utility**) menu bar, and select **Show Info**.

3. Select **Installable Options**, and select the options that have been installed on the printer, and then click **Apply Changes**.

4. Click **Apply**, and then click **OK**.

---

**Installing the Dell Multi Protocol Card**

A multi protocol card allows you to use the following network protocols.
<table>
<thead>
<tr>
<th>Network protocol</th>
<th>Supported operating systems</th>
</tr>
</thead>
<tbody>
<tr>
<td>IPP</td>
<td>Windows Vista/XP/XP x64/Server 2003/Server 2003 x64/2000/NT 4.0, Mac OS X 10.3.9/10.4.3</td>
</tr>
<tr>
<td>SMB</td>
<td>Windows Vista/XP/XP x64/Server 2003/Server 2003 x64/2000/ NT 4.0</td>
</tr>
<tr>
<td>IPX/SPX</td>
<td>NetWare3.12/3.2/4.1/4.11/4.2/5/6/6.5*</td>
</tr>
<tr>
<td>AppleTalk</td>
<td>Mac OS X 10.2.8/10.3.9/10.4.3</td>
</tr>
<tr>
<td>Bonjour</td>
<td>Mac OS X 10.2.8/10.3.9/10.4.3</td>
</tr>
<tr>
<td>IPv6</td>
<td>Windows Vista</td>
</tr>
</tbody>
</table>

*Only compatible with Support Pack 1.1 or later.

1. Make sure that the printer is turned off and unplug all cables including the power cord from the rear of the printer.

2. Turn the screw on the control board cover in counterclockwise direction and open the cover.

3. With the connector of the multi protocol card aligned over the mating connector on the control board, make connections together by pressing on the back of the MPC card nearest the connecter pins.
4. Press the printed circles with your fingers to secure the multi protocol card to the connector.

**NOTE:** Avoid pressing down on the multi protocol card's connector.

**NOTE:** Make sure that the multi protocol card is firmly fixed in the connector and cannot be moved easily.

5. Insert the two screws through the control board case and into the Multi Protocol Card as shown, and tighten the screws.
6. Close the control board cover and turn the screw clockwise.

---

**Confirming the Installation of the Multi Protocol Card**

1. Print a printer settings page to verify that the optional multi protocol card is installed correctly.
   a. Press **Menu**.
   b. Press ▼ until Report/List appears, and then press ✓.
   c. **Printer Setting** is displayed. Press ✓.
      The printer settings page is printed.
   d. Verify **Multi-Protocol Card** is listed in the printer settings under **Printer Options**.
      If it is not listed, turn off the printer, unplug the power cable, and reinstall the optional multi protocol card.

---

**Installing the Dell Wireless Printer Adapter 3310 USB**
<table>
<thead>
<tr>
<th>Connectivity Technology</th>
<th>Wireless</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compliant Standards</td>
<td>802.11b/802.11g</td>
</tr>
<tr>
<td>Bandwidth</td>
<td>2.4GHz</td>
</tr>
</tbody>
</table>
| Data Transfer Rate      | 11g mode: 54, 48, 36, 24, 18, 12, 9, 6 Mbps  
|                        | 11b mode: 11, 5.5, 2, 1 Mbps |
| Device Type             | Wireless Printer Adapter |
| Security                | 64(40-bit key)/128(104-bit key) WEP Encryption/WPA/WPA2 |

**NOTE:** To use the wireless printer adapter, you must install the multi protocol card first. To install the card, see "Installing the Dell Multi Protocol Card".

1. Make sure that the printer is turned off and unplug all cables including the power cord from the rear of the printer.

**NOTE:** Make sure that the multi protocol card is installed.

2. Remove the single thumbscrew from the top of the plate covering the wireless printer adapter socket and then remove the plate.

3. Insert the wireless printer adapter into the USB socket with the Dell logo of the adapter facing out.
NOTE: Make sure that the adapter is firmly fixed in the socket and cannot be moved easily.

4. Attach the wireless printer adapter cap by inserting the cap with the mark facing out until it clicks into place.

5. Turn on the printer and configure the wireless network settings.

**Wireless Installation using USB connection**

NOTE: The optional multi protocol card with the Wireless Printer Adapter attached must be installed on the printer.

**Scene 1. Install a printer to the already-operating wireless network (When wireless setting is already set to your computer)**

1. Insert the *Drivers and Utilities* CD into your computer.

2. The *Drivers and Utilities* CD should launch the installation software automatically.
If the CD does not automatically launch, click Start → Run, type D:\Setup.exe (where D is the drive letter of your CD), and then click OK.

**NOTE:** For Windows Vista, click Continue when the User Account Control dialog box appears.

3. Select the Network Installation option button, and then click Next.

4. Select the Configure Wireless Printer using a USB connection (Recommended) option button, and then click Next.

5. Reset the wireless setting of the printer following the steps on the Reset Wireless Setting screen.

6. In the list on the Select Printer screen, check the check box of the target printer that you are making wireless setting for, and then click Next. On the Enter Wireless Network Settings screen, set each wireless setting item, and then click Next. When you select the Fixed IP option button for IP address assignment, click Settings... and enter the IP address and subnet mask on the screen.

**NOTE:** When you enter a fixed IP address, avoid the "169.254.xxx.xxx" address used by AutoIP.

7. Set each item on the Enter Printer Settings screen, and then click Next.

8. On the Printer Software screen, specify the software that you want to install and installation path, and then click Next. At this point, the wireless setting specified on the Enter Wireless Network Settings screen is sent to the printer.

9. On the Wireless configuration is now complete screen, click Next. Since wireless setting is already made to your computer, no operation is necessary on this screen.

10. On the Setting-Ready Printer screen, verify that the correct IP address is assigned to the printer to which the wireless setting is set, and then click Install.

11. If you select the I am setting up this printer on server check box on the Select Printer screen and also select the PostScript Driver check box on the Enter Printer Settings screen, the Adobe Systems Inc. License Agreement screen appears. Select the I accept the terms of the license agreement option button, and then click Install.

12. On the Congratulations! screen, click Finish to complete the installation. A test page will be printed with the installed printer by clicking the Print Test Page button.

**Scene 2. Construct new wireless network environment for both computer and printer (When wireless setting needs to be set to your computer)**

1. Insert the Drivers and Utilities CD into your computer.

2. The Drivers and Utilities CD should launch the installation software automatically. If the CD does not automatically launch, click Start → Run, type D:\Setup.exe (where D is the drive letter of your CD), and then click OK.

**NOTE:** For Windows Vista, click Continue when the User Account Control dialog box appears.
3. Select the **Network Installation** option button, and then click **Next**.

4. Select the **Configure Wireless Printer using a USB connection (Recommended)** option button, and then click **Next**.

5. Reset the wireless setting of the printer following the steps on the **Reset Wireless Setting** screen.

6. In the list on the **Select Printer** screen, check the check box of the target printer that you are making wireless setting for, and then click **Next**.

   **NOTE:** When you enter a fixed IP address, avoid the "169.254.xxx.xxx" address used by AutoIP.

7. On the **Enter Wireless Network Settings** screen, set each wireless setting item, and then click **Next**. When you select the **Fixed IP** option button for **IP address assignment**, click **Settings...** and enter the IP address and subnet mask on the screen.

8. Set each item on the **Enter Printer Settings** screen, and then click **Next**.

9. On the **Printer Software** screen, specify the software that you want to install and installation path, and then click **Next**. At this point, the wireless setting specified on the **Enter Wireless Network Settings** screen is sent to the printer.

10. On the **Wireless configuration is now complete** screen, create the wireless setting sent to the printer on your computer following the steps below, and then click **Next**.

   **NOTE:** If your computer provides a wireless LAN adapter tool, change the wireless settings using this tool. Or you can change the wireless settings using the tool provided by the operating system. See the instructions below.

   a. Select **Network Connections** from Control Panel.

   b. Right-click **Wireless Network Connection** and select **Properties**.

   c. Select the **Wireless Network** tab.

   d. Make sure the check box for **Use Windows to configure my wireless network settings** is checked.

   e. Click **Advanced**.

   f. Do either of the following:

   **When wireless ad-hoc mode is set to the printer:**
   Select **Computer to Computer (ad hoc) networks only** and close the **Advanced** dialog box.

   **When wireless infrastructure mode is set to the printer:**
   Select **Access point (Infrastructure) networks only** and close the **Advanced** dialog box.

   g. Click **Add** to display Wireless network properties.

   h. Enter the setting that you send to the printer and click **OK**.
i. Click Move up to move the setting to the top of the list.

j. Click OK to close the Property dialog box.

11. On the Setting-Ready Printer screen, verify that the correct IP address is assigned to the printer to which the wireless setting is set, and then click Install.

12. If you select the I am setting up this printer on server check box on the Select Printer screen and also select the PostScript Driver check box on the Enter Printer Settings screen, the Adobe Systems Inc. License Agreement screen appears. Select the I accept the terms of the license agreement option button, and then click Install.

13. On the Congratulations! screen, click Finish to complete the installation. A test page will be printed with the installed printer by clicking the Print Test Page button.

Use the Dell Printer Configuration Web Tool to monitor the status of your network printer without leaving your desk. You can view and/or change the printer configuration settings, monitor toner level, and when it is time to order replacement consumables, just click the Dell supplies link right from your Web browser.

NOTE: The Dell Printer Configuration Web Tool is not available when the printer is locally attached to a computer or a print server.

Wireless Installation using wireless connection

Scene 1. Install a printer to the already-operating wireless network (When wireless setting is already set to your computer)

1. Insert the Drivers and Utilities CD into your computer to launch the installation software.

NOTE: If the CD does not automatically launch, click Start → Run, and then type D:\setup.exe (where D is the drive letter of your CD), and then click OK.

NOTE: For Windows Vista, click Continue when the User Account Control dialog box appears.

2. Select the Network Installation option button, and then click Next.

3. Select the Configure Wireless Printer using a wireless connection (Advanced) option button, and then click Next.

4. Reset the wireless setting of the printer following the steps on the Reset Wireless Setting screen.

5. Create the wireless setting of your computer following the steps shown on the Enable Communication with Printer screen, and then click Next.

NOTE: If your computer provides a wireless LAN adapter tool, change the wireless settings using this tool. Or you can change the wireless settings using the tool provided by the operating system. See the instructions below.

The steps are as follows.
a. Select **Network Connections** from Control Panel.

b. Right-click **Wireless Network Connection** and select **Properties**.

c. Select the **Wireless Networks** tab.

d. Make sure the check box for **Use Windows to configure my wireless network settings** is checked.

![NOTE: Be sure to write down the current wireless computer settings in steps d and f so that you can restore them later.]

e. Click the **Advanced** button.

f. Select **Computer to Computer (ad hoc) networks only** and close the **Advanced** dialog box.

g. Click the **Add** button to display Wireless network properties.

h. Under the Association tab, enter the following information and click **OK**.

   **Network name (SSID):** dell_device  
   **Network Authentication:** Open  
   **Data encryption:** Disabled  
   **Ad hoc network:** checked

   i. Click the **Move up** button to move the newly added SSID to the top of the list.

   j. Click **OK** to close the **Property** dialog box.

6. On the **Enter Wireless Network Settings** screen, set each wireless setting item, and then click **Next**.

7. When you select the **Fixed IP** option button for IP address assignment, click **Settings...** and enter the IP address and subnet mask on the screen.

![NOTE: When you enter a fixed IP address, avoid the "169.254.xxx.xxx" address used by AutoIP.]

8. Set each item on the **Enter Printer Settings** screen, and then click **Next**.

9. On the **Printer Software** screen, specify the software that you want to install and installation path, and then click **Next**. At this point, the wireless setting specified on the **Enter Wireless Network Settings** screen is sent to the printer.

10. On the **Wireless configuration is now complete** screen, change the wireless setting of your computer to the same as that sent to the printer, and then click **Next**.
NOTE: If your computer provides a wireless LAN adapter tool, change the wireless settings using this tool. Or you can change the wireless settings using the tool provided by the operating system. See the instructions below.

   a. Select **Network Connections** from Control Panel.

   b. Right-click **Wireless Network Connection** and select **Properties**.

   c. Select the **Wireless Network** tab.

   d. Click **Advanced**.

   e. Do either of the following:

      **When wireless ad-hoc mode is set to the printer:**
      Select **Computer to Computer (ad hoc) networks only** and close the **Advanced** dialog box.

      **When wireless infrastructure mode is set to the printer:**
      Select **Access point (Infrastructure) networks only** and close the **Advanced** dialog box.

   f. Select the setting that you send to the printer in the list in **Preferred Network** group.

   g. Click **Move up** to move the setting to the top of the list.

   h. Click **OK** to close the **Property** dialog box.

11. On the **Setting-Ready Printer** screen, verify that the correct IP address is assigned to the printer to which the wireless setting is set, and then click **Install**.

12. If you select the **I am setting up this printer on server** check box on the **Select Printer** screen and also select the **PostScript Driver** check box on the **Enter Printer Settings** screen, the **Adobe Systems Inc. License Agreement** screen appears. Select the **I accept the terms of the license agreement** option button, and then click **Install**.

13. On the **Congratulations!** screen, click **Finish** to complete the installation. A test page will be printed with the installed printer by clicking the **Print Test Page** button.

**Scene 2. Construct new wireless network environment for both computer and printer (When wireless setting needs to be set to your computer)**

1. Insert the **Drivers and Utilities** CD into your computer to launch the installation software.

   NOTE: If the CD does not automatically launch, click **Start → Run**, and then type `D:\setup.exe` (where D is the drive letter of your CD), and then click **OK**.

   NOTE: For Windows Vista, click **Continue** when the **User Account Control** dialog box appears.

2. Select the **Network Installation** option button, and then click **Next**.
3. Select the **Configure Wireless Printer using a wireless connection (Advanced)** option button, and then click **Next**.

4. Reset the wireless setting of the printer following the steps on the **Reset Wireless Setting** screen.

5. Create the wireless setting of your computer following the steps shown on the Enable Communication with Printer screen, and then click **Next**. The steps are as follows.

   **NOTE:** If your computer provides a wireless LAN adapter tool, change the wireless settings using this tool. Or you can change the wireless settings using the tool provided by the operating system. See the instructions below.

   a. Select **Network Connections** from Control Panel.

   b. Right-click **Wireless Network Connection** and select **Properties**.

   c. Select the **Wireless Networks** tab.

   d. Make sure the check box for **Use Windows to configure my wireless network settings** is checked.

   **NOTE:** Be sure to write down the current wireless computer settings in steps d and f so that you can restore them later.

   e. Click the **Advanced** button.

   f. Select **Computer to Computer (ad hoc) networks only** and close the **Advanced** dialog box.

   g. Click the **Add** button to display **Wireless network properties**.

   h. Under the **Association** tab, enter the following information and click **OK**.

   - Network name (SSID): dell_device
   - Network Authentication: Open
   - Data encryption: Disabled
   - Ad hoc network: checked

   i. Click the **Move up** button to move the newly added SSID to the top of the list.

   j. Click **OK** to close the **Property** dialog box.

6. On the **Enter Wireless Network Settings** screen, set each wireless setting item, and then click **Next**.

7. When you select the **Fixed IP** option button for **IP address assignment**, click **Settings...** and enter the IP address and subnet mask on the screen.

   **NOTE:** When you enter a fixed IP address, avoid the "169.254.xxx.xxx" address used by AutoIP.
8. Set each item on the **Enter Printer Settings** screen, and then click **Next**.

9. On the **Printer Software** screen, specify the software that you want to install and installation path, and then click **Next**. At this point, the wireless setting specified on the **Enter Wireless Network Settings** screen is sent to the printer.

10. On the **Wireless configuration is now complete** screen, create the wireless setting sent to the printer on your computer following the steps below, and then click **Next**.

**NOTE:** If your computer provides a wireless LAN adapter tool, change the wireless settings using this tool. Or you can change the wireless settings using the tool provided by the operating system. See the instructions below.

a. Select **Network Connections** from Control Panel.

b. Right-click **Wireless Network Connection** and select **Properties**.

c. Select the **Wireless Network** tab.

d. Make sure the check box for **Use Windows to configure my wireless network settings** is checked.

e. Click **Advanced**.

f. Do either of the following:

**When wireless ad-hoc mode is set to the printer:**
Select **Computer to Computer (ad hoc) networks only** and close the **Advanced** dialog box.

**When wireless infrastructure mode is set to the printer:**
Select **Access point (Infrastructure) networks only** and close the **Advanced** dialog box.

g. Click **Add** to display **Wireless network** properties.

h. Enter the setting that you send to printer and click **OK**.

i. Click **Move up** to move the setting to the top of the list.

j. Click **OK** to close the **Property** dialog box.

11. On the **Setting-Ready Printer** screen, verify that the correct IP address is assigned to the printer to which the wireless setting is set, and then click **Install**.

12. If you select the **I am setting up this printer on server** check box on the **Select Printer** screen and also select the **PostScript Driver** check box on the **Enter Printer Settings** screen, the **Adobe Systems Inc. License Agreement** screen appears. Select the **I accept the terms of the license agreement** option button, and then click **Install**.

13. On the **Congratulations!** screen, click **Finish** to complete the installation. A test page will be printed with the installed printer by clicking the **Print Test Page** button.

Use the **Dell Printer Configuration Web Tool** to monitor the status of your network printer without
leaving your desk. You can view and/or change the printer configuration settings, monitor toner level, and when it is time to order replacement consumables, just click the Dell supplies link right from your Web browser.

**NOTE:** The Dell Printer Configuration Web Tool is not available when the printer is locally attached to a computer or a print server.

Wireless Installation using Dell Printer Configuration Web Tool

**Scene 1. Install a printer to the already-operating wireless network (When wireless setting is already set to your computer)**

**For DHCP network:**

1. Create wireless setting of your computer following the steps below.

**NOTE:** If your computer provides a wireless LAN adapter tool, change the wireless settings using this tool. Or you can change the wireless settings using the tool provided by the operating system. See the instructions below.

   a. Select **Network Connections** from Control Panel.
   
   b. Right-click **Wireless Network Connection** and select **Properties**.
   
   c. Select the **Wireless Networks** tab.
   
   d. Make sure the check box for **Use Windows to configure my wireless network settings** is checked.

   **NOTE:** Be sure to write down the current wireless computer settings in steps d and f so that you can restore them later.

   e. Click the **Advanced** button.
   
   f. Select **Computer to Computer (ad hoc) networks only** and close the **Advanced** dialog box.
   
   g. Click the **Add** button to display **Wireless network properties**.
   
   h. Under the **Association** tab, enter the following information and click **OK**.

   Network name (SSID): dell_device
   
   Network Authentication: Open
   
   Data encryption: Disabled
   
   Ad hoc network: checked

   i. Click the **Move up** button to move the newly added SSID to the top of the list.
j. Click **OK** to close the **Property** dialog box.

**NOTE:** When your operating system is earlier than Windows 2000, create settings according to the manual of the wireless setting tool provided by your wireless device manufacturer.

2. Check the IP address assigned by AutoIP on the printer.
   
   e.g.: 168.254.1.1

3. Check that the IP address on your computer is assigned by DHCP.

4. Open Dell Printer Configuration Web Tool using WEB browser.
   
   e.g.: http://168.254.1.1/

5. Change the wireless setting of the printer on Dell Printer Configuration Web Tool.

6. Reboot the printer.

7. Restore the wireless setting on your computer.

**NOTE:** If your computer provides a wireless LAN adapter tool, change the wireless settings using this tool. Or you can change the wireless settings using the tool provided by the operating system. See the instructions below.

   a. Select **Network Connections** from Control Panel.

   b. Right-click **Wireless Network Connection** and select **Properties**.

   c. Select **Wireless Network** tab.

   d. Click **Advanced**.

   e. Do either of the following:

   **When wireless ad-hoc mode is set to the printer:**
   Select **Computer to Computer (ad hoc) networks only** and close the **Advanced** dialog box.

   **When wireless infrastructure mode is set to the printer:**
   Select **Access point (Infrastructure) networks only** and close the **Advanced** dialog box.

   f. Select the setting that you send to the printer in the list in **Preferred Network** group.

   g. Click **Move up** to move the setting to the top of the list.

   h. Click **OK** to close the **Property** dialog box.
NOTE: When your operating system is earlier than Windows 2000, create settings according to the manual of the wireless setting tool provided by your wireless device manufacturer.

For Fixed IP network:

1. Create wireless setting of your computer following the steps below.

   a. Select **Network Connections** from Control Panel.

   b. Right-click **Wireless Network Connection** and select **Properties**.

   c. Select the **Wireless Networks** tab.

   d. Make sure the check box for **Use Windows to configure my wireless network settings** is checked.

   NOTE: Be sure to write down the current wireless computer settings in steps d and f so that you can restore them later.)

   e. Click the **Advanced** button.

   f. Select **Computer to Computer (ad hoc) networks only** and close the **Advanced** dialog box.

   g. Click the **Add** button to display **Wireless network properties**.

   h. Under the **Association** tab, enter the following information and click **OK**.

   Network name (SSID): dell_device

   Network Authentication: Open

   Data encryption: Disabled

   Ad hoc network: checked

   i. Click the **Move up** button to move the newly added SSID to the top of the list.

   j. Click **OK** to close the **Property** dialog box.

NOTE: When your operating system is earlier than Windows 2000, create settings according to the manual of the wireless setting tool provided by your wireless device manufacturer.

2. Check the IP address on your computer.
e.g.: 1.2.3.4

3. Set the IP address on the printer.

   e.g.: 1.2.3.5

4. Open Dell Printer Configuration Web Tool using WEB browser.

   e.g.: http://1.2.3.5/

5. Change the wireless setting of the printer on Dell Printer Configuration Web Tool.

6. Reboot the printer.

7. Restore the wireless setting on your computer.

**NOTE:** If your computer provides a wireless LAN adapter tool, change the wireless settings using this tool. Or you can change the wireless settings using the tool provided by the operating system. See the instructions below.

   a. Select **Network Connections** from Control Panel.

   b. Right-click **Wireless Network Connection** and select **Properties**.

   c. Select **Wireless Network** tab.

   d. Click **Advanced**.

   e. Do either of the following:

   **When wireless ad-hoc mode is set to the printer:**
   Select **Computer to Computer (ad hoc) networks only** and close the **Advanced** dialog box.

   **When wireless infrastructure mode is set to the printer:**
   Select **Access point (Infrastructure) networks only** and close the **Advanced** dialog box.

   f. Select the setting that you send to the printer in the list in **Preferred Network** group.

   g. Click **Move up** to move the setting to the top of the list.

   h. Click **OK** to close the **Property** dialog box.

**NOTE:** When your operating system is earlier than Windows 2000, create settings according to the manual of the wireless setting tool provided by your wireless device manufacturer.

**Scene 2. Construct new wireless network environment for both computer and printer (When wireless setting needs to be set to your computer)**
For DHCP network:

1. Create wireless setting of your computer following the steps below.

   NOTE: If your computer provides a wireless LAN adapter tool, change the wireless settings using this tool. Or you can change the wireless settings using the tool provided by the operating system. See the instructions below.

   a. Select **Network Connections** from Control Panel.

   b. Right-click **Wireless Network Connection** and select **Properties**.

   c. Select the **Wireless Networks** tab.

   d. Make sure the check box for **Use Windows to configure my wireless network settings** is checked.

   NOTE: Be sure to write down the current wireless computer settings in steps e and g so that you can restore them later.

   e. Click the **Advanced** button.

   f. Select **Computer to Computer (ad hoc) networks only** and close the **Advanced** dialog box.

   g. Click the **Add** button to display **Wireless network properties**.

   h. Under the **Association** tab, enter the following information and click **OK**.

      Network name (SSID): dell_device
      Network Authentication: Open
      Data encryption: Disabled
      Ad hoc network: checked

      i. Click the **Move up** button to move the newly added SSID to the top of the list.

      j. Click **OK** to close the **Property** dialog box.

   NOTE: When your operating system is earlier than Windows 2000, create settings according to the manual of the wireless setting tool provided by your wireless device manufacturer.

2. Check the IP address assigned by AutoIP on the printer.

   e.g.: 168.254.1.1

3. Check that the IP address on your computer is assigned by DHCP.

4. Open Dell Printer Configuration Web Tool using WEB browser.
e.g.: http://168.254.1.1

5. Create wireless setting of the printer on Dell Printer Configuration Web Tool.
6. Reboot the printer.
7. Restore the wireless setting on your computer.

**NOTE:** If your computer provides a wireless LAN adapter tool, change the wireless settings using this tool. Or you can change the wireless settings using the tool provided by the operating system. See the instructions below.

- Select **Network Connections** from Control Panel.
- Right-click **Wireless Network Connection** and select **Properties**.
- Select **Wireless Network** tab.
- Make sure the check box for **Use Windows to configure my wireless network settings** is checked.
- Click **Advanced**.
- Do either of the following:

  **When wireless ad-hoc mode is set to the printer:**
  Select **Computer to Computer (ad hoc) networks only** and close the **Advanced** dialog box.

  **When wireless infrastructure mode is set to the printer:**
  Select **Access point (Infrastructure) networks only** and close the **Advanced** dialog box.

- Click **Add** to display **Wireless network properties**.
- Enter the setting that you send to printer and click **OK**.
- Click **Move up** to move the setting to the top of the list.
- Click **OK** to close the **Property** dialog box.

**NOTE:** When your operating system is earlier than Windows 2000, create settings according to the manual of the wireless setting tool provided by your wireless device manufacturer.

**For Fixed IP network:**

1. Create wireless setting of your computer following the steps below.
NOTE: If your computer provides a wireless LAN adapter tool, change the wireless settings using this tool. Or you can change the wireless settings using the tool provided by the operating system. See the instructions below.

a. Select **Network Connections** from Control Panel.

b. Right-click **Wireless Network Connection** and select **Properties**.

c. Select the **Wireless Networks** tab.

d. Make sure the check box for **Use Windows to configure my wireless network settings** is checked.

NOTE: Be sure to write down the current wireless computer settings in steps d and f so that you can restore them later.

e. Click the **Advanced** button.

f. Select **Computer to Computer (ad hoc) networks only** and close the **Advanced** dialog box.

g. Click the **Add** button to display **Wireless network properties**.

h. Under the **Association** tab, enter the following information and click **OK**.

Network name (SSID): dell_device
Network Authentication: Open
Data encryption: Disabled
Ad hoc network: checked

i. Click the **Move up** button to move the newly added SSID to the top of the list.

j. Click **OK** to close the **Property** dialog box.

NOTE: When your operating system is earlier than Windows 2000, create settings according to the manual of the wireless setting tool provided by your wireless device manufacturer.

2. Check the IP address on your computer.

   e.g.: 1.2.3.4

3. Set the IP address on the printer.

   e.g.: 1.2.3.5

4. Open Dell Printer Configuration Web Tool using WEB browser.

   e.g.: http://1.2.3.5
5. Change the wireless setting of the printer on Dell Printer Configuration Web Tool.
6. Reboot the printer.
7. Restore the wireless setting on your computer.

**NOTE:** If your computer provides a wireless LAN adapter tool, change the wireless settings using this tool. Or you can change the wireless settings using the tool provided by the operating system. See the instructions below.

a. Select **Network Connections** from Control Panel.

b. Right-click **Wireless Network Connection** and select **Properties**.

c. Select **Wireless Network** tab.

d. Make sure the check box for **Use Windows to configure my wireless network settings** is checked.

e. Click **Advanced**.

f. Do either of the following:

**When wireless ad-hoc mode is set to the printer:**
Select **Computer to Computer (ad hoc) networks only** and close the **Advanced** dialog box.

**When wireless infrastructure mode is set to the printer:**
Select **Access point (Infrastructure) networks only** and close the **Advanced** dialog box.

g. Click **Add** to display **Wireless network properties**.

h. Enter the setting that you send to printer and click **OK**.

i. Click **Move up** to move the setting to the top of the list.

j. Click **OK** to close the **Property** dialog box.

**NOTE:** When your operating system is earlier than Windows 2000, create settings according to the manual of the wireless setting tool provided by your wireless device manufacturer.

**Wireless Setting through Dell Printer Configuration Web Tool - Advanced setup**

**Access point (Infrastructure, DHCP network)**

1. Create new wireless settings for your computer.
NOTE: If your computer provides a wireless LAN adapter tool, change the wireless settings using this tool. Or you can change the wireless settings using the tool provided by the operating system. See the instructions below.

a. Select **Network Connections** from Control Panel.

b. Right-click **Wireless Network Connection** and select **Properties**.

c. Select the **Wireless Networks** tab.

d. Make sure the check box for **Use Windows to configure my wireless network settings** is checked.

NOTE: Be sure to write down the current wireless computer settings in steps d and g so that you can restore them later.

e. Click the **Advanced** button.

f. Select **Computer to Computer (ad hoc) networks only** and close the Advanced dialog box.

g. Click the **Add** button to display Wireless network properties.

h. Under the **Association** tab, enter the following information and click **OK**.

   - Network name (SSID): dell_device
   - Network Authentication: Open
   - Data encryption: Disabled
   - Ad hoc network: checked

   i. Click the **Move up** button to move the newly added SSID to the top of the list.

   j. Click **OK** to close the Property dialog box.

NOTE: When your operating system is earlier than Windows 2000, create settings according to the manual of the wireless setting tool provided by your wireless device manufacturer.

2. Set up the printer wireless adapter IP address.

   a. Reset the settings for the wireless adapter to the default.

   i. Press **Menu** on printer control panel.
   ii. Scroll down and select **Admin Menu**.
   iii. Scroll down and select **Wireless net**.
   iv. Scroll down and select **Reset MPC**.
   v. Restart the printer.

   b. Retrieve the wireless adapter IP address on the printer.
i. Press **Menu** on the printer control panel.

ii. Scroll down and select **Admin Menu**.

iii. Scroll down and select wireless net.

iv. Scroll down and select **TCP/IP**.

v. Scroll down and select **IP Address**.

(Default IP address range: 169.254.xxx.yyy)

3. Access Dell Printer Configuration Web Tool on your computer browser.
   a. Assign the PC IP address by DHCP mode (Change the TCP/IP properties to obtain the IP address automatically).
   
   b. Make sure your computer has the same IP address range as the printer wireless adapter.

   e.g. 169.254.xxx.zzz

   c. Access the Dell Printer Configuration Web Tool using the WEB browser, and then type printer wireless adapter settings in the address field of the browser.

   e.g. http://169.254.xxx.yyy/ (Your wireless adapter IP address)

   d. Change wireless settings (SSID/ communication mode) from Dell Printer Configuration Web Tool.

   i. Click **Print server setting** on the left navigational bar.

   ii. Click the **Print server setting** tab.

   iii. Click the **TCP/IP** sub-tab.

   iv. Select **DHCP**.

   v. Click the **Apply new setting** button without restarting the printer (Ignore the screen instructions to restart the printer).

   vi. Click the **Wireless LAN** sub-tab.

   vii. Change the **SSID** setting (according to your Access point SSID) and change **Network type** to **Infrastructure**.

   viii. Click the **Restart printer to apply new settings** button.

4. Once printer wireless adapter is properly configured, you may use the typical network printer installation method to complete driver installation.

5. To communicate with printer, you need to restore the previous wireless settings on your computer.

6. Restore the previous wireless settings for your computer.

**NOTE:** If your computer provides a wireless LAN adapter tool, change the wireless settings using this tool. Or you can change the wireless settings using the tool provided by the operating system. See the instructions below.
a. Select **Network Connections** from Control Panel. 

b. Right-click **Wireless Network Connection** and select **Properties**. 

c. Select the **Wireless Network** tab. 

d. Click the **Advanced** button. 

e. Select **Access point (Infrastructure) networks only** and close the Advanced dialog box (Applicable to printer with the wireless infrastructure mode). 

f. Select the setting that you send to the printer in the list in the **Preferred Network** group 

g. Click **Move up** to move the setting to the top of the list. 

h. Click **OK** to close the Property dialog box. 

**NOTE:** When your operating system is earlier than Windows 2000, create settings according to the manual of the wireless setting tool provided by your wireless device manufacturer.

### Access point (Infrastructure, Fixed IP network)

1. Ensure that the addresses of your computer and access point is in the same IP range. Match the subnet mask and gateway addresses of your computer to the access point settings. 

2. Create new wireless settings of your computer by following the steps below. 

**NOTE:** If your computer provides a wireless LAN adapter tool, change the wireless settings using this tool. Or you can change the wireless settings using the tool provided by the operating system. See the instructions below. 

a. Select **Network Connections** from Control Panel. 

b. Right-click **Wireless Network Connection** and select **Properties**. 

c. Select the **Wireless Networks** tab. 

d. Make sure the check box for **Use Windows to configure my wireless network settings** is checked. 

**NOTE:** Be sure to write down the current wireless computer settings in steps d and f so that you can restore them later. 

e. Click the **Advanced** button. 

f. Select **Computer to Computer (ad hoc) networks only** and close the Advanced dialog box. 

g. Click the **Add** button to display Wireless network properties. 

h. Under the **Association** tab, enter the following information and click **OK**.
Network name (SSID): dell_device
Network Authentication: Open
Data encryption: Disabled
Ad hoc network: Checked

i. Click the Move up button to move the newly added SSID to the top of the list.

j. Click OK to close the Property dialog box.

NOTE: When your OS is earlier than Windows 2000, create settings according to the manual of the wireless setting tool provided by your wireless device manufacturer.

3. Check the IP, subnet mask and gateway address on your computer.

   e.g. IP: 192.168.1.1
   Subnet mask: 255.255.0.0

4. Set the IP address from the printer control panel to be in the same range as that of your computer. Match the subnet mask and gateway addresses of the printer to your computer settings.

   a. Press **Menu** button.

   b. Scroll to **Admin** menu.

   c. Select **Wireless Net**.

   d. Select **TCP/IP**.

   e. Select **Get IP Address**.

   f. Select **Panel**.

   g. Scroll back to **IP Address**.

   h. Manually enter the IP address using the directional buttons on the control panel and press enter button.

   e.g.: 192.168.1.2

   i. Scroll back to **Subnet Mask**.

   j. Manually enter the subnet mask address using the directional buttons on the control panel and press enter button.

   k. Scroll back to **Gateway Address**.

   l. Manually enter the gateway address using the directional buttons on the control panel and press the Enter button.

   m. Restart the printer.
5. Open Dell Printer Configuration Web Tool using the WEB browser.
   
e.g.: http://192.168.1.2

6. Change wireless settings of the printer from Dell Printer Configuration Web Tool.
   a. Click Print server setting on the left navigational bar.
   b. Click Print server setting tab.
   c. Click Wireless LAN sub-tab.
   d. Change the SSID setting (according to your access point SSID) and change Network type to Infrastructure.
   e. Click the Restart printer to apply new settings button.

7. Restore the previous wireless settings for your computer.

**NOTE:** If your computer provides a wireless LAN adapter tool, change the wireless settings using this tool. Or you can change the wireless settings using the tool provided by the operating system. See the instructions below.

   a. Select Network Connections from Control Panel.
   b. Right-click Wireless Network Connection and select Properties.
   c. Select Wireless Network tab.
   d. Click Advanced.
   e. Do either of the following:

      **When wireless ad-hoc mode is set to the printer:**
      Select Computer to Computer (ad hoc) networks only and close the Advanced dialog box.

      **When wireless infrastructure mode is set to the printer:**
      Select Access point (Infrastructure) networks only and close the Advanced dialog box.
      f. Select the setting that you send to the printer in the list in Preferred Network group.
      g. Click Move up to move the setting to the top of the list.

8. Click OK to close the Property dialog box.

**NOTE:** When your operating system is earlier than Windows 2000, create settings according to the manual of the wireless setting tool provided by your wireless device manufacturer.
Confirming the Installation of the Wireless Printer Adapter

1. Print a printer settings page to verify that the optional wireless printer adapter is installed correctly.
   
   a. Press Menu.

   b. Press ▼ until Report/List appears, and then press ✓.

   c. Printer Setting is displayed. Press ✓. The printer settings page is printed.

   d. Verify Wireless LAN Adapter is listed in the printer settings under Printer Options.

   If it is not listed, turn off the printer, unplug the power cable, and reinstall the optional wireless printer adapter.
Print Media Guidelines

Print media is paper, transparencies, labels, envelopes, coated paper among others. Your printer provides high-quality printing on a variety of print media. Selecting the appropriate print media for your printer helps avoid printing troubles. This section describes how to select print media, how to care for print media, and how to load the print media in the standard 250-sheet tray or optional 550-sheet feeder.

- Paper
- Transparencies
- Envelopes
- Labels
- Storing Print Media
- Identifying Print Media Sources and Specifications

Paper

For the best print quality in color, use 75 g/m² (20 lb) xerographic, grain long paper. For the best print quality in black and white, use 90 g/m² (24 lb) xerographic, grain long paper. Before buying large quantities of any print media, Dell recommends trying a sample first.

When loading paper, identify the recommended print side on the paper package, and load the paper accordingly. See "Loading Print Media in Standard and Optional Trays" and "Loading the Multipurpose Feeder" for detailed loading instructions.

Paper Characteristics

The following paper characteristics affect print quality and reliability. Dell recommends that you follow these guidelines when evaluating new paper stock.

Weight

The tray automatically feeds paper weights from 60 to 216 g/m² (16 to 60 lb bond) grain long. The multipurpose feeder automatically feeds paper weights from 60 to 216 g/m² (16 to 80 lb bond) grain long. Paper lighter than 60 g/m² (16 lb) might not be stiff enough to feed properly, and could cause paper jams. For best performance, use 75 g/m² (20 lb bond) grain long paper.

Curl

Curl is the tendency of print media to curve at its edges. Excessive curl can cause paper feeding problems. Curl usually occurs after the paper passes through the printer, where it is exposed to high temperatures. Storing paper unwrapped, even in the paper tray, can contribute to paper curling prior to printing and cause...
feeding problems regardless of humidity. When printing on curled paper, straighten the paper and then insert it into the multipurpose feeder.

**Smoothness**

The degree of paper smoothness directly affects print quality. If the paper is too rough, the toner does not fuse to the paper properly, resulting in poor print quality. If the paper is too smooth, it can cause paper feeding problems. Smoothness between 150 and 250 Sheffield points produces the best print quality.

**Moisture Content**

The amount of moisture in the paper affects both print quality and the ability of the printer to feed the paper properly. Leave the paper in its original packaging until you are ready to use it. This limits the exposure of the paper to moisture changes that can degrade its performance.

**Grain Direction**

Grain refers to the alignment of the paper fibers in a sheet of paper. Grain is either grain long, running the length of the paper, or grain short, running the width of the paper. For 60 to 135 g/m² (16 to 36 lb bond) paper, grain long fibers are recommended. For papers heavier than 135 g/m² (36 lb bond), grain short is preferred.

**Fiber Content**

Most high-quality xerographic paper is made from 100% chemically pulped wood. Paper containing fibers such as cotton possess characteristics that can result in degraded paper handling.

**Recommended Paper**

To ensure the best print quality and feed reliability, use 75 g/m² (20 lb) xerographic paper. Business papers designed for general business use also provide acceptable print quality. Only use paper able to withstand high temperatures without discoloring, bleeding, or releasing hazardous emissions. The laser printing process heats paper to high temperatures. Check with the manufacturer or vendor to determine whether the paper you have chosen is acceptable for laser printers.

Always print several samples before buying large quantities of any type of print media. When choosing any print media, you should consider the weight, fiber content, and color.

**Unacceptable Paper**

The following paper types are not recommended for use with the printer:

- Chemically treated papers used to make copies without carbon paper, also known as carbonless papers, carbonless copy paper (CCP), or no carbon required (NCR) paper
- Preprinted papers with chemicals that may contaminate the printer
- Preprinted papers that can be affected by the temperature in the printer fuser
- Preprinted papers that require a registration (the precise print location on the page) greater than \( \pm 0.09 \) in., such as optical character recognition (OCR) forms

In some cases, you can adjust registration with your software program to successfully print on these forms.

- Coated papers (erasable bond), synthetic papers, thermal papers
- Rough-edged, rough or heavily textured surface papers or curled papers
- Recycled papers containing more than 25% post-consumer waste that do not meet DIN 19 309
- Multiple-part forms or documents
- Print quality may deteriorate (blank spaces or blotches may appear in the text) when printing on talc or acid paper.

### Selecting Paper

Proper paper selection helps prevent jams and ensures trouble-free printing.

To help avoid jams or poor print quality:

- Always use new, undamaged paper.
- Before loading the paper, identify the recommended print side of the paper. This information is usually indicated on the paper package.
- Do not use paper that you have cut or trimmed yourself.
- Do not mix print media sizes, weights, or types in the same source. This may result in a paper jam.
- Do not remove trays while a job is printing or **Printing** is displayed on the operator panel.
- Make sure the **Paper Type** setting is correct. (See "Tray Settings" for detailed information about these settings.)
- Make sure the paper is properly loaded in the tray.
- Flex paper back and forth, and then fan them. Straighten the edges of the stack on a level surface.
Selecting Preprinted Forms and Letterhead

When selecting preprinted forms and letterhead paper for the printer:

- Use grain long papers for best results.
- Use only forms and letterhead printed using an offset lithographic or engraved printing process.
- Select papers that absorb ink, but do not bleed.
- Avoid papers with rough or heavily textured surfaces.
- Use papers printed with heat-resistant inks designed for use in xerographic copiers. The ink must withstand temperatures of 225°C (437°F) without melting or releasing hazardous emissions.
- Use inks that are not affected by the resin in toner or the silicone in the fuser. Inks that are oxidation-set or oil-based should meet these requirements; latex inks might not. If you are in doubt, contact your paper supplier.

Printing on Letterhead

Check with the manufacturer or vendor to determine whether the preprinted letterhead you have selected is acceptable for laser printers.

Page orientation is important when printing on letterhead. Use the following table for help when loading letterhead in the print media sources.
### Print media source | Print side | Page orientation
--- | --- | ---
Standard 250-sheet tray
Optional 550-sheet feeder | Face up | Letterhead enters the printer last

| Multipurpose feeder | Face down | Letterhead enters the printer first |

## Selecting Pre-punched Paper

Pre-punched paper brands can differ in the number and placement of holes and in manufacturing techniques. However, it may not be possible to print on the paper to depending on the placement of holes on the paper.

To select and use pre-punched paper:

- Test paper from several manufacturers before ordering and using large quantities of pre-punched paper.
- Paper should be punched at the paper manufacturer and not drilled into paper already packaged in a ream. Drilled paper can cause jams when multiple sheets feed through the printer. This may result in a paper jam.
- Pre-punched paper can include more paper dust than standard paper. Your printer may require more frequent cleaning and feed reliability may not be as good as standard paper.
- Weight guidelines for pre-punched paper are the same as non-punched paper.

## Transparencies
You can load up to 75 sheets of transparencies in the multipurpose feeder for a single print job. Before buying large quantities of any print media, Dell recommends trying a sample first.

When printing on transparencies:

- Set the paper type to **Transparency** from the printer driver to avoid damaging your printer.
- Use transparencies designed specifically for laser printers. Do not use regular transparencies. Transparencies must be able to withstand temperatures of 205°C (401°F) without melting, discoloring, offsetting or releasing hazardous emissions.
- Avoid getting fingerprints on the transparencies. This may result in poor print quality.
- Before loading transparencies, fan the stack to prevent sheets from sticking together.
- Non-white transparencies are not supported with the printer.

**Selecting Transparencies**

The printer can print directly on transparencies designed for use in laser printers. Print quality and durability depend on the transparency used. Before buying large quantities of any print media, Dell recommends trying a sample first.

The paper type setting for the multipurpose feeder should be set to **Transparency** to help prevent jams. (See "Tray Settings" for detailed information about this setting.) Check with the manufacturer or vendor to determine whether your transparencies are compatible with laser printers that reach temperatures as high as 205°C (401°F). Only use transparencies that are able to withstand these temperatures without melting, discoloring, offsetting, or releasing hazardous emissions.

---

**Envelopes**

You can load a stack of envelopes up to 15 mm (0.59 in.) in height in the multipurpose feeder for a single print job. Depending on the type of envelope and how they have been stored, loading a large quantity of envelopes, within the maximum range, may not feed into the printer. If this happens, reduce the number of envelopes in the stack. Depending on the choice of envelopes, it is possible to expect variable levels of light wrinkling. Before buying large quantities of any print media, Dell recommends trying a sample first. See "Loading the Multipurpose Feeder" for instructions on loading an envelope.

When printing on envelopes:

- Use only high-quality envelopes that are designed for use in laser printers.
- Set the print media source to the multipurpose feeder. Set the paper type to **Envelope**, and select the correct size of envelope from the printer driver.
- For best performance, use envelopes made from 75 g/m² (20 lb bond) paper. You can use up to 105 g/m² (28 lb bond) weight for the envelope feeder as long as the cotton content is 25% or less.
Envelopes with 100% cotton content must not exceed 90 g/m² (24 lb bond) weight.

- Use only new, undamaged envelopes.
- For best performance, do not use envelopes that:
  - Have excessive curl or twist
  - Are stuck together or damaged in any way
  - Contain windows, holes, perforations, cutouts, embossing
  - Use metal clasps, string ties, or metal folding bars
  - Have an interlocking design
  - Have postage stamps attached
  - Have any exposed adhesive when the flap is in the sealed or closed position
  - Have nicked edges or bent corners
  - Have rough, cockle, or laid finishes
- Use envelopes that can withstand temperatures of 205°C (401°F) without sealing, excessive curling, wrinkling, or releasing hazardous emissions. If you have any doubts about the envelopes you are considering, check with the envelope supplier.
- Adjust the width guide to fit the width of the envelopes.
- To load envelope in the multipurpose feeder, insert the envelopes with the flaps closed and the short-edge of the envelopes facing into the printer. The print side must be facing down.
- See "Loading the Multipurpose Feeder" for instructions on loading an envelope.
- Use one envelope size during a print job.
- Make sure the humidity is low because high humidity (more than 60%) and the high printing temperatures may seal the envelopes.

---

**Labels**

Your printer can print on many labels designed for use with laser printers. Label adhesives, face sheet (printable stock), and topcoats must be able to withstand temperatures of 205°C (401°F) and pressure of 25 pounds per square inch (psi). Before buying large quantities of any print media, Dell recommends trying a sample first.

When printing on labels:

- Set the paper type to **Label** in the Tray Settings. Set the paper type to **Label** from the printer driver.
- Do not load labels together with paper or transparencies in the same tray. This may result in a jam.
- Do not use label sheets with a slick backing material.
- Do not print within 1 mm (0.04 in.) of the die cut.
- Use full label sheets. Partial sheets may cause labels to peel off during printing, resulting in a jam. Partial sheets also contaminate your printer and your cartridge with adhesive, and could void your printer and cartridge warranties.
- Use labels that can withstand temperatures of 205°C (401°F) without sealing, excessive curling, wrinkling, or releasing hazardous emissions.
- Do not print within 1 mm (0.04 in.) of the edge of the label, of the perforations, or between die-cuts of the label.
- Do not use label sheets that have adhesive to the edge of the sheet. Dell recommends zone coating of the adhesive at least 1 mm (0.04 in.) away from edges. Adhesive material contaminates your printer and could void your warranty.
- If zone coating of the adhesive is not possible, a 3 mm (0.125 in.) strip should be removed on the leading and driver edge, and a non-oozing adhesive should be used.
- Remove a 3 mm (0.125 in.) strip from the leading edge to prevent labels from peeling inside the printer.
- Portrait orientation is preferred, especially when printing bar codes.
- Do not use labels that have exposed adhesive.

---

**Storing Print Media**

For proper print media storage, the following guidelines help avoid media feeding problems and uneven print quality.

- For best results, store print media in an environment where the temperature is approximately 21°C (70°F) and the relative humidity is 40%.
- Store cartons of print media on a pallet or shelf, rather than directly on the floor.
- If you store individual packages of print media out of the original carton, make sure they rest on a flat surface so that the edges do not buckle or curl.
- Do not place anything on top of the print media packages.

---

**Identifying Print Media Sources and Specifications**

The following tables provide information on standard and optional print media sources.
## Print Media Sizes and Support

<table>
<thead>
<tr>
<th>Print Media</th>
<th>Multipurpose feeder</th>
<th>Standard 250-sheet tray</th>
<th>Optional 550-sheet feeder</th>
<th>Optional duplexer</th>
</tr>
</thead>
<tbody>
<tr>
<td>A4</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>A5</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>B5</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Letter</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Folio (8.5 x 13 in.)</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Legal (8.5 x 14 in.)</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Executive</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>COM-10 Envelope</td>
<td>Y</td>
<td>N</td>
<td>N</td>
<td>N</td>
</tr>
<tr>
<td>Monarch</td>
<td>Y</td>
<td>N</td>
<td>N</td>
<td>N</td>
</tr>
<tr>
<td>C5</td>
<td>Y</td>
<td>N</td>
<td>N</td>
<td>N</td>
</tr>
<tr>
<td>DL</td>
<td>Y</td>
<td>N</td>
<td>N</td>
<td>N</td>
</tr>
<tr>
<td>Yokei size2</td>
<td>Y</td>
<td>N</td>
<td>N</td>
<td>N</td>
</tr>
<tr>
<td>Yokei size3</td>
<td>Y</td>
<td>N</td>
<td>N</td>
<td>N</td>
</tr>
<tr>
<td>Yokei size4</td>
<td>Y</td>
<td>N</td>
<td>N</td>
<td>N</td>
</tr>
<tr>
<td>Yochokei size3</td>
<td>Y</td>
<td>N</td>
<td>N</td>
<td>N</td>
</tr>
<tr>
<td>Chokei size3</td>
<td>Y</td>
<td>N</td>
<td>N</td>
<td>N</td>
</tr>
<tr>
<td>Japanese Post Card</td>
<td>Y</td>
<td>N</td>
<td>N</td>
<td>N</td>
</tr>
<tr>
<td>User-specified print size</td>
<td>Y*1</td>
<td>Y*2</td>
<td>Y*2</td>
<td>Y*3</td>
</tr>
</tbody>
</table>

*1 The tray supports user-specified print media that are 76.2 mm (3.00 in.) to 220 mm (8.66 in.) wide and 98.4 mm (3.87 in.) to 355.6 mm (14.00 in.) long.

*2 The tray supports user-specified print media that are 148.5 mm (5.85 in.) to 215.9 mm (8.50 in.) wide and 210 mm (8.27 in.) to 355.6 mm (14.00 in.) long.

*3 The duplexer supports user-specified print media that are 148.5 mm (5.85 in.) to 215.9 mm (8.50 in.) wide and 210 mm (8.27 in.) to 355.6 mm (14.00 in.) long.

## Print Media Supported
<table>
<thead>
<tr>
<th>Paper Type</th>
<th>Multipurpose Feeder</th>
<th>Standard 250-sheet Tray</th>
<th>Optional 550-sheet Feeder</th>
<th>Optional Duplexer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain Paper (60–80 gsm)</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Plain Paper -Side2 (60–80 gsm)</td>
<td>Y</td>
<td>N</td>
<td>N</td>
<td>N</td>
</tr>
<tr>
<td>Plain Thick Paper (81–105 gsm)</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Plain Thick Paper -Side2 (81–105 gsm)</td>
<td>Y</td>
<td>N</td>
<td>N</td>
<td>N</td>
</tr>
<tr>
<td>Covers (106–163 gsm)</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Covers -Side2 (106–163 gsm)</td>
<td>Y</td>
<td>N</td>
<td>N</td>
<td>N</td>
</tr>
<tr>
<td>Covers Thick (164–216 gsm)</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>N</td>
</tr>
<tr>
<td>Covers Thick -Side2 (164–216 gsm)</td>
<td>Y</td>
<td>N</td>
<td>N</td>
<td>N</td>
</tr>
<tr>
<td>Transparency</td>
<td>Y</td>
<td>N</td>
<td>N</td>
<td>N</td>
</tr>
<tr>
<td>Label</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>N</td>
</tr>
<tr>
<td>Coated (106–163 gsm)</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Coated -Side2 (106–163 gsm)</td>
<td>Y</td>
<td>N</td>
<td>N</td>
<td>N</td>
</tr>
<tr>
<td>Coated Thick (164–216 gsm)</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>N</td>
</tr>
<tr>
<td>Coated Thick -Side2 (164–216 gsm)</td>
<td>Y</td>
<td>N</td>
<td>N</td>
<td>N</td>
</tr>
<tr>
<td>JPN Coated S2 (95–105 gsm)</td>
<td>Y</td>
<td>N</td>
<td>N</td>
<td>N</td>
</tr>
<tr>
<td>Envelope</td>
<td>Y</td>
<td>N</td>
<td>N</td>
<td>N</td>
</tr>
<tr>
<td>Japanese Post Card</td>
<td>Y</td>
<td>N</td>
<td>N</td>
<td>N</td>
</tr>
<tr>
<td>Recycled</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
</tbody>
</table>

**Setup Paper Type**
<table>
<thead>
<tr>
<th>Paper type</th>
<th>Weight (gsm)</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain Paper</td>
<td>60-80</td>
<td>-</td>
</tr>
<tr>
<td>Plain Thick Paper</td>
<td>81-105</td>
<td>-</td>
</tr>
<tr>
<td>Covers</td>
<td>106-163</td>
<td>-</td>
</tr>
<tr>
<td>Covers Thick</td>
<td>164-216</td>
<td>-</td>
</tr>
<tr>
<td>JPN Coated</td>
<td>95-105</td>
<td>Inkjet Printer paper cannot be used.</td>
</tr>
<tr>
<td>Coated</td>
<td>106-163</td>
<td>Inkjet Printer paper cannot be used.</td>
</tr>
<tr>
<td>Coated Thick</td>
<td>164-216</td>
<td>Inkjet Printer paper cannot be used.</td>
</tr>
<tr>
<td>Transparency</td>
<td>-</td>
<td>Inkjet Printer paper cannot be used.</td>
</tr>
<tr>
<td>Label</td>
<td>-</td>
<td>Inkjet Printer paper cannot be used.</td>
</tr>
<tr>
<td>Envelopes</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>
Loading Print Media

Proper print media loading helps prevent jams and ensures trouble-free printing.

Before loading print media, identify the recommended print side of the print media. This information is usually on the print media package.

- Loading Print Media in Standard and Optional Trays
- Multipurpose Feeder
- Loading the Multipurpose Feeder
- Using the Multipurpose Feeder
- Linking Trays
- Using the Duplex Function
- Using the Center Output Tray
- Using the Output Tray Extension

**NOTE:** After loading paper in the tray, specify the same paper type on the operator panel.

Loading Print Media in Standard and Optional Trays

**NOTE:** To avoid paper jams, do not remove trays while a job prints.

**NOTE:** Use only laser print media. Do not use ink jet paper in the printer.

All trays are loaded the same way.

1. Pull the tray out of the printer until it stops. Hold the tray with both hands, lift the front slightly, and remove it from the printer.
2. Slide the width guides to the edge of the tray. The width guides should be fully extended.

![NOTE: For Letter paper, push the lever to the 8.5" position.]

3. Slide the tray to the size of the paper to be loaded by using the length guide.
NOTE: When loading user-specified print media, fully extend the tray by squeezing the length guide at the back of the tray.

4. Before loading the print media, flex the sheets back and forth, and then fan them. Straighten the edges of the stack on a level surface.

5. Place the print media into the tray with the recommended print side face up.

NOTE: Do not exceed the maximum fill line in the tray. Overfilling the tray may cause paper jams.

6. Adjust the width guides until they rest lightly against the edges of the stack of paper.

NOTE: When loading user-specified print media, adjust the width guides and slide the extendable part of the tray by squeezing the length guide and sliding it until it rests lightly against the edge of the stack of paper.
7. Insert the tray into the printer, and push until it stops.

8. Select the paper type from the operator panel if any print media other than plain print media is loaded. If a user-specified print media is loaded, you must specify the paper size setting by using the operator panel.

**Loading Letterhead**

The letterhead must be toward the top edge of the standard tray or the optional feeder with the print side facing up. However, the letterhead must be inserted top edge first with the print side facing down when loading paper into the multipurpose feeder.

<table>
<thead>
<tr>
<th>Print media source</th>
<th>Print side</th>
<th>Page orientation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard 250-sheet tray</td>
<td>Face up</td>
<td>Letterhead enters the printer last</td>
</tr>
<tr>
<td>Optional 550-sheet feeder</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Multipurpose feeder</td>
<td>Face down</td>
<td>Letterhead enters the printer first</td>
</tr>
</tbody>
</table>

---

**Multipurpose Feeder**

**Capacity**

The multipurpose feeder can hold approximately:

- 150 sheets of the standard paper or 15 mm (0.59 in.) or less in height.
Print Media Dimensions

The multipurpose feeder accepts print media within the following dimensions:

- Width -- 76.2 mm (3.00 in.) to 220.0 mm (8.66 in.)
- Length -- 98.4 mm (3.87 in.) to 355.6 mm (14.00 in.)

Loading the Multipurpose Feeder

In addition to plain paper, the multipurpose feeder can use various other sizes and types of print media such as envelopes, and transparencies.

1. Gently pull open the multipurpose feeder cover.

2. Slide the width guides to the edge of the tray. The width guides should be fully extended.
3. Insert all media face down and top edge first into the multipurpose feeder.

**NOTE:** Do not force the print media.

4. Slide both width guides until they rest lightly against the edge of the print media stack.

**NOTE:** Be careful not to bend the print media.

5. Make sure the type setting for the multipurpose feeder is set to the correct value for the print media you have loaded.

6. Select print media source, size, and type in your software program and select the print media size and type on the printer operator panel.

**Loading Envelopes**

To load envelopes in the multipurpose feeder, insert the envelopes with the flaps closed and the short-edge
of the envelopes facing into the printer. Orientate the print side facing down and slide the envelope into the entry slot. You can load envelopes up to the maximum fill line in the tray at one time.

**NOTE:** Make sure to set the envelopes with the flaps completely closed.

**NOTICE:** Never use envelopes with windows, coated linings, or self-stick adhesives. These lead to paper jams and damage to the printer.

---

### Using the Multipurpose Feeder

- Load only one size and type of print media during a single print job.

- To achieve the best possible print quality, use only high-quality print media that is designed for use in laser printers. For more guidelines on print media, see "Print Media Guidelines."

- Do not add or remove print media when there is still print media in the multipurpose feeder or when the printer is printing from the multipurpose feeder. This may result in a paper jam.

- Print media should be loaded with the recommended print side down and the top of the print media going into the multipurpose feeder first.

- Do not place objects on the multipurpose feeder. Also, avoid pressing down or applying excessive force on it.

- Do not remove any tray while a job is printing from the multipurpose feeder or Printing is displayed on the operator panel. This may result in a paper jam.

The icons on the multipurpose feeder identify how to load the multipurpose feeder with paper, and how to turn an envelope for printing.
Linking Trays

Tray linking allows you to load the same size and type of print media in multiple sources. The printer automatically links the source/trays and will use the first tray until it runs out, then switch to the linked tray.

If you load the same size print media in each tray, make sure the print media is the same type in order to link the trays.

When the selected trays are loaded with the same size and type of print media, select the Paper Type settings in the Tray Settings for each source.

To disable tray linking, set the Paper Type to a unique value in each one of the trays. If all trays do not have the same type of print media when linked, you could mistakenly print a job on the wrong paper type.

Using the Duplex Function

Duplex printing (or two-sided printing) allows you to print on both sides of a sheet of paper. For sizes that are acceptable for duplex printing, see "Print Media Sizes and Support." Duplex printing is only available when the optional duplexer is installed on the printer. For information on how to install the duplexer, see "Installing a Duplexer."

Using Booklet Print

To use booklet print, you must select either Flip on Short Edge or Flip on Long Edge from the Duplex menu in the printer properties dialog box and then select Booklet Creation in the Booklet/Poster/Mixed Document dialog box displayed by clicking the Booklet/Poster/Mixed Document button. From the Duplex menu, you can define the way 2-sided print pages are bound, and how the printing on the back of the sheet (even-numbered pages) is oriented in relation to the printing on the front (odd-numbered pages).
<table>
<thead>
<tr>
<th></th>
<th>Assumes binding along the long edge of the page (left edge for portrait orientation and top edge for landscape orientation). The following illustration shows long-edge binding for portrait and landscape pages:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flip on Long Edge</td>
<td></td>
</tr>
<tr>
<td><img src="image1" alt="Diagram" /></td>
<td></td>
</tr>
<tr>
<td>Flip on Short Edge</td>
<td>Assumes binding along the short edge of the page (top edge for portrait orientation and left edge for landscape orientation). The following illustration shows short-edge binding for portrait and landscape pages:</td>
</tr>
<tr>
<td><img src="image2" alt="Diagram" /></td>
<td></td>
</tr>
</tbody>
</table>

**Using the Center Output Tray**

The center output tray holds up to:

- 250 sheets (20 lb (75 g/m²)) of plain paper
Using the Output Tray Extension

The output tray extension is designed to prevent print media from falling from the printer after the print job is complete.

Before printing a document, make sure the output tray extension is fully extended.
Operator Panel

- Using the Operator Panel Buttons
- Printing a Panel Settings Page

Using the Operator Panel Buttons

The printer operator panel has a 2-line by 16-character liquid crystal display (LCD), seven buttons, and two indicators that flash when the printer is ready to print, and when an error occurs.

1. LCD display
2. Ready indicator
   - Lights green when the printer is ready or sleeping and blinks when data is being received.
3. ▼ ▲ buttons
   - In the Menu mode, scrolls through menus or items. To enter numbers or passwords for secure print jobs, press these buttons.
4. Menu button
   - Switches to the Menu mode.
5. ◀ ▶ buttons
   - In the Menu mode, selects submenus or setting values.
6. Error indicator
   - Lights orange when an error occurs and blinks when an unrecoverable print error occurs.
7. Cancel button
   - In the Menu mode, switches to the Print mode.
   - Cancels the current print job.
Printing a Panel Settings Page

The Panel Settings page shows current settings for the operator panel menus.

1. Press **Menu**.

2. Press ▼ until **Report/List** appears, and then press ✓.

3. Press ▼ until **Panel Settings** appears, and then press ✓.
   The panel settings page is printed.
Printer Settings

You can change most printer settings from your software program or printer driver. If your printer is attached to the network, you can change settings from the Dell Printer Configuration Web Tool. To launch the Dell Printer Configuration Web Tool, type the printer IP address in your Web browser. Print a printer settings page to find your printer's IP address (see "Printing a Printer Settings Page").

From the software program print settings, settings you change apply only to the job you are preparing to send to the printer.

From the driver settings, changes made to the printer settings override changes made from the printer operator panel and may require you to change the operator panel default settings.

If you cannot change a setting from your software program, use the printer operator panel or the Dell Printer Configuration Web Tool. Changing a printer setting from the printer operator panel or from the Dell Printer Configuration Web Tool makes that setting the user default.

Printing a Printer Settings Page

The printer settings page lists all the options you purchased or installed. If a feature or an option is not listed, you need to check your installation.

1. Press Menu.

2. Press ▼ until Report/List appears, and then press ✓.

3. Printer Setting is displayed. Press ✓. The printer settings page is printed.

4. Verify that the options you installed are correctly listed under Printer Options.

5. If an option you installed is not listed, turn off the printer, unplug the power cord, and reinstall the option.

6. Verify the amount of memory installed is correctly listed under General.

Using the Operator Panel to Change Printer Settings

You can select menu items and corresponding values from the operator panel.

When you first enter the printer menus from the operator panel, you see an asterisk (*) next to a value in the menus.

This asterisk indicates the factory default menu setting. These settings are the original printer settings. (Factory defaults may vary for different countries.)
When you select a new setting from the operator panel, an asterisk appears next to the setting to identify it as the current user default menu setting.

These settings are active until new ones are selected or the factory defaults are restored.

To select a new value as a setting:

1. Press **Menu**.

2. Press ▲ or ▼ until the required menu appears, and then press ✔.

3. Press ▲ or ▼ until the desired menu or menu item appears, and then press ✔.
   - If the selection is a menu, the menu is opened and the first printer setting in the menu appears.
   - If the selection is a menu item, the default menu setting for the menu item appears. (The current user default menu setting has an asterisk (*) beside it.)

   Each menu item has a list of values for the menu item. A value can be:
   - A phrase or word to describe a setting
   - A numerical value that can be changed
   - An On or Off setting
   - Press ▲ and ▼ at the same time. This will recover the factory default menu settings. Press ✔ to return the settings to the factory default menu settings.

4. Press ▲ or ▼ to scroll until the desired value appears.

5. Press ✔.
   - This enables the setting value, which is indicated by an asterisk (*) next to the setting value.

6. Press **Cancel** or ◀ to return to the previous menu.
   - To continue setting other items, select the desired menu. To quit setting new values, press **Cancel**.

Driver settings may override changes previously made and may require you to change the operator panel defaults.

**NOTE:** Driver settings you choose from your software program may override the settings you select from the operator panel.

**Using the Dell Printer Configuration Web Tool to Change**
Printer Settings

If your printer is connected to the network, you can change the operator panel settings from your Web browser. If you are a network administrator, you can clone the printer settings of one printer to one or all printers on the network.

Type your network printer IP address in your Web browser. Choose Printer Settings from the topics list, and then select the printer settings you want to change.

To copy your printer settings to another printer on the network, choose Copy Printer Settings from the topics list, and then type the other printer's IP address.

If you do not know your printer IP address, it is specified on the printer settings page. To print a printer settings page:

1. Press Menu.
2. Press ▼ until Report/List appears, and then press ✓.
3. Printer Setting is displayed. Press ✓. The printer settings page is printed.

Resetting Defaults

After executing this function and rebooting the printer, all the menu parameters, except the parameters for the network, are reset to their default values.

1. Press Menu.
2. Press ▼ until Admin Menu appears, and then press ✓.
3. Press ▼ until Maintenance appears, and then press ✓.
4. Press ▼ until Reset Defaults appears, and then press ✓.
5. The Are you sure? message appears on the operator panel. Press ✓.
6. Turn off the printer, and then on again to apply the settings.

Initializing NVRAM for Network Settings

You can initialize the IP address and network-related settings by initializing NVRAM for Network settings.

1. Press Menu.
2. Press ▼ until Admin Menu appears, and then press ✓.

3. Press ▼ until Wired Network or Wireless Net appears, and then press ✓.

4. Press ▼ until Reset LAN or Reset MPC appears, and then press ✓.

5. The Are you sure? message appears on the operator panel. Press ✓.

6. Turn off the printer, and then on again to apply the settings.
Understanding Printer Menus

When your printer is configured as a network printer available to a number of users, the access to the Admin Menu menus can be limited. This prevents other users from using the operator panel to inadvertently change a printer user default that has been set by the administrator. In this case, you can access the Stored Print, and Tray Settings menus only.

However, you can use your printer driver to override printer user defaults and select settings for individual print jobs.

To complete print jobs, you may also need to modify tray settings.

- Using the Printer Menus
- Setting of Panel Lock

Using the Printer Menus

Report/List

Use the Report/List menu to print various types of reports and lists.

Printer Setting

Purpose:

To print a list of the current user default values, the installed options, the amount of installed print memory, and the status of printer supplies.

Panel Settings

Purpose:

To print a detailed list of all the settings on the operator panel menus.

PCL Fonts List

Purpose:
To print a sample of the available PCL fonts.

See also:

"Understanding Fonts," "Printing a Font Sample List"

PCL Macro List

Purpose:

To print the information on the downloaded PCL macro.

PS Fonts List

Purpose:

To print a sample of the available PostScript fonts.

See also:

"Understanding Fonts," "Printing a Font Sample List"

Job History

Purpose:

To print a detailed list of the processed print jobs. This list contains the latest 20 print jobs.

Error History

Purpose:

To print a detailed list of paper jam and fatal errors.

Print Meter

Purpose:

To print the reports for the total number of pages printed. When printed using either the printer control panel or Dell Printer Configuration Web Tool, the report will be titled Print Volume Report.
Color Test Page

Purpose:

To print a page for testing colors.

Stored Document

Purpose:

To print a list of all files that are stored as Secure, Store, and Proof Print in the RAM disk.

NOTE: The Stored Print menu is only displayed when 256 MB or more of optional memory card is installed on the printer.

Admin Menu

Use the Admin Menu menu to configure a variety of printer features.

Wired Network

Use the Wired Network menu to change printer settings affecting jobs sent to the printer through the wired network.

NOTE: Values marked by an asterisk (*) are the factory default menu settings.

Ethernet

Purpose:

To specify the communication speed and the duplex settings of Ethernet. The change becomes effective after the printer is turned off and then on again.

Values:
**Auto**
Detects the Ethernet settings automatically.

| 10Base Half | Uses 10base-T half-duplex. |
| 10Base Full | Uses 10base-T full-duplex. |
| 100Base Half | Uses 100base-TX half-duplex. |
| 100Base Full | Uses 100base-TX full-duplex. |

**TCP/IP**

**Purpose:**
To specify the TCP/IP settings for the wired network. The change becomes effective after the printer is turned off and then on again.

**Values:**

<table>
<thead>
<tr>
<th>IP Mode*¹</th>
<th>IPv4 Mode</th>
<th>IPv6 Mode*³</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dual Stack</td>
<td>Uses IPv4 to set the IP address.</td>
<td>Uses IPv6 to set the IP address.</td>
</tr>
<tr>
<td>IPv4 Mode</td>
<td></td>
<td></td>
</tr>
<tr>
<td>IPv6 Mode</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**IPv4**

<table>
<thead>
<tr>
<th>Get IP Address</th>
<th>AutoIP*</th>
<th>BOO TP</th>
<th>RARP</th>
<th>DHCP</th>
<th>Panel</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Automatically sets the IP address.</td>
<td>Uses BOO TP to set the IP address.</td>
<td>Uses RARP to set the IP address.</td>
<td>Uses DHCP to set the IP address.</td>
<td>Enables the IP address entered on the operator panel.</td>
</tr>
</tbody>
</table>

**IP Address**
Sets the IP address allocated to the printer by using the keys on the operator panel.

**Subnet Mask**
Sets the subnet mask.
### Gateway Address
Sets the gateway address.

<table>
<thead>
<tr>
<th>Reset IPsec*2</th>
<th>Disables IPsec.</th>
</tr>
</thead>
</table>

*1 Only displayed when an optional multi-protocol card is installed on the printer.

*2 Only displayed when IPsec is enabled.

*3 This mode is available only when firmware version 200705311601 or later and network (MPC) firmware version 16.03 or later are installed. Since you cannot set IPsec in Windows Vista in this mode, use the Dell Printer Configuration Web Tool. The Get Information from Printer function on the Options tab of the printer driver is not available when using this mode.

### Protocol

**Purpose:**
To enable or disable each item. The change becomes effective after the printer is turned off and then on again.

**Values:**

<table>
<thead>
<tr>
<th>Protocol</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LPD</td>
<td>Enable*</td>
<td>Enables the LPD port.</td>
</tr>
<tr>
<td></td>
<td>Disable</td>
<td>Disables the LPD port.</td>
</tr>
<tr>
<td>Port9100</td>
<td>Enable*</td>
<td>Enables the Port9100 port.</td>
</tr>
<tr>
<td></td>
<td>Disable</td>
<td>Disables the Port9100 port.</td>
</tr>
<tr>
<td>IPP*1</td>
<td>Enable*</td>
<td>Enables the IPP port.</td>
</tr>
<tr>
<td></td>
<td>Disable</td>
<td>Disables the IPP port.</td>
</tr>
<tr>
<td>SMB TCP/IP*1</td>
<td>Enable*</td>
<td>Uses TCP/IP for SMB.</td>
</tr>
<tr>
<td></td>
<td>Disable</td>
<td>Does not use TCP/IP for SSB.</td>
</tr>
<tr>
<td>SMB NetBEUI*1</td>
<td>Enable*</td>
<td>Uses NetBEUI for SMB.</td>
</tr>
<tr>
<td></td>
<td>Disable</td>
<td>Does not use NetBEUI for SMB.</td>
</tr>
<tr>
<td>Service</td>
<td>Option 1</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>-----------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td><strong>FTP</strong></td>
<td><strong>Enable</strong></td>
<td>Enables the FTP port.</td>
</tr>
<tr>
<td></td>
<td><strong>Disable</strong></td>
<td>Disables the FTP port.</td>
</tr>
<tr>
<td><strong>NetWare</strong></td>
<td><strong>Enable</strong></td>
<td>Uses IP for NetWare.</td>
</tr>
<tr>
<td><strong>NetWare IP</strong></td>
<td><strong>Enable</strong></td>
<td>Uses IP for NetWare.</td>
</tr>
<tr>
<td></td>
<td><strong>Disable</strong></td>
<td>Does not use IP for NetWare.</td>
</tr>
<tr>
<td><strong>NetWare IPX</strong></td>
<td><strong>Enable</strong></td>
<td>Uses IPX for NetWare.</td>
</tr>
<tr>
<td></td>
<td><strong>Disable</strong></td>
<td>Does not use IPX for NetWare.</td>
</tr>
<tr>
<td><strong>WSD</strong></td>
<td><strong>Enable</strong></td>
<td>Enables the WSD port.</td>
</tr>
<tr>
<td></td>
<td><strong>Disable</strong></td>
<td>Disables the WSD port.</td>
</tr>
<tr>
<td><strong>SNMP</strong></td>
<td><strong>Enable</strong></td>
<td>Enables the UDP.</td>
</tr>
<tr>
<td><strong>SNMP UDP</strong></td>
<td><strong>Enable</strong></td>
<td>Enables the UDP.</td>
</tr>
<tr>
<td></td>
<td><strong>Disable</strong></td>
<td>Disables the UDP.</td>
</tr>
<tr>
<td><strong>SNMP IPX</strong></td>
<td><strong>Enable</strong></td>
<td>Enables the IPX.</td>
</tr>
<tr>
<td></td>
<td><strong>Disable</strong></td>
<td>Disables the IPX.</td>
</tr>
<tr>
<td><strong>E-Mail Alert</strong></td>
<td><strong>Enable</strong></td>
<td>Enables the E-Mail Alert feature.</td>
</tr>
<tr>
<td></td>
<td><strong>Disable</strong></td>
<td>Disables the E-Mail Alert feature.</td>
</tr>
<tr>
<td><strong>EWS</strong></td>
<td><strong>Enable</strong></td>
<td>Enables an access to <strong>Dell Printer Configuration Web Tool</strong> embedded in the printer.</td>
</tr>
<tr>
<td></td>
<td><strong>Disable</strong></td>
<td>Disables an access to <strong>Dell Printer Configuration Web Tool</strong> embedded in the printer.</td>
</tr>
<tr>
<td><strong>AppleTalk</strong></td>
<td><strong>Enable</strong></td>
<td>Enables the AppleTalk port.</td>
</tr>
<tr>
<td></td>
<td><strong>Disable</strong></td>
<td>Disables the AppleTalk port.</td>
</tr>
<tr>
<td><strong>Bonjour(mDNS)</strong></td>
<td><strong>Enable</strong></td>
<td>Enables the Bonjour(mDNS) port.</td>
</tr>
<tr>
<td></td>
<td><strong>Disable</strong></td>
<td>Disables the Bonjour(mDNS) port.</td>
</tr>
<tr>
<td>HTTP-SSL/TLS*1</td>
<td>Enable*</td>
<td>Enables the HTTP-SSL/TLS port.</td>
</tr>
<tr>
<td>----------------</td>
<td>---------</td>
<td>--------------------------------</td>
</tr>
<tr>
<td></td>
<td>Disable</td>
<td>Disables the HTTP-SSL/TLS port.</td>
</tr>
</tbody>
</table>

*1 Only displayed when an optional multi protocol card is installed on the printer and the optional wireless printer adapter is not installed on the card.

**IPX/SPX**

**Purpose:**

To configure the IPX/SPX settings for the wired network. The change becomes effective after the printer is turned off and then on again.

**Values:**

<table>
<thead>
<tr>
<th>Auto*</th>
<th>Automatically sets the frame type.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ethernet II</td>
<td>Uses the Ethernet II frame type.</td>
</tr>
<tr>
<td>Ethernet 802.3</td>
<td>Uses the IEEE802.3 frame type.</td>
</tr>
<tr>
<td>Ethernet 802.2</td>
<td>Uses the IEEE802.2 frame type.</td>
</tr>
<tr>
<td>Ethernet SNAP</td>
<td>Use the SNAP frame type.</td>
</tr>
</tbody>
</table>

**NOTE:** The IPX/SPX menu is only displayed when an optional multi protocol card is installed on the printer and the optional wireless printer adapter is not installed on the card.

**IP Filter (IPv4)**

**Purpose:**

To specify that data received from certain IP addresses through the wired network is blocked. You can set up to 5 IP addresses. The change becomes effective after the printer is turned off and then on again.

**Values:**
<table>
<thead>
<tr>
<th>Filter*¹</th>
<th>No. n/Address (n is 1 to 5.)</th>
<th>Sets the IP address for Filter n.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>No. n/Mask (n is 1 to 5.)</td>
<td>Sets the mask for Filter n.</td>
</tr>
<tr>
<td></td>
<td>No. n/Mode (n is 1 to 5.)</td>
<td>Off* Disable the IP Filter feature for Filter n.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Accept Accepts an access from specified IP address.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Reject Rejects an access from specified IP address.</td>
</tr>
</tbody>
</table>

*¹ This item is only available for LPD or Port9100.

**Reset LAN**

**Purpose:**

To initialize wired network data stored in NV (non-volatile) memory. After executing this function and rebooting the printer, all wired network settings are reset to their default values.

**Adobe Protocol**

**Purpose:**

To specify PostScript communication protocol for each interface. You can configure the Adobe Protocol settings for the wired network. The change becomes effective after the printer is turned off and then on again.

**Values:**

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto*</td>
<td>Used when auto-detecting the PostScript communication protocol.</td>
</tr>
<tr>
<td>Standard</td>
<td>Used when the communication protocol is in ASCII interface.</td>
</tr>
<tr>
<td>BCP</td>
<td>Used when the communication protocol is in binary format.</td>
</tr>
<tr>
<td>TBCP</td>
<td>Used when the communication protocol supports both ASCII and binary data to switch between them according to the specified control code.</td>
</tr>
<tr>
<td>Binary</td>
<td>Used when no special processing is required for data.</td>
</tr>
</tbody>
</table>
Wireless Net

Use the Wireless Net menu to change print settings affecting jobs sent to the printer through a wireless network.

**NOTE:** The Wireless Net menu is only displayed when an optional multi protocol card is installed on the printer and the optional wireless printer adapter is installed on the card.

**NOTE:** Values marked by an asterisk (*) are the factory default menu settings.

### Status

**Purpose:**

To display the information on the wireless signal strength. Any change cannot be made on the operator panel to improve the status of the wireless connection.

**Values:**

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Good</td>
<td>Indicates good signal strength.</td>
</tr>
<tr>
<td>Acceptable</td>
<td>Indicates marginal signal strength.</td>
</tr>
<tr>
<td>Low</td>
<td>Indicates insufficient signal strength.</td>
</tr>
<tr>
<td>No Reception</td>
<td>Indicates that no signal is received.</td>
</tr>
</tbody>
</table>

### Reset Wireless

**Purpose:**

To initialize wireless network settings. After executing this function and rebooting the printer, all wireless network settings are reset to their default values.

### TCP/IP

**Purpose:**

To specify the TCP/IP settings for the wireless network. The change becomes effective after the printer is turned off and then on again.
Values:

<table>
<thead>
<tr>
<th>IP Mode*¹</th>
<th><strong>Dual Stack</strong></th>
<th>Uses both IPv4 and IPv6 to set the IP address.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>IPv4 Mode</strong></td>
<td>Uses IPv4 to set the IP address.</td>
</tr>
<tr>
<td></td>
<td><strong>IPv6 Mode</strong></td>
<td>Uses IPv6 to set the IP address.</td>
</tr>
<tr>
<td>IPv4</td>
<td><strong>Get IP Address</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>AutoIP</strong>*</td>
<td>Automatically sets the IP address.</td>
</tr>
<tr>
<td></td>
<td><strong>BOOTP</strong></td>
<td>Uses BOOTP to set the IP address.</td>
</tr>
<tr>
<td></td>
<td><strong>RARP</strong></td>
<td>Uses RARP to set the IP address.</td>
</tr>
<tr>
<td></td>
<td><strong>DHCP</strong></td>
<td>Uses DHCP to set the IP address.</td>
</tr>
<tr>
<td></td>
<td><strong>Panel</strong></td>
<td>Enables the IP address entered on the operator panel.</td>
</tr>
<tr>
<td></td>
<td><strong>IP Address</strong></td>
<td>Sets the IP address allocated to the printer by using the keys on the operator panel.</td>
</tr>
<tr>
<td></td>
<td><strong>Subnet Mask</strong></td>
<td>Sets the subnet mask.</td>
</tr>
<tr>
<td></td>
<td><strong>Gateway Address</strong></td>
<td>Sets the gateway address.</td>
</tr>
<tr>
<td>Reset IPsec*²</td>
<td></td>
<td>Disables IPsec.</td>
</tr>
</tbody>
</table>

*¹ Only displayed when an optional multi-protocol card is installed on the printer.

*² Only displayed when IPsec is enabled.

*³ This mode is available only when firmware version 200705311601 or later and network (MPC) firmware version 16.03 or later are installed. Since you cannot set IPsec in Windows Vista in this mode, use the Dell Printer Configuration Web Tool. The Get Information from Printer function on the Options tab of the printer driver is not available when using this mode.

**Protocol**

**Purpose:**

To enable or disable each item. The change becomes effective after the printer is turned off and then on again.
Values:

<table>
<thead>
<tr>
<th></th>
<th>Enable*</th>
<th>Disable</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>LPD</strong></td>
<td>Enables the LPD port.</td>
<td>Disables the LPD port.</td>
</tr>
<tr>
<td><strong>Port9100</strong></td>
<td>Enables the Port9100 port.</td>
<td>Disables the Port9100 port.</td>
</tr>
<tr>
<td><strong>IPP</strong></td>
<td>Enables the IPP port.</td>
<td>Disables the IPP port.</td>
</tr>
<tr>
<td><strong>SMB TCP/IP</strong></td>
<td>Uses TCP/IP for SMB.</td>
<td>Does not use TCP/IP for SMB.</td>
</tr>
<tr>
<td><strong>SMB NetBEUI</strong></td>
<td>Uses NetBEUI for SMB.</td>
<td>Does not use NetBEUI for SMB.</td>
</tr>
<tr>
<td><strong>FTP</strong></td>
<td>Enables the FTP port.</td>
<td>Disables the FTP port.</td>
</tr>
<tr>
<td><strong>NetWare IP</strong></td>
<td>Uses IP for NetWare.</td>
<td>Does not use IP for NetWare.</td>
</tr>
<tr>
<td><strong>NetWare IPX</strong></td>
<td>Uses IPX for NetWare.</td>
<td>Does not use IPX for NetWare.</td>
</tr>
<tr>
<td><strong>WSD</strong></td>
<td>Enables the WSD port.</td>
<td>Disables the WSD port.</td>
</tr>
<tr>
<td><strong>SNMP UDP</strong></td>
<td>Enables the UDP.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>-------</td>
<td>-------</td>
<td>-----------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>SNMP IPX</strong></td>
<td><strong>Enable</strong></td>
<td>Enables the IPX.</td>
</tr>
<tr>
<td></td>
<td><strong>Disable</strong></td>
<td>Disables the IPX.</td>
</tr>
<tr>
<td><strong>E-Mail Alert</strong></td>
<td><strong>Enable</strong></td>
<td>Enables the E-Mail Alert feature.</td>
</tr>
<tr>
<td></td>
<td><strong>Disable</strong></td>
<td>Disables the E-Mail Alert feature.</td>
</tr>
<tr>
<td><strong>EWS</strong></td>
<td><strong>Enable</strong></td>
<td>Enables an access to <strong>Dell Printer Configuration Web Tool</strong> embedded in the printer.</td>
</tr>
<tr>
<td></td>
<td><strong>Disable</strong></td>
<td>Disables an access to <strong>Dell Printer Configuration Web Tool</strong> embedded in the printer.</td>
</tr>
<tr>
<td><strong>AppleTalk</strong></td>
<td><strong>Enable</strong></td>
<td>Enables the AppleTalk port.</td>
</tr>
<tr>
<td></td>
<td><strong>Disable</strong></td>
<td>Disables the AppleTalk port.</td>
</tr>
<tr>
<td><strong>Bonjour(mDNS)</strong></td>
<td><strong>Enable</strong></td>
<td>Enables the Bonjour(mDNS) port.</td>
</tr>
<tr>
<td></td>
<td><strong>Disable</strong></td>
<td>Disables the Bonjour(mDNS) port.</td>
</tr>
<tr>
<td><strong>HTTP-SSL/TLS</strong></td>
<td><strong>Enable</strong></td>
<td>Enables the HTTP-SSL/TLS port.</td>
</tr>
<tr>
<td></td>
<td><strong>Disable</strong></td>
<td>Disables the HTTP-SSL/TLS port.</td>
</tr>
</tbody>
</table>

**IPX/SPX**

**Purpose:**

To configure the IPX/SPX settings for the wireless network. The change becomes effective after the printer is turned off and then on again.

**Values:**

- **Enable**
- **Disable**
### Auto
Automatically sets the frame type.

### Ethernet II
Uses the Ethernet II frame type.

### Ethernet 802.3
Uses the IEEE802.3 frame type.

### Ethernet 802.2
Uses the IEEE802.2 frame type.

### Ethernet SNAP
Use the SNAP frame type.

### IP Filter (IPv4)

**Purpose:**
To specify that data received from certain IP addresses through the wireless network is blocked. You can set up to 5 IP addresses. The change becomes effective after the printer is turned off and then on again.

**Values:**

<table>
<thead>
<tr>
<th>IP Filter*1</th>
<th>No. n/Address (n is 1 to 5.)</th>
<th>Sets the IP address for Filter n.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>No. n/Mask (n is 1 to 5.)</td>
<td>Sets the mask for Filter n.</td>
</tr>
<tr>
<td></td>
<td>No. n/Mode (n is 1 to 5.)</td>
<td>Off* Disable the IP Filter feature for Filter n.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Accept Accepts an access from specified IP address.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Reject Rejects an access from specified IP address.</td>
</tr>
</tbody>
</table>

*1 This item is only available for LPD or Port9100.

### Reset MPC

**Purpose:**
To initialize wireless network data stored in NVRAM.

### Adobe Protocol
Purpose:

To specify PostScript communication protocol for each interface. You can configure Adobe Protocol settings for the wireless network. The change becomes effective after the printer is turned off and then on again.

Values:

<table>
<thead>
<tr>
<th>Auto*</th>
<th>Used when auto-detecting the PostScript communication protocol.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard</td>
<td>Used when the communication protocol is in ASCII interface.</td>
</tr>
<tr>
<td>BCP</td>
<td>Used when the communication protocol is in binary format.</td>
</tr>
<tr>
<td>TBCP</td>
<td>Used when the communication protocol supports both ASCII and binary data to switch between them according to the specified control code.</td>
</tr>
<tr>
<td>Binary</td>
<td>Used when no special processing is required.</td>
</tr>
</tbody>
</table>

Parallel

The Parallel menu can be adjusted to configure the parallel interface.

**NOTE:** Values marked by an asterisk (*) are the factory default menu settings.

ECP

Purpose:

To specify the ECP communication mode of the parallel interface. The change becomes effective after the printer is turned off and then on again.

Values:

<table>
<thead>
<tr>
<th>Enable*</th>
<th>The ECP communication mode is enabled.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disable</td>
<td>The ECP communication mode is disabled.</td>
</tr>
</tbody>
</table>

Adobe Protocol
Purpose:

To specify PostScript communication protocol for the parallel interface. The change becomes effective after the printer is turned off and then on again.

Values:

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto</td>
<td>Used when auto-detecting the PostScript communication protocol.</td>
</tr>
<tr>
<td>Standard</td>
<td>Used when the communication protocol is in ASCII format.</td>
</tr>
<tr>
<td>BCP</td>
<td>Used when the communication protocol is in binary format.</td>
</tr>
<tr>
<td>TBCP*</td>
<td>Used when the communication protocol supports both ASCII and binary data to switch between them according to the specified control code.</td>
</tr>
<tr>
<td>Binary</td>
<td>Used when no special processing is required.</td>
</tr>
</tbody>
</table>

USB Settings

Use the **USB Settings** menu to change printer settings affecting a USB port.

**NOTE:** Values marked by an asterisk (*) are the factory default menu settings.

Adobe Protocol

Purpose:

To specify PostScript communication protocol for each interface. The change becomes effective after the printer is turned off and then on again.

Values:
<table>
<thead>
<tr>
<th>Auto</th>
<th>Automatically selects a tray according to the paper size and type settings of the job being printed except for the multipurpose feeder.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard</td>
<td>Used when the communication protocol is in ASCII interface.</td>
</tr>
<tr>
<td>BCP</td>
<td>Used when the communication protocol is in binary format.</td>
</tr>
<tr>
<td>TBCP*</td>
<td>Used when the communication protocol supports both ASCII and binary data to switch between them according to the specified control code.</td>
</tr>
<tr>
<td>Binary</td>
<td>Used when no special processing is required.</td>
</tr>
</tbody>
</table>

**System Settings**

Use the System Settings menu to configure the basic printer settings.

**NOTE:** Values marked by an asterisk (*) are the factory default menu settings.

**PowerSaver Time**

**Purpose:**

To specify the amount of time the printer waits after a job is printed before it goes into the power saver mode.

**Values:**

<table>
<thead>
<tr>
<th>Mode1</th>
<th>5-60 min</th>
<th>Specifies the amount of time before the printer enters power saver mode after it finishes a print job.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>5 min*</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Mode2</th>
<th>1-6 min</th>
<th>Enter 5 to put the printer in power saver mode five minutes after it finishes a print job. This uses much less energy, but requires more warm-up time for the printer. Enter 5 if your printer shares an electrical circuit with room lighting and you notice lights flickering.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>6 min*</td>
<td>Select a high value if your printer is in constant use. Under most circumstances, this keeps the printer ready to print with minimum warm-up time. Select a value between 5 and 60 minutes for power save mode if you</td>
</tr>
</tbody>
</table>


want a balance between energy consumption and a shorter warm-up period.

The printer automatically returns to the print mode from the power saver mode when it receives data from the computer. You can also return the printer to the print mode by pressing any button on the operator panel.

**Alert Tone**

**Purpose:**

To establish whether the printer sounds an alarm when an error occurs.

**Values:**

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off*</td>
<td>Does not sound an alarm when an error occurs.</td>
</tr>
<tr>
<td>On</td>
<td>Sounds an alarm when an error occurs.</td>
</tr>
</tbody>
</table>

**Time-Out**

**Purpose:**

To specify the amount of time the printer waits to receive additional bytes of data from the computer. When this timeout expires, the print job is canceled.

**Values:**

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>Disables the job timeout.</td>
</tr>
<tr>
<td>5-300 sec</td>
<td>Specifies the amount of time the printer waits for additional data before it cancels the job.</td>
</tr>
<tr>
<td>30 sec*</td>
<td></td>
</tr>
</tbody>
</table>

**Panel Language**

**Purpose:**

To determine the language of the text on the operator panel screen.
Values:

<table>
<thead>
<tr>
<th>English*</th>
<th>French</th>
</tr>
</thead>
<tbody>
<tr>
<td>Italian</td>
<td>German</td>
</tr>
<tr>
<td>Spanish</td>
<td>Danish</td>
</tr>
<tr>
<td>Dutch</td>
<td>Norwegian</td>
</tr>
<tr>
<td>Swedish</td>
<td></td>
</tr>
</tbody>
</table>

**Auto Log Print**

Purpose:

To specify whether the printer outputs logs automatically.

Values:

<table>
<thead>
<tr>
<th>Off*</th>
<th>Does not print the logs.</th>
</tr>
</thead>
<tbody>
<tr>
<td>On</td>
<td>Prints the logs.</td>
</tr>
</tbody>
</table>

Print logs can also be printed using the Report/List menu.

See also:

"USB Settings"

**Print ID**

Purpose:

To specify a location where the user ID is printed. This feature is available for the PCL driver and unavailable for the PS driver.

Values:
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off*</td>
<td>Does not print the user ID.</td>
</tr>
<tr>
<td>Top Left</td>
<td>Prints the user ID on the top left of the page.</td>
</tr>
<tr>
<td>Top Right</td>
<td>Prints the user ID on the top right of the page.</td>
</tr>
<tr>
<td>Bottom Left</td>
<td>Prints the user ID on the bottom left of the page.</td>
</tr>
<tr>
<td>Bottom Right</td>
<td>Prints the user ID on the bottom right of the page.</td>
</tr>
</tbody>
</table>

**NOTE:** When printing on DL size paper, a part of the user ID may not be printed correctly.

**Print Text**

**Purpose:**

To specify whether the printer outputs PDL data, which is not supported by the printer, as text when the printer receives it. Text data is printed on A4 or Letter size paper.

**Values:**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>Does not print the received data.</td>
</tr>
<tr>
<td>On*</td>
<td>Prints the received data as text data.</td>
</tr>
</tbody>
</table>

**Banner Sheet**

**Purpose:**

To specify the position of banner sheet, and also specify the tray in which the banner sheet is loaded. This feature is available for the PCL driver but is not available for the PS driver.

**Values:**
<table>
<thead>
<tr>
<th>Insert Position</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off*</td>
<td>Does not print the banner sheet.</td>
</tr>
<tr>
<td>Front</td>
<td>Prints on the beginning of document.</td>
</tr>
<tr>
<td>Back</td>
<td>Prints on the end of document.</td>
</tr>
<tr>
<td>Front &amp; Back</td>
<td>Prints on both beginning and end of document.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Specify Tray</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tray 1*</td>
<td>The banner sheet is loaded in tray 1.</td>
</tr>
<tr>
<td>Tray 2*1</td>
<td>The banner sheet is loaded in tray 2.</td>
</tr>
<tr>
<td>MPF</td>
<td>The banner sheet is loaded in multipurpose feeder.</td>
</tr>
</tbody>
</table>

*1 Only displayed when an optional 550-sheet feeder is installed on the printer.

**RAM Disk**

**Purpose:**

To allocate memory to the RAM disk file system for the Secure Print and Proof Print features. The change becomes effective after the printer is turned off and then on again.

**Values:**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disable</td>
<td>Does not allocate memory to the RAM disk file system. Secure Print and Proof Print jobs will abort and be recorded to the job log.</td>
</tr>
<tr>
<td>Enable*</td>
<td>Allocates memory to the RAM disk file system automatically.</td>
</tr>
</tbody>
</table>

**NOTE:** The RAM Disk menu is only displayed when 256 MB or more of additional print memory is installed on the printer.

**NOTE:** Restart your printer when you change the settings for the RAM Disk menu.

**Substitute Tray**

**Purpose:**

Specifies whether or not to use another size paper when the paper that is loaded in the specified tray does not match the paper size settings for the current job.
Values:

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off*</td>
<td>No tray size substitute accepted.</td>
</tr>
<tr>
<td>Larger Size</td>
<td>Substitutes paper of next largest size. When there is no larger paper size, the printer substitutes paper of nearest size.</td>
</tr>
<tr>
<td>Nearest Size</td>
<td>Substitutes paper of nearest size.</td>
</tr>
<tr>
<td>MPF Feed</td>
<td>Substitutes paper from the multipurpose feeder.</td>
</tr>
</tbody>
</table>

**mm/inch**

**Purpose:**

Specifies the default measurement unit displayed after the numeric value on the operator panel.

**Values:**

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>millimeter(mm)*</td>
<td>Selects millimeter as the default measurement unit.</td>
</tr>
<tr>
<td>inch(&quot;&quot;)</td>
<td>Selects inch as the default measurement unit.</td>
</tr>
</tbody>
</table>

**Maintenance**

Use the **Maintenance** menu to initialize the NV (non-volatile) memory, configure the plain paper quality adjustment settings, and configure the security settings.

**NOTE:** Values marked by an asterisk (*) are the factory default menu settings.

**Paper Density**

**Purpose:**

To specify the paper density.

**Values:**
### Adjust BTR

**NOTICE:** The print quality changes depending on the setting values you select for this item.

**Purpose:**

To specify the reference voltage settings for the transfer roller.

**Values:**

<table>
<thead>
<tr>
<th>Type</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain</td>
<td>-3 - +3</td>
</tr>
<tr>
<td></td>
<td>0*</td>
</tr>
<tr>
<td>Plain Thick</td>
<td>-3 - +3</td>
</tr>
<tr>
<td></td>
<td>0*</td>
</tr>
<tr>
<td>Transparency</td>
<td>-3 - +3</td>
</tr>
<tr>
<td></td>
<td>0*</td>
</tr>
<tr>
<td>Covers</td>
<td>-3 - +3</td>
</tr>
<tr>
<td></td>
<td>0*</td>
</tr>
<tr>
<td>Covers Thick</td>
<td>-3 - +3</td>
</tr>
<tr>
<td></td>
<td>0*</td>
</tr>
</tbody>
</table>
### Adjust Fuser

**NOTICE:** The print quality changes depending on the setting values you select for this item.

**Purpose:**

To specify the temperature settings value for the fuser.

**Values:**

<table>
<thead>
<tr>
<th>Material</th>
<th>Setting Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>-3 - +3</td>
</tr>
<tr>
<td>Coated</td>
<td>-3 - +3</td>
</tr>
<tr>
<td>Coated Thick</td>
<td>-3 - +3</td>
</tr>
<tr>
<td>Envelope</td>
<td>-3 - +3</td>
</tr>
<tr>
<td>Recycled</td>
<td>-3 - +3</td>
</tr>
<tr>
<td>JPN Coated</td>
<td>-3 - +3</td>
</tr>
<tr>
<td>JPN Postcard</td>
<td>-3 - +3</td>
</tr>
<tr>
<td>Category</td>
<td>Range</td>
</tr>
<tr>
<td>--------------</td>
<td>-------</td>
</tr>
<tr>
<td>Plain</td>
<td>-2 - +2</td>
</tr>
<tr>
<td>Plain Thick</td>
<td>-2 - +2</td>
</tr>
<tr>
<td>Transparency</td>
<td>-2 - +2</td>
</tr>
<tr>
<td>Covers</td>
<td>-2 - +2</td>
</tr>
<tr>
<td>Covers Thick</td>
<td>-2 - +2</td>
</tr>
<tr>
<td>Label</td>
<td>-2 - +2</td>
</tr>
<tr>
<td>Coated</td>
<td>-2 - +2</td>
</tr>
<tr>
<td>Coated Thick</td>
<td>-2 - +2</td>
</tr>
<tr>
<td>Envelope</td>
<td>-2 - +2</td>
</tr>
<tr>
<td>Recycled</td>
<td>-2 - +2</td>
</tr>
</tbody>
</table>
Auto Reg Adj

Purpose:
To adjust the registration automatically.

Values:

<table>
<thead>
<tr>
<th>On*</th>
<th>Adjusts the registration automatically.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>Does not adjust the registration automatically.</td>
</tr>
</tbody>
</table>

Color Reg Adj

Purpose:
To print the color registration chart and to adjust the color registration by using the chart. This function is required after the printer is set up or moved.

Values:

<table>
<thead>
<tr>
<th>Auto Correct</th>
<th>Adjusts color registration automatically.</th>
</tr>
</thead>
<tbody>
<tr>
<td>ColorRegi Chart</td>
<td>Prints the color registration chart.</td>
</tr>
<tr>
<td>Enter Number</td>
<td>Specifies the values that are found in the color registration chart for Yellow.</td>
</tr>
<tr>
<td></td>
<td>Specifies the values that are found in the color registration chart for Magenta.</td>
</tr>
<tr>
<td></td>
<td>Specifies the values that are found in the color registration chart for Cyan.</td>
</tr>
</tbody>
</table>
**Init PrintMeter**

**Purpose:**

To initialize the data for the print meter. When initializing the data on the print meter, the value of the meter resets to 0.

**Reset Defaults**

**Purpose:**

To initialize the NV (non-volatile) memory. After executing this function and rebooting the printer, all the menu parameters, except the parameters for the network, are reset to their default values.

**Clear Storage**

**Purpose:**

To clear all files that are stored as Secure, Store, and Proof Print in the RAM disk.

![NOTE: The Clear Storage menu is only displayed when 256 MB or more of additional print memory is installed on the printer and then the RAM Disk menu is set to Enable.]

**Non-Dell Toner**

**NOTICE:** When Non-Dell toner is used, the printer may be severely damaged and may not be covered by your warranty.

**Purpose:**

To specify whether to use the refilled print cartridge or not. When this setting is on, you can use print cartridges provided by other companies.

**Values:**

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>On</strong></td>
<td>Enables the use of refilled print cartridges.</td>
</tr>
<tr>
<td><strong>Off</strong>*</td>
<td>Disables the use of refilled print cartridges.</td>
</tr>
</tbody>
</table>
PCL

Use the PCL menu to change printer settings that only affect jobs using the PCL emulation printer language.

**NOTE:** Values marked by an asterisk (*) are the factory default menu settings.

**Paper Tray**

**Purpose:**

To specify the input tray.

**Values:**

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto*</td>
<td>Automatically selects a tray according to the paper size and type settings of the printing job.</td>
</tr>
<tr>
<td>Tray 1</td>
<td>The paper is fed from the standard 250-sheet tray.</td>
</tr>
<tr>
<td>Tray 2 *1</td>
<td>The paper is fed from the optional 550-sheet feeder.</td>
</tr>
<tr>
<td>MPF</td>
<td>The paper is fed from the multipurpose feeder.</td>
</tr>
</tbody>
</table>

*1 Only displayed when an optional 550-sheet feeder is installed on the printer.

**Paper Size**

**Purpose:**

To specify the default paper size.

**Values:**
<table>
<thead>
<tr>
<th>Paper Size</th>
<th>Envelope Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>A4*1</td>
<td>C5</td>
</tr>
<tr>
<td>A5</td>
<td>Envelope #10</td>
</tr>
<tr>
<td>B5</td>
<td>JPN Postcard</td>
</tr>
<tr>
<td>Letter*1</td>
<td>Youkei 2 Env</td>
</tr>
<tr>
<td>8.5x13&quot;</td>
<td>Youkei 3 Env</td>
</tr>
<tr>
<td>Legal</td>
<td>Youkei 4 Env</td>
</tr>
<tr>
<td>Executive</td>
<td>Youchou 3 Env</td>
</tr>
<tr>
<td>Monarch</td>
<td>Choukei 3 Env</td>
</tr>
<tr>
<td>DL</td>
<td>Custom Size</td>
</tr>
</tbody>
</table>

*1 Denotes country-specific factory default values.

**NOTE:** Selecting a custom size for the paper size prompts you to enter a custom length and width.

**Orientation**

**Purpose:**

To specify how text and graphics are oriented on the page.

**Values:**

<table>
<thead>
<tr>
<th>Orientation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Portrait*</td>
<td>Prints text and graphics parallel to the short edge of the paper.</td>
</tr>
<tr>
<td>Landscape</td>
<td>Prints text and graphics parallel to the long edge of the paper.</td>
</tr>
</tbody>
</table>

**2 Sided**

**Purpose:**

To set duplexing as the default for all print jobs. (Select **Duplex** from the printer driver to duplex only...
specific jobs.)

NOTE: Values marked by an asterisk (*) are the factory default menu settings.

NOTE: The 2 Sided menu is only available when the optional duplexer is installed on the printer.

Values:

<table>
<thead>
<tr>
<th>2 Sided Print</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Off*</td>
<td>Prints on one side of the paper.</td>
<td></td>
</tr>
<tr>
<td>On</td>
<td>Prints on both sides of the paper.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Binding Edge</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Flip Long Edge*</td>
<td>Assumes binding along the long edge of the page. (Left edge for portrait orientation and top edge for landscape orientation)</td>
<td></td>
</tr>
<tr>
<td>Flip Short Edge</td>
<td>Assumes binding along the short edge of the page. (Top edge for portrait orientation and left edge for landscape orientation)</td>
<td></td>
</tr>
</tbody>
</table>

Font

Purpose:

To specify the default font from the registered fonts in the printer.

Values:

<table>
<thead>
<tr>
<th>CG Times</th>
<th>CG Times It</th>
<th>CG Times Bd</th>
</tr>
</thead>
<tbody>
<tr>
<td>CG Times BdIt</td>
<td>Univers Md</td>
<td>Univers MdIt</td>
</tr>
<tr>
<td>Univers Bd</td>
<td>Univers BdIt</td>
<td>Univers MdCd</td>
</tr>
<tr>
<td>Univers MdCdIt</td>
<td>Univers BdCd</td>
<td>Univers BdCdIt</td>
</tr>
<tr>
<td>AntiqueOlv</td>
<td>AntiqueOlv It</td>
<td>AntiqueOlv Bd</td>
</tr>
<tr>
<td>CG Omega</td>
<td>CG Omega It</td>
<td>CG Omega Bd</td>
</tr>
<tr>
<td>CG Omega BdIt</td>
<td>GaramondAntiqua</td>
<td>Garamond Krsv</td>
</tr>
<tr>
<td>Font Style</td>
<td>Font Style</td>
<td>Font Style</td>
</tr>
<tr>
<td>--------------------</td>
<td>------------</td>
<td>--------------------</td>
</tr>
<tr>
<td>Garamond Hlb</td>
<td>GaramondKrsvHlb</td>
<td>Courier*</td>
</tr>
<tr>
<td>Courier It</td>
<td>Courier Bd</td>
<td>Courier BdIt</td>
</tr>
<tr>
<td>LetterGothic</td>
<td>LetterGothic It</td>
<td>LetterGothic Bd</td>
</tr>
<tr>
<td>Albertus Md</td>
<td>Albertus X Bd</td>
<td>Clarendon Cd</td>
</tr>
<tr>
<td>Coronet</td>
<td>Marigold</td>
<td>Arial</td>
</tr>
<tr>
<td>Arial It</td>
<td>Arial Bd</td>
<td>Arial BdIt</td>
</tr>
<tr>
<td>Times New</td>
<td>Times New It</td>
<td>Times New Bd</td>
</tr>
<tr>
<td>Times New BdIt</td>
<td>Symbol</td>
<td>Wingdings</td>
</tr>
<tr>
<td>Line Printer</td>
<td>Times Roman</td>
<td>Times It</td>
</tr>
<tr>
<td>Times Bd</td>
<td>Times BdIt</td>
<td>Helvetica</td>
</tr>
<tr>
<td>Helvetica Ob</td>
<td>Helvetica Bd</td>
<td>Helvetica BdOb</td>
</tr>
<tr>
<td>CourierPS</td>
<td>CourierPS Ob</td>
<td>CourierPS Bd</td>
</tr>
<tr>
<td>CourierPS BdOb</td>
<td>SymbolPS</td>
<td>Palatino Roman</td>
</tr>
<tr>
<td>Palatino It</td>
<td>Palatino Bd</td>
<td>Palatino BdIt</td>
</tr>
<tr>
<td>ITCBookman Lt</td>
<td>ITCBookman LtIt</td>
<td>ITCBookmanDm</td>
</tr>
<tr>
<td>ITCBookmanDm It</td>
<td>HelveticaNr</td>
<td>HelveticaNr Ob</td>
</tr>
<tr>
<td>HelveticaNr Bd</td>
<td>HelveticaNrBdOb</td>
<td>N C Schbk Roman</td>
</tr>
<tr>
<td>N C Schbk It</td>
<td>N C Schbk Bd</td>
<td>N C Schbk BdIt</td>
</tr>
<tr>
<td>ITC A G Go Bk</td>
<td>ITC A G Go BkOb</td>
<td>ITC A G Go Dm</td>
</tr>
<tr>
<td>ITC A G Go DmOb</td>
<td>ZapfC MdIt</td>
<td>ZapfDingbats</td>
</tr>
</tbody>
</table>
Symbol Set

Purpose:

To specify a symbol set for a specified font.

Values:

<table>
<thead>
<tr>
<th>ROMAN-8*</th>
<th>ISO L1</th>
<th>ISO L2</th>
</tr>
</thead>
<tbody>
<tr>
<td>ISO L5</td>
<td>ISO L6</td>
<td>PC-8</td>
</tr>
<tr>
<td>PC-8 DN</td>
<td>PC-775</td>
<td>PC-850</td>
</tr>
<tr>
<td>PC-852</td>
<td>PC-1004</td>
<td>PC-8 TK</td>
</tr>
<tr>
<td>WIN L1</td>
<td>WIN L2</td>
<td>WIN L5</td>
</tr>
<tr>
<td>DESKTOP</td>
<td>PS TEXT</td>
<td>MC TEXT</td>
</tr>
<tr>
<td>MS PUB</td>
<td>MATH-8</td>
<td>PS MATH</td>
</tr>
<tr>
<td>PI FONT</td>
<td>LEGAL</td>
<td>ISO-4</td>
</tr>
<tr>
<td>ISO-6</td>
<td>ISO-11</td>
<td>ISO-15</td>
</tr>
<tr>
<td>ISO-17</td>
<td>ISO-21</td>
<td>ISO-60</td>
</tr>
<tr>
<td>ISO-69</td>
<td>WIN 3.0</td>
<td>WINBALT</td>
</tr>
<tr>
<td>SYMBOL</td>
<td>WINGDINGS</td>
<td>DNGBTSMS</td>
</tr>
</tbody>
</table>

Font Size

Purpose:

To specify the font size for scalable typographic fonts.

Values:
Font size refers to the height of the characters in the font. One point equals approximately 1/72 of an inch.

**NOTE:** The Font Size menu is only displayed for typographic fonts.

**See also:**

"Pitch and Point Size"

**Font Pitch**

**Purpose:**

To specify the font pitch for scalable monospaced fonts.

**Values:**

<table>
<thead>
<tr>
<th>6.00 - 24.00</th>
<th>The values are in steps of 0.01.</th>
</tr>
</thead>
<tbody>
<tr>
<td>10.00*</td>
<td></td>
</tr>
</tbody>
</table>

Font pitch refers to the number of fixed-space characters in a horizontal inch of type. For nonscalable monospaced fonts, the pitch is displayed, but cannot be changed.

**NOTE:** The Font Pitch menu is only displayed for fixed, or monospaced, fonts.

**See also:**

"Pitch and Point Size"

**Form Line**

**Purpose:**

To set the number of lines in a page.
Values:

| 5 - 128 | The values are in steps of 1. |
| 64* or 64*¹ |

*¹ Denotes country-specific factory default values.

The printer sets the amount of space between each line (vertical line spacing) based on the Form Line and Orientation menu items. Select the correct Form Line and Orientation before changing Form Line.

See also:

"Orientation," "Use this menu item to:"

**Quantity**

**Purpose:**

To set the number of copies you want for the printer default value. (Set the number of copies required for a specific job from the printer driver. Values selected from the printer driver always override values selected from the operator panel.)

**Values:**

| 1-999 | The values are in steps of 1. |
| 1* |

**Image Enhance**

**Purpose:**

To specify whether to perform the image enhancement feature. Image enhancement is a feature that makes the boundary line between black and white smoother to decrease jagged edges and enhance the visual appearance.

**Values:**
### On

Enables to perform the image enhancement feature.

### Off

Disables to perform the image enhancement feature.

---

**Hex Dump**

**Purpose:**

To help isolate the source of a print job problem. With Hex Dump selected, all data sent to the printer is printed in hexadecimal and character representation. Control codes are not executed.

**Values:**

<table>
<thead>
<tr>
<th>Disable*</th>
<th>Enables the Hex Dump feature.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable</td>
<td>Enables the Hex Dump feature.</td>
</tr>
</tbody>
</table>

---

**Draft Mode**

**Purpose:**

To save toner by printing in the draft mode. The print quality is reduced when printing in the draft mode.

**Values:**

<table>
<thead>
<tr>
<th>Disable*</th>
<th>Does not print in the draft mode.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable</td>
<td>Prints in the draft mode.</td>
</tr>
</tbody>
</table>

---

**LineTermination**

**Purpose:**

To add the line termination commands.

**Values:**
The line termination command is not added.
CR=CR, LF=LF, FF=FF

Add-LF
The LF command is added.
CR=CR-LF, LF=LF, FF=FF

Add-CR
The CR command is added.
CR=CR, LF=CR-LF, FF=CR-FF

CR-XX
The CR and LF commands are added.
CR=CR-LF, LF=CR-LF, FF=CR-FF

**Default Color**

**Purpose:**

To specify the color mode to Color or Black. This setting is used when the color printing mode setting is not specified for the print job that is sent to the printer.

**Value:**

<table>
<thead>
<tr>
<th>Black*</th>
<th>Prints in the black and white mode.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color</td>
<td>Prints in the color mode.</td>
</tr>
</tbody>
</table>

**PostScript**

Use the PostScript menu to change printer settings that only affect jobs using the PostScript emulation printer language.

**NOTE:** Values marked by an asterisk (*) are the factory default menu settings.

**PS Error Report**

**Purpose:**

To specify whether the printer outputs error contents for a PostScript error. The change becomes effective after the printer is turned off and then on again.

**Values:**
Prints an error message before it discards the job.

Off
Discards the print job without printing an error message.

**NOTE:** This instructions from the PS driver override the settings specified on the operator panel.

### PS Job Time-Out

**Purpose:**
To specify the execution time for one PostScript job. The change becomes effective after the printer is turned off and then on again.

**Values:**

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off*</td>
<td>Job timeout does not occur.</td>
</tr>
<tr>
<td>1-900min.</td>
<td>A PostScript error occurs if processing is not completed after the specified time.</td>
</tr>
</tbody>
</table>

### PaperSelectMode

**Purpose:**
To specify the way to select the tray for PostScript mode. The change becomes effective after the printer is turned off and then on again.

**Value:**

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto*</td>
<td>The tray is selected as the same setting as in the PCL mode.</td>
</tr>
<tr>
<td>Select FromTray</td>
<td>The tray is selected in a method compatible with regular Post Script printers.</td>
</tr>
</tbody>
</table>

### Panel Settings

Use the Panel Settings menu to set a password to limit access to the menus. This prevents items from being change accidentally.
NOTE: Values marked by an asterisk (*) are the factory default menu settings.

See also:

"Setting of Panel Lock"

Panel Lock

Purpose:

To limit access to the menus.

Values:

<table>
<thead>
<tr>
<th>Disable*</th>
<th>Does not limit access to the menus.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable</td>
<td>Limits access to the menus.</td>
</tr>
</tbody>
</table>

Change Password

Purpose:

To set a password to limit access to the menus.

Values:

<table>
<thead>
<tr>
<th>0000-9999</th>
</tr>
</thead>
<tbody>
<tr>
<td>0000*</td>
</tr>
</tbody>
</table>

Tray Settings

Use the Tray Settings menu to define the print media loaded in each tray.

NOTE: Values marked by an asterisk (*) are the factory default menu settings.
**Purpose:**

To specify the paper loaded in the multipurpose feeder.

**Values:**

<table>
<thead>
<tr>
<th>Paper Type</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain*</td>
<td></td>
</tr>
<tr>
<td>Plain Thick</td>
<td></td>
</tr>
<tr>
<td>Transparency</td>
<td></td>
</tr>
<tr>
<td>Covers</td>
<td></td>
</tr>
<tr>
<td>Covers Thick</td>
<td></td>
</tr>
<tr>
<td>Label</td>
<td></td>
</tr>
<tr>
<td>Coated</td>
<td></td>
</tr>
<tr>
<td>Coated Thick</td>
<td></td>
</tr>
<tr>
<td>Envelope</td>
<td></td>
</tr>
<tr>
<td>Recycled</td>
<td></td>
</tr>
<tr>
<td>JPN Coated</td>
<td></td>
</tr>
<tr>
<td>JPN Postcard</td>
<td></td>
</tr>
<tr>
<td>Plain S2</td>
<td></td>
</tr>
<tr>
<td>Plain Thick S2</td>
<td></td>
</tr>
<tr>
<td>Covers S2</td>
<td></td>
</tr>
<tr>
<td>Covers Thick S2</td>
<td></td>
</tr>
<tr>
<td>Coated S2</td>
<td></td>
</tr>
<tr>
<td>Coated Thick S2</td>
<td></td>
</tr>
<tr>
<td>Recycled S2</td>
<td></td>
</tr>
<tr>
<td>JPN Coated S2</td>
<td></td>
</tr>
<tr>
<td>JPN Postcard S2</td>
<td></td>
</tr>
</tbody>
</table>

| Paper Size | A4   |
| Paper Size       | A5       | B5       | Driver Size* | Letter | 8.5x13" | Legal | Executive | Monarch | DL | C5 | Envelope #10 | JPN Postcard | Youkei 2 Env | Youkei 3 Env | Youkei 4 Env | Youchou 3 Env | Choukei 3 Env | Custom Size |
|-----------------|---------|---------|-------------|--------|---------|-------|-----------|---------|----|----|------------|-------------|--------------|--------------|--------------|--------------|--------------|--------------|-------------|

<table>
<thead>
<tr>
<th><strong>MPF Mode</strong></th>
<th><strong>Panel Specified</strong></th>
<th>Stop printing and show an error on the operation panel if the paper specified from the printer driver does not match the paper configured for the MFP from the operation panel.</th>
</tr>
</thead>
<tbody>
<tr>
<td>DriverSpecified*</td>
<td>Continue to print even if the paper specified from the printer driver does not match the paper configured for the MFP from the operation panel.</td>
<td></td>
</tr>
<tr>
<td><strong>Display Popup</strong></td>
<td><strong>On</strong>*</td>
<td>Specifies the size and type of paper loaded in the multipurpose feeder. This item is available only when Panel Specified is selected for MFP Mode.</td>
</tr>
<tr>
<td>Off</td>
<td>Size and type of paper loaded in the multipurpose feeder is not specified. This item is available only when Panel Specified is selected for MFP Mode.</td>
<td></td>
</tr>
</tbody>
</table>

**NOTE:** For the standard 250-sheet tray or optional 550-sheet feeder, setting paper size is not required. These trays detect the paper size automatically. For more information on supported paper size for the standard and optional trays, see "Print Media Sizes and Support."

**Use this menu item to:**
- Optimize print quality for the specified paper.
- Select paper source through your software program by selecting type and size.
- Automatically link trays. The printer automatically links any trays containing the same type and size of paper, if you have set the Paper Type to the correct values.

**Tray 1**

**Purpose:**

To specify the paper loaded in the 250-sheet tray.

**Values:**

<table>
<thead>
<tr>
<th>Paper Type</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paper Type</td>
<td>Plain*</td>
</tr>
<tr>
<td></td>
<td>Plain Thick</td>
</tr>
<tr>
<td></td>
<td>Covers</td>
</tr>
<tr>
<td></td>
<td>Covers Thick</td>
</tr>
<tr>
<td></td>
<td>Label</td>
</tr>
<tr>
<td></td>
<td>Coated</td>
</tr>
<tr>
<td></td>
<td>Coated Thick</td>
</tr>
<tr>
<td></td>
<td>Recycled</td>
</tr>
<tr>
<td></td>
<td>JPN Coated</td>
</tr>
<tr>
<td>Paper Size</td>
<td>Auto*</td>
</tr>
<tr>
<td></td>
<td>Custom Size</td>
</tr>
</tbody>
</table>

**Tray 2**

**Purpose:**

To specify the paper loaded in the 550-sheet feeder.

**Values:**
<table>
<thead>
<tr>
<th>Paper Type</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain*</td>
<td></td>
</tr>
<tr>
<td>Plain Thick</td>
<td></td>
</tr>
<tr>
<td>Covers</td>
<td></td>
</tr>
<tr>
<td>Covers Thick</td>
<td></td>
</tr>
<tr>
<td>Label</td>
<td></td>
</tr>
<tr>
<td>Coated</td>
<td></td>
</tr>
<tr>
<td>Coated Thick</td>
<td></td>
</tr>
<tr>
<td>Recycled</td>
<td></td>
</tr>
<tr>
<td>JPN Coated</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Paper Size</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto*</td>
<td></td>
</tr>
<tr>
<td>Custom Size</td>
<td></td>
</tr>
</tbody>
</table>

**Stored Print**

This Stored Print menu provides applicable printing services such as Secure Print and Proof Print.

⚠️ **NOTE:** The Stored Print menu is only displayed when 256 MB or more of optional memory card is installed on the printer.

**Secure Print**

**Purpose:**

To print confidential jobs. The printer can hold the job in memory until you arrive at the printer and type the password on the operator panel.

**Values:**

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Del after Print</td>
<td>Prints the job, and then deletes it from print memory.</td>
</tr>
<tr>
<td>Print and Save</td>
<td>Prints the job, and then saves it in print memory.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes the job from print memory.</td>
</tr>
</tbody>
</table>
Proof Print

Purpose:

To print only one copy and check the print result before printing all of the copies. This prevents a large number of misprinted copies from being printed at one time.

Values:

<table>
<thead>
<tr>
<th>Del after Print</th>
<th>Prints the job, and then deletes it from print memory.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print and Save</td>
<td>Prints the job, and then saves it in print memory.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes the job from print memory.</td>
</tr>
</tbody>
</table>

Setting of Panel Lock

This feature prevents unauthorized personnel from changing settings made by the printer administrator. For regular printing, items can be selected from the menu and printer settings remain unchanged. For regular printing, items can be configured using the printer driver.

![NOTE: Disabling the operator panel menus does not prevent access to the Stored Print and Tray Settings menus.]

1. Press Menu.
2. Press ▼ until Admin Menu appears, and then press ✔.
3. Press ▼ until Panel Settings appears, and then press ✔.
4. Panel Lock is displayed. Press ✔.
5. Press ▼ until Enable appears, and then press ✔.
6. Press ◀.
7. Press ▼ until Change Password appears, and then press ✔.
8. Enter the old password (when you enter it for the first time after doing the settings, enter 0000), and then press ✔.
9. Enter the new password, and then press ✔.
10. Reenter the password to confirm the password that you entered, and then press ✓.
    The password has been changed.

![NOTE:](image) If you forget your password, turn off the printer. Then, while holding Menu, turn on the printer. Continue to hold Menu until the display indicates Ready to Init. Release Menu and press ✓. Press ◀ to select Yes, then press ✓. The display will briefly indicate Password has been initialized. This will recover the factory default panel password.

![NOTE:](image) If panel lock is Enable, the factory-default panel password is 0000.

See also:

"Change Password"

**Disabling Panel Lock**

1. Press Menu.

2. Press ◀ until Admin Menu appears, and then press ✓.

3. Press ◀ until Panel Settings appears, and then press ✓.

4. Panel Lock is displayed. Press ✓.

5. Press ◀ until Disable appears, and then press ✓.
Understanding Your Printer Software

Use the Drivers and Utilities CD that came with your printer to install a combination of software programs, depending on your operating system.

The following software programs can only operate on Windows. They cannot operate on Macintosh, UNIX, or Linux.

Printing Status Window

The Printing Status Window alerts you when an error or warning occurs, for example, when a paper jam occurs or toner is running low.

You can select whether to display the Printing Status Window when printing. When an error occurs, the error message appears on the Printing Status Window.

Status Window

On the Status Window, you can check how much toner and paper are remaining or the configuration of options for the local printer.

Status Monitor Console

Use the Status Monitor Console to manage multiple Status Window.

- Select a printer from the list view (or Printer Selection) by clicking its name to open a Status Window or Dell Printer Configuration Web Tool for a particular printer.

- The Status Monitor Console displays the Status Window for local connections, or the Dell Printer Configuration Web Tool for network connections.

Dell Supplies Management System™

You can launch the Dell Supplies Management System dialog box from the Printing Status window, the All Programs menu, or the desktop icon. You can also launch it from the Status Window when a toner error occurs.
You can order consumables by phone or from the web.

1. Click **Start** → **All Programs** → **Dell Printers** → **Additional Color Laser Software** → **Dell Supplies Management System**.

   The **Dell Supplies Management System** window appears.

2. Select your printer from the **Select Printer Model** list.

3. If ordering from the Web:
   
   a. When you cannot get information from the printer automatically by two-way communication, a window that prompts you to type the Service Tag number appears. Type your Dell printer Service Tag number in the field provided.
      
      Your Service Tag number is located inside the front door of your printer.

   b. Select an URL from the **Select Reorder URL** list.

   c. Click **Visit Dell printer supplies ordering web site**.

4. If ordering by phone, call the number that appears under the **By Telephone** heading.

---

**User Setup Disk Creating Tool**

The **User Setup Disk Creating Tool** program located in the **MakeDisk** folder of the **Utilities** folder on the **Drivers and Utilities** CD and the printer drivers located on the **Drivers and Utilities** CD are used to create driver installation packages that contain custom driver settings. A driver installation package can contain a group of saved printer driver settings and other data for things such as:

- Print orientation and Multiple Up (document settings)
- Watermarks
- Font references

If you want to install the printer driver with the same settings to multiple computers running the same operating system, create a setup disk in a floppy disk or in a server on the network. Using the setup disk that you have created will reduce the amount of work required when installing the printer driver.

- Install in advance the Dell™ Color Laser Printer 3110cn printer driver in the computer on which the setup disk is to be created.

- The setup disk can only be used on the operating system on which the disk was created or computers running the same operating system. Create a separate setup disk for different types of operating systems.
Software Update

The firmware and/or driver updates can be downloaded from http://support.dell.com.
Printing

This chapter covers tips for printing, how to print certain lists of information from your printer, and how to cancel a job.

- Tips for Successful Printing
- Sending a Job to Print
- Canceling a Print Job
- Printing a Printer Settings Page
- Printing a Font Sample List
- Using the Print and Hold Function

Tips for Successful Printing

Tips on Storing Print Media

Store your print media properly. For more information, see "Storing Print Media."

Avoiding Jams

- **NOTE:** Dell recommends that you try a limited sample of any print media you are considering using with the printer before purchasing large quantities.

By selecting appropriate print media and loading it properly, you are able to avoid most jams. See the following for instructions on loading print media:

- "Loading Print Media in Standard and Optional Trays" (which includes the standard 250-sheet tray and the optional 550-sheet feeder)
- "Loading the Multipurpose Feeder"
- "Avoiding Jams"

If you experience a jam, see "Clearing Jams" for instructions.

Sending a Job to Print

To support all of the printer features, use the printer driver. When you choose **Print** from a software program, a window representing the printer driver opens. Select the appropriate settings for the specific job.
you are sending to print. Print settings selected from the driver override the default menu settings selected from the printer operator panel.

You may need to click Properties or Setup from the initial Print box to see all of the available printer settings you can change. If you are not familiar with a feature in the printer driver window, open the online Help for more information. Changing paper size or type that is different from type setting in the operator panel will require a user to change the operator panel tray setting before the job will print.

To print a job from a typical Windows application:

1. Open the file you want to print.
2. From the File menu, select Print.
3. Verify that the correct printer is selected in the dialog box. Modify the printer settings as appropriate (such as the pages you want to print or the number of copies).
4. Click Properties or Setup to adjust printer settings not available from the first screen, and then click OK.
5. Click OK or Print to send the job to the selected printer.

---

**Canceling a Print Job**

There are several methods for canceling a print job.

**Canceling From the Printer Operator Panel**

To cancel a print job after it has started printing:

1. Press Cancel.
   Printing is canceled only for the current print job. All the following print jobs will continue to print.

**Canceling a Job From the Computer Running Windows**

**Canceling a Job From the Taskbar**

When you send a job to print, a small printer icon appears in the right corner of the taskbar.

1. Double-click the printer icon.
   A list of print jobs appears in the printer window.
2. Select the job you want to cancel.
3. Press <Delete> on the keyboard.
Canceling a Job From the Desktop

1. Minimize all programs to reveal the desktop.

2. Click **Start** → **Printers and Faxes**. Click **Start** → **Control Panel** → **Hardware and Sound** → **Printers** (for Windows Vista™).
   A list of available printers appears.

3. Double-click the printer you selected when you sent the job.
   A list of print jobs appears in the printer window.

4. Select the job you want to cancel.

5. Press <Delete> on the keyboard.

---

Printing a Printer Settings Page

To verify detailed printer settings, print a printer settings page. A printed printer settings page also allows you to verify whether or not options have been installed properly.

See "Understanding Printer Menus" to identify the display and operator panel buttons if you need help.

1. Press **Menu**.

2. Press ▼ until **Report/List** appears, and then press ✓.

3. **Printer Setting** is displayed, and then press ✓.
   The printer settings page is printed.

The message **Printer Settings Printing** appears while the page prints. The printer returns to the **Ready to Print** message after the printer settings page prints.

If any other message appears when you print this page, see "Understanding Printer Messages" for more information.

---

Printing a Font Sample List

To print samples of all the fonts currently available for your printer:

1. Press **Menu**.
Press \( \downarrow \) until Report/List appears, and then press \( \checkmark \).

Press \( \downarrow \) until either PCL Fonts List or PS Fonts List appears.

- Select PCL Fonts List to print a listing of the fonts available to the PCL.
- Select PS Fonts List to print a listing of the fonts available to the PostScript\(^{\circledR} \ 3^{\text{TM}}\).

Press \( \checkmark \).

The message PCL Fonts List Printing or PS Fonts List Printing appears and remains on the operator panel until the page prints. The printer returns to the Ready to Print state after the font sample list prints.

---

**Using the Print and Hold Function**

When you send a job to the printer, you can specify in the driver that you want the printer to hold the job in memory. When you are ready to print the job, you must go to the printer and use the operator panel menus to identify which job in the memory you want to print. You can use this function to print a confidential job (Secure Print), delay printing a job (Store Print), or verify one copy before printing additional copies (Proof Print).

**NOTE:** The printer holds the job until you delete it by using the operator panel or you turn off the printer. The data on memory is cleared when the printer is turned off.

**NOTE:** Print and Hold functions require a minimum of 384 MB available print memory. Also, you need to configure the RAM disk settings on both the operator panel and the printer driver.

**NOTE:** Depending on the documents, its job may be too big for the available memory. In this case, an error occurs.

**NOTE:** If a document name is not assigned to your print job in the print driver, the job’s name will be identified using the PC’s time and date of submission to distinguish it from other jobs you have stored under your name.

**Printing and Deleting Held Jobs**

Once held jobs are stored in print memory, you can use the printer operator panel to specify what you want to do with one or more of the jobs. You can select either Secure Print and Proof Print from "Stored Print". Then, you select your user name from a list. If you select Secure Print, you must type the password you specified in the driver when you sent the job. See "Secure Print" for more information.

From either the Secure Print or Proof Print menu items, you have three choices:

- Del after Print
- Print and Save
- Delete
Accessing Held Jobs From the Operator Panel

1. Press **Menu**.

2. Press ◀ until **Stored Print** appears, and then press ✔.

3. **Secure Print** is displayed. Press ✔.

4. Press ◀ until your user name appears, and then press ✔.

5. If you print confidential jobs (Secure Print jobs), enter the password you have specified on the printer driver, and then press ✔.

6. Press ◀ until the job you want to print appears, and then press ✔.

7. Press ◀ until the action you want to do appears, and then press ✔.

8. Enter the print quantity, and then press ✔.
   When you select All Documents in step 6 and the print quantity has been set on the computer, select Use PC Settings, and then press ✔. When you select a document in step 6, the number of copies that is specified in the printer driver appears.

Accessing the Proof Print Jobs

1. Press **Menu**.

2. Press ◀ until **Stored Print** appears, and then press ✔.

3. Press ◀ until **Proof Print** appears, and then press ✔.

4. Press ◀ until your user name appears, and then press ✔.

5. Press ◀ until the job you want to print appears, and then press ✔.

6. Press ◀ until the action you want to do appears, and then press ✔.

7. Enter the print quantity, and then press ✔.
   When you select All Documents in step 5 and the print quantity has been set on the computer, select Use PC Settings, and then press ✔. When you select a document in step 5, the number of copies that is specified in the printer driver appears.

Store Print
If you send a Store Print job, the printer does not print the job immediately, but stores the job in memory so you can print the job later. See "Printing and Deleting Held Jobs" for more information.

**NOTE:** The printer holds the job until you delete it by using the operator panel or you turn off the printer.

**NOTE:** When you select Del after Print, the held job is automatically deleted after printing.

### Proof Print

If you send a Proof Print job, the printer prints one copy and holds the remaining copies you requested from the driver in print memory. Use Proof Print function to examine the first copy to see if it is satisfactory before printing the remaining copies.

See "Printing and Deleting Held Jobs" if you need help printing the additional copies stored in memory.

**NOTE:** The printer holds the job until you delete it by using the operator panel or you turn off the printer. The data on memory is cleared when the printer is turned off.

**NOTE:** When you select Del after Print, the held job is automatically deleted after printing.

### Secure Print

When you send a job to the printer, you can specify a password from the driver. The password must be between 1 and 12 digits using numbers 0 through 9. The job is then held in print memory until you enter the same numeric password from the printer operator panel and choose to print or delete the job. This function is called "Store Print". This ensures that the job does not print until you are there to retrieve it, and no one else using the printer can print the job.

When you select Secure Print from Stored Print after selecting your user name, the following prompt is displayed:

```
Password
[xxxxxxxxxxxxx]
```

Use the buttons on the operator panel to enter the numeric password associated with your confidential job. As you enter the password, the password you entered is displayed to ensure confidentiality.

If you enter an invalid password, the message Wrong Password appears. Wait three seconds, or Press ✓ or Cancel to return to the screen for user selection.

When you enter a valid password, you have access to all print jobs matching the user name and password you entered. The print jobs matching the password you entered appear on the screen. You can then choose to print or delete jobs matching the password you entered. (See "Printing and Deleting Held Jobs" for more information.)
**NOTE:** The printer holds the job until you delete it by using the operator panel or you turn off the printer. The data on memory is cleared when the printer is turned off.

**NOTE:** When you select Del after Print, the held job is automatically deleted after printing.
Setting Up for Shared Printing

- **Point and Print**
- **Peer-to-Peer**

You can share your new printer on the network using the *Drivers and Utilities* CD that shipped with your printer, or using Microsoft's point and print or peer-to-peer method. However, if you use one of the Microsoft methods, you will not have all of the features, such as the status monitor and other printer utilities, that are installed with the *Drivers and Utilities* CD.

To share a locally-attached printer on the network, you need to share the printer, and then install the shared printer on network clients:

1. Click **Start** → **Settings** → **Printers and Faxes (Printers for Windows 2000)**.
2. Right-click this printer icon and select **Properties**.
3. From the **Sharing** tab, check the **Shared this printer (Shared for Windows 2000)** check box, and then type a name in the **Shared name (Share as for Windows 2000)** text box.
4. Click **Additional Drivers** and select the operating systems of all network clients printing to this printer.
5. Click **OK**.
   - If you are missing files, you are prompted to insert the server operating system CD.

**For Windows Vista™**

1. Click **Start** → **Control Panel** → **Hardware and Sound** → **Printers**.
2. Right-click the printer's icon and select **Sharing**.
3. Click the **Change sharing options** button.
4. Click the **Continue** button.
5. Check the **Share this printer** check box, and then type a name in the **Share name** text box.
6. Click **OK**.

The PCL driver supports an Additional Driver for Windows Vista (not including Itanium). To register the Additional Driver, follow the instructions below.

1. Click **Start** → **Control Panel** → **Hardware and Sound** → **Printers**.
2. Right-click the printer's icon and select **Sharing**.
3. Click the **Change sharing options** button.
4. Click the **Continue** button.
5. Click **Additional Drivers** and select the processors of all the network clients printing with this printer.
6. Click **OK**.
7. Click the **Browse** button and locate the driver in the *Drivers and Utilities* CD.

To check that the printer was successfully shared:

- Make sure the printer object in the **Printers and Faxes (Printers for Windows 2000)** folder shows it is shared. For example, in Windows 2000, a hand is shown underneath the printer icon.
- Browse **My Network Places (Network Neighborhood for Windows 2000)**. Find the host name of the server and look for the shared name you assigned to the printer.

Now that the printer is shared, you can install the printer on network clients using the point and print method or the peer-to-peer method.

---

**Point and Print**

This method is usually the best use of system resources. The server handles driver modifications and print job processing. This lets network clients return to their programs much faster.

If you use the point and print method, a subset of driver information is copied from the server to the client computer. This is just enough information to send a print job to the printer.

2. Locate the host name of the server computer, and then double-click the host name.
3. Right-click the shared printer name, and then click **Install**. Wait for the driver information to copy from the server computer to the client computer, and for a new printer object to be added to the **Printers and Faxes (Printers for Windows 2000)** folder. The time this takes varies, based on network traffic and other factors. Close **My Network Places (Network Neighborhood for Windows 2000)**.
4. Print a test page to verify print installation.
5. Click **Start** → **Settings** → **Printers and Faxes (Printers for Windows 2000)**.
6. Select the printer you just created.
7. Click **File** → **Properties**.
8. From the **General** tab, click **Print Test Page (Print a Test Page for Windows 2000)**.
When a test page prints successfully, printer installation is complete.

**For Windows Vista**

1. On the Windows desktop of the client computer, click **Start → Network**.
2. Locate the host name of the server computer, and then double-click the host name.
3. Right-click the shared printer name, and then click **Connect**.
4. Click **Install driver**.
5. Click **Continue** in the **User Account Control** dialog box.
6. Wait for the driver information to copy from the server computer to the client computer, and for a new printer object to be added to the **Printers** folder. The time this takes varies, based on network traffic and other factors.
7. Print a test page to verify printer driver installation.
8. Click **Start → Control Panel → Hardware and Sound → Printers**.
9. Right-click the printer you just created and select **Properties**.
10. From the **General** tab, click **Print Test Page**.

If the test page prints successfully, the printer driver installation is complete.

**Peer-to-Peer**

If you use the peer-to-peer method, the printer driver is fully installed on each client computer. Network clients retain control of driver modifications. The client computer handles the print job processing.

1. Click **Start → Settings → Printers and Faxes (Printers** for Windows 2000).
2. Click **Add Printer** to launch the **Add Printer** wizard.
3. Click **Next (Network Print Server** for Windows 2000).
4. Select **A network printer** or **a printer attached to another computer**, and then click **Next** (For Windows 2000, select the network printer from the **Shared printers** list). If the printer is not listed, type in the path of the printer in the text box.  
   For example: `\<server host name>\<shared printer name>`  
   The server host name is the name of the server computer that identifies it to the network. The shared printer name is the name assigned during the server installation process.
5. Click **Browse for a printer**, and then click **Yes** (For Windows 2000, click **OK**).  
   If this is a new printer, you may be prompted to install a printer driver. If no system driver is available, then you will need to provide a path to available drivers.
6. Select whether you want this printer to be the default printer for the client, click **Next**, and then click
Finish (For Windows 2000, click Finish).

7. Print a test page to verify printer installation:
   b. Select the printer you just created.
   c. Click File → Properties.
   d. From the General tab, click Print Test Page (Print a Test Page for Windows 2000).
      When a test page prints successfully, printer installation is complete.

For Windows Vista

1. Click Start → Control Panel → Hardware and Sound → Printers.
2. Click Add a printer to launch the Add Printer wizard.
3. Select Add a network, wireless or Bluetooth printer, and then click Next. If the printer is listed, select the printer and click Next, or select The printer that I want isn’t listed and type in the path of the printer in the Select a shared printer by name text box and click Next.

   For example: \\<server host name>\<shared printer name>

   The server host name is the name of the server computer that identifies it to the network. The shared printer name is the name assigned to the printer during the server installation process.

4. If this is a new printer, you may be prompted to install a printer driver. If no system driver is available, then you will need to provide a path to available drivers.
5. Select whether you want this printer to be the default printer for the client, click Next.
6. If you want to the verify printer driver installation then click Print a test page.
7. Click Finish.
Understanding Fonts

- Typefaces and fonts
- Bitmapped and Scalable Fonts
- Resident Fonts
- Symbol Sets

Typefaces and fonts

A font is a set of characters and symbols created with a distinct design. The distinct design is called a typeface. The typefaces you select add personality to a document. Well-chosen typefaces make a document easier to read.

The printer has numerous resident fonts in PCL 5/PCL 6 and PostScript 3. See "Resident Fonts" for a listing of all resident fonts.

Weight and style

Typefaces are often available in different weights and styles. These variations modify the original typeface so you can, for example, emphasize important words in text or highlight book titles. The different weights and styles are designed to complement the original typeface.

Weight refers to the thickness of the lines that form the characters. Thicker lines result in darker characters. Some words commonly used to describe the weight of a typeface are bold, medium, light, black, and heavy.

Style refers to other typeface modifications, such as tilt or character width. Italic and oblique are styles where the characters are tilted. Narrow, condensed, and extended are three common styles that modify the character widths.

Some fonts combine several weight and style modifications; for example, Helvetica Narrow Bold Oblique. A group of several weight and style variations of a single typeface is called a typeface family. Most typeface families have four variations: regular, italic (oblique), bold, and bold italic (bold oblique). Some families have more variations, as the following illustration for the Helvetica typeface family shows:
Pitch and Point Size

The size of a font is specified as either a pitch or point size, depending on whether the font is fixed space or proportional.

In fixed space fonts, each character has the same width. Pitch is used to specify the size of fixed space fonts. It is a measure of the number of characters that will print in one horizontal inch of type. For example, all 10-pitch fonts print 10 characters per inch (cpi) and all 12-pitch fonts print 12 cpi:

In proportional (or typographic) fonts, every character can have a different width. Since proportional fonts have characters with different widths, the font size is specified in point size, not pitch. Point size refers to the height of the characters in the font. A point is defined as 1/72 inch. The characters in a font printed at 24 point will be twice as large as the characters in the same font printed at 12 point.

The following illustration shows samples of a font printed in different point sizes:

The point size of a font is defined as the distance from the top of the tallest character in the font to the bottom of the lowest character in the font. Due to the definition of point size, different fonts printed at the same point size may appear quite different in size. This is because there are other font parameters that affect how the font looks. However, the point size of a font is an excellent specification of the relative size of a font. The following examples illustrate two very different proportional fonts at 14 point:
Bitmapped and Scalable Fonts

The printer uses both bitmapped and scalable fonts.

Bitmapped fonts are stored in print memory as predefined patterns of bits that represent a typeface at a specific size, style, and resolution. The following illustration shows an example of a character from a bitmapped font.

Bitmapped fonts are available in different type styles and point sizes as downloadable fonts.

Scalable fonts (also called outline fonts) are stored as computer programs that define the outlines of the characters in the font. Each time you print characters from a scalable font, the printer creates a bitmap of the characters at the point size you choose and saves it temporarily in print memory.

These temporary bitmapped fonts are deleted when you turn off or reset the printer. Scalable fonts provide the flexibility of printing in many different point sizes.

Your printer uses different scalable font formats for downloading fonts to the printer. PCL 5/PCL 6 uses Intellifont and TrueType scalable fonts. PostScript 3 uses Type 1 and TrueType scalable fonts. There are thousands of different scalable fonts available in these different font formats from numerous font suppliers.
If you plan to use many downloadable bitmapped or scalable fonts or if you plan to use many different sizes of scalable fonts, you may need to purchase additional memory for your printer.

### Resident Fonts

Your printer is equipped with resident fonts stored permanently in print memory. Different fonts are available in PCL 5/PCL 6 and PostScript 3. Some of the most popular typefaces, like Courier and Times New (PCL 5/PCL 6)/Times New Roman (PostScript 3), are available for all printer languages.

The following table lists all the fonts resident in your printer. See "Printing a Font Sample List" for instructions on how to print samples of the fonts. You can select the resident fonts from your software program. You can also select the fonts from the operator panel if you are using PCL 5.

<table>
<thead>
<tr>
<th>Resident scalable fonts</th>
<th>PCL 5/PCL 6</th>
<th>PostScript 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>CG Times</td>
<td>Albertus</td>
<td></td>
</tr>
<tr>
<td>CG Times It</td>
<td>Albertus Italic</td>
<td></td>
</tr>
<tr>
<td>CG Times Bd</td>
<td>Albertus Light</td>
<td></td>
</tr>
<tr>
<td>CG Times BdIt</td>
<td>Antique Olive Roman</td>
<td></td>
</tr>
<tr>
<td>Univers Md</td>
<td>Antique Olive Italic</td>
<td></td>
</tr>
<tr>
<td>Univers MdIt</td>
<td>Antique Olive Bold</td>
<td></td>
</tr>
<tr>
<td>Univers Bd</td>
<td>Antique Olive Compact</td>
<td></td>
</tr>
<tr>
<td>Univers BdIt</td>
<td>Apple Chancery</td>
<td></td>
</tr>
<tr>
<td>Univers MdCd</td>
<td>Arial</td>
<td></td>
</tr>
<tr>
<td>Univers MdCdIt</td>
<td>Arial Italic</td>
<td></td>
</tr>
<tr>
<td>Univers BdCd</td>
<td>Arial Bold</td>
<td></td>
</tr>
<tr>
<td>Univers BdCdIt</td>
<td>Arial Bold Italic</td>
<td></td>
</tr>
<tr>
<td>AntiqueOlv</td>
<td>ITC Avant Garde Gothic Book</td>
<td></td>
</tr>
<tr>
<td>AntiqueOlv It</td>
<td>ITC Avant Garde Gothic Book Oblique</td>
<td></td>
</tr>
<tr>
<td>Font Name</td>
<td>Font Name</td>
<td></td>
</tr>
<tr>
<td>--------------</td>
<td>-------------------------------</td>
<td></td>
</tr>
<tr>
<td>AntiqueOlv Bd</td>
<td>ITC AvantGarde Gothic Demi Oblique</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Bodoni Roman</td>
<td></td>
</tr>
<tr>
<td>CG Omega</td>
<td>Bodoni Italic</td>
<td></td>
</tr>
<tr>
<td>CG Omega It</td>
<td>Bodoni Bold</td>
<td></td>
</tr>
<tr>
<td>CG Omega Bd</td>
<td>Bodoni Bold Italic</td>
<td></td>
</tr>
<tr>
<td>CG Omega BdIt</td>
<td>Bodoni Poster</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Bodoni Poster Compressed</td>
<td></td>
</tr>
<tr>
<td>Garamond Antiqua</td>
<td>ITC Bookman Light</td>
<td></td>
</tr>
<tr>
<td>Garamond Krvv</td>
<td>ITC Bookman Light Italic</td>
<td></td>
</tr>
<tr>
<td>Garamond Hlb</td>
<td>ITC Bookman Demi</td>
<td></td>
</tr>
<tr>
<td>Garamond KrvvHlb</td>
<td>ITC Bookman Demi Italic</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Carta</td>
<td></td>
</tr>
<tr>
<td>Courier</td>
<td>Chicago</td>
<td></td>
</tr>
<tr>
<td>Courier It</td>
<td>Clarendon Roman</td>
<td></td>
</tr>
<tr>
<td>Courier Bd</td>
<td>Clarendon Bold</td>
<td></td>
</tr>
<tr>
<td>Courier BdIt</td>
<td>Clarendon Light</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Cooper Black</td>
<td></td>
</tr>
<tr>
<td>LetterGothic</td>
<td>Cooper Black Italic</td>
<td></td>
</tr>
<tr>
<td>LetterGothic It</td>
<td>Cooper Gothic 32BC</td>
<td></td>
</tr>
<tr>
<td>LetterGothic Bd</td>
<td>Cooper Gothic 33BC</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Coronet</td>
<td></td>
</tr>
<tr>
<td>Albertus Md</td>
<td>Courier</td>
<td></td>
</tr>
<tr>
<td>Albertus Xbd</td>
<td>Courier Oblique</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Courier Bold</td>
<td></td>
</tr>
<tr>
<td>Clarendon Cd</td>
<td>Courier Bold Oblique</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Eurostile Medium</td>
<td></td>
</tr>
<tr>
<td>Coronet</td>
<td>Eurostile Bold</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Eurostile Extended No. 2</td>
<td></td>
</tr>
<tr>
<td>Font</td>
<td>Style</td>
<td></td>
</tr>
<tr>
<td>-----------------</td>
<td>----------------------------</td>
<td></td>
</tr>
<tr>
<td>Marigold</td>
<td>Eurostile Bold Extended No. 2</td>
<td></td>
</tr>
<tr>
<td>Arial</td>
<td>Gill Sans</td>
<td></td>
</tr>
<tr>
<td>Arial It</td>
<td>Gill Sans Italic</td>
<td></td>
</tr>
<tr>
<td>Arial Bd</td>
<td>Gill Sans Bold</td>
<td></td>
</tr>
<tr>
<td>Arial BdIt</td>
<td>Gill Sans Bold Italic</td>
<td></td>
</tr>
<tr>
<td>TimesNew</td>
<td>Gill Sans Light Italic</td>
<td></td>
</tr>
<tr>
<td>TimesNew It</td>
<td>Gill Sans Extra Bold</td>
<td></td>
</tr>
<tr>
<td>TimesNew Bd</td>
<td>Gill Sans Condensed</td>
<td></td>
</tr>
<tr>
<td>TimesNew BdIt</td>
<td>Gill Sans Condensed Bold</td>
<td></td>
</tr>
<tr>
<td>Symbol</td>
<td>Goudy Oldstyle</td>
<td></td>
</tr>
<tr>
<td>Symbol</td>
<td>Goudy Oldstyle Italic</td>
<td></td>
</tr>
<tr>
<td>Symbol</td>
<td>Goudy Bold</td>
<td></td>
</tr>
<tr>
<td>Wingdings</td>
<td>Goudy Bold Italic</td>
<td></td>
</tr>
<tr>
<td>Wingdings</td>
<td>Goudy Extra Bold</td>
<td></td>
</tr>
<tr>
<td>Line Printer</td>
<td>Helvetica</td>
<td></td>
</tr>
<tr>
<td>Line Printer</td>
<td>Helvetica Oblique</td>
<td></td>
</tr>
<tr>
<td>Times Roman</td>
<td>Helvetica Bold</td>
<td></td>
</tr>
<tr>
<td>Times It</td>
<td>Helvetica Bold Oblique</td>
<td></td>
</tr>
<tr>
<td>Times Bd</td>
<td>Helvetica Narrow</td>
<td></td>
</tr>
<tr>
<td>Times BdIt</td>
<td>Helvetica Narrow Oblique</td>
<td></td>
</tr>
<tr>
<td>Helvetica</td>
<td>Helvetica Narrow Bold</td>
<td></td>
</tr>
<tr>
<td>Helvetica Ob</td>
<td>Helvetica Narrow Bold Oblique</td>
<td></td>
</tr>
<tr>
<td>Helvetica Ob</td>
<td>Helvetica Condensed</td>
<td></td>
</tr>
<tr>
<td>Helvetica Bd</td>
<td>Helvetica Condensed Oblique</td>
<td></td>
</tr>
<tr>
<td>Helvetica BdOb</td>
<td>Helvetica Condensed Bold</td>
<td></td>
</tr>
<tr>
<td>Helvetica BdOb</td>
<td>Helvetica Condensed Bold Oblique</td>
<td></td>
</tr>
<tr>
<td>Font</td>
<td>Style</td>
<td></td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------</td>
<td></td>
</tr>
<tr>
<td>CourierPS</td>
<td>Hoefler Text</td>
<td></td>
</tr>
<tr>
<td>CourierPS Ob</td>
<td>Hoefler Text Italic</td>
<td></td>
</tr>
<tr>
<td>CourierPS Bd</td>
<td>Hoefler Text Black</td>
<td></td>
</tr>
<tr>
<td>CourierPS BdOb</td>
<td>Hoefler Text Black Italic</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Hoefler Ornaments</td>
<td></td>
</tr>
<tr>
<td>SymbolPS</td>
<td>Joanna</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Joanna Italic</td>
<td></td>
</tr>
<tr>
<td>Palatino Roman</td>
<td>Joanna Bold</td>
<td></td>
</tr>
<tr>
<td>Palatino It</td>
<td>Joanna Bold Italic</td>
<td></td>
</tr>
<tr>
<td>Palatino Bd</td>
<td>Letter Gothic</td>
<td></td>
</tr>
<tr>
<td>Palatino BdIt</td>
<td>Letter Gothic Slanted</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Letter Gothic Bold</td>
<td></td>
</tr>
<tr>
<td>ITCBookman Lt</td>
<td>Letter Gothic Bold Slanted</td>
<td></td>
</tr>
<tr>
<td>ITCBookman LtIt</td>
<td>ITC Lubalin Graph Book</td>
<td></td>
</tr>
<tr>
<td>ITCBookmanDm</td>
<td>ITC Lubalin Graph Book Oblique</td>
<td></td>
</tr>
<tr>
<td>ITCBookmanDm It</td>
<td>ITC Lubalin Graph Demi</td>
<td></td>
</tr>
<tr>
<td></td>
<td>ITC Lubalin Graph Demi Oblique</td>
<td></td>
</tr>
<tr>
<td>HelveticaNr</td>
<td>Marigold</td>
<td></td>
</tr>
<tr>
<td>HelveticaNr Ob</td>
<td>Monaco</td>
<td></td>
</tr>
<tr>
<td>HelveticaNr Bd</td>
<td>ITC Mona Lisa Recut</td>
<td></td>
</tr>
<tr>
<td>HelveticaNr BdOb</td>
<td>New Century Schoolbook Roman</td>
<td></td>
</tr>
<tr>
<td></td>
<td>New Century Schoolbook Italic</td>
<td></td>
</tr>
<tr>
<td>N C Schbk Roman</td>
<td>New Century Schoolbook Bold</td>
<td></td>
</tr>
<tr>
<td>N C Schbk It</td>
<td>New Century Schoolbook Bold Italic</td>
<td></td>
</tr>
<tr>
<td>N C Schbk Bd</td>
<td>NewYork</td>
<td></td>
</tr>
<tr>
<td>N C Schbk BdIt</td>
<td>Optima Roman</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Optima Italic</td>
<td></td>
</tr>
<tr>
<td>ITC A G Go Bk</td>
<td>Optima Bold</td>
<td></td>
</tr>
<tr>
<td>Font Family</td>
<td>Font Style</td>
<td></td>
</tr>
<tr>
<td>--------------------</td>
<td>--------------------------</td>
<td></td>
</tr>
<tr>
<td>ITC A G Go BkOb</td>
<td>Optima Bold Italic</td>
<td></td>
</tr>
<tr>
<td>ITC A G Go Dm</td>
<td>Oxford</td>
<td></td>
</tr>
<tr>
<td>ITC A G Go DmOb</td>
<td>Palatino Roman</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Palatino Italic</td>
<td></td>
</tr>
<tr>
<td>ZapfC MdIt</td>
<td>Palatino Bold</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Palatino Bold Italic</td>
<td></td>
</tr>
<tr>
<td>ZapfDingbats</td>
<td>Stempel Garamond Roman</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Stempel Garamond Italic</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Stempel Garamond Bold</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Stempel Garamond Bold Italic</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Symbol</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Tekton Regular</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Times Roman</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Times Italic</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Times Bold</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Times Bold Italic</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Times New Roman</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Times New Roman Italic</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Times New Roman Bold</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Times New Roman Bold Italic</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Univers 45 Light</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Univers 45 Light Oblique</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Univers 55</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Univers 55 Oblique</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Univers 65 Bold</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Univers 65 Bold Oblique</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Univers 57 Condensed</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Univers 57 Condensed Oblique</td>
<td></td>
</tr>
</tbody>
</table>
A symbol set is the collection of alphabetic and numeric characters, punctuation, and special characters available in the font you select. Symbol sets support the requirements for different languages or specific applications, such as math symbols used for scientific text.

In PCL 5/PCL 6, a symbol set also defines which character will print for each key on the keyboard (or more specifically, for each code point). Some applications require different characters at some code points. To support multiple applications and languages, your printer has 36 symbol sets for the resident PCL 5/PCL 6 fonts.

Symbol Sets for PCL 5/PCL 6

Not all font names support all of the symbol sets listed.
<table>
<thead>
<tr>
<th>Font Style</th>
<th>Code Page 1</th>
<th>Code Page 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Roman 8 (Default)</td>
<td>ISO 8859-1 Latin 1</td>
<td>ISO 8859-2 Latin 2</td>
</tr>
<tr>
<td>ISO 8859-9 Latin 5</td>
<td>ISO 8859-10 Latin 6</td>
<td>PC-8</td>
</tr>
<tr>
<td>PC-8 DN</td>
<td>PC-775 Baltic</td>
<td>PC-850 Multilingual</td>
</tr>
<tr>
<td>PC-852 Latin 2</td>
<td>PC-1004 OS/2</td>
<td>PC Turkish</td>
</tr>
<tr>
<td>Windows 3.1 Latin 1</td>
<td>Windows 3.1 Latin 2</td>
<td>Windows 3.1 Latin 5</td>
</tr>
<tr>
<td>DeskTop</td>
<td>PS Text</td>
<td>MC Text</td>
</tr>
<tr>
<td>Microsoft Publishing</td>
<td>Math 8</td>
<td>PS Math</td>
</tr>
<tr>
<td>Pi Font</td>
<td>Legal</td>
<td>ISO 4 United Kingdom</td>
</tr>
<tr>
<td>ISO 6 ASCII</td>
<td>ISO 11 Swedish::names</td>
<td>ISO 15 Italian</td>
</tr>
<tr>
<td>ISO 17 Spanish</td>
<td>ISO 21 German</td>
<td>ISO 60 Norwegian v1</td>
</tr>
<tr>
<td>ISO 69 French</td>
<td>Windows 3.0 Latin 1</td>
<td>Windows Baltic</td>
</tr>
<tr>
<td>Symbol</td>
<td>Wingdings</td>
<td>ITC ZapfDingbats MS</td>
</tr>
</tbody>
</table>
Understanding Printer Messages

The printer operator panel displays messages describing the current state of the printer and indicates possible printer problems you must resolve. This topic provides a list of all printer messages, explains what they mean, and tells you how to clear the messages.

<table>
<thead>
<tr>
<th>Message</th>
<th>What this message means</th>
<th>What you can do</th>
</tr>
</thead>
<tbody>
<tr>
<td>NNN-NNN Restart Printer Contact Support IfMessageReturns</td>
<td>Error NNN-NNN relates to printer problems.</td>
<td>Turn off the printer, and then on. If this does not solve the problem, contact Dell. See &quot;Contacting Dell&quot; in the Owner's Manual.</td>
</tr>
<tr>
<td>NNN-NNN Restart Printer Reseat Fuser Contact Support</td>
<td>The outer levers on both sides of the fuser unit are not securely locked. Error NNN-NNN relates to printer problems.</td>
<td>Confirm that the outer levers on both sides of the fuser unit are securely locked. If this does not solve the problem, contact Dell. See &quot;Contacting Dell&quot; in the Owner's Manual.</td>
</tr>
<tr>
<td>016-316 Restart Printer Reseat Memory Contact Support</td>
<td>The printer detected an unsupported additional memory module in the memory slot.</td>
<td>Remove the additional memory module. If this does not solve the problem, contact Dell. See &quot;Contacting Dell&quot; in the Owner's Manual.</td>
</tr>
<tr>
<td>Code</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>--------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>016-318</td>
<td>Restart Printer</td>
<td>The additional memory module is not fully inserted into the slot.</td>
</tr>
<tr>
<td>016-340</td>
<td>Restart Printer</td>
<td>A communication error occurred in the network interface card.</td>
</tr>
<tr>
<td>016-330</td>
<td>Restart Printer</td>
<td>A communication card error occurred between the network interface card and control card.</td>
</tr>
</tbody>
</table>
| 016-338 | Restart Printer                | An error occurred in the wireless printer adapter.                         | Turn the printer off and then on. Ensure the following:  
· The wireless printer adapter is securely inserted into the slot on the controller card.  
· Unauthorized USB devices are not used.  
If this does not solve the problem, contact Dell. See "Contacting Dell" in the Owner's Manual. |
| NNN-NNN | Restart Printer                | XXX is not fully inserted. Error NNN-NNN relates to printer problems.       | Confirm that the unit is securely inserted. If this does not solve the problem, contact Dell. See "Contacting Dell" in the Owner's Manual. |
| Paper Jam 077-901 Open Front Cover Remove Paper |                                      | The printer detects a paper jam. XXX and YYY indicates a position that you open. Error NNN-NNN relates to printer problems. | Clear the paper path. When "Reg Cover" appears in XXX, the procedure to remove print media is different depending on whether the duplexer is attached or not. See "Clearing Jams" |
| Paper Jam 077-907 Open Front Cover & Belt Unit Remove Paper |                                      | The printer detects a paper jam. N indicates the tray number. | Pull out the specified tray and clear the paper path. See "Clearing Jams" |
| Paper Jam NNN-NNN Open XXX Open YYY |                                      | The specified print cartridge is either missing or not fully inserted into the printer. XXX is one of the following:  
· Black | Reinsert the specified print cartridge. See "Replacing Print Cartridges" |
<table>
<thead>
<tr>
<th>Error</th>
<th>Description</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Replace Cart.</td>
<td>The print cartridge is low on toner. XXX is one of the following: Black, Cyan, Yellow, Magenta.</td>
<td>Replace the specified print cartridge and install a new one. <strong>NOTE:</strong> If you do not replace the print cartridge, print quality problems may occur. Order a new print cartridge at the website <a href="http://www.dell.com/supplies">www.dell.com/supplies</a> or <a href="http://www.euro.dell.com/supplies">www.euro.dell.com/supplies</a>. See &quot;Replacing Print Cartridges&quot;.</td>
</tr>
<tr>
<td>Error XXX Cart.</td>
<td>The density of the print cartridge is not enough. XXX is one of the following: Yellow Print, Cyan Print, Magenta Print, Black Print.</td>
<td>Confirm that the toner seal is removed from the specified print cartridge and the cartridge is installed correctly. If this does not solve the problem, contact Dell. See &quot;Replacing Print Cartridges&quot;. See &quot;Contact Dell&quot; in the Owner's Manual.</td>
</tr>
<tr>
<td>Close FrontCover</td>
<td>Printer cover is open.</td>
<td>Close the specified cover.</td>
</tr>
<tr>
<td>Load XXX</td>
<td>Incorrect paper size is loaded in the specified tray. XXX indicates the number of the tray or multipurpose feeder. YYY indicates a paper size. Yyy indicates paper quality.</td>
<td>Load the specified paper in the specified trays. See &quot;Loading Print Media in Standard and Optional Trays&quot;</td>
</tr>
<tr>
<td>Out of Memory</td>
<td>The printer memory is full and cannot continue processing the current print job.</td>
<td>Press ✓ to clear the message, cancel the current print job, and conduct the next print job, if any. Press Cancel to cancel the print job. Press Menu to open Stored Print and delete the holding job. To avoid this error in the future, do the following: Delete unnecessary fonts, macros, and other data in printer memory. Install additional printer memory.</td>
</tr>
<tr>
<td>Error Code</td>
<td>Description</td>
<td>Action 1</td>
</tr>
<tr>
<td>------------</td>
<td>-------------</td>
<td>--------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Disk Full</td>
<td>RAM disk memory is full and cannot continue processing the current print job.</td>
<td>Press ✓ to clear the message, cancel the current print job, and conduct the next print job, if any.</td>
</tr>
<tr>
<td>016-980</td>
<td>Job too Large</td>
<td>· Press ✓ to clear the message, cancel the current print job, and conduct the next print job, if any.</td>
</tr>
<tr>
<td>Press ✓</td>
<td></td>
<td>· To avoid this error in the future, do the following: · Reduce the number of print pages such as splitting the print data.</td>
</tr>
<tr>
<td>PDL Request</td>
<td>Error relating to PDL emulation problems occurs.</td>
<td>Press ✓ to clear the message, cancel the current print job, and conduct the next print job, if any.</td>
</tr>
<tr>
<td>016-720</td>
<td></td>
<td>· Press ✓ to clear the message, cancel the current print job, and conduct the next print job, if any.</td>
</tr>
<tr>
<td>Data Violation Press ✓</td>
<td>When the configuration of the printer on the printer driver does not conform to the printer you are using, this message appears.</td>
<td>· Press <strong>Cancel</strong> to cancel the print job.</td>
</tr>
<tr>
<td>Invalid Job</td>
<td></td>
<td></td>
</tr>
<tr>
<td>016-799</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Data Violation Press ✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ready to Print</td>
<td>The printer is in the custom print cartridge mode.</td>
<td>Though some of the print cartridges reach the end of their lives, you can continue printing.</td>
</tr>
<tr>
<td>193-700</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Non-DELL Toner Installed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Over Heat</td>
<td>Since it is abnormally hot inside the printer, printing is paused.</td>
<td>Wait for a while with the printer on until the error disappears.</td>
</tr>
<tr>
<td>042-700</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cooling down Please Wait...</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ready to Print</td>
<td>Since it is abnormally hot inside the printer, the print speed decreases.</td>
<td>Do not start another print job until the warning disappears.</td>
</tr>
<tr>
<td>142-700</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Over Heat Turned Halfmode</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Clearing Jams

Careful selection of appropriate print media and proper loading allow you to avoid most jams. See "Print Media Guidelines" for more information.

- Avoiding Jams
- Identifying the Location of Paper Jams
- Removing Print Jams From the Multipurpose Feeder
- Removing Print Jams From the Standard Tray
- Removing Print Jams From the Fuser
- Removing Print Jams From the Optional Duplexer
- Removing Print Jams From the Optional Feeder

**NOTE:** Before buying large quantities of any print media, Dell recommends trying a sample first.

Avoiding Jams

- Use only recommended print media. See "Print Media Guidelines" for more information.
- See "Loading Print Media in Standard and Optional Trays" and "Loading the Multipurpose Feeder" to load printer media properly.
- Do not overload the print media sources. Make sure the stack print media height does not exceed the maximum height indicated by the load line labels in the trays.
- Do not load wrinkled, creased, damp, or curled print media.
- Flex, fan, and straighten print media before you load it. If a jam occurs with print media, try feeding one sheet at a time through the multipurpose feeder.
- Do not use print media that you have cut or trimmed yourself.
- Do not mix print media sizes, weights, or types in the same print media source.
- Make sure the recommended print side is face up when you insert the print media. However, the recommended print side should be face down when using the multipurpose feeder.
- Keep print media stored in an acceptable environment. For more information, see "Storing Print Media".
- Do not remove the feeding tray during a print job.
- Push all trays in firmly after loading them.
- Make sure all cables that connect to the printer are correctly attached.
- Overtightening the guides may cause jams.
- Wipe the feeder rollers in the trays or multipurpose feeder with a cloth that is slightly dampened with
Identifying the Location of Paper Jams

The following illustration shows where paper jams may occur along the print media path.

---

**CAUTION:** Do not attempt to clear any jams using tools or instruments. This may permanently damage the printer.

<table>
<thead>
<tr>
<th></th>
<th>1 Standard 250-sheet tray</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>2 Optional 550-sheet feeder</td>
</tr>
<tr>
<td></td>
<td>3 Multipurpose feeder</td>
</tr>
<tr>
<td></td>
<td>4 Optional duplexer</td>
</tr>
<tr>
<td></td>
<td>5 Fuser</td>
</tr>
<tr>
<td></td>
<td>6 Front cover</td>
</tr>
</tbody>
</table>
Removing Print Jams From the Multipurpose Feeder

**NOTICE:** To protect the drums of the print cartridges against bright light, close the front cover within 5 minutes. If the front cover remains open for more than 5 minutes, print quality may deteriorate.

**NOTE:** To resolve the error displayed on the operator panel, you must clear all print media from the print media path.

1. Pull the jammed paper out of the multipurpose feeder. If no jammed paper can be found or it is hard to remove the paper, close the multipurpose feeder and go to the next step to remove the jammed paper from the inside of the printer.

2. Remove the 250-sheet tray from the printer, and then pull out the jammed paper remaining inside the printer. If no jammed paper can be found or it is hard to remove the paper, go to the next step to remove the jammed paper from the inside of the printer.

3. Open the front cover by pushing the side button and remove the jammed paper. Then, confirm that
there are no scraps of paper remaining inside the printer.

4. Insert the tray back into the printer, and push until it stops.

5. Open and close the front cover.

---

**Removing Print Jams From the Standard Tray**

- **NOTICE:** To protect the drums of the print cartridges against bright light, close the front cover within 5 minutes. If the front cover remains open for more than 5 minutes, print quality may deteriorate.

- **NOTE:** To resolve the error displayed on the operator panel, you must clear all print media from the print media path.

1. Pull the tray out of the printer until it stops. Hold the tray with both hands, lift the front slightly, and remove it from the printer.
2. Remove all the jammed and/or creased paper from the tray.

3. Pull the jammed paper out carefully to avoid tearing it. If it is still hard to remove the paper, go to the next step to remove the jammed paper from the inside of the printer.
4. Open the front cover by pushing the side button and remove the jammed paper. Then, confirm that there are no scraps of paper remaining inside the printer.

5. Close the front cover.

6. Insert the tray into the printer, and push until it stops.
**CAUTION:** Do not use excessive force on the tray. Doing so could damage the tray or the inside of the printer.

---

**Removing Print Jams From the Fuser**

**NOTICE:** Make sure nothing touches or scratches the surface (black-colored film) of the belt unit. Scratches, dirt, or oil from your hands on the film of the belt unit may reduce print quality.

**NOTICE:** To protect the drums of the print cartridges against bright light, close the front cover within 5 minutes. If the front cover remains open for more than 5 minutes, print quality may deteriorate.

**NOTE:** To resolve the error displayed on the operator panel, you must clear all print media from the print media path.

1. Turn off the printer and wait for 30 minutes.

2. Push the side button and open the front cover.

3. Lift the levers at both ends of the fuser, and remove the jammed paper. If any jammed paper cannot be found, go to the next step.
3. **CAUTION:** The fuser is hot. Do not touch it, doing so may cause burns.

4. Open the cover of the fuser and remove the jammed paper.

5. Close the cover of the fuser and press down the levers at both ends of the fuser.
6. Confirm that there are no scraps of paper remaining inside the printer, and then close the front cover.

---

**Removing Print Jams From the Optional Duplexer**

- **NOTICE:** Make sure nothing touches or scratches the surface (black-colored film) of the belt unit. Scratches, dirt, or oil from your hands on the film of the belt unit may reduce print quality.

- **NOTICE:** To protect the drums of the print cartridges against bright light, close the front cover within 5 minutes. If the front cover remains open for more than 5 minutes, print quality may deteriorate.

- **NOTE:** To resolve the error displayed on the operator panel, you must clear all print media from the print media path.

1. Push the side button and open the front cover.
2. Pull out the jammed paper from the duplexer. If jammed paper cannot be found, go to the next step.

3. Pull up on the belt release levers and rotate the belt unit up as shown in the illustration.

4. Remove the jammed paper and close the belt unit.
Removing Print Jams From the Optional Feeder

**NOTICE:** To protect the drums of the print cartridges against bright light, close the front cover within 5 minutes. If the front cover remains open for more than 5 minutes, print quality may deteriorate.

**NOTE:** To resolve the error displayed on the operator panel, you must clear all print media from the print media path.

1. Pull the tray out of the printer until it stops. Hold the tray with both hands, lift the front slightly, and remove it from the printer.

**NOTE:** Paper in the 550-sheet feeder feeds to the printer from the front of the 250-sheet tray, therefore paper jammed in the 250-sheet tray can block the optional tray module in the printer, preventing you from opening them. Look for the jammed paper sequentially, starting with the optional 550-sheet feeder.
2. Remove all jammed and/or creased paper from the tray.

3. Pull the jammed paper out carefully to avoid tearing it. If it is still hard to remove the paper, go to the next step to remove the jammed paper from the inside of the printer.
4. Open the front cover by pushing the side button and remove the jammed paper. Then, confirm that there are no scraps of paper remaining inside the printer.

5. Close the front cover.
NOTE: If the paper jam message is not cleared after closing the front cover, pull out the 250-sheet tray from the printer and remove the jammed paper.

6. Insert the tray back into the printer, and push until it stops.

CAUTION: Do not use excessive force on the tray. Doing so could damage the tray or the inside of the printer.
Troubleshooting

Troubleshooting Guide

This section consists of the following instructions.

Configuration of your printer instructions

User Settings

- Menu Map
- Setup printing Letter Plain 1 from Multipurpose Feeder
- Setup printing Letter Plain 1 from Tray1
- Setup printing Letter Plain 1 from Tray2
- Setup printing Transparency from Multipurpose Feeder
- Setup printing Envelope from Multipurpose Feeder
- Setup Paper Size
- Setup Paper Type

Configuration

- Parallel Printing
- USB Printing
- Setup Network
- Setup Security

Troubleshooting Instructions

- Diagnostic Menu Map (Customer Mode)
- Testing "Print Quality"
- Testing "Toner Pallet Check" or "Contamination Chk"

Other Problems
The section will help you solve problems with the printer, options, or print quality.

Basic Printer Problems

Some printer problems can be easy to resolve. If a problem occurs with your printer, check each of the following:

- If a message displays on the operator panel, see "Understanding Printer Messages."
- The printer power cable is plugged into the printer and a properly grounded electrical outlet.
- The printer power is on.
- The electrical outlet is not turned off at any switch or breaker.
- Other electrical equipment plugged into the outlet is working.
- All options are properly installed.
- If you have checked all of the above and still have a problem, turn off the printer, wait for 10 seconds, and then turn on the printer. This often fixes the problem.

**NOTICE:** If an error message appears, see "Understanding Printer Messages."
## Display Problems

<table>
<thead>
<tr>
<th>Problem</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operator panel displays only diamonds or is blank.</td>
<td>· Turn off the printer, wait for 10 seconds, and turn on the printer.</td>
</tr>
<tr>
<td></td>
<td>· Self Test Message appears on the operator panel. When the test is</td>
</tr>
<tr>
<td></td>
<td>completed, Ready to Print is displayed.</td>
</tr>
<tr>
<td>Menu settings changed from the operator panel have no effect.</td>
<td>Settings in the software program, the printer driver, or the printer</td>
</tr>
<tr>
<td></td>
<td>utilities are overriding the settings made on the operator panel.</td>
</tr>
<tr>
<td></td>
<td>· Change the menu settings from the printer driver, the printer</td>
</tr>
<tr>
<td></td>
<td>utilities, or the software program instead of the operator panel.</td>
</tr>
</tbody>
</table>

## Printing Problems

<table>
<thead>
<tr>
<th>Problem</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Job did not print or incorrect characters printed.</td>
<td>Make sure Ready to Print appears on the operator panel before you</td>
</tr>
<tr>
<td></td>
<td>send a job to print. Press Menu to return to Ready to Print.</td>
</tr>
<tr>
<td></td>
<td>Make sure print media is loaded in the printer. Press Menu to return to</td>
</tr>
<tr>
<td></td>
<td>Ready to Print.</td>
</tr>
<tr>
<td></td>
<td>Verify the printer is using the correct page-description language (PDL).</td>
</tr>
<tr>
<td></td>
<td>Verify that you are using the correct printer driver.</td>
</tr>
<tr>
<td></td>
<td>Make sure you are using the correct Ethernet, USB, IEEE cable, or</td>
</tr>
<tr>
<td></td>
<td>wireless printer adapter and that it is securely connected to the printer.</td>
</tr>
<tr>
<td></td>
<td>Verify that the correct print media size is selected.</td>
</tr>
<tr>
<td></td>
<td>If using a print spooler, verify that the spooler has not stalled.</td>
</tr>
<tr>
<td></td>
<td>Check the printer interface from the Admin Menu menu. Determine the</td>
</tr>
<tr>
<td></td>
<td>host interface you are using. Print a Panel Settings page to verify</td>
</tr>
<tr>
<td></td>
<td>that the current interface settings are correct.</td>
</tr>
<tr>
<td>Print media misfeeds or multiple feeds occur.</td>
<td>Make sure the print media you are using meets the specifications for</td>
</tr>
<tr>
<td></td>
<td>your printer. See &quot;Print Media Supported&quot; for more information.</td>
</tr>
<tr>
<td></td>
<td>Flex print media before loading it in any of the sources.</td>
</tr>
<tr>
<td></td>
<td>Make sure the print media is loaded correctly.</td>
</tr>
<tr>
<td></td>
<td>Make sure the width and length guides on the print media sources are</td>
</tr>
<tr>
<td></td>
<td>adjusted correctly.</td>
</tr>
<tr>
<td></td>
<td>Do not overfill the print media sources.</td>
</tr>
<tr>
<td></td>
<td>Do not force print media into the multipurpose feeder when you load it;</td>
</tr>
<tr>
<td></td>
<td>otherwise, it may skew or buckle.</td>
</tr>
<tr>
<td></td>
<td>Remove any curled print media from sources.</td>
</tr>
</tbody>
</table>
Load the recommended print side correctly for the type of print media you are using. See "Loading Print Media in Standard and Optional Trays" for more information.

Turn the print media over or around and try printing again to see if feeding improves.

Do not mix print media types.

Do not mix reams of print media.

Remove the top and bottom sheets of a ream before loading the print media.

Load a print media source only when it is empty.

Wipe the feeder rollers in the trays or multipurpose feeder with a cloth that slightly dampened with water.

<table>
<thead>
<tr>
<th>Problem</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Envelope misfeeds or multiple feeds occur.</td>
<td>Reduce the number of envelopes in the stack.</td>
</tr>
<tr>
<td>Page breaks in unexpected places.</td>
<td>Check the <strong>Time-Out</strong> in the <strong>System Settings</strong> menu. Increase the setting.</td>
</tr>
<tr>
<td>Job prints from the wrong source or on the wrong print media.</td>
<td>Check the Paper Type in the <strong>Tray Settings</strong> menu on the printer operator panel and in the printer driver.</td>
</tr>
<tr>
<td>Print media does not stack neatly in the output bin.</td>
<td>Turn the print media stack over in the tray or multipurpose feeder.</td>
</tr>
<tr>
<td>Printer does not duplex pages.</td>
<td>Make sure <strong>2 Sided</strong> is selected in both the PCL (Printer Control Language) menu on the printer operator panel and in the printer driver.</td>
</tr>
</tbody>
</table>

**Print Quality Problems**

<table>
<thead>
<tr>
<th>Problem</th>
<th>Action</th>
</tr>
</thead>
</table>
| Print is too light. | · The print cartridges may be low or need to be replaced. Confirm the amount of toner in each print cartridge and replace it with a new one if necessary.  
· Set the **Toner Saving Mode** check box to off in the **Advanced** tab in the printer driver.  
· If you are printing on an uneven print surface, change the **Paper Type** settings in the **Tray Settings** menu. See "**System Settings**."  
· Verify that the correct print media is being used. |
<table>
<thead>
<tr>
<th>Problem Description</th>
<th>Solution</th>
</tr>
</thead>
</table>
| Toner smears or print comes off page.          | - If you are printing on an uneven print surface, change the Paper Type settings in the Tray Settings menu. See "System Settings".  
|                                                | - Verify that the print media is within the printer specifications.                        |
|                                                | - The fuser is old or damaged. Replace the fuser. See "Replacing the Fuser".               |
| Toner spots appear on the page/printing is blurred. | - Check the print cartridges to make sure they are installed correctly.                    |
|                                                | - Change the print cartridges. See "Replacing Print Cartridges."                          |
| Entire page is white.                          | - Make sure the packaging material is removed from the print cartridges.                    |
|                                                | - Check the print cartridges to make sure they are installed correctly.                    |
|                                                | - The print cartridges may be low or need to be replaced. Confirm the amount of toner in each print cartridge and replace it with a new one if necessary. See "Replacing Print Cartridges." |
| Streaks appear on the page.                    | - The print cartridges may be low or need to be replaced. Confirm the amount                |
of toner in each print cartridge and replace it with a new one if necessary. See "Replacing Print Cartridges."

- If you are using preprinted forms, make sure the media can withstand a temperature of 190 °C (374 °F).

| Characters have jagged or uneven edges. | · Select **On** for **Bitmap Text Smoothing** in the **Advanced** tab in the printer properties dialog box.
- If you are using downloaded fonts, verify that the fonts are supported by the printer, the host computer, and the software program. |

| Part or all of the page prints in black. | · Check the print cartridges to make sure they are installed correctly. |

<p>| The job prints, but the top and side margins are incorrect. | · Make sure the margins are set correctly in your software program. |</p>
<table>
<thead>
<tr>
<th>Issue</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Printing on both ends of the transparencies is faded.</td>
<td>- This occurs when the printer is operating in a location where relative humidity reaches 85% or more. Adjust the humidity or relocate the printer to an appropriate environment.</td>
</tr>
<tr>
<td>Color registration is out of alignment.</td>
<td>- Print the color registration chart and adjust the color registration from the operator panel by using the chart. See &quot;Color Reg Adj&quot; for more details.</td>
</tr>
<tr>
<td>Colored dots are printed at regular intervals.</td>
<td>- Replace the print cartridge that prints the dots with a new one.</td>
</tr>
</tbody>
</table>
Partial blanks, creased paper or blotted printing.

- Condensation inside the printer causes partial blanks or creased paper. Keep the printer turned on and leave it more than one hour to get rid of the condensation. In winter, keep the printer turned on to prevent condensation from forming. In this case, you can reduce power consumption by using the energy-saving mode. If the problems still occur, contact Dell. See "Contacting Dell" in the Owner's Manual.
- This occurs when you print on talc paper or acid paper. Use neutralized paper.

Vertical blanks

- A print cartridge is damaged. Replace the print cartridge with a new one.

Option Problems

If an option does not operate correctly following installation or stops working:
• Turn off the printer, wait for 10 seconds, and then turn on the printer. If this does not fix the problem, unplug the printer, and check the connection between the option and the printer.

• Print the printer settings page to see if the option is listed in the Installed Options list. If the option is not listed, reinstall it. See "Printing a Printer Settings Page."

• Make sure the option is selected in the printer driver you are using.

The following table lists printer options and corrective actions for related problems. If the suggested corrective action does not correct the problem, call customer service.

<table>
<thead>
<tr>
<th>Problem</th>
<th>Action</th>
</tr>
</thead>
</table>
| Optional tray  | • Make sure the 550-sheet feeder is correctly connected to the printer. Reinstall the feeder. See "Removing the Optional 550-Sheet Feeder" and "Installing the Optional 550-Sheet Feeder".  
• Make sure the print media is loaded correctly. See "Loading Print Media in Standard and Optional Trays" for more information. |
| Duplexer       | • Make sure the duplexer is correctly installed. Reinstall the duplexer. See "Removing the Optional Duplexer" and "Installing a Duplexer". |
| Memory card    | • Make sure the memory card is securely connected to the printer system board.            |
| Multi protocol card | • Make sure the card is securely inserted to the correct slot.  
• Make sure you are using the correct card.                               |
| Wireless printer adapter | • Make sure that the wireless printer adapter is securely connected to the multi protocol card. |

Other Problems

<table>
<thead>
<tr>
<th>Problem</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Condensation has occurred inside the printer.</td>
<td>• This usually occurs within several hours after you heat the room in winter. This also occurs when the printer is operating in a location where relative humidity reaches 85% or more. Adjust the humidity or relocate the printer to an appropriate environment.</td>
</tr>
</tbody>
</table>

Contacting Service

When you call for printer service, be prepared to describe the problem you are experiencing or the error message on the display.

You need to know your printer model type and serial number. See the label on the back of the printer near the controller card for this information.
Troubleshooting Guide

Configuration of your printer instructions

User Settings

Menu Map
Setup printing Letter Plain 1 from Multipurpose Feeder

1. On the printer operator panel press **MENU**.
2. Press ▼ to get to Tray Settings.
3. Press ► to select Tray Settings.
4. Press ▼ to get to Paper Size. (ONLY ON 3x00cn)
5. Press ▲ to select Paper Size. (ONLY ON 3x00cn)
6. Press ▼ to get to MPF. (ONLY ON 3x00cn)
7. Press ▲ to select MPF. (ONLY ON 3x00cn)
8. Using ▲ and ▼, select the appropriate paper size (Letter). (ONLY ON 3x00cn)
9. Press the middle button, SELECT, once Letter is displayed on the lower line, this puts a * by it. (ONLY ON 3x00cn)
10. Now we have the MPF Size set to Letter. (ONLY ON 3x00cn)
11. Now press MENU to get back to Tray Settings/Paper Size.
12. Press ▼ to get to Paper Type.
13. Press ▲ to select Paper Type.
14. Press ▼ to get to MPF.
15. Press ▼ to select MPF.
16. Using ▲ and ▼, select the appropriate paper type (Plain 1).
17. Press SELECT, once Plain 1 is displayed on the lower line.
18. Now we have the MPF Type set to Plain 1.
19. Now press MENU to get back to Ready to Print
20. Now insert the Letter-sized stack of paper into the MPF.
21. On the screen MPF/Letter will appear. (ONLY ON 3x00cn)
22. Press SELECT to confirm this. (ONLY ON 3x00cn)
23. Now on the screen MPF/Plain 1 will appear.
24. Press SELECT to confirm this.
25. We now have all the hardware settings on the printer correct

Now, all software settings screen shots are from WORD, this was done in Word 2003. However if in any application, you go File → Print and then click the Properties button, you will get this same driver properties window.

27. Go to File → Print.
28. Select the Dell Color Laser Printer from the printers list
29. Click the Properties button to the right.
30. This brings up Driver Properties.
31. Click on the Paper Tray Tab.
32. Change the Paper Source to MPF.
33. Click the Paper Tab.
34. Select in paper size, Letter.
35. Select for Output Size, Same as Paper Size.
36. Click OK.
37. Click Close.
38. Now the printer driver is setup correctly.
40. Click the Paper Tab.
41. Change Paper Size to Legal.
42. Change the Paper source settings BOTH to "DEFAULT TRAY AS PER PRINTER".
43. Click OK.
44. Type in some gibberish in the body of the document and click Print!

**Setup printing Letter Plain 1 from Tray1**

1. On the printer operator panel press MENU.
2. Press ▼ to get to Tray Settings.
3. Press ► to select Tray Settings.
4. Press ▼ to get to Paper Size. (ONLY ON 3x00cn)
5. Press ► to select Paper Size. (ONLY ON 3x00cn)
6. Press ▼ to get to Tray 1. (ONLY ON 3x00cn)
7. Press ► to select Tray 1. (ONLY ON 3x00cn)
8. Using ▲ and ◀, select the appropriate paper size (Letter). (ONLY ON 3x00cn)
9. Press the middle button, SELECT, once Letter is displayed on the lower line, this puts a * by it. (ONLY ON 3x00cn)
10. Now we have the Tray 1 Size set to Letter. (ONLY ON 3x00cn)
11. Now press MENU to get back to Tray Settings/Paper Size.
12. Press ▼ to get to Paper Type.
13. Press ► to select Paper Type.
14. Press ▼ to get to Tray 1.
15. Press ► to select Tray 1.
16. Using ▲ and ▼, select the appropriate paper type (Plain 1).
17. Press SELECT, once Plain 1 is displayed on the lower line.
18. Now we have the Tray 1 Type set to Plain 1.
19. Now press MENU to get back to Ready to Print.
21. On the screen Tray 1/Letter will appear. (ONLY ON 3x00cn)
22. Press SELECT to confirm this. (ONLY ON 3x00cn)
23. Now on the screen Tray 1/Plain 1 will appear.
24. Press SELECT to confirm this.
25. We now have all the hardware settings on the printer correct.

Now, all software settings screen shots are from WORD, this was done in Word 2003. However if in any application, you go File → Print and then click the Properties button, you will get this same driver properties window.

27. Go to File → Print.
28. Select the Dell Color Laser Printer from the printers list.
29. Click the Properties button to the right.
30. This brings up Driver Properties.
31. Click on the Paper Tray Tab.
32. Change the Paper Source to Tray 1.
33. Click the Paper Tab.
34. Select in paper size, Letter.
35. Select for Output Size, Same as Paper Size.
36. Click OK.
37. Click Close.
36. Now the printer driver is setup correctly.
37. Now go to **File → Page Setup**.
38. Click the **Paper Tab**.
39. Change Paper Size to **Legal**.
40. Change the Paper source settings BOTH to "DEFAULT TRAY AS PER PRINTER".
41. Click **OK**.
42. Type in some gibberish in the body of the document and click **Print**!

**Setup printing Letter Plain 1 from Tray2**

1. On the printer operator panel press **MENU**.
2. Press ▼ to get to **Tray Settings**.
3. Press ► to select **Tray Settings**.
4. Press ▼ to get to **Paper Size**. (ONLY ON 3x00cn)
5. Press ► to select **Paper Size**. (ONLY ON 3x00cn)
6. Press ▼ to get to **Tray 2**. (ONLY ON 3x00cn)
7. Press ► to select **Tray 2**. (ONLY ON 3x00cn)
8. Using ▲ and ▼, select the appropriate paper size (Letter). (ONLY ON 3x00cn)
9. Press the middle button, **SELECT**, once Letter is displayed on the lower line, this puts a * by it. (ONLY ON 3x00cn)
10. Now we have the **Tray 2 Size set to Letter**. (ONLY ON 3x00cn)
11. Now press **MENU** to get back to **Tray Settings/Paper Size**.
12. Press ▼ to get to **Paper Type**.
13. Press ► to select **Paper Type**.
14. Press ▼ to get to **Tray 2**.
15. Press ▼ to select **Tray 2**.
16. Using ▲ and ▼, select the appropriate paper type (Plain 1).
17. Press **SELECT**, once Plain 1 is displayed on the lower line.
18. Now we have the **Tray 2 Type set to Plain 1**.
19. Now press **MENU** to get back to **Ready to Print**.
21. On the screen Tray 2/Letter will appear. (ONLY ON 3x00cn)
22. Press SELECT to confirm this. (ONLY ON 3x00cn)
23. Now on the screen Tray 2/Plain 1 will appear.
24. Press SELECT to confirm this.
25. We now have all the hardware settings on the printer correct.

Now, all software settings screen shots are from WORD, this was done in Word 2003. However if in any application, you go File → Print and then click the Properties button, you will get this same driver properties window.

27. Go to File → Print.
28. Select the Dell Color Laser Printer from the printers list.
29. Click the Properties button to the right.
30. This brings up Driver Properties.
31. Click on the Paper Tray Tab.
32. Change the Paper Source to Tray 2.
33. Click the Paper Tab.
34. Select in paper size, Letter.
35. Select for Output Size, Same as Paper Size.
36. Click OK.
37. Click Close.
38. Now the printer driver is setup correctly.
40. Click the Paper Tab.
41. Change Paper Size to Legal.
42. Change the Paper source settings BOTH to "DEFAULT TRAY AS PER PRINTER".
43. Click OK.
44. Type in some gibberish in the body of the document and click Print!
**Setup printing Transparency from Multipurpose Feeder**

1. On the printer operator panel press **MENU**.
2. Press ▼ to get to Tray Settings.
3. Press ► to select Tray Settings.
4. Press ▼ to get to Paper Size. (ONLY ON 3x00cn)
5. Press ► to select Paper Size. (ONLY ON 3x00cn)
6. Press ▼ to get to MPF. (ONLY ON 3x00cn)
7. Press ► to select MPF. (ONLY ON 3x00cn)
8. Using ▲ and ▼, select the appropriate paper size (Transparency). (ONLY ON 3x00cn)
9. Press the middle button, **SELECT**, once Transparency is displayed on the lower line, this puts a * by it. (ONLY ON 3x00cn)
10. Now we have the MPF Size set to Transparency. (ONLY ON 3x00cn)
11. Now press **MENU** to get back to Tray Settings/Paper Size.
12. Press ▼ to get to Paper Type.
13. Press ► to select Paper Type.
14. Press ▼ to get to MPF.
15. Press ► to select MPF.
16. Using ▲ and ▼, select the appropriate paper type (Transparency).
17. Press **SELECT**, once Transparency is displayed on the lower line.
18. Now we have the MPF Type set to Transparency.
19. Now press **MENU** to get back to Ready to Print
20. Now insert the Transparency-sized stack of paper into the MPF.
21. On the screen MPF/Transparency will appear. (ONLY ON 3x00cn)
22. Press **SELECT** to confirm this. (ONLY ON 3x00cn)
24. Press **SELECT** to confirm this.
25. We now have all the hardware settings on the printer correct

Now, all software settings screen shots are from WORD, this was done in Word 2003. However if in any
application, you go **File** → **Print** and then click the **Properties** button, you will get this same driver properties window.

27. Go to **File** → **Print**.
28. Select the Dell Color Laser Printer from the printers list.
29. Click the **Properties** button to the right.
30. This brings up Driver Properties.
31. Click on the **Paper** Tray Tab.
32. Change the Paper Source to **MPF**.
33. Click the **Paper** Tab.
34. Select in **paper size**, **Transparency**.
35. Select for **Output Size**, **Same as Paper Size**.
36. Click **OK**.
37. Click **Close**.
38. Now the printer driver is setup correctly.
39. Now go to **File** → **Page Setup**.
40. Click the **Paper** Tab.
41. Change **Paper Size** to **Legal**.
42. Change the Paper source settings BOTH to "DEFAULT TRAY AS PER PRINTER".
43. Click **OK**.
44. Type in some gibberish in the body of the document and click **Print!**

**Setup printing Envelope from Multipurpose Feeder**

1. On the printer operator panel press **MENU**.
2. Press ▼ to get to **Tray Settings**.
3. Press ► to select **Tray Settings**.
4. Press ▼ to get to **Paper Size**. (ONLY ON 3x00cn)
5. Press ► to select **Paper Size**. (ONLY ON 3x00cn)
6. Press ▼ to get to **MPF**. (ONLY ON 3x00cn)
7. Press ▶ to select MPF. (ONLY ON 3x00cn)

8. Using ▲ and ▼, select the appropriate paper size (Envelope). (ONLY ON 3x00cn)

9. Press the middle button, SELECT, once Envelope is displayed on the lower line, this puts a * by it. (ONLY ON 3x00cn)

10. Now we have the MPF Size set to Envelope. (ONLY ON 3x00cn)

11. Now press MENU to get back to Tray Settings/Paper Size.

12. Press ▼ to get to Paper Type.

13. Press ▶ to select Paper Type.

14. Press ▼ to get to MPF.

15. Press ▼ to select MPF.

16. Using ▲ and ▼, select the appropriate paper type (Envelope).

17. Press SELECT, once Envelope is displayed on the lower line.

18. Now we have the MPF Type set to Envelope.

19. Now press MENU to get back to Ready to Print.

20. Now insert the Envelope-sized stack of paper into the MPF.

21. On the screen MPF/Envelope will appear. (ONLY ON 3x00cn)

22. Press SELECT to confirm this. (ONLY ON 3x00cn)

23. Now on the screen MPF/Envelope will appear.

24. Press SELECT to confirm this.

25. We now have all the hardware settings on the printer correct.

Now, all software settings screen shots are from WORD, this was done in Word 2003. However if in any application, you go File → Print and then click the Properties button, you will get this same driver properties window.


27. Go to File → Print.

28. Select the Dell Color Laser Printer from the printers list.

29. Click the Properties button to the right.

30. This brings up Driver Properties.

31. Click on the Paper Tray Tab.
32. Change the Paper Source to **MPF**.
33. **Click the Paper Tab.**
34. **Select in paper size, Transparency.**
35. **Select for Output Size, Same as Paper Size.**
36. **Click OK.**
37. **Click Close.**
38. Now the printer driver is setup correctly.
39. **Now go to File -> Page Setup.**
40. **Click the Paper Tab.**
41. Change Paper Size to Legal.
42. **Change the Paper source settings BOTH to "DEFAULT TRAY AS PER PRINTER".**
43. **Click OK.**
44. Type in some gibberish in the body of the document and click Print!

**Setup Paper Size**

1. Start Here
2. On the printer press **MENU.**
3. Press ▼ to get to Tray Settings.
4. Press ► to select Tray Settings.
5. Press ▼ to get to Paper Size.
7. Press ▼ to get to MPF.
8. Press ► to select MPF.
9. Using ▲ and ▼, select the appropriate paper size (Letter).
10. Press the middle button, **SELECT**, once Letter is displayed on the lower line, this puts a * by it.
11. Now we have the MPF Size set to Letter.
12. Now press **MENU** to get back to Tray Settings/Paper Size.
13. Press ▼ to get to Paper Type.
14. Press ► to select Paper Type.
15. Press ▼ to get to MPF.
16. Press ▼ to select MPF.
17. Using ▲ and ▼, select the appropriate paper type (Plain 1).
18. Press SELECT, once Plain 1 is displayed on the lower line.
19. Now we have the MPF Type set to Plain 1.
20. Now press MENU to get back to Ready to Print.
21. Now insert the Letter-sized stack of paper into the MPF.
23. Press SELECT to confirm this.
24. Now on the screen MPF/Plain 1 will appear.
25. Press SELECT to confirm this.
26. We now have all the hardware settings on the printer correct.

Now, all software settings screen shots are from WORD, this was done in Word 2003. However if in any application, you go File → Print and then click the Properties button, you will get this same driver properties window.

27. Open up Word and create a new document.
28. Go to File → Print.
29. Select the Dell Color Laser Printer from the printers list.
30. Click the Properties button to the right.
31. This brings up Driver Properties.
32. Click on the Paper Tray Tab.
33. Change the Paper Source to MPF.
34. Click the MPF Settings button.
35. Select Plain 1 from the list of paper types.
36. Click OK.
37. Now click the Paper Tab.
38. Select in paper size, Letter.
39. Select for Output Size, Same as Paper Size.
40. Click OK.
41. Click **Close**.

**Setup Paper Type**

<table>
<thead>
<tr>
<th>Paper type</th>
<th>Weight (gsm)</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain</td>
<td>60-80</td>
<td>-</td>
</tr>
<tr>
<td>Plain Thick</td>
<td>81-105</td>
<td>-</td>
</tr>
<tr>
<td>Covers</td>
<td>106-163</td>
<td>-</td>
</tr>
<tr>
<td>Covers Thick</td>
<td>164-216</td>
<td>-</td>
</tr>
<tr>
<td>Coated</td>
<td>106-163</td>
<td>Inkjet Printer paper cannot be used.</td>
</tr>
<tr>
<td>Coated Thick</td>
<td>164-216</td>
<td>Inkjet Printer paper cannot be used.</td>
</tr>
<tr>
<td>Transparency</td>
<td>-</td>
<td>Inkjet Printer paper cannot be used.</td>
</tr>
<tr>
<td>Label</td>
<td>-</td>
<td>Inkjet Printer paper cannot be used.</td>
</tr>
<tr>
<td>Envelopes</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>

**Configuration**

**Parallel Printing**

A local printer is a printer attached to your computer or a print server using a USB or parallel cable. If your printer is attached to a network and not your computer, see "Setting Up Network Printing" in the **Owner's Manual**.

**Installing Printer Drivers**

**Microsoft® Windows Vista™**

1. Insert the **Drivers and Utilities** CD into your computer.

   **NOTE:** Click **Continue** when the **User Account Control** dialog box appears.

2. Click **Personal Installation**.

3. Connect your printer to your computer.
At this point, Plug and Play is activate automatically and installs the printer. If the Plug and Play is not activate, click Install.

When the Plug and Play is complete, the Installation goes to the next step automatically.

4. Select either the Typical Installation or Custom Installation radio button, and then click Next. If you select Custom Installation, you can select the specific software you want to install.

5. When the Congratulations! screen appears, click Print Test Page if necessary. Click Finish.


1. Connect the printer to your computer with a USB cable or a parallel cable. Then, turn on the printer.

2. When the Found New Hardware Wizard dialog box appears, click Cancel.

3. Insert the drivers and utilities CD into your computer to launch the installation software.

NOTE: If the CD does not automatically launch, click Start -> Run, and then type D:\setup.exe (where D is the drive letter of your CD), and then click OK.

4. Select Personal Installation, and then click Next.

5. Click Install.

6. When the Found New Hardware Wizard dialog box appears, follow the on-screen instructions to install the printer driver on your computer.

7. When the Completing the Found New Hardware Wizard dialog box appears, click Finish.

8. Select either Typical Installation or Custom Installation from the installation wizard, and then click Install. If you select Custom Installation, you can select the specific software you want to install.

9. Click Finish to exit the wizard when the Congratulations! screen appears. If necessary, click Print Test Page to print a test page.

Windows NT® 4.0

1. Connect the printer to your computer with a parallel cable. Then, turn on the printer.

2. Insert the drivers and utilities CD into your computer.

3. Select Personal Installation, and then click Next.

4. On the Add Printer screen, select the port name from the Port Name combo box, and then set the printer’s options under Printer Configuration. Then, click Next.

5. Select either Typical Installation or Custom Installation from the installation wizard, and then click
Install. If you select Custom Installation, you can select the specific software you want to install.

6. The Adobe License Agreement appears, click to accept the agreement and then click Install.

7. Click Finish to exit the wizard when the Congratulations! screen appears.

**USB Printing**

A local printer is a printer attached to your computer or a print server using a USB or parallel cable. If your printer is attached to a network and not your computer, see "Setting Up Network Printing" in the Owner's Manual.

**Setup Network**

- **NOTE:** To use this printer in a UNIX or Linux environment, you need to install a UX Filter or Linux Driver. For more information on how to install and use these, refer to your User's Guide.
- **NOTE:** When using a CD drive in a Linux environment, you need to mount the CD according to your system environment. The command strings are mount/media/cdrom.
- **NOTE:** For additional network set-up configurations, refer to your User's Guide.

**Disable Microsoft® Windows Vista or Windows XP Firewall Before Printer Software Installation**

- **NOTE:** This step may not be necessary if you have Windows XP Service Pack 2 installed.

If your multifunction printer is connected directly to a network and the built-in operating system firewall is enabled, you cannot view your networked printer(s) when you run the Dell™ printer installation software. To prevent this situation, disable the built-in operating system firewall before you install the Dell printer software. To disable or enable your built-in operating system firewall, perform the following steps:

- **NOTICE:** Dell recommends that you enable your built-in operating system firewall after you install the printer software. Enabling the built-in operating system firewall after you install the printer software does not limit the use of your network printer.

1. Click the Start button and click Help and Support.
2. In the Search box, type firewall and then click the green arrow.
3. In the Pick a Task list, click Enable or disable Internet Connection Firewall and then follow the instructions on the screen.

**Print and Check the Printer Settings Page**

1. Print the Printer Settings page.
   a. When Ready to Print appears in the LCD, press Menu.
b. Report/List appears. Press ✓.

c. Printer Settings is displayed. Press ✓.

The Printer Settings page is printed.

2. Under the TCP/IP heading, verify the IP address.

If the IP address is 0.0.0.0, wait for a few minutes to resolve the IP address automatically, and then print the Printer Settings page again.

**Printer Setup**

**NOTE:** When you use IPv6 Mode for network printing, you cannot install the printer driver from the Drivers and Utilities CD. Use the Add Printer wizard in Windows Vista. For details, see "Printing With Web Services for Devices (WSD)" in the User's Guide.

1. Insert the Drivers and Utilities CD into your computer to launch the installation software.

**NOTE:** If the CD does not automatically launch, click Start → Run, and then type D:\setup.exe (where D is the drive letter of your CD), and then click OK.

**NOTE:** For Windows Vista, click Continue when the User Account Control dialog box appears.

2. Select Network Installation, and then click Next.

3. Select Configure New Wired Printer, or Install Driver and Software for existing network printer, and then click Next.

4. For local installation, select Local Installation, and then click Next.

   For remote installation:
   a. Select Remote Installation, and then click Next.

   **NOTE:** Remote installation between Windows NT and the following operating systems is not supported.
   - Windows XP Professional x64 Edition
   - Windows Server 2003 x64 Edition
   - Windows Vista
   - Windows Vista x64

   **NOTE:** Installation on Windows XP Home Edition, Windows Vista Home Basic, Windows Vista Home Premium, Windows Vista x64 Home Basic, and Windows Vista x64 Home Premium is not supported.

   b. Enter the computer name, user ID, and password. Then, click Add.
c. Click **Next**.

5. Select the printer you want to install from the printer list, and then click **Next**. If the target printer is not displayed on the list, click **Update** to refresh the list or click **Add Printer** to add a printer to the list manually. You may specify the IP address and port name at this point. If you have installed this printer on the server computer, select the **I am setting up this printer on a server** check box.

**NOTE:** When using AutoIP, `0.0.0.0` is displayed in the installer. Before you can continue, you must enter a valid IP address.

6. Specify the printer settings, and then click **Next**.
   
a. Enter the printer name.
   
b. If you want other users on the network to access this printer, select **Share this printer with other computers on the network**, and then enter a share name that users will easily identify.
   
c. If you want to set a printer as the default, select the **Set this printer as default** check box.
   
d. If you want to restrict color printing, select the appropriate **Dell ColorTrack** option. Enter the password when **Color-Password Enabled** is selected for **Dell ColorTrack**.
   
e. If the postscript driver is available and you want to install it, select the **PostScript Driver** check box.

7. Select the software and documentation you want to install, and then click **Next**. You can specify folders in which to install the Dell software and documentation. To change the folders, click **Browser**.

8. If the Adobe license agreement screen appears, click to accept the agreement and then click **Install**.

9. Click **Finish** to exit the wizard when the Congratulations! screen appears. If necessary, click **Print Test Page** to print a test page.

Use the **Dell Printer Configuration Web Tool** to monitor the status of your network printer without leaving your desk. You can view and/or change the printer configuration settings, monitor toner level, and when it is time to order replacement consumables, just click the Dell supplies link right from your Web browser.

**NOTE:** The **Dell Printer Configuration Web Tool** is not available when the printer is locally attached to a computer or a print server.

To launch the **Dell Printer Configuration Web Tool**, type the network printer IP address in your Web browser, and the printer configuration appears on the screen. Refer to your **User’s Guide** for more information.

You can set up the **Dell Printer Configuration Web Tool** to send you an email when the printer needs supplies or intervention.

To set up e-mail alerts:
1. Launch the **Dell Printer Configuration Web Tool**.

2. Click **E-Mail Alert** link.

3. Under **Setup E-Mail Lists and Alerts**, enter the Primary SMTP Gateway, the Reply Address, and enter your email address or the key operator’s email address in the email list box.

4. Click **Apply New Settings**.

**NOTE:** The SMTP server will display **Connection in Progress** until an error occurs.

### Determining the Wireless Network Settings

You need to know the settings for the wireless network to set up the wireless printer. For details of the settings, contact your network administrator.

<table>
<thead>
<tr>
<th>Wireless Settings</th>
<th>SSID</th>
<th>Specifies the name that identifies the wireless network. Up to 32 alphanumeric characters.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Network Type</td>
<td>Specifies the network type from Ad-hoc or Infrastructure.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Security Settings</th>
<th>Security</th>
<th>Selects the security method from No security, WEP, WPA-PSK TKIP and WPA-PSK AES.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Transmit Key</td>
<td>Specifies the transmit key from the list.</td>
</tr>
<tr>
<td></td>
<td>WEP Key</td>
<td>Specified the WEP key set used through the wireless network only when WEP is selected for Security.</td>
</tr>
<tr>
<td></td>
<td>Pass Phrase</td>
<td>Specifies the pass phrase of alphanumeric characters from 8 to 63 bytes long only when WPA-PSK is selected for Encryption.</td>
</tr>
</tbody>
</table>

**NOTE:** To set WPA2-PSK as security, select WPA-PSK AES.

### Wireless Installation using USB connection

**NOTE:** The optional multi protocol card with the Wireless Printer Adapter attached must be installed on the printer.

**Scene 1. Install a printer to the already-operating wireless network (When wireless setting is already set to your computer)**

1. Insert the **Drivers and Utilities** CD into your computer.

2. The **Drivers and Utilities** CD should launch the installation software automatically. If the CD does not automatically launch, click **Start → Run**, type `D:\Setup.exe` (where D is the drive letter of your CD), and then click **OK**.
**NOTE:** For Windows Vista, click **Continue** when the **User Account Control** dialog box appears.

3. Select the **Network Installation** option button, and then click **Next**.

4. Select the **Configure Wireless Printer using a USB connection (Recommended)** option button, and then click **Next**.

5. Reset the wireless setting of the printer following the steps on the **Reset Wireless Setting** screen.

6. In the list on the **Select Printer** screen, check the check box of the target printer that you are making wireless setting for, and then click **Next**. On the **Enter Wireless Network Settings** screen, set each wireless setting item, and then click **Next**. When you select the **Fixed IP** option button for **IP Address assignment**, click **Change...** and enter the IP address and subnet mask on the screen.

**NOTE:** When you enter a fixed IP address, avoid the "169.254.xxx.xxx" address used by AutoIP.

7. Set each item on the **Enter Printer Settings** screen, and then click **Next**.

8. On the **Printer Software** screen, specify the software that you want to install and installation path, and then click **Next**. At this point, the wireless setting specified on the **Enter Wireless Network Settings** screen is sent to the printer.

9. On the **Wireless configuration is now complete** screen, click **Next**. Since wireless setting is already made to your computer, no operation is necessary on this screen.

10. On the **Setting-Ready Printer** screen, verify that the correct IP address is assigned to the printer to which the wireless setting is set, and then click **Install**.

**NOTE:** If your system has any of the following operating systems:
- Windows XP x64
- Windows Server® 2003 x64
- Windows Vista x64
- Windows Vista x86

,skip step 11 and go to step 12.

11. If you select the **I am setting up this printer on a server** check box on the **Select Printer** screen and also select the **PostScript Driver** check box on the **Enter Printer Settings** screen, the **Adobe Systems Inc. License Agreement** screen appears. Select the **I accept the terms of the license agreement** option button, and then click **Install**.

12. On the **Congratulations!** screen, click **Finish** to complete the installation. A test page will be printed with the installed printer by clicking the **Print Test Page** button.

---

**Scene 2. Construct new wireless network environment for both computer and printer (When wireless setting needs to be set to your computer)**

1. Insert the **Drivers and Utilities** CD into your computer.

2. The **Drivers and Utilities** CD should launch the installation software automatically.
If the CD does not automatically launch, click Start → Run, type D:\Setup.exe (where D is the drive letter of your CD), and then click OK.

**NOTE:** For Windows Vista, click Continue when the User Account Control dialog box appears.

3. Select the **Network Installation** option button, and then click **Next**.

4. Select the **Configure Wireless Printer using a USB connection (Recommended)** option button, and then click **Next**.

5. Reset the wireless setting of the printer following the steps on the **Reset Wireless Setting** screen.

6. In the list on the **Select Printer** screen, check the check box of the target printer that you are making wireless setting for, and then click **Next**.

**NOTE:** When you enter a fixed IP address, avoid the "169.254.x.x" address used by AutoIP.

7. On the **Enter Wireless Network Settings** screen, set each wireless setting item, and then click **Next**. When you select the **Fixed IP** option button for **IP Address assignment**, click **Change...** and enter the IP address and subnet mask on the screen.

8. Set each item on the **Enter Printer Settings** screen, and then click **Next**.

9. On the **Printer Software** screen, specify the software that you want to install and installation path, and then click **Next**. At this point, the wireless setting specified on the **Enter Wireless Network Settings** screen is sent to the printer.

10. On the **Wireless configuration is now complete** screen, create the wireless setting sent to the printer on your computer following the steps below, and then click **Next**.

**NOTE:** If your computer provides a wireless LAN adapter tool, change the wireless settings using this tool. Or you can change the wireless settings using the tool provided by the operating system. See the instructions below.

**For Windows XP and Windows Server 2003:**

a. Select **Network Connections** from Control Panel.

b. Right-click **Wireless Network Connection** and select **Properties**.

c. Select the **Wireless Network** tab.

d. Make sure the check box for **Use Windows to configure my wireless network settings** is checked.

e. Click **Advanced**.

f. Do either of the following:

**When wireless ad-hoc mode is set to the printer:**
Select **Computer to Computer (ad hoc) networks only** and close the **Advanced** dialog box.
When wireless infrastructure mode is set to the printer:
Select Access point (Infrastructure) networks only and close the Advanced dialog box.

- g. Click Add to display Wireless network properties.
- h. Enter the setting that you send to the printer and click OK.
- i. Click Move up to move the setting to the top of the list.
- j. Click OK to close the Property dialog box.

For Windows Vista:

- a. Open Control Panel.

- b. Select Network and Internet.
- c. Select Network and Sharing Center.
- d. Select Connect to a network.
- e. Select the setting you send to the printer from the network items listed in Connect to a network.
- f. Select Connect Anyway in the warning dialog box indicating you are entering an unsecured area.
- g. Click Close in the dialog box after confirming the connection is a success.

11. On the Setting-Ready Printer screen, verify that the correct IP address is assigned to the printer to which the wireless setting is set, and then click Install.

NOTE: If your system has any of the following operating systems:
- Windows XP x64
- Windows Server® 2003 x64
- Windows Vista x64
- Windows Vista x86
skip step 12 and go to step 13.

12. If you select the I am setting up this printer on a server check box on the Select Printer screen and also select the PostScript Driver check box on the Enter Printer Settings screen, the Adobe Systems Inc. License Agreement screen appears. Select the I accept the terms of the license agreement option button, and then click Install.

13. On the Congratulations! screen, click Finish to complete the installation. A test page will be printed with the installed printer by clicking the Print Test Page button.

Use the Dell Printer Configuration Web Tool to monitor the status of your network printer without leaving your desk. You can view and/or change the printer configuration settings, monitor toner level, and when it is time to order replacement consumables, just click the Dell supplies link right from your Web
NOTE: The Dell Printer Configuration Web Tool is not available when the printer is locally attached to a computer or a print server.

**Wireless Installation using wireless connection**

**Scene 1. Install a printer to the already-operating wireless network (When wireless setting is already set to your computer)**

1. Insert the *Drivers and Utilities* CD into your computer to launch the installation software.

   **NOTE:** If the CD does not automatically launch, click **Start → Run**, and then type `D:\setup.exe` (where D is the drive letter of your CD), and then click **OK**.

   **NOTE:** For Windows Vista, click **Continue** when the **User Account Control** dialog box appears.

2. Select the **Network Installation** option button, and then click **Next**.

3. Select the **Configure Wireless Printer using a wireless connection (Advanced)** option button, and then click **Next**.

4. Reset the wireless setting of the printer following the steps on the **Reset Wireless Setting** screen.

5. Create the wireless setting of your computer following the steps shown on the **Enable Communication with Printer** screen, and then click **Next**.

   **NOTE:** If your computer provides a wireless LAN adapter tool, change the wireless settings using this tool. Or you can change the wireless settings using the tool provided by the operating system. See the instructions below.

   The steps are as follows.

   **For Windows XP and Windows Server 2003:**
   
   a. Select **Network Connections** from Control Panel.
   
   b. Right-click **Wireless Network Connection** and select **Properties**.
   
   c. Select the **Wireless Networks** tab.
   
   d. Make sure the check box for **Use Windows to configure my wireless network settings** is checked.

   **NOTE:** Be sure to write down the current wireless computer settings in steps d and f so that you can restore them later.

   e. Click the **Advanced** button.
   
   f. Select **Computer to Computer (ad hoc) networks only** and close the **Advanced** dialog box.
g. Click the **Add** button to display Wireless network properties.

h. Under the Association tab, enter the following information and click **OK**.

Network name (SSID): dell_device
Network Authentication: Open
Data encryption: Disabled
Ad hoc network: checked

i. Click the **Move up** button to move the newly added SSID to the top of the list.

j. Click **OK** to close the **Property** dialog box.

**For Windows Vista:**

a. Open **Control Panel**.

b. Select **Network and Internet**.

c. Select **Network and Sharing Center**.

d. Select **Connect to a network**.

e. Select **dell_device** from the network items listed in **Connect to a network**.

f. Select **Connect Anyway** in the warning dialog box indicating you are entering an unsecured area.

g. Click **Close** in the dialog box after confirming the connection is a success.

6. On the **Enter Wireless Network Settings** screen, set each wireless setting item, and then click **Next**.

7. When you select the **Fixed IP** option button for **IP Address assignment**, click **Change...** and enter the IP address and subnet mask on the screen.

**NOTE:** When you enter a fixed IP address, avoid the "169.254.xxx.xxx" address used by AutoIP.

8. Set each item on the **Enter Printer Settings** screen, and then click **Next**.

9. On the **Printer Software** screen, specify the software that you want to install and installation path, and then click **Next**. At this point, the wireless setting specified on the **Enter Wireless Network Settings** screen is sent to the printer.

10. On the **Wireless configuration is now complete** screen, change the wireless setting of your computer to the same as that sent to the printer, and then click **Next**.
**NOTE:** If your computer provides a wireless LAN adapter tool, change the wireless settings using this tool. Or you can change the wireless settings using the tool provided by the operating system. See the instructions below.

**For Windows XP and Windows Server 2003:**

a. Select **Network Connections** from Control Panel.

b. Right-click **Wireless Network Connection** and select **Properties**.

c. Select the **Wireless Network** tab.

d. Click **Advanced**.

e. Do either of the following:

**When wireless ad-hoc mode is set to the printer:**
Select **Computer to Computer (ad hoc) networks only** and close the **Advanced** dialog box.

**When wireless infrastructure mode is set to the printer:**
Select **Access point (Infrastructure) networks only** and close the **Advanced** dialog box.

f. Select the setting that you send to the printer in the list in **Preferred Network** group.

g. Click **Move up** to move the setting to the top of the list.

h. Click **OK** to close the **Property** dialog box.

**For Windows Vista:**

a. Open **Control Panel**.

b. Select **Network and Internet**.

c. Select **Network and Sharing Center**.

d. Select **Connect to a network**.

e. Select the original setting from the network items listed in **Connect to a network**, and then click **Connect**.

11. On the **Setting-Ready Printer** screen, verify that the correct IP address is assigned to the printer to which the wireless setting is set, and then click **Install**.
NOTE: If your system has any of the following operating systems:
Windows XP x64
Windows Server® 2003 x64
Windows Vista x64
Windows Vista x86
skip step 12 and go to step 13.

12. If you select the I am setting up this printer on a server check box on the Select Printer screen and also select the PostScript Driver check box on the Enter Printer Settings screen, the Adobe Systems Inc. License Agreement screen appears. Select the I accept the terms of the license agreement option button, and then click Install.

13. On the Congratulations! screen, click Finish to complete the installation. A test page will be printed with the installed printer by clicking the Print Test Page button.

Scene 2. Construct new wireless network environment for both computer and printer (When wireless setting needs to be set to your computer)

1. Insert the Drivers and Utilities CD into your computer to launch the installation software.

NOTE: If the CD does not automatically launch, click Start → Run, and then type D:\setup.exe (where D is the drive letter of your CD), and then click OK.

NOTE: For Windows Vista, click Continue when the User Account Control dialog box appears.

2. Select the Network Installation option button, and then click Next.

3. Select the Configure Wireless Printer using a wireless connection (Advanced) option button, and then click Next.

4. Reset the wireless setting of the printer following the steps on the Reset Wireless Setting screen.

5. Create the wireless setting of your computer following the steps shown on the Enable Communication with Printer screen, and then click Next. The steps are as follows.

NOTE: If your computer provides a wireless LAN adapter tool, change the wireless settings using this tool. Or you can change the wireless settings using the tool provided by the operating system. See the instructions below.

For Windows XP and Windows Server 2003:

a. Select Network Connections from Control Panel.

b. Right-click Wireless Network Connection and select Properties.

c. Select the Wireless Networks tab.

d. Make sure the check box for Use Windows to configure my wireless network settings is
NOTE: Be sure to write down the current wireless computer settings in steps d and f so that you can restore them later.

e. Click the Advanced button.
f. Select Computer to Computer (ad hoc) networks only and close the Advanced dialog box.
g. Click the Add button to display Wireless network properties.
h. Under the Association tab, enter the following information and click OK.

Network name (SSID): dell_device
Network Authentication: Open
Data encryption: Disabled
Ad hoc network: checked

i. Click the Move up button to move the newly added SSID to the top of the list.
j. Click OK to close the Property dialog box.

For Windows Vista:

a. Open Control Panel.

b. Select Network and Internet.
c. Select Network and Sharing Center.
d. Select Connect to a network.
e. Select dell_device from the network items listed in Connect to a network.
f. Select Connect Anyway in the warning dialog box indicating you are entering an unsecured area.
g. Click Close in the dialog box after confirming the connection is a success.

6. On the Enter Wireless Network Settings screen, set each wireless setting item, and then click Next.

7. When you select the Fixed IP option button for IP Address assignment, click Change... and enter the IP address and subnet mask on the screen.

NOTE: When you enter a fixed IP address, avoid the "169.254.xxx.xxx" address used by AutoIP.

8. Set each item on the Enter Printer Settings screen, and then click Next.
9. On the **Printer Software** screen, specify the software that you want to install and installation path, and then click **Next**. At this point, the wireless setting specified on the **Enter Wireless Network Settings** screen is sent to the printer.

10. On the **Wireless configuration is now complete** screen, create the wireless setting sent to the printer on your computer following the steps below, and then click **Next**.

**NOTE:** If your computer provides a wireless LAN adapter tool, change the wireless settings using this tool. Or you can change the wireless settings using the tool provided by the operating system. See the instructions below.

**For Windows XP and Windows Server 2003:**

a. Select **Network Connections** from Control Panel.

b. Right-click **Wireless Network Connection** and select **Properties**.

c. Select the **Wireless Network** tab.

d. Make sure the check box for **Use Windows to configure my wireless network settings** is checked.

e. Click **Advanced**.

f. Do either of the following:

**When wireless ad-hoc mode is set to the printer:**
Select **Computer to Computer (ad hoc) networks only** and close the **Advanced** dialog box.

**When wireless infrastructure mode is set to the printer:**
Select **Access point (Infrastructure) networks only** and close the **Advanced** dialog box.

g. Click **Add** to display **Wireless network** properties.

h. Enter the setting that you send to printer and click **OK**.

i. Click **Move up** to move the setting to the top of the list.

j. Click **OK** to close the **Property** dialog box.

**For Windows Vista:**

a. Open **Control Panel**.

b. Select **Network and Internet**.

c. Select **Network and Sharing Center**.

d. Select **Connect to a network**.

e. Select the setting you send to the printer from the network items listed in **Connect to a network**.
f. Select **Connect Anyway** in the warning dialog box indication indicating you are entering an unsecured area.

g. Click **Close** in the dialog box after confirming the connection is a success.

11. On the **Setting-Ready Printer** screen, verify that the correct IP address is assigned to the printer to which the wireless setting is set, and then click **Install**.

**NOTE:** If your system has any of the following operating systems:
- Windows XP x64
- Windows Server® 2003 x64
- Windows Vista x64
- Windows Vista x86
  ,skip step 12 and go to step 13.

12. If you select the **I am setting up this printer on a server** check box on the **Select Printer** screen and also select the **PostScript Driver** check box on the **Enter Printer Settings** screen, the **Adobe Systems Inc. License Agreement** screen appears. Select the **I accept the terms of the license agreement** option button, and then click **Install**.

13. On the **Congratulations!** screen, click **Finish** to complete the installation. A test page will be printed with the installed printer by clicking the **Print Test Page** button.

Use the **Dell Printer Configuration Web Tool** to monitor the status of your network printer without leaving your desk. You can view and/or change the printer configuration settings, monitor toner level, and when it is time to order replacement consumables, just click the Dell supplies link right from your Web browser.

**NOTE:** The **Dell Printer Configuration Web Tool** is not available when the printer is locally attached to a computer or a print server.

**Wireless Installation using Dell Printer Configuration Web Tool**

**Scene 1. Install a printer to the already-operating wireless network (When wireless setting is already set to your computer)**

**For DHCP network:**

1. Create wireless setting of your computer following the steps below.

**NOTE:** If your computer provides a wireless LAN adapter tool, change the wireless settings using this tool. Or you can change the wireless settings using the tool provided by the operating system. See the instructions below.
For Windows XP and Windows Server 2003:

a. Select **Network Connections** from Control Panel.

b. Right-click **Wireless Network Connection** and select **Properties**.

c. Select the **Wireless Networks** tab.

d. Make sure the check box for **Use Windows to configure my wireless network settings** is checked.

**NOTE:** Be sure to write down the current wireless computer settings in steps d and f so that you can restore them later.

e. Click the **Advanced** button.

f. Select **Computer to Computer (ad hoc) networks only** and close the **Advanced** dialog box.

g. Click the **Add** button to display **Wireless network properties**.

h. Under the **Association** tab, enter the following information and click **OK**.

   Network name (SSID): dell_device
   Network Authentication: Open
   Data encryption: Disabled
   Ad hoc network: checked

   i. Click the **Move up** button to move the newly added SSID to the top of the list.

   j. Click **OK** to close the **Property** dialog box.

**NOTE:** When your operating system is earlier than Windows 2000, create settings according to the manual of the wireless setting tool provided by your wireless device manufacturer.

For Windows Vista:

a. Open **Control Panel**.

b. Select **Network and Internet**.

c. Select **Network and Sharing Center**.

d. Select **Connect to a network**.

e. Select **dell_device** from the network items listed in **Connect to a network**.

f. Select **Connect Anyway** in the warning dialog box indicating you are entering an unsecured area.

g. Click **Close** in the dialog box after confirming the connection is a success.
2. Check the IP address assigned by AutoIP on the printer.
   
e.g.: 168.254.1.1
3. Check that the IP address on your computer is assigned by DHCP.
4. Open Dell Printer Configuration Web Tool using WEB browser.
   
e.g.: http://168.254.1.1/
5. Change the wireless setting of the printer on Dell Printer Configuration Web Tool.
6. Reboot the printer.
7. Restore the wireless setting on your computer.

**NOTE:** If your computer provides a wireless LAN adapter tool, change the wireless settings using this tool. Or you can change the wireless settings using the tool provided by the operating system. See the instructions below.

**For Windows XP and Windows Server 2003:**

a. Select **Network Connections** from Control Panel.

b. Right-click **Wireless Network Connection** and select **Properties**.

c. Select **Wireless Network** tab.

d. Click **Advanced**.

e. Do either of the following:

**When wireless ad-hoc mode is set to the printer:**
Select **Computer to Computer (ad hoc) networks only** and close the **Advanced** dialog box.

**When wireless infrastructure mode is set to the printer:**
Select **Access point (Infrastructure) networks only** and close the **Advanced** dialog box.

f. Select the setting that you send to the printer in the list in **Preferred Network** group.

g. Click **Move up** to move the setting to the top of the list.

h. Click **OK** to close the **Property** dialog box.

**NOTE:** When your operating system is earlier than Windows 2000, create settings according to the manual of the wireless setting tool provided by your wireless device manufacturer.

**For Windows Vista:**
a. Open **Control Panel**.

b. Select **Network and Internet**.

c. Select **Network and Sharing Center**.

d. Select **Connect to a network**.

e. Select the original setting from the network items listed in **Connect to a network**, and then click **Connect**.

**For Fixed IP network:**

1. Create wireless setting of your computer following the steps below.

**NOTE:** If your computer provides a wireless LAN adapter tool, change the wireless settings using this tool. Or you can change the wireless settings using the tool provided by the operating system. See the instructions below.

**For Windows XP and Windows Server 2003:**

a. Select **Network Connections** from Control Panel.

b. Right-click **Wireless Network Connection** and select **Properties**.

c. Select the **Wireless Networks** tab.

d. Make sure the check box for **Use Windows to configure my wireless network settings** is checked.

**NOTE:** Be sure to write down the current wireless computer settings in steps d and f so that you can restore them later.)

e. Click the **Advanced** button.

f. Select **Computer to Computer (ad hoc) networks only** and close the **Advanced** dialog box.

g. Click the **Add** button to display **Wireless network properties**.

h. Under the **Association** tab, enter the following information and click **OK**.

---

Network name (SSID): dell_device
Network Authentication: Open
Data encryption: Disabled
Ad hoc network: checked

i. Click the **Move up** button to move the newly added SSID to the top of the list.

j. Click **OK** to close the **Property** dialog box.
NOTE: When your operating system is earlier than Windows 2000, create settings according to the manual of the wireless setting tool provided by your wireless device manufacturer.

For Windows Vista:

a. Open Control Panel.

b. Select Network and Internet.

c. Select Network and Sharing Center.

d. Select Connect to a network.

e. Select dell_device from the network items listed in Connect to a network.

f. Select Connect Anyway in the warning dialog box indicating you are entering an unsecured area.

g. Click Close in the dialog box after confirming the connection is a success.

2. Check the IP address on your computer.

   e.g.: 1.2.3.4

3. Set the IP address on the printer.

   e.g.: 1.2.3.5

4. Open Dell Printer Configuration Web Tool using WEB browser.

   e.g.: http://1.2.3.5/

5. Change the wireless setting of the printer on Dell Printer Configuration Web Tool.

6. Reboot the printer.

7. Restore the wireless setting on your computer.

NOTE: If your computer provides a wireless LAN adapter tool, change the wireless settings using this tool. Or you can change the wireless settings using the tool provided by the operating system. See the instructions below.

For Windows XP and Windows Server 2003:

a. Select Network Connections from Control Panel.
b. Right-click **Wireless Network Connection** and select **Properties**.

c. Select **Wireless Network** tab.

d. Click **Advanced**.

e. Do either of the following:

**When wireless ad-hoc mode is set to the printer:**
Select **Computer to Computer (ad hoc) networks only** and close the **Advanced** dialog box.

**When wireless infrastructure mode is set to the printer:**
Select **Access point (Infrastructure) networks only** and close the **Advanced** dialog box.

g. Click **Move up** to move the setting to the top of the list.

h. Click **OK** to close the **Property** dialog box.

NOTE: When your operating system is earlier than Windows 2000, create settings according to the manual of the wireless setting tool provided by your wireless device manufacturer.

**For Windows Vista:**

a. Open **Control Panel**.

b. Select **Network and Internet**.

c. Select **Network and Sharing Center**.

d. Select **Connect to a network**.

e. Select the original setting from the network items listed in **Connect to a network**, and then click **Connect**.

**Scene 2. Construct new wireless network environment for both computer and printer (When wireless setting needs to be set to your computer)**

**For DHCP network:**

1. Create wireless setting of your computer following the steps below.

NOTE: If your computer provides a wireless LAN adapter tool, change the wireless settings using this tool. Or you can change the wireless settings using the tool provided by the operating system. See the instructions below.

**For Windows XP and Windows Server 2003:**

a. Select **Network Connections** from Control Panel.
b. Right-click **Wireless Network Connection** and select **Properties**.

c. Select the **Wireless Networks** tab.

d. Make sure the check box for **Use Windows to configure my wireless network settings** is checked.

- **NOTE:** Be sure to write down the current wireless computer settings in steps e and g so that you can restore them later.

e. Click the **Advanced** button.

f. Select **Computer to Computer (ad hoc) networks only** and close the **Advanced** dialog box.

g. Click the **Add** button to display **Wireless network properties**.

h. Under the **Association** tab, enter the following information and click **OK**.

Network name (SSID): dell_device
Network Authentication: Open
Data encryption: Disabled
Ad hoc network: checked

i. Click the **Move up** button to move the newly added SSID to the top of the list.

j. Click **OK** to close the **Property** dialog box.

- **NOTE:** When your operating system is earlier than Windows 2000, create settings according to the manual of the wireless setting tool provided by your wireless device manufacturer.

For Windows Vista:

a. Open **Control Panel**.

b. Select **Network and Internet**.

c. Select **Network and Sharing Center**.

d. Select **Connect to a network**.

e. Select **dell_device** from the network items listed in **Connect to a network**.

f. Select **Connect Anyway** in the warning dialog box indicating you are entering an unsecured area.

g. Click **Close** in the dialog box after confirming the connection is a success.
2. Check the IP address assigned by AutoIP on the printer.

   e.g.: 168.254.1.1

3. Check that the IP address on your computer is assigned by DHCP.

4. Open Dell Printer Configuration Web Tool using WEB browser.

   e.g.: http://168.254.1.1

5. Create wireless setting of the printer on Dell Printer Configuration Web Tool.

6. Reboot the printer.

7. Restore the wireless setting on your computer.

**NOTE:** If your computer provides a wireless LAN adapter tool, change the wireless settings using this tool. Or you can change the wireless settings using the tool provided by the operating system. See the instructions below.

**For Windows XP and Windows Server 2003:**

a. Select **Network Connections** from Control Panel.

b. Right-click **Wireless Network Connection** and select **Properties**.

c. Select **Wireless Network** tab.

d. Make sure the check box for **Use Windows to configure my wireless network settings** is checked.

e. Click **Advanced**.

f. Do either of the following:

**When wireless ad-hoc mode is set to the printer:**

Select **Computer to Computer (ad hoc) networks only** and close the **Advanced** dialog box.

**When wireless infrastructure mode is set to the printer:**

Select **Access point (Infrastructure) networks only** and close the **Advanced** dialog box.

g. Click **Add** to display **Wireless network properties**.

h. Enter the setting that you send to printer and click **OK**.

i. Click **Move up** to move the setting to the top of the list.

j. Click **OK** to close the **Property** dialog box.
NOTE: When your operating system is earlier than Windows 2000, create settings according to the manual of the wireless setting tool provided by your wireless device manufacturer.

For Windows Vista:

a. Open Control Panel.

b. Select Network and Internet.

c. Select Network and Sharing Center.

d. Select Connect to a network.

e. Select the setting you send to the printer from the network items listed in Connect to a network.

f. Select Connect Anyway in the warning dialog box indicating you are entering an unsecured area.

g. Click Close in the dialog box after confirming the connection is a success.

For Fixed IP network:

1. Create wireless setting of your computer following the steps below.

NOTE: If your computer provides a wireless LAN adapter tool, change the wireless settings using this tool. Or you can change the wireless settings using the tool provided by the operating system. See the instructions below.

For Windows XP and Windows Server 2003:

a. Select Network Connections from Control Panel.

b. Right-click Wireless Network Connection and select Properties.

c. Select the Wireless Networks tab.

d. Make sure the check box for Use Windows to configure my wireless network settings is checked.

NOTE: Be sure to write down the current wireless computer settings in steps d and f so that you can restore them later.

e. Click the Advanced button.

f. Select Computer to Computer (ad hoc) networks only and close the Advanced dialog box.
g. Click the **Add** button to display **Wireless network properties**.

h. Under the **Association** tab, enter the following information and click **OK**.

Network name (SSID): dell_device
Network Authentication: Open
Data encryption: Disabled
Ad hoc network: checked

i. Click the **Move up** button to move the newly added SSID to the top of the list.

j. Click **OK** to close the **Property** dialog box.

![NOTE:] When your operating system is earlier than Windows 2000, create settings according to the manual of the wireless setting tool provided by your wireless device manufacturer.

**For Windows Vista:**

a. Open **Control Panel**.

b. Select **Network and Internet**.

c. Select **Network and Sharing Center**.

d. Select **Connect to a network**.

e. Select **dell_device** from the network items listed in **Connect to a network**.

f. Select **Connect Anyway** in the warning dialog box indicating you are entering an unsecured area.

  g. Click **Close** in the dialog box after confirming the connection is a success.

2. Check the IP address on your computer.

   e.g.: 1.2.3.4

3. Set the IP address on the printer.

   e.g.: 1.2.3.5

4. Open Dell Printer Configuration Web Tool using WEB browser.

   e.g.: http://1.2.3.5

5. Change the wireless setting of the printer on Dell Printer Configuration Web Tool.
6. Reboot the printer.
7. Restore the wireless setting on your computer.

**NOTE:** If your computer provides a wireless LAN adapter tool, change the wireless settings using this tool. Or you can change the wireless settings using the tool provided by the operating system. See the instructions below.

**For Windows XP and Windows Server 2003:**

a. Select **Network Connections** from Control Panel.

b. Right-click **Wireless Network Connection** and select **Properties**.

c. Select **Wireless Network** tab.

d. Make sure the check box for **Use Windows to configure my wireless network settings** is checked.

e. Click Advanced.

f. Do either of the following:

**When wireless ad-hoc mode is set to the printer:**
Select **Computer to Computer (ad hoc) networks only** and close the Advanced dialog box.

**When wireless infrastructure mode is set to the printer:**
Select **Access point (Infrastructure) networks only** and close the Advanced dialog box.

g. Click Add to display **Wireless network properties**.

h. Enter the setting that you send to printer and click **OK**.

i. Click **Move up** to move the setting to the top of the list.

j. Click **OK** to close the Property dialog box.

**NOTE:** When your operating system is earlier than Windows 2000, create settings according to the manual of the wireless setting tool provided by your wireless device manufacturer.

**For Windows Vista:**

a. Open **Control Panel**.

b. Select **Network and Internet**.

c. Select **Network and Sharing Center**.

d. Select **Connect to a network**.

e. Select the setting you send to the printer from the network items listed in **Connect to a network**.
Wireless Setting through Dell Printer Configuration Web Tool - Advanced setup

Access point (Infrastructure, DHCP network)

1. Create new wireless settings for your computer.

**NOTE:** If your computer provides a wireless LAN adapter tool, change the wireless settings using this tool. Or you can change the wireless settings using the tool provided by the operating system. See the instructions below.

For Windows XP and Windows Server 2003:

a. Select **Network Connections** from Control Panel.

b. Right-click **Wireless Network Connection** and select **Properties**.

c. Select the **Wireless Networks** tab.

d. Make sure the check box for **Use Windows to configure my wireless network settings** is checked.

**NOTE:** Be sure to write down the current wireless computer settings in steps d and g so that you can restore them later.

  e. Click the **Advanced** button.

  f. Select **Computer to Computer (ad hoc) networks only** and close the Advanced dialog box.

  g. Click the **Add** button to display Wireless network properties.

  h. Under the **Association** tab, enter the following information and click **OK**.

  Network name (SSID): dell_device
  Network Authentication: Open
  Data encryption: Disabled
  Ad hoc network: checked

  i. Click the **Move up** button to move the newly added SSID to the top of the list.

  j. Click **OK** to close the Property dialog box.
NOTE: When your operating system is earlier than Windows 2000, create settings according to the manual of the wireless setting tool provided by your wireless device manufacturer.

For Windows Vista:

a. Open Control Panel.

b. Select Network and Internet.

c. Select Network and Sharing Center.

d. Select Connect to a network.

e. Select dell_device from the network items listed in Connect to a network.

f. Select Connect Anyway in the warning dialog box indicating you are entering an unsecured area.

g. Click Close in the dialog box after confirming the connection is a success.

2. Set up the printer wireless adapter IP address.

a. Reset the settings for the wireless adapter to the default.

i. Press Menu on printer control panel.
ii. Scroll down and select Admin Menu.
iii. Scroll down and select Wireless net.
iv. Scroll down and select Reset MPC.
v. Restart the printer.

b. Retrieve the wireless adapter IP address on the printer.

i. Press Menu on the printer control panel.
ii. Scroll down and select Admin Menu.
iii. Scroll down and select wireless net.
iv. Scroll down and select TCP/IP.
v. Scroll down and select IP Address.
( Default IP address range: 169.254.xxx.yyy )

3. Access Dell Printer Configuration Web Tool on your computer browser.

a. Assign the PC IP address by DHCP mode (Change the TCP/IP properties to obtain the IP address automatically).
b. Make sure your computer has the same IP address range as the printer wireless adapter.

e.g. 169.254.xxx.zzz

c. Access the Dell Printer Configuration Web Tool using the WEB browser, and then type printer wireless adapter settings in the address field of the browser.

e.g. http://169.254.xxx.yyy/ (Your wireless adapter IP address)

d. Change wireless settings (SSID/communication mode) from Dell Printer Configuration Web Tool.

i. Click **Print server setting** on the left navigational bar.

ii. Click the **Print server setting** tab.

iii. Click the **TCP/IP** sub-tab.

iv. Select **DHCP**.

v. Click the **Apply new setting** button without restarting the printer (Ignore the screen instructions to restart the printer).

vi. Click the **Wireless LAN** sub-tab.

vii. Change the **SSID** setting (according to your Access point SSID) and change **Network type** to **Infrastructure**.

viii. Click the **Restart printer to apply new settings** button.

4. Once printer wireless adapter is properly configured, you may use the typical network printer installation method to complete driver installation.

5. To communicate with printer, you need to restore the previous wireless settings on your computer.

6. Restore the previous wireless settings for your computer.

**NOTE:** If your computer provides a wireless LAN adapter tool, change the wireless settings using this tool. Or you can change the wireless settings using the tool provided by the operating system. See the instructions below.

**For Windows XP and Windows Server 2003:**

a. Select **Network Connections** from Control Panel.

b. Right-click **Wireless Network Connection** and select **Properties**.

c. Select the **Wireless Network** tab.

d. Click the **Advanced** button.

e. Select **Access point (Infrastructure) networks only** and close the Advanced dialog box (Applicable to printer with the wireless infrastructure mode).

f. Select the setting that you send to the printer in the list in the **Preferred Network** group.

g. Click **Move up** to move the setting to the top of the list.
h. Click OK to close the Property dialog box.

**NOTE:** When your operating system is earlier than Windows 2000, create settings according to the manual of the wireless setting tool provided by your wireless device manufacturer.

**For Windows Vista:**

a. Open **Control Panel**.

b. Select **Network and Internet**.

c. Select **Network and Sharing Center**.

d. Select **Connect to a network**.

e. Select the setting you send to the printer from the network items listed in **Connect to a network**.

f. Select **Connect Anyway** in the warning dialog box indicating you are entering an unsecured area.

g. Click **Close** in the dialog box after confirming the connection is a success.

**Access point (Infrastructure, Fixed IP network)**

1. Ensure that the addresses of your computer and access point is in the same IP range. Match the subnet mask and gateway addresses of your computer to the access point settings.

2. Create new wireless settings of your computer by following the steps below.

**NOTE:** If your computer provides a wireless LAN adapter tool, change the wireless settings using this tool. Or you can change the wireless settings using the tool provided by the operating system. See the instructions below.

**For Windows XP and Windows Server 2003:**

a. Select **Network Connections** from Control Panel.

b. Right-click **Wireless Network Connection** and select **Properties**.

c. Select the **Wireless Networks** tab.

d. Make sure the check box for **Use Windows to configure my wireless network settings** is checked.

**NOTE:** Be sure to write down the current wireless computer settings in steps d and f so that you can restore them later.

e. Click the **Advanced** button.
f. Select **Computer to Computer (ad hoc) networks only** and close the Advanced dialog box.

g. Click the **Add** button to display Wireless network properties.

h. Under the **Association** tab, enter the following information and click **OK**.

Network name (SSID): **dell_device**
Network Authentication: **Open**
Data encryption: **Disabled**
Ad hoc network: **Checked**

i. Click the **Move up** button to move the newly added SSID to the top of the list.

j. Click **OK** to close the Property dialog box.

**NOTE:** When your OS is earlier than Windows 2000, create settings according to the manual of the wireless setting tool provided by your wireless device manufacturer.

**For Windows Vista:**

a. Open **Control Panel**.

b. Select **Network and Internet**.

c. Select **Network and Sharing Center**.

d. Select **Connect to a network**.

e. Select **dell_device** from the network items listed in **Connect to a network**.

f. Select **Connect Anyway** in the warning dialog box indicating you are entering an unsecured area.

g. Click **Close** in the dialog box after confirming the connection is a success.

3. Check the IP, subnet mask and gateway address on your computer.

   e.g. IP: 192.168.1.1
   Subnet mask: 255.255.0.0

4. Set the IP address from the printer control panel to be in the same range as that of your computer. Match the subnet mask and gateway addresses of the printer to your computer settings.

   a. Press **Menu** button.

   b. Scroll to **Admin** menu.
c. Select **Wireless Net**.

d. Select **TCP/IP**.

e. Select **Get IP Address**.

f. Select **Panel**.

g. Scroll back to **IP Address**.

h. Manually enter the IP address using the directional buttons on the control panel and press enter button.

e.g.: 192.168.1.2

i. Scroll back to **Subnet Mask**.

j. Manually enter the subnet mask address using the directional buttons on the control panel and press enter button.

k. Scroll back to **Gateway Address**.

l. Manually enter the gateway address using the directional buttons on the control panel and press the Enter button.

m. Restart the printer.

5. Open Dell Printer Configuration Web Tool using the WEB browser.

e.g.: http://192.168.1.2

6. Change wireless settings of the printer from Dell Printer Configuration Web Tool.

a. Click **Print server setting** on the left navigational bar.

b. Click **Print server setting** tab.

c. Click **Wireless LAN** sub-tab.

d. Change the SSID setting (according to your access point SSID) and change **Network type** to **Infrastructure**.

e. Click the **Restart printer to apply new settings** button.

7. Restore the previous wireless settings for your computer.
NOTE: If your computer provides a wireless LAN adapter tool, change the wireless settings using this tool. Or you can change the wireless settings using the tool provided by the operating system. See the instructions below.

For Windows XP and Windows Server 2003:
  a. Select Network Connections from Control Panel.
  b. Right-click Wireless Network Connection and select Properties.
  c. Select Wireless Network tab.
  d. Click Advanced.
  e. Do either of the following:

When wireless ad-hoc mode is set to the printer:
Select Computer to Computer (ad hoc) networks only and close the Advanced dialog box.

When wireless infrastructure mode is set to the printer:
Select Access point (Infrastructure) networks only and close the Advanced dialog box.
  f. Select the setting that you send to the printer in the list in Preferred Network group.
  g. Click Move up to move the setting to the top of the list.

For Windows Vista:
  a. Open Control Panel.
  b. Select Network and Internet.
  c. Select Network and Sharing Center.
  d. Select Connect to a network.
  e. Select the setting you send to the printer from the network items listed in Connect to a network.
  f. Select Connect Anyway in the warning dialog box indicating you are entering an unsecured area.
  g. Click Close in the dialog box after confirming the connection is a success.

8. Click OK to close the Property dialog box.

NOTE: When your operating system is earlier than Windows 2000, create settings according to the manual of the wireless setting tool provided by your wireless device manufacturer.
Setup Security

1. Press Menu.

2. Press ▼ until Printer Setting appears, and then press ✓.

3. Press ▼ until Printer Settings appears, and then press ✓.

4. Press ▼ until Security Settings appears, and then press ✓. Security Settings is displayed.

To set or change the password to limit access to the menus from the operator panel.

Set the password of the Dell Printer Configuration Web Tool from Set Password in Print Server Settings.

Values:

<table>
<thead>
<tr>
<th>Panel Lock</th>
<th>Specifies whether to limit access to the menus.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Password</td>
<td>Sets a password to limit access to the menus.</td>
</tr>
<tr>
<td>Re-enter Password</td>
<td>Type the new password again to confirm.</td>
</tr>
</tbody>
</table>

**NOTE:** This menu sets a password to lock the operator panel. When changing the password for the Dell Printer Configuration Web Tool, click Set Password on the left frame and set the password.

Troubleshooting Instructions

Use the Customer Mode to locate the unit in the printer that causes a problem.

Diagnostic Menu Map (Customer Mode)

1. Turn off the printer.

2. Turn on the printer while holding down ▲ and ▼. The Customer Mode menu appears.
Testing "Print Quality"

"Print Quality" is used to diagnose print quality defects.

1. On the Customer Mode menu, go down to Cyan20%, Magenta20%, Yellow20%, or Black20% and press ✓.

<table>
<thead>
<tr>
<th>Cyan20%</th>
<th>Outputs cyan toner at 20% density on the whole area of the paper.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Magenta20%</td>
<td>Outputs magenta toner at 20% density on the whole area of the paper.</td>
</tr>
<tr>
<td>Yellow20%</td>
<td>Outputs yellow toner at 20% density on the whole area of the paper.</td>
</tr>
<tr>
<td>Black20%</td>
<td>Outputs black toner at 20% density on the whole area of the paper.</td>
</tr>
</tbody>
</table>

After you output the test results, contact Dell.
Testing "Toner Pallet Check" or "Contamination Chk"

"Toner Pallet Check" and "Contamination Chk" are used to diagnose machine problems.

1. On the **Customer Mode** menu, go down to **TonerPalletCheck** or **ContaminationChk**, and press ✓.

<table>
<thead>
<tr>
<th>Toner Pallet Check</th>
<th>Allows you to identify the problem with the toner when print quality problems occur while printing pictures or photos.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contamination Check</td>
<td>Allows you to check for any regular lines or spots when printing if print quality problems are occurring.</td>
</tr>
</tbody>
</table>

After you output the test results, contact Dell.

**Clear NVRAM**

You can restore the original factory default menu settings by initializing NVRAM.

1. Press **Menu**.

2. Press ▼ until **Configure** appears, and then press ✓.

3. Press ▼ until **Maintenance** appears, and then press ✓.

4. Press ▼ until **Reset Defaults** appears, and then press ✓.

5. The **Are you sure?** message appears on the operator panel. Press ✓.

Turn off the printer, and then on again.

**Others**

**How to replace Print cartridges**

⚠️ **CAUTION:** Before performing any of the following procedures, read and follow the safety instructions in your Owner's Manual.

⚠️ **NOTICE:** To protect the drums of the print cartridges against bright light, close the front cover within 5 minutes. If the front cover remains open for more than 5 minutes, print quality may deteriorate.

Dell print cartridges are available only through Dell. You can order more cartridges online at [http://www.dell.com/supplies](http://www.dell.com/supplies) or by phone. To order by phone, see your Owner's Manual.
Dell recommends Dell print cartridges for your printer. Dell does not provide warranty coverage for problems caused by using accessories, parts, or components not supplied by Dell.

⚠️ **CAUTION:** Never throw used print cartridges into a fire. The residual toner could explode resulting in burns and injuries.

⚠️ **CAUTION:** Since the used print cartridge may spill some toner, do not shake it.

### Removing the Used Print Cartridge

1. Push the side button and open the front cover.

2. Grasp the handles at both ends of the print cartridge that you want to replace and pull it out.

⚠️ **CAUTION:** Since the used print cartridge may spill some toner, do not shake it.

### Installing a New Print Cartridge

1. Select the new print cartridge which color matches the color of the handles on the printer cartridge to
be replaced and shake it 5 or 6 times to distribute the toner evenly.

2. Remove the print cartridge from its packaging.

![Image](image1.png)

**NOTE:** To protect the drum against bright light, do not remove the orange protective cover of the print cartridge before the cartridge is inserted into its slot in the printer.

3. Completely remove the seal from the print cartridge by pulling the tab on the end of the print cartridge.

![Image](image2.png)
NOTE: Pull the seal out straight. Pulling the seal diagonally may tear it.

4. Grasp both handles of the print cartridge with the label facing up and slide the cartridge into the same color slot. Make sure the cartridge is fully inserted.

5. Remove the orange protective cover of the installed print cartridge and discard.

6. Close the front cover.
How to replace the Fuser

**CAUTION:** To prevent electric shock, always turn off the printer and disconnect the power cable from the grounded outlet before performing maintenance.

**CAUTION:** Before performing any of the following procedures, read and follow the safety instructions in your Owner's Manual.

**NOTICE:** To protect the drums of the print cartridges against bright light, close the front cover within 5 minutes. If the front cover remains open for more than 5 minutes, print quality may deteriorate.

**NOTE:** Remove any print jobs from the center output tray, and close the multipurpose feeder before opening the front cover.

Dell fuser are available only through Dell. To order by phone, see your Owner's Manual.

Dell recommends Dell fuser for your printer. Dell does not provide warranty coverage for problems caused by using accessories, parts, or components not supplied by Dell.

Removing the Used Fuser

**CAUTION:** To avoid burns, do not replace the fuser immediately after printing, as the fuser gets very hot during this process.

1. Turn off the printer and wait for 30 minutes for the fuser to cool down before removal.

2. Push the side button and open the front cover.
3. Lift the chute gate to its upright position.

4. Release the levers at both ends of the fuser.
5. Hold both sides of the installed fuser, pull it towards the front of the printer to release the connection on the right side, then lift upward to remove.

Installing a New Fuser

1. Unpack a new fuser and hold both sides of the fuser with both hands.

2. With the connector of the fuser toward the slot, push the connector into the slot firmly.
NOTE: Make sure that the fuser connector is firmly seated.

3. Lock both levers at the ends of the fuser.

4. Lower the chute gate to its horizontal position.
5. Close the front cover.

How to replace Rollers

There are three separator rollers in the printer which need to be replaced periodically. One is in the tray and the others are inside the printer. Basically, all the separator rollers are replaced in the same way as described in this section.

⚠️ **CAUTION:** To prevent electric shock, always turn off the printer and disconnect the power cable from the grounded outlet before performing maintenance.

⚠️ **CAUTION:** Before performing any of the following procedures, read and follow the safety instructions in your *Owner's Manual*.

Dell separator rollers are available only through Dell. To order by phone, see your *Owner's Manual*.

Dell recommends Dell separator rollers for your printer. Dell does not provide warranty coverage for problems caused by using accessories, parts, or components not supplied by Dell.
Removing the Used Separator Roller in Tray

1. **NOTE:** Remove any print jobs from the tray before pulling the tray out of the printer. Pull the tray out of the printer until it stops. Hold the tray with both hands, lift the front slightly, and remove it from the printer.

![Image of printer with tray pulled out]

2. **NOTE:** Remove all paper from the tray before opening the separator roller cover. Push back the handles on each side of the separator roller cover as shown in the following illustration and open the cover.

![Image of separator roller cover open]

3. Turn the separator roller until the roller hook can be seen.
Pull the separator roller hook out of the groove in the axle, and then slide the separator roller to the right.

**Installing the New Separator Roller in the Tray**

1. Align the hole of the new separator roller with the axle.
2. Slide the separator roller along the axle so the protrusions fit completely into the slots and the roller hook re-seats into the groove on the axle.

3. Close the separator roller cover until both sides click into place.

4. Load paper into the tray and replace it into the printer.
Removing the Used Separator Roller Inside the Printer

1. Pull the tray out of the printer until it stops. Hold the tray with both hands, lift the front slightly, and remove it from the printer.

2. Turn the separator roller until the roller hook can be seen.
NOTE: The roller is located approximately 165 mm (6.5 in.) inside the machine as measured from the face of the paper tray opening.

3. Pull the separator roller hook out of the groove on the axle, and then slide the separator roller to the left.

4. Repeat steps 2 and 3 to remove the other separator roller from the inside of the printer.
Installing the New Separator Roller Inside the Printer

1. Align the hole of the new separator roller with the axle.

2. Slide the separator roller along the axle so the protrusions fit completely into the slots and the roller hook re-seats into the groove on the axle.
3. Replace the tray into the printer.

Replacing the Belt Unit

⚠️ **CAUTION:** Before performing any of the following procedures, read and follow the safety instructions in your *Owner's Manual*.

⚠️ **NOTICE:** Make sure nothing touches or scratches the surface (black-colored film) of the belt unit. Scratches, dirt, or oil from your hands on the film of the belt unit may reduce print quality.

⚠️ **NOTICE:** To protect the drums of the print cartridges against bright light, close the front cover within 5 minutes. If the front cover remains open for more than 5 minutes, print quality may deteriorate.

Dell belt units are available only through Dell. To order by phone, see your *Owner's Manual*. Dell recommends Dell belt units for your printer. Dell does not provide warranty coverage for problems caused by using accessories, parts, or components not supplied by Dell.

Removing the Used Belt Unit

⚠️ **NOTE:** Remove any print jobs from the center output tray, and close the multipurpose feeder cover before opening the front cover.

1. Make sure that the printer is turned off.

2. Push the side button and open the front cover.
3. Pull up on the belt release levers and rotate the belt unit up as shown in the illustration.

4. *CAUTION: Do not touch the inside of the printer. Some parts may be hot. Allow time for the printer to cool before attempting to remove parts in this area.*

4. Hold both sides of the belt unit with both hands and pull up the left side of the unit until the peg on the left side comes out of the groove. Then, shift the belt unit to the right and remove the unit from the printer.
Installing a New Belt Unit

1. Unpack a new belt unit.

2. Insert the left peg into the corresponding left side belt unit hole, then align the right peg with the groove, and then push down on the right side of the belt unit to seat into place.

3. Close the belt unit by pulling it down until it clicks.
4. Remove the film cover from the installed belt unit and discard

5. Close the front cover.
Printing With Web Services for Devices (WSD)

This section provides information for network printing with WSD, Microsoft’s new Windows Vista protocol.

Printer Setup

You can install your new printer on the network using the Drivers and Utilities CD that shipped with your printer, or using Microsoft’s Windows Add Printer wizard.

However, when you use IPv6 Mode, you cannot install the printer driver from the Drivers and Utilities CD. Use the Add Printer wizard.

Installing a Printer Driver Using the Add Printer Wizard

1. Click Start ➔ Control Panel ➔ Hardware and Sound ➔ Printers.
2. Click Add a printer to launch the Add Printer wizard.
3. Select Add a network, wireless or Bluetooth printer.
4. In the list of available printers, select the one you want to use, and then click Next. If your computer is connected to a network, only printers listed in Active Directory for your domain are displayed in the list.
5. If prompted, install the printer driver on your computer. If you are prompted for an administrator password or confirmation, type the password or provide confirmation.
6. Complete the additional steps in the wizard, and then click Finish.
7. Print a test page to verify print installation.
8. Click Start ➔ Control Panel ➔ Hardware and Sound ➔ Printers.
9. Right-click the printer you just created, and then click Properties.
10. On the General tab, click Print Test Page. When a test page prints successfully, printer installation is complete.
Maintaining Your Printer

Periodically your printer requires you to complete certain tasks to maintain optimum print quality. If several people are using the printer, you may want to designate a key operator to maintain your printer. Refer printing problems and maintenance tasks to this key operator.

- Determining the Status of Supplies
- Conserving Supplies
- Ordering Supplies
- Storing Print Media
- Storing Consumables
- Replacing Print Cartridges
- Replacing the Fuser
- Replacing Separator Rollers
- Replacing the Belt Unit
- Adjusting Color Registration

Determining the Status of Supplies

If your printer is connected to the network, the Dell Printer Configuration Web Tool can provide instant feedback on remaining toner levels. Type the printer IP address in your Web browser to view this information. To use the E-Mail Alert Setup feature that notifies you when the printer requires new supplies, type your name or the name of the key operator in the e-mail list box.

On the operator panel, you can also confirm the following:

- Any supply or maintenance items that require attention replacing (However, the printer can only display information about one item at a time.)
- Amount of toner remaining in each print cartridge

Conserving Supplies

You can change several settings in your software program or on the operator panel to conserve print cartridge and paper.
<table>
<thead>
<tr>
<th>Supply</th>
<th>Setting</th>
<th>Function</th>
<th>For more information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print cartridge</td>
<td>Draft Mode in the Advanced</td>
<td>This check box allows the users to select a print mode that uses less toner. When this feature is used, the image quality will be lower than when it is not used.</td>
<td></td>
</tr>
<tr>
<td>Print media</td>
<td>Multiple Up</td>
<td>The printer prints two or more pages on one side of a sheet. Values for <strong>Multiple Up</strong> are 2 Up, 4 Up, 8 Up, 16 Up, or 32 Up. Combined with the duplex setting, <strong>Multiple Up</strong> allows you to print up to 64 pages on one sheet of paper. (32 images on the front and 32 on the back)</td>
<td></td>
</tr>
<tr>
<td>Duplex</td>
<td></td>
<td>This allows you to print on both sides of a sheet of paper. Duplex printing is only available when the optional duplexer is installed on the printer.</td>
<td></td>
</tr>
</tbody>
</table>

**Ordering Supplies**

You can order consumables from Dell on the Internet when using a networked printer. Type the IP address of your printer in your Web browser, launch the **Dell Printer Configuration Web Tool**, and click the **Order Supplies at:** to order toner for your printer.

You can also order print cartridges by the following method.

1. Click **Start** → **All Programs** → **Dell Printers** → **Additional Color Laser Software** → **Dell Supplies Management System**.

   The **Dell Supplies Management System** window appears.

2. Select your printer from the **Select Printer Model** list.

3. If ordering from the Web:

   a. When you cannot get information from the printer automatically by two-way communication, a window that prompts you to type the Service Tag number appears. Type your Dell printer Service Tag number in the field provided. Your Service Tag number is located inside the front door of your printer.

   b. Select an URL from the **Select Reorder URL** list.

   c. Click **Visit Dell printer supplies ordering web site**.

4. If ordering by phone, call the number that appears under the **By Telephone** heading.

**Storing Print Media**
To avoid potential paper feeding problems and uneven print quality, there are several things you can do.

- To achieve the best possible print quality, store print media in an environment where the temperature is approximately 21°C (70°F) and the relative humidity is 40%.
- Store cartons of print media on a pallet or shelf, rather than directly on the floor.
- If you store individual packages of print media out of the original carton, make sure they rest on a flat surface so the edges do not buckle or curl.
- Do not place anything on top of the print media packages.

---

**Storing Consumables**

Store consumables in their original packaging until you need to use them. Do not store consumables in:

- Temperatures greater than 40°C (104°F).
- An environment with extreme changes in humidity or temperature.
- Direct sunlight.
- Dusty places.
- A car for a long period of time.
- An environment where corrosive gases are present.
- An environment with salty air.

---

**Replacing Print Cartridges**

⚠️ **CAUTION:** Before performing any of the following procedures, read and follow the safety instructions in your Owner’s Manual.

⚠️ **NOTICE:** To protect the drums of the print cartridges against bright light, close the front cover within 5 minutes. If the front cover remains open for more than 5 minutes, print quality may deteriorate.

Dell print cartridges are available only through Dell. You can order more cartridges online at [http://www.dell.com/supplies](http://www.dell.com/supplies) or by phone. To order by phone, see your Owner’s Manual.

Dell recommends Dell print cartridges for your printer. Dell does not provide warranty coverage for problems caused by using accessories, parts, or components not supplied by Dell.

⚠️ **CAUTION:** Never throw used print cartridges into a fire. The residual toner could explode resulting in burns and injuries.
CAUTION: Since the used print cartridge may spill some toner, do not shake it.

Removing the Used Print Cartridge

1. Push the side button and open the front cover.

2. Grasp the handles at both ends of the print cartridge that you want to replace and pull it out.

CAUTION: Since the used print cartridge may spill some toner, do not shake it.

Installing a New Print Cartridge

1. Select the new print cartridge which color matches the color of the handles on the printer cartridge to be replaced and shake it 5 or 6 times to distribute the toner evenly.
2. Remove the print cartridge from its packaging.

NOTE: To protect the drum against bright light, do not remove the orange protective cover of the print cartridge before the cartridge is inserted into its slot in the printer.

3. Completely remove the seal from the print cartridge by pulling the tab on the end of the print cartridge.

NOTE: Pull the seal out straight. Pulling the seal diagonally may tear it.

4. Grasp both handles of the print cartridge with the label facing up and slide the cartridge into the same color slot. Make sure the cartridge is fully inserted.
5. Remove the orange protective cover of the installed print cartridge and discard.

6. Close the front cover.
Replacing the Fuser

**CAUTION:** To prevent electric shock, always turn off the printer and disconnect the power cable from the grounded outlet before performing maintenance.

**CAUTION:** Before performing any of the following procedures, read and follow the safety instructions in your Owner’s Manual.

**NOTICE:** To protect the drums of the print cartridges against bright light, close the front cover within 5 minutes. If the front cover remains open for more than 5 minutes, print quality may deteriorate.

**NOTE:** Remove any print jobs from the center output tray, and close the multipurpose feeder before opening the front cover.

Dell fuser are available only through Dell. To order by phone, see your Owner’s Manual.

Dell recommends Dell fuser for your printer. Dell does not provide warranty coverage for problems caused by using accessories, parts, or components not supplied by Dell.

Removing the Used Fuser

**CAUTION:** To avoid burns, do not replace the fuser immediately after printing, as the fuser gets very hot during this process.

1. Turn off the printer and wait for 30 minutes for the fuser to cool down before removal.

2. Push the side button and open the front cover.

3. Lift the chute gate to its upright position.
4. Release the levers at both ends of the fuser.

5. Hold both sides of the installed fuser, pull it towards the front of the printer to release the connection on the right side, then lift upward to remove.
Installing a New Fuser

1. Unpack a new fuser and hold both sides of the fuser with both hands.
2. With the connector of the fuser toward the slot, push the connector into the slot firmly.

**NOTE:** Make sure that the fuser connector is firmly seated.

3. Lock both levers at the ends of the fuser.
4. Lower the chute gate to its horizontal position.

5. Close the front cover.
Replacing Separator Rollers

There are three separator rollers in the printer which need to be replaced periodically. One is in the tray and the others are inside the printer. Basically, all the separator rollers are replaced in the same way as described in this section.

⚠️ **CAUTION:** To prevent electric shock, always turn off the printer and disconnect the power cable from the grounded outlet before performing maintenance.

⚠️ **CAUTION:** Before performing any of the following procedures, read and follow the safety instructions in your Owner’s Manual.

Dell separator rollers are available only through Dell. To order by phone, see your Owner’s Manual.

Dell recommends Dell separator rollers for your printer. Dell does not provide warranty coverage for problems caused by using accessories, parts, or components not supplied by Dell.

**Removing the Used Separator Roller in Tray**

**NOTE:** Remove any print jobs from the tray before pulling the tray out of the printer.

1. Pull the tray out of the printer until it stops. Hold the tray with both hands, lift the front slightly, and remove it from the printer.
NOTE: Remove all paper from the tray before opening the separator roller cover.

2. Push back the handles on each side of the separator roller cover as shown in the following illustration and open the cover.

3. Turn the separator roller until the roller hook can be seen.
4. Pull the separator roller hook out of the groove in the axle, and then slide the separator roller to the right.

**Installing the New Separator Roller in the Tray**

1. Align the hole of the new separator roller with the axle.
2. Slide the separator roller along the axle so the protrusions fit completely into the slots and the roller hook re-seats into the groove on the axle.

3. Close the separator roller cover until both sides click into place.

4. Load paper into the tray and replace it into the printer.
Removing the Used Separator Roller Inside the Printer

1. Pull the tray out of the printer until it stops. Hold the tray with both hands, lift the front slightly, and remove it from the printer.

2. Turn the separator roller until the roller hook can be seen.
**NOTE:** The roller is located approximately 165 mm (6.5 in.) inside the machine as measured from the face of the paper tray opening.

3. Pull the separator roller hook out of the groove on the axle, and then slide the separator roller to the left.

4. Repeat steps 2 and 3 to remove the other separator roller from the inside of the printer.
Installing the New Separator Roller Inside the Printer

1. Align the hole of the new separator roller with the axle.

2. Slide the separator roller along the axle so the protrusions fit completely into the slots and the roller hook re-seats into the groove on the axle.
3. Replace the tray into the printer.

---

Replacing the Belt Unit

⚠️ **CAUTION:** Before performing any of the following procedures, read and follow the safety instructions in your *Owner’s Manual*.

⚠️ **NOTICE:** Make sure nothing touches or scratches the surface (black-colored film) of the belt unit. Scratches, dirt, or oil from your hands on the film of the belt unit may reduce print quality.

⚠️ **NOTICE:** To protect the drums of the print cartridges against bright light, close the front cover within 5 minutes. If the front cover remains open for more than 5 minutes, print quality may deteriorate.

Dell belt units are available only through Dell. To order by phone, see your *Owner’s Manual*. Dell recommends Dell belt units for your printer. Dell does not provide warranty coverage for problems caused by using accessories, parts, or components not supplied by Dell.

Removing the Used Belt Unit

⚠️ **NOTE:** Remove any print jobs from the center output tray, and close the multipurpose feeder cover before opening the front cover.

1. Make sure that the printer is turned off.

2. Push the side button and open the front cover.
3. Pull up on the belt release levers and rotate the belt unit up as shown in the illustration.

4. **CAUTION:** Do not touch the inside of the printer. Some parts may be hot. Allow time for the printer to cool before attempting to remove parts in this area.

4. Hold both sides of the belt unit with both hands and pull up the left side of the unit until the peg on the left side comes out of the groove. Then, shift the belt unit to the right and remove the unit from the printer.
Installing a New Belt Unit

1. Unpack a new belt unit.

2. Insert the left peg into the corresponding left side belt unit hole, then align the right peg with the groove, and then push down on the right side of the belt unit to seat into place.

3. Close the belt unit by pulling it down until it clicks.
4. Remove the film cover from the installed belt unit and discard.

5. Close the front cover.

---

**Adjusting Color Registration**
To adjust the color registration when you first install the printer or after moving it to a new location, follow the procedure below. See "Operator Panel" and "Color Reg Adj" for information about the operator panel.

**Printing the Color Registration Chart**

Use the operator panel to print the color registration chart.

1. Press **Menu**.
2. Press ▼ until **Admin Menu** appears, and then press ✔.
3. Press ▼ until **Maintenance** appears, and then press ✔.
4. Press ▼ until **Color Reg Adj** appears, and then press ✔.
5. Press ▼ until **ColorRegi Chart** appears, and then press ✔.

The color registration chart is printed.

**Determining Values**

From the lines to the right of the **Y** (Yellow), **M** (Magenta), and **C** (Cyan) pattern, find the values of the straightest lines.

![NOTE:](image) You can also use the densest colors of the lattice pattern to find the straightest lines. The colors printed at the highest density are those next to the straightest lines. When 0 is the value nearest the straightest line, you do not need to adjust the color registration. When the value is not 0, follow the procedure outlined in "Entering Values".
Entering Values

Using the operator panel, enter the values that you found in the color registration chart to make adjustments.

1. Press **Menu**.

2. Press ▼ until **Admin Menu** appears, and then press ✓.

3. Press ▼ until **Maintenance** appears, and then press ✓.

4. Press ▼ until **Color Reg Adj** appears, and then press ✓.

5. Press ▼ until **Enter Number** appears, and then press ✓. The cursor is located at the first digit of the **Enter Number**.

6. Press ▲ or ▼ until you reach the value (for example, +3) displayed on the chart.

7. Press ► once and move the cursor to the next value.

8. Repeat steps 6 and 7 to enter all of the digits of the **Enter Number**, and then press ✓.

9. Press ▼ until **ColorRegi Chart** appears, and then press ✓. The color registration chart is printed with the new values.

10. Color registration adjustment is complete when the straightest **Y** (Yellow), **M** (Magenta), and **C** (Cyan) lines are next to the 0 line.

**CAUTION:** After printing the color registration chart, do not turn off the printer until the printer motor has stopped running.
NOTE: If 0 is not next to the straightest lines, determine the values and adjust the printer again.
Removing Options

If the printer location needs to change or the printer and print media handling options need to be shipped to a new location, all print media handling options must be removed from the printer. For shipping, pack the printer and print media handling options securely to avoid damage.

- Removing the Optional 550-Sheet Feeder
- Removing the Optional Duplexer
- Removing the Optional Memory Card
- Removing the Optional Multi Protocol Card
- Removing the Wireless Printer Adapter

Removing the Optional 550-Sheet Feeder

**NOTE:** If you are removing the optional 550-sheet feeder, be sure to turn off the printer, unplug the power cable, and disconnect all cables from the back of the printer before completing these tasks.

1. Turn off the printer and unplug the printer power cable.
2. Pull the tray out of the printer until it stops. Hold the tray with both hands, lift the front slightly, and remove it from the printer.
3. Remove the two screws joining the printer and the 550-sheet feeder by unscrewing them with a coin or similar object.
4. Gently lift the printer off the tray module, and place it on a level surface.

**CAUTION:** To lift the printer safely, remove the print cartridges and lift it with two people facing the front and back. Never try to lift the printer while facing its right and left sides.

5. Insert the tray into the printer, and push until it stops.
Removing the Optional Duplexer

**NOTICE:** Make sure nothing touches or scratches the surface (black-colored film) of the belt unit. Scratches, dirt, or oil from your hands on the film of the belt unit may reduce print quality.

**NOTICE:** To protect the drums of the print cartridges against bright light, close the front cover within 5 minutes. If the front cover remains open for more than 5 minutes, print quality may deteriorate.

1. Make sure that the printer is turned off and unplug the power cord from the rear of the printer.
2. Push the side button and open the front cover.
3. Pull up on the belt release levers and rotate the belt unit up as shown in the illustration.
4. Hold the latch of the duplexer as shown in the following illustration and pull out the duplexer from the printer.

5. Close the belt unit by pulling it down.
6. Close the front cover.

---

**Removing the Optional Memory Card**

1. Make sure that the printer is turned off and unplug all cables including the power cord from the rear of the printer.

2. Turn the screw on the control board cover gently in a counterclockwise direction and open the cover.
3. Pull the latches on both edges of the socket outward at the same time to raise the memory card up.

4. Hold the memory card and pull it out.
5. Close the control board cover and turn the screw clockwise.

---

Removing the Optional Multi Protocol Card

**NOTE:** If the optional wireless printer adapter is also installed, it must be removed first.

1. Make sure that the printer is turned off and unplug all cables including the power cord from the rear of the printer.
2. Turn the screw on the control board cover gently in counterclockwise direction and open the cover.
3. Remove the two screws from the multipurpose card on the back side of the control board.

4. Hold the multi protocol card and remove it from the control board.

5. Close the control board cover and turn the screw clockwise.
Removing the Wireless Printer Adapter

1. Make sure that the printer is turned off.

2. Turn the screw on the control board cover gently in a counterclockwise direction and open the cover.

3. Remove the wireless printer adapter cap from the control board by releasing the cap's hooks.
4. Remove the wireless printer adapter from the printer.

5. Attach the plate by tightening the screw on the back side of the printer to cover the wireless printer adapter socket.
6. Close the control board cover and turn the screw clockwise.
Printer Specifications

- **OS Compatibility**
- **Power Supply**
- **Dimensions**
- **Memory**
- **Page-Description Language (PDL)/Emulation, Operating System, and Interface**
- **Environmental**
- **Cables**

OS Compatibility

Compatible with Windows® (Vista, Vista x64, XP, Server 2003, XP x64, Server 2003 x64, 2000, NT 4.0); Mac OS X (10.2.8/10.3.9/10.4.x); Novell® (3.X, 4.X, 5.X, 6, 6.5) but not supported¹; Linux (RedHat ES4 (English), SuSE 9.2/9.3 (English), TurboLinux 10 Desktop (English)) but not supported²; Unix (RedHat AS 2.1, HP-UX 11.i, Solaris 9/10) (English).

¹ Dell networked Printers are compatible with Microsoft, Novell and Linux operating systems, but Dell telephone support only supports factory-installed operating systems (Microsoft) for the first 30 days for free. See [http://www1.us.dell.com/content/products/compare.aspx/laser?c=us&cs=555&l=en&s=biz](http://www1.us.dell.com/content/products/compare.aspx/laser?c=us&cs=555&l=en&s=biz) for more details. The customer will have to purchase technical support from the manufacturer of the operating system in order to get technical assistance beyond 30 days.

² If the customer has other operating systems, such as Novell or Linux, and has purchased Gold Technical Support (for more information on Gold Technical Support, see [http://www1.us.dell.com/content/topics/global.aspx/services/en/gts?c=us&cs=555&l=en&s=biz](http://www1.us.dell.com/content/topics/global.aspx/services/en/gts?c=us&cs=555&l=en&s=biz)), the telephone support will be a "best effort" attempt to resolve the operating system issue. If the manufacturer needs to be contacted, the customer must pay an additional fee for that support. The only time that Dell pays for the third party support is when Dell is responsible for the issue. In the case of getting the printers installed and working, this is configuration and the customer would be responsible for paying.

Power Supply

<table>
<thead>
<tr>
<th></th>
<th>220 to 240 VAC</th>
<th>110 to 127 VAC</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rated Voltage</td>
<td>50/60 Hz</td>
<td>50/60 Hz</td>
</tr>
<tr>
<td>Frequency</td>
<td>5 A</td>
<td>11 A</td>
</tr>
</tbody>
</table>
**Dimensions**

Height: 470 mm (18.5 in.) Width: 400 mm (15.7 in.) Depth: 485 mm (19.1 in.)

Weight (not including cartridge): 24 kg (52.9 lb)

**Memory**

<table>
<thead>
<tr>
<th>Feature</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Base memory</td>
<td>128 MB</td>
</tr>
<tr>
<td>Maximum memory</td>
<td>1152 MB (128+1024 MB)</td>
</tr>
<tr>
<td>Connector</td>
<td>200 pin DDR2 SO-DIMM</td>
</tr>
<tr>
<td>DIMM Size</td>
<td>256 MB, 512 MB, 1024 MB</td>
</tr>
<tr>
<td>Speed</td>
<td>PC2-3200, PC2-4200, PC2-5300</td>
</tr>
</tbody>
</table>

**Page-Description Language (PDL)/Emulation, Operating System, and Interface**

<table>
<thead>
<tr>
<th>Feature</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>PDL/Emulations</td>
<td>PostScript 3, PCL 6, PCL5c</td>
</tr>
<tr>
<td>OSes</td>
<td>Windows Vista/Vista x64/XP/XP x64/Server 2003/Server 2003 x64/2000/NT 4.0, UNIX (Solaris 9/10, HP-UX 11.i), Linux (Red Hat ES 3/4, SuSE 9.2/9.3, TurboLinux 10 Desktop), TurboLinux 10 Desktop), Mac OS X (10.2.8, 10.3.9, 10.4.x)</td>
</tr>
<tr>
<td>Interfaces</td>
<td>Standard local: USB, IEEE 1284, Standard network: 10Base-T/100Base-TX Ethernet, Optional network: IEEE802.11b/802.11g (Wireless)</td>
</tr>
</tbody>
</table>

**MIB Compatibility**

A Management Information Base (MIB) is a database containing information about network devices (such as adapters, bridges, routers, or computers). This information helps network administrators manage the network (analyze performance, traffic, errors, and so on). The 3110cn complies with standard industry MIB specifications, allowing the printer to be recognized and managed by various printer and network management software systems, such as IBM Tivoli, Hewlett-Packard OpenView, CA Unicenter, Hewlett-Packard Web JetAdmin, and so on.
Environmental

Operation

<table>
<thead>
<tr>
<th>Temperature</th>
<th>5°C to 32°C</th>
</tr>
</thead>
<tbody>
<tr>
<td>Relative humidity</td>
<td>15% RH to 85% RH (no-condensation)</td>
</tr>
</tbody>
</table>

Print Quality Guarantee

<table>
<thead>
<tr>
<th>Temperature</th>
<th>10°C to 28°C</th>
</tr>
</thead>
<tbody>
<tr>
<td>Relative humidity</td>
<td>15% RH to 85% RH (no-condensation) (Temperature should be 28°C or below at 85% RH.)</td>
</tr>
</tbody>
</table>

Storage

| Temperature range | -20°C to 40°C (0 °F to 104 °F) |
| Storage humidity range | 5% RH to 95% RH (no-condensation) |

Altitude

| Operating | Up to 3,100 m (10,000 feet) |
| Storage | 70.9275 Kpa |

Chemical Emission

| Concentration of ozone | 0.019 mg/m³ |

Cables

Your interconnection cable must meet the following requirements:
<table>
<thead>
<tr>
<th>Connection type</th>
<th>Connection specifications and symbols</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Parallel</td>
<td>IEEE 1284</td>
</tr>
<tr>
<td>2 USB</td>
<td>USB2.0</td>
</tr>
<tr>
<td>3 Ethernet</td>
<td>10 Base-T/100 Base-TX</td>
</tr>
<tr>
<td>4 Wireless</td>
<td>IEEE802.11b/802.11g</td>
</tr>
</tbody>
</table>
Overview

The UX Filter

This section describes the features of the UX filter and its operating environment.

Features

The UX filter is a utility software which converts files created by the UNIX workstation into a format which conforms to the PostScript language loaded in the printer. The utility provides software that converts text files, SunRaster image files (for Sun/Solaris only), TIFF image files and XWD image files into the PostScript language program. Also, it makes use of the printer features to output in the following manner.

- Input paper selection
- Double-sided printing
- Output paper selection

**NOTICE:** Depending on the configurations of the printers, some may not be able to use the UX filter.

Operating Environment

Text files, SunRaster image files (for Solaris only), TIFF image files and XWD image files received from a workstation connected to a printer by a USB cable or parallel cable (hereinafter referred to as the local workstation), or from one located on the network (hereinafter referred to as the remote workstation), can be converted into the PostScript language program and output to the printer.
In addition, it can also be used in an environment where a printer, installed with an interface board, is connected directly to the network.

### Before Using UX Filter

Check the following items before using the UX filter.

Before setting up the workstation, set up the printer as follows.

1. Make sure the lpd port is working or not when using the network environment. If the lpd port is not working, set `LPD` to `On` on the operator panel. (Mandatory) See "Protocol" for more information.

   When a parallel or USB port is to be used, make sure these are working. (Mandatory)

2. Set up IP address and subnet mask when the printer is used in the network environment. (Mandatory)

3. Make TBCPFilter function available if TBCPFilter function is installed on the printer. See "Adobe Protocol" for more information.

### Installing the UX Filter
Before Installation

The following are required for the installation.

- Supported operating system is described in "Page-Description Language (PDL)/Emulation, Operating System, and Interface."

  Disk capacity: 20 MB of free disk space required, including temporary working space for installation.

- Log on as a root account to perform the operation here. If you have no root privilege, contact your system administrator.

- Output printer must be registered in the workstation before using UX filter. (HP-UX)
  Use `sam` command for registration of output printer.
  For more information, see the HP-UX related manual.

Files Added by the Installation

The following files will be added when the UX filter is installed.

**Solaris**

<table>
<thead>
<tr>
<th>Directory</th>
<th>File name</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>/usr/local/dellbin3110</td>
<td>txt2ps2</td>
<td>Text conversion utility</td>
</tr>
<tr>
<td></td>
<td>sunras2ps2</td>
<td>SunRaster conversion utility</td>
</tr>
<tr>
<td></td>
<td>tiff2ps2</td>
<td>TIFF conversion utility</td>
</tr>
<tr>
<td></td>
<td>xwd2ps2</td>
<td>XWD conversion utility</td>
</tr>
<tr>
<td></td>
<td>dellpsif</td>
<td>Input filter</td>
</tr>
<tr>
<td>/usr/lib/lp/postscript</td>
<td>dellposttxt3110cn</td>
<td>Symbolic link file to call txt2ps2</td>
</tr>
<tr>
<td></td>
<td>dellpostps3110cn</td>
<td>Symbolic link file to call dellpsif</td>
</tr>
<tr>
<td></td>
<td>dellbinpath3110</td>
<td>Directory description file for the UX filter print tool</td>
</tr>
<tr>
<td>/usr/lib/lp/model</td>
<td>Model interface program</td>
<td>Source file of the model interface program (stored as the printer name during registration)</td>
</tr>
<tr>
<td>/etc/lp/interfaces</td>
<td>Model interface program</td>
<td>Interface program for PRINTER (stored as the printer name during registration)</td>
</tr>
<tr>
<td>/etc/lp/fd</td>
<td>posttxt3110cn.fd</td>
<td>Filter description file for txt2ps2</td>
</tr>
<tr>
<td>File name</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>-------------------</td>
<td>--------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>dell3110cn.fd</td>
<td>Dell3110cn filter description file for Dell™ Color Laser Printer 3110cn</td>
<td></td>
</tr>
<tr>
<td>postio3110.fd</td>
<td>Dellpostio filter description file</td>
<td></td>
</tr>
<tr>
<td>download3110cn.fd</td>
<td>Delldownload filter description file</td>
<td></td>
</tr>
</tbody>
</table>

### /usr/share/man/man1

<table>
<thead>
<tr>
<th>File name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>txt2ps23110cn.1</td>
<td>Manual page file for txt2ps2</td>
</tr>
<tr>
<td>sunras2ps23110cn.1</td>
<td>Manual page file for sunras2ps2</td>
</tr>
<tr>
<td>tiff2ps23110cn.1</td>
<td>Manual page file for tiff2ps2</td>
</tr>
<tr>
<td>xwd2ps23110cn.1</td>
<td>Manual page file for xwd2ps2</td>
</tr>
<tr>
<td>dellpsif3110cn.1</td>
<td>Manual page file for dellpsif</td>
</tr>
</tbody>
</table>

**NOTE:** The directories listed are default directories.

### Linux

<table>
<thead>
<tr>
<th>Directory</th>
<th>File name</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>/usr/local/dellbin3110</td>
<td>txt2ps2</td>
<td>Text conversion utility</td>
</tr>
<tr>
<td></td>
<td>tiff2ps2</td>
<td>TIFF conversion utility</td>
</tr>
<tr>
<td></td>
<td>xwd2ps2</td>
<td>XWD conversion utility</td>
</tr>
<tr>
<td></td>
<td>printcap. sample</td>
<td>Printcap file sample</td>
</tr>
<tr>
<td></td>
<td>dellpsif</td>
<td>Input Filter</td>
</tr>
<tr>
<td></td>
<td>.dellpsdefault3110</td>
<td>Default command option file</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Directory</th>
<th>File name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>/usr/share/man/man1</td>
<td>txt2ps23110cn.1</td>
<td>Manual page file for txt2ps2</td>
</tr>
<tr>
<td></td>
<td>tiff2ps23110cn.1</td>
<td>Manual page file for tiff2ps2</td>
</tr>
<tr>
<td></td>
<td>xwd2ps23110cn.1</td>
<td>Manual page file for xwd2ps2</td>
</tr>
<tr>
<td></td>
<td>dellpsif3110cn.1</td>
<td>Manual page file for dellpsif</td>
</tr>
</tbody>
</table>

**NOTE:** The directories listed are default directories.

### HP-UX
### Installation Procedure Overview

This section provides information on the installation of the UX filter using the UNIX workstation.

#### Linux

1. Setup the printer and network.
2. Insert the *drivers and utilities* CD into the local workstation.
3. Run the installer and begin the installation.
4. Edit `/etc/printcap` and print for testing the printer.

#### Solaris

1. Setup the printer and network.
2. Insert the *drivers and utilities* CD into the local workstation.
3. Run the installer and begin the installation.
4. Print for testing the printer.

#### HP-UX

1. Setup the printer and network.

---

<table>
<thead>
<tr>
<th>Directory</th>
<th>File name</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>/usr/local/dellbin3110</code></td>
<td>txt2ps2</td>
<td>Text conversion utility</td>
</tr>
<tr>
<td></td>
<td>xwd2ps2</td>
<td>XWD conversion utility</td>
</tr>
<tr>
<td></td>
<td>tiff2ps2</td>
<td>TIFF conversion utility</td>
</tr>
<tr>
<td><code>/usr/lib/lp/postscript</code></td>
<td>dellbinpath3110</td>
<td>Directory description file for the UX filter print tool</td>
</tr>
<tr>
<td><code>/usr/spool/lp/interface</code></td>
<td>Model interface program</td>
<td>Interface program for PRINTER (stored as the printer name during registration)</td>
</tr>
<tr>
<td><code>/usr/share/man/man1</code></td>
<td>txt2ps23110cn.1</td>
<td>Manual page file for txt2ps2</td>
</tr>
<tr>
<td></td>
<td>tiff2ps23110cn.1</td>
<td>Manual page file for tiff2ps2</td>
</tr>
<tr>
<td></td>
<td>xwd2ps23110cn.1</td>
<td>Manual page file for xwd2ps2</td>
</tr>
</tbody>
</table>

**NOTE:** The directories listed are default directories.
2. Insert the *drivers and utilities* CD into the local workstation.

3. Run the installer and begin the installation.

4. Print for testing the printer.

---

**Operation on Linux**

**Installation of Software**

1. Insert the *drivers and utilities* CD in the CD-ROM drive of the local workstation. If CD-ROM drive is not mounted on your workstation, extract files by using another workstation that has a CD-ROM drive to transfer those files to your workstation.

2. Log on as a root account and extract the installation script from the *drivers and utilities* CD.

   **NOTICE:** If you have no root privilege, contact your system administrator.

   ```
   # mount /dev/cdrom /mnt/cdrom
   # cd /tmp
   # cp /mnt/cdrom/UXFILTER.tar /tmp
   # tar xvf ./UXFILTER.tar
   ```

   **NOTE:** CD-ROM is sometimes mounted automatically.

3. Type `./install.sh` and run the installer.

   ```
   #./install.sh
   ```

4. Select the printer model to install.

   ```
   Printer Model?
   1. Dell Color Laser Printer 3110cn
   2. Exit
   Enter Process No(1/2)? : 1
   ```

5. It asks whether you want to install the filter. Type `<y>`.

   ```
   Install Filter? (y/n) [y] : y
   ```

   **NOTE:** If [ ] appears in a message, the default value will appear inside the [ ]. It will be selected when you press the <Enter> key.

   The disk status on the workstation appears. 20 MB of free disk space is required for the installation of the filter.

6. Specify the directory to install the filter. To install into `/usr/local/dellbin3110`, press the <Enter>
key. To change the directory, specify one. Change the directory to.
Enter Library directory name [/usr/local/dellbin3110]

7. Confirm the directory to be installed.

```
directory is '/usr/local/dellbin3110' (y/n)[n] : y
```

The software installation is complete.

**Setting the Printer**

Write printer setting in `/etc/printcap` or `/etc/printcap.local` referencing `/usr/local/dellbin3110/printcap.sample`.

Linux (LPRng):

```
/etc/printcap.local or /etc/printcap

lp:  
  :bk:  
  :bkf:  
  :lpd_bounce=true:  
  :sd=/var/spool/lpd/lp:  
  :af=/var/spool/lpd/lp/lp.acct:  
  :lf=/var/spool/lpd/lp/log:  
  :rm=PrinterHostName:  
  :rp=ps:  
  :if=/usr/local/dellbin3110cn/dellpsif:
```

**NOTICE:** The directory to spool can be created in the partition with sufficient disk space. If there is no spooling directory, it is not possible to print large files.

**NOTICE:** The account files or logging files can be created with the file name specified in the directory path specified.

**Operation on Solaris**

**Installation/Printer Setting**

1. Insert the `drivers and utilities` CD in the CD-ROM drive of the local workstation. If CD-ROM drive is not mounted on your workstation, extract files by using another workstation that has a CD-ROM drive to transfer those files to your workstation.

2. Log on as a root account and extract the installation script from the `drivers and utilities` CD.
**NOTICE:** If you have no root privilege, contact your system administrator.

```bash
# cd /tmp
# cp /cdrom/cdrom0/UXFILTER.tar /tmp
# tar xvf ./UXFILTER.tar
```

3. Type `./install.sh` and run the installer.

```bash
# ./install.sh
```

4. Select the printer model to install.

```
Printer Model ?
  1. Dell Color Laser Printer 3110cn
  2. Exit
Enter Process No (1/2)? : 1
```

5. The following menu appears. Select `<1>` and set up the local printer.

```
Solaris Installation for Dell Color Laser Printer 3110cn Type Printer
  1. Set Local Printer
  2. Set Remote Printer
Enter Process No (1/2)? : 1
```

6. Type the device name of the connection port.

```
Enter port-device-name? [/dev/ecpp0] : /dev/bpp0
```

**NOTICE:** Specify the device file in the communication port available.

7. When **Set Remote Printer** is selected, type the host name of the server or the host name of the printer.

```
Enter server-hostname? : server
server-hostname is 'server' (y/n)[y] : y
```

**NOTICE:** The host name of the server must be pre-registered with DNS, NIS, NIS+ or /etc/hosts.

8. When **Set Remote Printer** is selected, type the remote printer name.

```
Enter server-printer-name? : ps
server-printer-name is 'ps' (y/n)[y] : y
```
NOTICE: Type `ps` when the printer is a network connection printer.

9. Type the printer name to be registered with the system.

```
Enter printer-name? [dell3110cn] : dell3110cn
Printer-name is 'dell3110cn' (y/n)[y] : y
```

10. Specify the directory to install the utility. To install into `/usr/local/dellbin3110`, press the `<Enter>` key. To change the directory, specify one.

```
Enter Binary directory name? [/usr/local/dellbin3110] :
```

11. If this utility has been installed earlier, the user will be prompted whether to overwrite the earlier version.

```
directory is '/usr/local/dellbin3110' (y/n)[n] : y
```

12. If the server input at step 5 the printer connected by the network, type `<y>`. If the server and the printer are connected locally, type `<n>`.

```
'dell3110cn'is network printer?:(y/n)[y] : y
```

The software installation is complete.

NOTICE: When the printing settings are modified or changed by the Administration Tool (admintool) after the installation, printing may not work.

Operation on HP-UX

Installation Procedure

NOTE: The host name of the output printer which you want to specify in step 6 must be pre-registered with a `sam` command.

1. Insert the `rivers and utilities` CD into the CD-ROM drive of the local workstation.

2. Log on as a root account and extract the installation script from the `drivers and utilities` CD.
NOTICE: If you have no root privilege, contact your system administrator.

```
# mount -F cdfs -o cdcase /dev/dsk/c1t2d0 /cdrom
# cd /tmp
# cp /cdrom/uxfilter.tar /tmp
# tar xvf UXFILTER.tar
```

NOTE: /dev/ds/clt2d0 is an example. Specify the CD-ROM device file for all workstations.

3. Type `./install.sh` and run the installer.

   ```
   # ./install.sh
   ```

4. Select the printer model to install.

   Printer Model ?
   1. Dell Color Laser Printer 3110cn
   2. Exit
   Enter Process No (1/2)? : 1

5. Specify the directory to install the utility.

   Enter install directory name /usr/local/dellbin3110] :
   directory is '/usr/local/dellbin3110' (y/n)[n]: y

6. Type the name of the output printer. Type `delllp3110cn`. Type the printer name to be registered with the system.

   Enter output-printer-name? : delllp3110cn
   output-printer-name is 'delllp3110cn' (y/n)[y]: y

NOTE: The registered printer name can be verified by executing `lpstat -v`.

7. Type the logical printer name. Register `dell3110cn`. Type a printer name that has not already been registered with the system.

   Enter logical-printer-name? : dell3110cn
   Printer-name is 'dell3110cn' (y/n)[y]: y

8. The utility will be installed in the directory specified at step 5. Registration will be executed here so that the logical printer registered at step 7 can access the utility. As this process is automatically executed, no input is required. With the above steps, the installation is complete.


**Uninstalling the UX Filter**

**About Uninstalling**

The UX filter does not come with an uninstaller. To uninstall the UX filter, follow the following procedure.

⚠️ **NOTICE:** Log on as a root account to perform the operation here. If you have no root privilege, contact your system administrator.

**Linux**

1. Delete the descriptions for each printer from `/etc/printcap`
2. Delete the added spool directory.
3. Restart lpd.
4. Delete all the directories that contain the UX filters and the files in these directories created during the installation. The following directories must be deleted.

   `/usr/local/dellbin3110`

   The above directories are standard directories created during the installation. If you had specified other directories for the installation, delete those directories.

**Solaris**

1. Delete the printer that was registered with the system. Use the printer name created during the installation and the `lpadmin` command.

   ```bash
   # lpadmin -x printename
   ```

2. Delete the filters registered with the system. Delete the filters registered during the installation using the `lpfilter` command.

   ```bash
   # lpfilter -f dell3110cn -x
   # lpfilter -f download3110 -x
   # lpfilter -f postio3110cn -x
   # lpfilter -f posttxt3110cn -x
   ```

3. Delete the symbolic files required to call up the filter.
   Delete the following files from `/usr/lib/lp/postscript`.

   ```bash
   dellposttxt3110cn
dellpostps3110cn
dellbinpath3110
   ```
4. Delete the interface program files of Selected printer type name from /usr/lib/lp/model.
Please also delete the interface program files of Selected printer name from /etc/lp/interfaces.

5. Delete all the directories that contain the UX filters and the files in these directories created during the installation. The following directories must be deleted.

   /usr/local/dellbin3110

6. Delete the filter description files. Delete the following files from /etc/lp/fd.
Filter description files for various printers.

dell3110cn.fd  (for Dell™ Color Laser Printer 3110cn)
download3110.fd
postio3110cn.fd
posttxt3110cn.fd

---

**HP-UX**

1. Delete the printer that was registered with the system. Use the sam command to delete the printer setup during the installation.

   # sam

2. Delete all the directories that contain the UX filters and the files in these directories created during the installation. The following directories must be deleted.

   /usr/local/dellbin3110 (directory specified during the installation)

---

**Printing and Using the Utilities**

**Printing (Linux)**

This section provides information on printing with the filter.
To print, specify the printer registered with /etc/printcap as the output destination.

**Printing From Linux**

To print to the default printer:

   If the printer is registered as the default printer, the name of the printer can be shortened and specified as shown in the following example.

   % lpr filename
To print to other printers:

To print to a printer named `dell3110cn`, type as follows.

```
% lpr -Pdell3110cn filename
```

To select a paper tray for printing:

To select a paper tray for printing, the `.dellpsdefault3110` file must be executed in advance to define the printer which uses the desired paper tray.

To select tray 2 (optional 550-sheet feeder) for printing, execute the `.dellpsdefault3110` file and define the printer so that it feeds paper from tray 2. Specify `tray2`, which is the defined printer name, as follows.

```
% lpr -Ptray2 filename
```

About `/usr/local/dellbin3110/.dellpsdefault3110`:

This is the file for system default settings when using various utilities via `/etc/printcap`. Hereinafter, it is referred to as the `default command option setting file`.

**Method:**

To define a printer named `a4d` which prints on A4 with the long-edge binding feature turned on, follow the following steps.

**Procedure:**

1. Register the printer `a4d` with `/etc/printcap`.

   **Linux (LPRng):**

   ```
   /etc/printcap.local or /etc/printcap
   a4d:\
   :bk:
   :bkf:
   :lpd_bounce=true:\
   :sd=/var/spool/lpd/a4d:\
   :af=/var/spool/lpd/a4d/a4d.acct:\
   :lf=/var/spool/lpd/a4d/a4d/log:\
   :rm=PrinterHostName:\
   :rp=ps:\
   :if=/usr/local/dellbin3110/dellpsif_a4d:
   ```

2. Log on as the root account and create the symbolic links for `dellpsif_a4d` of IF Filter for printing on A4 with the long-edge binding feature turned on.

   ```
   # ln -s /usr/local/dellbin3110/dellpsif /usr/local/dellbin3110/dellpsif_a4d
   ```
3. Add the following descriptions to the default command option setting file that specifies the user defined commands of the \texttt{dellpsif\_a4d} of IF Filter.

\texttt{/usr/local/dellbin3110/.dellpsdefault3110}

\texttt{dellpsif\_a4d -IA4 -D}

4. When the printer name \texttt{a4d} is specified, printing can be done on A4 with the long-edge binding feature turned on.

\texttt{\% lpr -Pa4d filename}

\section*{Printing (Solaris)}

This section provides information on printing that makes use of the filter. To print from Solaris, specify the printer registered during the installation of filters as the output destination.

\textbf{NOTICE:} To use the \texttt{lp} command, make sure the operating environment of the spooler has been set up correctly (enabled, available) using the \texttt{lpstat} command (\texttt{lpstat-p all}). For details on the options of the \texttt{lp} command and the \texttt{lpstat} command or how to make use of them, see the related manuals of Solaris.

\subsection*{Printing From Solaris}

To print to the default printer:

If the printer is registered as the default printer, the name of the printer can be shortened and specified as shown in the following example.

\texttt{\% lp filename}

To print to other printers:

To print to a printer named \texttt{dell3110cn}, type as follows.

\texttt{\% lp -d dell3110cn filename}

\textbf{NOTE:} The name of the printer can be confirmed by executing \texttt{lpstat -v}.

To change the default printer temporarily for printing:

To change the default printer, set the printer name in the environment variable \texttt{LPDEST}.

To set a printer named \texttt{dell3110cn} as the default printer for printing, type as follows.

\texttt{\% setenv LPDEST dell3110cn}

\texttt{\% lp filename}
NOTE: Using this method, a default printer can be set up for each user.

NOTE: The above example describes the setup method executed when csh is used.

To select a paper tray for printing:

To select a paper tray for printing, specify the paper tray after the -y option of the lp command.

NOTE: Depending on installed options, the available paper trays are different.

To select and print to a letter size paper of the printer named dell3110cn with landscape, specify as follows.

```
% lp -d dell3110cn -y landscape -y letter filename
```

The following options can be specified by the lp command. To print text files:

NOTE: It prints according to the length and width specified by the lpadmin command.

- y double

Sets printing to 2-column printing.

- y landscape

Rotates the image by 90° and uses the paper in the landscape orientation.

- y size=n

Sets the font size to n point.

- y outcolumn=n

This option converts text to single-byte text and sets printing to start from the nth column.

- y outline=n

Sets printing to start from the nth line.

- y font=font

Sets the font for printing single-byte alphanumeric characters. If the font specified is not available for the printer, the default fonts are used.

NOTE: To specify a font, type the font name as-is after the -y font= option.

```
% lp -y font=Courier-Oblique filename
```

NOTE: For information on the available fonts, see the PS Fonts List.

- y margin=u:b:r:l

Specifies the margin of a page in inches. The u (upper margin), b (bottom margin), r (right margin), and l (left margin) are positive real numbers (up to two decimal points). The default is 0.
The input file will be processed as the PostScript file. If the file does not begin with "%!", "%!" will be output to the beginning line. Whether the file contains "%!" will be ignored.

To print text/PostScript files:

-y DuplexBook

Enables the long-edge binding feature. When it is specified, the printing direction or position will be adjusted and both sides of the paper printed so that the longer edge of the pages can be bound.

-y DuplexList

Enables the short-edge binding feature. When it is specified, the printing direction or position will be adjusted and both sides of the paper printed so that the shorter edge of the pages can be bound.

-y tray-input

The paper tray-related parameters that can be specified by the lp command are as follows.

tray1
Feed paper from tray 1 (Standard 250-sheet tray).

tray2
Feed paper from tray 2 (Optional 550-sheet feeder).

a4
Feed paper from the tray loaded with A4 (210 x 297 mm).

a5
Feed paper from the tray loaded with A5 (148 x 210 mm).

b5
Feed paper from the tray loaded with B5 (182 x 257 mm).

letter
Feed paper from the tray loaded with Letter (8.5 x 11 inches).

folio
Feed paper from the tray loaded with Folio (8.5 x 13 inches).

legal
Feed paper from the tray loaded with Legal (8.5 x 14 inches).

executive
Feed paper from the tray loaded with Executive (7.25 x 10.5 inches).

monarch
Feed paper from the tray loaded with Monarch (3.875 x 7.5 inches).

com10
Feed paper from the tray loaded with Envelope #10 (4.125 x 9.5 inches).
dl
Feed paper from the tray loaded with DL (110 x 220 mm).

c5
Feed paper from the tray loaded with C5 (162 x 229 mm).

MxNmm
Feed paper from the tray loaded with MxNmm defined by users.
Possible range specified:
Width: 76.2 to 220.0 mm
Length: 98.0 to 355.6 mm

MxNin
Feed paper from the tray loaded with MxNinches defined by users.
Possible range specified:
Width: 3.00 to 8.66 inches
Length: 3.86 to 14.0 inches
If this option is not specified or the tray specified tray is not available, feed paper from the default tray.

-y toner_save
Turns on the save toner mode for printing. The print result will be fainter than that of normal printing.

-y nc=n
Specifies the number of output copies (the value of copies must be a positive integer). If this option is not specified, 1 will be selected.

-y cl
Specifies that printing be collated. If the copies option is not specified, this option will be ignored.

-y ps
The input file will be processed as the PostScript file. If the file does not begin with %!, %! will be output to the beginning line. If a file contains %!, this option will be ignored.

-y msi
Specifies multipurpose feeder.

-y m=type
Specifies multipurpose feeder Paper Type.

Available multipurpose feeder Paper Types are as follows.

B
FinePaper/Bond/Plain Paper 2

BB
FinePaperBack/Bond/Plain Paper 2 - Side 2

P
Stationary/Plain/Plain Paper 1

PB
StationaryBack/Plain/Plain Paper 1 - Side 2

R
If this option is not specified, multipurpose feeder Paper Type for the printer can be used.

-y mfo=mode

Specifies orientation for multipurpose feeder.

Available orientations for multipurpose feeder are as follows.

le
Landscape

ler
Landscape (Rotated)

se
Portrait

ser
Specifies alternate tray.
Available alternate trays are as follows.

0 Use printer settings
1 Display message
2 Feed from multipurpose feeder
3 Use nearest size (Adjust to fit)
4 Use larger size (Adjust to fit)
5 Use nearest size (No zoom)
6 Use larger size (No zoom)

Specifies feed separators from.
Available feed separators from the following.

auto AutoTray/Auto
1 1stTray/Tray 1 (Standard 250-sheet tray)
2 2ndTray/Tray 2 (Optional 550-sheet feeder)
off Off

Specifies printed separators.

Specifies Skip Blank Pages.

Specifies output color.
Available output colors are as follows.
Color (CMYK)

k
Black

-y pr=mode
   Specifies print mode.
   Available print modes are as follows.
   hs
   High speed
   hq
   High quality
   sf
   Super fine

-y cc=mode
   Specifies image types.
   Available image types are as follows.
   0
   Off
   1
   Photo
   2
   sRGB
   3
   Standard/ Normal
   4
   Presentation
   This option is available only for color printing and when entry data is RGB data.

-y gc=mode
   Specifies RGB gamma correction.
   Available RGB gamma corrections are as follows.
   1.0
   1.0
   1.4
   1.4
   1.8
1.8
2.2
2.2
2.6
2.6
off
Off
This option is available only for color printing and when entry data is RGB data.

\(-y\ \text{sc}=\text{mode}\)

Specifies screen.
Available screens are as follows.
0 Fineness
1 Gradation
2 Auto
3 For Transparency

\(-y\ \text{gg}=\text{mode}\)

Specifies gray guaranteed.
Available gray guaranteed modes are as follows.
on On
off Off
This option is available only for color printing.

\(-y\ \text{ct}\)

Specifies color transformation.
This option is available only for color printing.

\(-y\ \text{br}=\text{mode}\)

Specifies brightness adjustment.
Available brightness adjustment option value are as follows.
+5
Bright 5
+4
Bright 4
+3
Bright 3
+2
Bright 2
+1
Bright 1
+0
Normal
-1
Dark 1
-2
Dark 2
-3
Dark 3
-4
Dark 4
-5
Dark 5

-y rgbc=mode

Specifies RGB color correction.

Available RGB color corrections are as follows.

10 Perceptual
11 Saturation
12 RelativeC
13 AbsoluteC

This option is available only for color printing and when entry data is RGB data.

-y rgbpr=mode

Specifies RGB input profile.

Available RGB input profile option value are as follows.
This option is available only for color printing and when entry data is RGB data.

-y rgbtb=mode

Specifies RGB color temperature.
Available RGB color temperature option value are as follows.

5000
5000K

6000
6000K

9300
9300K

This option is available only for color printing and when entry data is RGB data.


Specifies adjustment value for color balance of each color/density.
Available adjustment values are as follows.

+3
Dark 3

+2
Dark 2

+1
Dark 1

0
Normal

-1
Light 1

-2
Light 2

-3
Light 3

-Cb
Option value must be specified in the following order:

Cyan low density, Cyan medium density, Cyan high density, Magenta low density, Magenta medium density, Magenta high density, Yellow low density, Yellow medium density, Yellow high
density, Black low density, Black medium density, Black high density

If no value is specified, it is treated as "0" (Normal).

For example, if you want to specify "Light 2" for Cyan medium density, "Dark 3" for Yellow high density, and "Dark 2" for Black low density, it can be specified using either of the following:

- \( \text{-Cb}=0:-2:0:0:0:0:0:0:+3:+2:0:0 \)
- \( \text{-Cb}=-2:::::+3:+2:: \)

\( \text{-y -hld=PrintType:UserID:Password:DocumentName} \)

Secure Print

\text{PrintType}

store

Secure Print/Store Print

proof

Proof Print

\text{UserID}

Up to eight single-byte characters from 0x20 to 0x7E, except 0x20 " " (blank) and 0x3A":" (colon).

\text{Password}

Up to 12 single-byte characters from 0x30 to 0x39 (numeric characters).

\text{DocumentName}

Up to 12 single-byte characters from 0x20 to 0x7E, except 0x20 " " (blank) and 0x3A":" (colon).

Secure Print

\( \text{-y hld=store:UserID:Password:DocumentName} \)

\( \text{-y hld=store:UserID:Password:} \)

Store Print

\( \text{-y hld=store:UserID::DocumentName} \)

\( \text{-y hld=store:UserID::} \)

Proof Print

\( \text{-y hld=proof:UserID::DocumentName} \)

\( \text{-y hld=proof:UserID::} \)

\( \text{-y -Jown= jobownername: Password Authentication Setting} \)
Specifies job owner name and password for authentication.

- When only job owner name is specified (-Jown=jobownername:) (no password specified), authentication password is treated as not specified.
- When only password is specified (-Jown=:password) (no job owner name specified), login user name is used as job owner name. Entered password is used as authentication password.
- When neither of job owner name nor password is specified (-Jown=:), login user name is used as job owner name, and authentication password is treated as not specified.
- When a job owner name exceeds allowable character length, the extra characters are ignored.
- When an unacceptable character is specified for job owner name, "Unknown User" is used as job owner name.

**NOTE:** Characters acceptable for job owner name are alphanumeric characters and symbols, except for space and colon.

**NOTE:** Up to 32 characters are acceptable for job owner name.

- When an unacceptable character is specified for password, or when a specified password is not within the range of the allowable character length, the authentication password is treated as not specified.

**NOTE:** Only numbers are acceptable for password.

**NOTE:** Acceptable password length is between 4 and 12 characters.

Incomplete form of -Jown option is treated as no authentication setting being made. In such case, if authentication setting is made with the environmental variable, it is used as setting information.

### Printing (HP-UX)

This section provides information on printing from the registered logical printer during the installation.

### Printing From HP-UX

To print to the default printer:

If the printer is registered as the default printer, the name of the printer can be shortened and specified as shown in the following example.

```
% lp filename
```

To print to other printers:
To print to a printer named `dell3110cn`, type as follows.

```
% lp -d dell3110cn filename
```

To change the default printer temporarily for printing:

To change the default printer, set the printer name in the environment variable `PRINTER`. To set a printer named `dell3110cn` as the default printer for printing, type as follows.

```
% setenv PRINTER dell3110cn
% lp filename
```

To print with added options:

To print with the options, specify the option of the `lp` command using `-o` as follows. The available options are the same as `txt2ps2/tiff2ps2/xwd2ps2`. Depending on installed options, the available paper trays are different.

```
% lp -d dell3110cn -o r -o ILT filename
```

To print using file format:

To print text files:

```
% lp -d dell3110cn filename
```

To print XWD files:

```
% lp -d dell3110cn -o XWD filename
```

To print TIFF format files:

```
% lp -d dell3110cn -o TIF filename
```

To print PostScript files:

```
% lp -d dell3110cn filename
```

To print PostScript files as text files:

```
% lp -d dell3110cn -o TX filename
```

However, for PostScript files with options set up, such as paper selection, etc., when the same option is specified, it will be ignored.

### Authentication Printing

This section provides information on how to specify the user name used for authentication printing in the environment variable.

### Specifying the User Name
To specify the User Name for Authentication Printing:

You can specify a unique user name in the environment variable as follows.

```
% setenv JOWN3110U "jobownername"
```

You can specify the login name as the user name as follows.

```
% setenv JOWN3110U ""
```

**NOTE:** Up to 32 characters are acceptable for the user name. When a user name exceeds allowable character length, the extra characters are ignored.

**NOTE:** If you specify the filter option when authentication printing is already specified, the filter option has the higher priority over authentication printing.

### Specifying the Password

#### To Specify the Password for Authentication Printing:

If you need to specify the password in authentication printing, you can specify the password in the environment variable as follows.

```
% setenv JOWN3110P "password"
```

If you do not specify the password inexplicity, type as follows.

```
% setenv JOWN3110P ""
```

**NOTE:** Acceptable password length is between 4 and 12 characters. When an unacceptable character is specified for password, or when a specified password is not within the range of the allowable character length, the extra characters are ignored.

**NOTE:** If you specify the filter option when authentication printing is already specified, the filter option has the higher priority over authentication printing.

**NOTE:** If you only specify the password without specifying the user name in the environment variable, the login name is assumed as the user name.

**NOTICE:** If you enter the password in the login file for automatically allocating the environment variable when you log in, you are recommended to specify the appropriate access privilege that prevents unauthorized users from reading the login file.

### txt2ps2 (Linux/Solaris/HP-UX)

#### Format

```
```
Function

Reads text, converts it to the PostScript language program, and writes to standard output. If the filename is not specified, the standard input will be taken as the command input. By typing character strings in the environmental variable `TXT2PS2OPTION`, the input of option at the command line can be omitted.

At the environmental variable `TXT2PS2OPTION` and the command line, if no option is specified, the printer will output in 10-point font size in the portrait orientation.

At the environmental variable `TXT2PS2OPTION` and the command line, if the same option is specified, the one specified at the command line will prevail.

txt2ps2 outputs the PostScript language program that adjusts the line/column according to the paper size. For this reason, the user need not be aware of the paper size. If there is an option to specify the line/column, automatic line feed according to the paper size will not be executed. Printing will be output according to the line/column specified.

txt2ps2 interprets the following control codes. Other control codes/undefined codes will be converted to octal numbers and output as-is.

```
LF
    Line feed
FF
    Form feed (modifiable by option)
TAB
    8-column tab stop (modifiable by option)
BS
    Backspace 1 character
```

Option

```
-d
```

Enables the short-edge binding feature. When it is specified, the printing direction or position will be adjusted and both sides of the paper printed so that the shorter edge of the pages can be bound. This option is available only when optional duplexer is installed on the printer.
Enables the long-edge binding feature. When it is specified, the printing direction or position will be adjusted and both sides of the paper printed so that the longer edge of the pages can be bound. This option is available only when optional duplexer is installed on the printer.

```
-tray-input
```

Specifies the paper tray. A paper tray can be selected by directly specifying a tray or by specifying a paper size. When a paper size is specified, the tray loaded with paper of the specified size will be found and selected automatically.

The parameters for selecting a paper tray are as follows.

1. Feed paper from tray 1 (Standard 250-sheet tray).
2. Feed paper from tray 2 (Optional 550-sheet feeder).
A4  Feed paper from the tray loaded with A4 (210 x 297 mm).
A5  Feed paper from the tray loaded with A5 (148 x 210 mm).
B5  Feed paper from the tray loaded with B5 (182 x 257 mm).
LT  Feed paper from the tray loaded with Letter (8.5 x 11 inches).
FL  Feed paper from the tray loaded with Folio (8.5 x 13 inches).
LG  Feed paper from the tray loaded with Legal (8.5 x 14 inches).
EX  Feed paper from the tray loaded with Executive (7.25 x 10.5 inches).
Feed paper from the tray loaded with Monarch (3.875 x 7.5 inches).

Feed paper from the tray loaded with Envelope #10 (4.125 x 9.5 inches).

Feed paper from the tray loaded with DL (110 x 220 mm).

Feed paper from the tray loaded with C5 (162 x 229 mm).

Feed paper from the tray loaded with Japanese Postcard (100 x 148 mm).

Feed paper from the tray loaded with Youkei 2 (114 x 162 mm).

Feed paper from the tray loaded with Youkei 3 (98 x 148 mm).

Feed paper from the tray loaded with Youkei 4 (105 x 235 mm).

Feed paper from the tray loaded with Youchoukei 3 (120 x 235 mm).

Feed paper from the tray loaded with Choukei 3 (120 x 235 mm).

Feed paper from the tray loaded with MxNmm defined by users.
Possible range specified:
Width: 76.2 to 220.0 mm
Length: 98.0 to 355.6 mm

Feed paper from the tray loaded with MxNinches defined by users.
Possible range specified:
Width: 3.00 to 8.66 inches
Length: 3.86 to 14.0 inches

If this option is not specified or the tray specified is not available, feed paper from the default tray.
Turns on the *save toner* mode for printing. The print result will be fainter than that of normal printing. In some cases, this option will be ignored.

```
-2
```
Sets printing to 2-column printing.

```
-f
```
Rotates the image by 90° and uses the paper in the landscape orientation.

```
-F
```
Ignores the form feed code (FF).

```
-llines
```
Specifies the number of lines per page.

```
-wcolumns
```
Specifies the number of columns per line.

```
-ooutcolumns
```
Converts print data to single-byte text and sets printing to start from outcolumns.

```
-Loutlines
```
Prints text from the outline columns.

```
-en
```
Expands horizontal tabs to *n* columns (space). The default is 8.

```
-ssize
```
Specifies the font size as point size. The default is 10.

```
-E
```
This function turns on the image enhancement function. For models without the image enhancement mechanism, this option will be ignored.

```
-ffont
```
Sets the font.

NOTE: The available fonts are limited to the font in the printer. For more information, see "Understanding Fonts."

-Nc=copies

Specifies the number of output copies (the value of copies must be a positive integer).

-cl

Specifies that printing be collated. If the copies option is not specified, this option will be ignored.

-ps

The input file will be processed as the PostScript file. If the file does not begin with %!, %! will be output to the beginning line. If a file contains %!, it will be processed in the same way as dellpsif.

-mg=up:bottom:right:left

Specifies the margin of a page in inches. The upper margin, bottom margin, right margin, and left margin are positive real numbers (up to two decimal points). The default is 0.

-mg=0:0:0:3

Sets the left margin to 3 inches.

-mg=3:3:0:5

Sets the upper margin to 3 inches; bottom margin, 3 inches; and left margin, 5 inches. If the margin is 0, it can be omitted.

-mg:::3

Sets the left margin to 3 inches.

-Hd=position:format:page

Specifies the position that the user information of the header or footer is output at. position specifies output position. But this option is available only for converting text files.

ul

Output on the upper left corner of the paper.

ur

Output on the upper right corner of the paper.

dl

Output on the lower left corner of the paper.
Output on the lower right corner of the paper.

*format* specifies the contents and the order to output. This option is omissible. If this option is omitted, *uh* is specified as the default value.

**u**

User name

**h**

Host name

**t**

Date and time

If the output contents are specified as *tuh*, it is output as follows.

Date and Time User: *username* Host: *hostname*

**page** specifies the page to output. This option is omissible.

**f**

Output the top page only.

(default in case of PostScript files conversion)

**a**

Output all pages.

(default in case of Text files conversion)

Specify these options as follows.

In the case that convert text file, output the host name following the user name on the upper right corner of the paper, output all pages. (User name, Host name, all page output are default)

- *Hd=ur*
- *Hd=ur:uh*
- *Hd=ur:uh:a*

In the case that convert PostScript file, output the host name following the date and time on the lower left corner of the paper, output all pages (*a* option value is necessary because *output the top page only* is default when PostScript file is converted.)

- *Hd=dl:th:a*

**NOTICE:** If the paper size is not specified, it outputs the header and footer at the position of A4 size by default. If the paper size is specified by *lp* command, the output position of the header or footer is not changed from the position of the paper size specified by *txt2ps2*. Specify the paper size at the same time when the header and footer option is used. Sometimes all pages are not printed despite specifying all page output when PostScript file conversion is specified. In such cases, specify *output the top page only*. By using TZ environmental variable, specify time zone (GMT etc.).
-Hf font

Specify the font to print the header and footer. European fonts the same as half size alphanumeric fonts can be specified. Helvetica is specified as default. If the wrong font is specified, the default European font of the printer can be used. If the header/footer output option is specified, the font specification for the header/footer is ignored.

-MSI

Specifies multipurpose feeder.

-M=type

Specifies multipurpose feeder Paper Type. Available multipurpose feeder Paper Types are as follows.

B

FinePaper/Bond/Plain Paper 2

BB

FinePaperBack/Bond/Plain Paper 2 - Side 2

P

Stationary/Plain/Plain Paper 1

PB

StationaryBack/Plain/Plain Paper 1 - Side 2

R

Recycled Paper

RB

RecycledPaperBack/ Recycled Paper - Side 2

H1

ThickPaper/Heavyweight 1/Covers 1

H1B

ThickPaperBack/Heavyweight 1/Covers 1 - Side 2

H2

ThickPaper2/Heavyweight 2/Covers 2

H2B

ThickPaper2Back/Heavyweight 2/Covers 2 - Side 2
OHP
  Transparency

L
  LabelPaper/Labels

C2
  Coated/Coated 2/Coated Paper 2

C2B
  Coated Back/Coated 2/Coated Paper 2- Side 2

C3
  Coated Thick/Coated 3/Coated Paper 3

C3B
  Coated Thick Back/Coated 3/Coated Paper 3- Side 2

JC

JCB

PC
  JapanesePostcard/Japanese Postcard

PCB

E
  Envelope

  If this option is not specified, multipurpose feeder Paper Type of the printer can be used.

-Mfo=mode

  Specifies orientation for multipurpose feeder.
  Available orientations for multipurpose feeder are as follows.

  le

  Landscape

  ler
Specifies alternate tray.
Available alternate trays are as follows.
0
  Use printer settings
1
  Display message
2
  Feed from multipurpose feeder
3
  Use nearest size (Adjust to fit)
4
  Use larger size (Adjust to fit)
5
  Use nearest size (No zoom)
6
  Use larger size (No zoom)

Specifies feed separators from.
Available feed separators froms are as follows.
auto
  AutoTray/Auto
1
  1stTray/Tray 1 (Standard 250-sheet tray)
2

2ndTray/Tray 2 (Optional 550-sheet feeder)

off

Off

-Sp

Specifies printed separators.
Available only when the paper tray for separators is specified.

-Sb

Specifies Skip Blank Pages.

-Cm=mode

Specifies output color.
Available output colors are as follows.

c

Color (CMYK)
k

Black

-Pr=mode

Specifies print mode.
Available print modes are as follows.

hs

High Speed

hq

High Quality

-Cc=mode

Specifies RGB Color Correction.
Available RGB Color Corrections are as follows.

0

Off

1
Photo

2

sRGB

3

Standard/ Normal

4

Presentation

This option is available only for color printing and when entry data is RGB data.

-Gc=mode

Specifies RGB gamma correction. Available RGB gamma corrections are as follows.

1.0

1.0

1.4

1.4

1.8

1.8

2.2

2.2

2.6

2.6

off

Off

This option is available only for color printing and when entry data is RGB data.

-Sc=mode

Specifies screen. Available screens are as follows.

0

Fineness
1
   Standard
2
   Auto
3
   Gradation

-Gg=mode

Specifies gray guaranteed. Available gray guaranteed options are as follows.

   on
      On
   off
      Off

This option is available only for color printing.

-Ct

Specifies color transformation. This option is available only for color printing.

-Br=mode

Specifies brightness adjustment. Available brightness adjustment option value are as follows.

+5
   Bright 5
+4
   Bright 4
+3
   Bright 3
+2
   Bright 2
+1
Bright 1
+0

Normal
-1

Dark 1
-2

Dark 2
-3

Dark 3
-4

Dark 4
-5

Dark 5

-rgb=mode

Specifies RGB color correction.
Available RGB color corrections are as follows.
10
Perceptual
11
Saturation
12
RelativeC
13
AbsoluteC

This option is available only for color printing and when entry data is RGB data.

-rgb=mode

Specifies RGB input profile.
Available RGB input profile option value are as follows.
-sRGB

1

-AdobeRGB

This option is available only for color printing and when entry data is RGB data.

-RGBT=mode

Specifies RGB color temperature.

Available RGB color temperature option value are as follows.

5000

5000K

6000

6000K

9300

9300K

This option is available only for color printing and when entry data is RGB data.


Specifies adjustment value for color balance of each color/density.

Available adjustment values are as follows.

+3

Dark 3

+2

Dark 2

+1

Dark 1

0

Normal

-1

Light 1
Light 2

Light 3

-Cb

Option value must be specified in the following order:

Cyan low density, Cyan medium density, Cyan high density, Magenta low density, Magenta medium density, Magenta high density, Yellow low density, Yellow medium density, Yellow high density, Black low density, Black medium density, Black high density

If no value is specified, it is treated as "0" (Normal).

For example, if you want to specify "Light 2" for Cyan medium density, "Dark 3" for Yellow high density, and "Dark 2" for Black low density, it can be specified using either of the following:

-Cb=0:-2:0:0:0:0:0:+3:+2:0:0

-Cb=:--2:-----+3:+2::

-Hld=PrintType:UserID:Password:DocumentName

Secure Print

PrintType

store

Secure Print/Store Print

proof

Proof Print

UserID

Up to eight single-byte characters from 0x20 to 0x7E, except 0x20 " " (blank) and 0x3A":" (colon).

Password

Up to 12 single-byte characters from 0x30 to 0x39 (numeric characters).

DocumentName

Up to 12 single-byte characters from 0x20 to 0x7E, except 0x20 " " (blank) and 0x3A":" (colon).

Secure Print

-Hld=store:UserID:Password:DocumentName
-Hld=store:UserID:Password:

Store Print

- Hld=store:UserID::DocumentName

- Hld=store:UserID::

Proof Print

- Hld=proof:UserID::DocumentName

- Hld=proof:UserID::

**NOTICE:** Make sure you specify Secure Print only when you directly print data to a printer. Secure Print may not be available if you specify it when data need to be printed through another server or data need to be handled by another program such as PostScript files. Collate is automatically specified when you specify Proof Print.

-Jown= jobownername: Password Authentication Setting

Specifies job owner name and password for authentication.

- When only job owner name is specified (-Jown=jobownername:) (no password specified), authentication password is treated as not specified.

- When only password is specified (-Jown=:password) (no job owner name specified), login user name is used as job owner name. Entered password is used as authentication password.

- When neither of job owner name nor password is specified (-Jown=:), login user name is used as job owner name, and authentication password is treated as not specified.

- When a job owner name exceeds allowable character length, the extra characters are ignored.

- When an unacceptable character is specified for job owner name, "Unknown User" is used as job owner name.

**NOTE:** Characters acceptable for job owner name are alphanumeric characters and symbols, except for space and colon.

**NOTE:** Up to 32 characters are acceptable for job owner name.

- When an unacceptable character is specified for password, or when a specified password is not within the range of the allowable character length, the authentication password is treated as not specified.

**NOTE:** Only numbers are acceptable for password.

**NOTE:** Acceptable password length is between 4 and 12 characters.

Incomplete form of -Jown option is treated as no authentication setting being made. In such case, if authentication setting is made with the environmental variable, it is used as setting information.
Example

To convert the program list of the file.txt file into the PostScript language program that sets the paper to the landscape orientation and prints in the 2-up mode, type as follows:

```
% txt2ps2 -r -2 file.txt | lpr (for Linux)
% txt2ps2 -r -2 file.txt | lp (for Solaris/HP-UX)
```

To convert file.txt to the PostScript language program and output it to the file.ps file, type as follows:

```
% txt2ps2 file.txt > file.ps
% lpr file.ps (for Linux)
% lp file.ps (for Solaris/HP-UX)
```

To convert the output result of the command into the PostScript language program using txt2ps2 and print it to the printer, type as follows:

```
% ls -alF | txt2ps2 | lpr (for Linux)
% ls -alF | txt2ps2 | lp (for Solaris/HP-UX)
```

Environmental Variable

TXT2PS2OPTION

Optional settings based on the environmental variable. To output in the 2-up mode, 8 points and the landscape orientation, type as follows:

```
% setenv TXT2PS2OPTION "-2 -s8 -r"
```

To use the same options as those of the dellpsif filter specified by printcap, type as follows:

```
% setenv TXT2PS2OPTION "<dellpsif>"
```

File

/usr/local/dellbin3110/.dellpsdefault3110
This is the default command option setting file for individual users.

Important

- When the same option is specified twice, the later setting will prevail. As TXT2PS2OPTION is analyzed before the option of the command line, it is possible to temporarily modify the options already set in TXT2PS2OPTION by typing at the command line.

- The comment description (`%%page:m n`) of the page number cannot be output to the PostScript program file which is output by the default option of txt2ps2. Thus, when the output of txt2ps2 is to be taken as the output of another application (psrev of TRANSCRIPT, etc.), add the page number description by inserting the line command (`-Ilines`).
- If a BS code is found at the beginning of a line, the print position of the next character will be located at the left of the beginning of the line.

- When there are multiple tab codes in one line, the tab position may be off as a result of automatic line feed. In such case, use the `-t` or `-w` option.

- The number of columns specified by the `-w` option is not the actual number of printed characters. The actual number of single-byte characters to be printed is derived by deducting the output column position (outcolumns) specified by the `o` option from the number of columns specified by the `-w` option. The `-mg` option cannot be specified when `-w`, `-l`, `-r`, and `-L` option are specified. The start positions of margin of the margin command (`-mg=u:b:r:l`) are not set against the edge of the paper. The margins are set against the printable area of the paper allowed by the printer. Use the `-ps` option only when a PostScript file that contains no `%` at the beginning of the file is used as the PostScript file. If a normal text file is input, it will not function correctly.

- In HP-UX, txt2ps2 considers files written by PostScript that contain `%` at the beginning of the file as the PostScript files. To print PostScript files as text files, specify the `TX` option. With this option, PostScript files will be processed as text files.

**sunras2ps2 (Solaris)**

**Format**

```
[=-Cb=cyan-low:cyan-middle:cyan-high:magenta-low:magenta-middle:magenta-high:yellow-
Hld=PrintType:UserID:Password:DocumentName] [-Jown= jobownername:password] [filename...]
```

**Function**

Reads SunRaster data, converts it to the PostScript language program and writes to standard output. If the filename is not specified, the standard input will be taken as the command input. SunRaster files with a pixel depth of 1, 8, 24, and 32 bits can be specified.

sunras2ps2 takes filename as having been created in 72dpi and calculates the output size. Thus, to convert SunRaster files created in other resolutions, specify the size option (`-s`, `-S`) explicitly.

**Option**

- `-d`

   Enables the short-edge binding feature. When it is specified, the printing direction or position will be adjusted and both sides of the paper printed so that the shorter edge of the pages can be bound. This option is available only when the optional duplexer is installed on the printer.
-D

Enables the long-edge binding feature. When it is specified, the printing direction or position will be adjusted and both sides of the paper printed so that the longer edge of the pages can be bound. This option is available only when the optional duplexer is installed on the printer.

-itray-input

Specifies the paper tray. A paper tray can be selected by directly specifying a tray or by specifying a paper size. When a paper size is specified, the tray loaded with paper of the specified size will be found and selected automatically.

The parameters for selecting a paper tray are as follows.

1

Feed paper from tray 1 (Standard 250-sheet tray).

2

Feed paper from tray 2 (Optional 550-sheet feeder).

A4

Feed paper from the tray loaded with A4 (210 x 297 mm).

A5

Feed paper from the tray loaded with A5 (148 x 210 mm).

B5

Feed paper from the tray loaded with B5 (182 x 257 mm).

LT

Feed paper from the tray loaded with Letter (8.5 x 11 inches).
Feed paper from the tray loaded with Folio (8.5 x 13 inches).

Feed paper from the tray loaded with Legal (8.5 x 14 inches).

Feed paper from the tray loaded with Executive (7.25 x 10.5 inches).

Feed paper from the tray loaded with Monarch (3.875 x 7.5 inches).

Feed paper from the tray loaded with Envelope #10 (4.125 x 9.5 inches).

Feed paper from the tray loaded with DL (110 x 220 mm).

Feed paper from the tray loaded with C5 (162 x 229 mm).

Feed paper from the tray loaded with Japanese Postcard (100 x 148 mm).

Feed paper from the tray loaded with Youkei 2 (114 x 162 mm).

Feed paper from the tray loaded with Youkei 3 (98 x 148 mm).

Feed paper from the tray loaded with Youkei 4 (105 x 235 mm).

Feed paper from the tray loaded with Youchoukei 3 (120 x 235 mm).

Feed paper from the tray loaded with Choukei 3 (120 x 235 mm).

Feed paper from the tray loaded with MxNmm defined by users.

Possible range specified:
Width: 76.2 to 220.0 mm
Length: 98.0 to 355.6 mm

mxn

Feed paper from the tray loaded with MxN inches defined by users.

Possible range specified:
Width: 3.00 to 8.66 inches
Length: 3.86 to 14.0 inches

If this option is not specified or the tray specified is not available, feed paper from the default tray.

-t

Turns on the save toner mode for printing. The print result will be fainter than that of normal printing. In some cases, this option will be ignored.

-r

Rotates the image by 90° and uses the paper in the landscape orientation.

-n

Disables the addition of the showpage. It is used when files converted to the PostScript language program are merged with files created with other applications.

-l=left,bottom

Specifies the print position. Printing will be executed from the left and bottom of the page. The default is 0.25 inches for both left and bottom.

-s=width,height

Specifies the output size. Printing will be executed with the width and height in inches.

-S=width

Sets the width of the output size in inches. The height will be calculated automatically according to the width.

-E

This function turns on the image enhancement function. In some cases, this option will be ignored.

-Nc=copies

Specifies the number of output copies (the value of copies must be a positive integer).
-Cl

Specifies that printing be collated. If the copies option is not specified, this option will be ignored.

-Hd=position:format

Specifies the position to be output the user information as the header or footer. 
position specifies output position. But this option is available only for converting text files.

ul
Output on the upper left corner of the paper.

ur
Output on the upper right corner of the paper.

dl
Output on the lower left corner of the paper.

dr
Output on the lower right corner of the paper.

format specifies the contents and the order to output. This option is omissible.
If this option is omitted, uh is specified as the default value.

u
User name

h
Host name

t
Date and time
If the output contents are specified as tuh, it is output as follows.
Date and Time User: username Host: hostname.

Specify these options as follows.
In the case that convert text file, output the host name following the user name on the upper right corner of the paper, output all pages.
(User name, Host name, all page output are default)

-Hd=ur
-Hd=ur:uh

-Hf font

Specify the font to print the header and footer. European fonts the same as half size alphanumeric fonts can be specified. Helvetica is specified as default.
If the wrong font is specified, default European font of the printer can be used.
If header/footer output option is specified, the font specification of header/footer is ignored.
Specifies multipurpose feeder.

-M=type

Specifies multipurpose feeder Paper Type. Available multipurpose feeder Paper Types are as follows.

B
FinePaper/Bond/Plain Paper 2

BB
FinePaperBack/Bond/Plain Paper 2 - Side 2

P
Stationary/Plain/Plain Paper 1

PB
StationaryBack/Plain/Plain Paper 1 - Side 2

R
Recycled Paper

RB
RecycledPaperBack/Recycled Paper - Side 2

H1
ThickPaper/Heavyweight 1/Covers 1

H1B
ThickPaperBack/Heavyweight 1/Covers 1 - Side 2

H2
ThickPaper2/Heavyweight 2/Covers 2

H2B
ThickPaper2Back/Heavyweight 2/Covers 2 - Side 2

OHP
Transparency

L
LabelPaper/Labels
-Mfo=mode

Specifies orientation for multipurpose feeder. Available orientations for multipurpose feeder are as follows.

le

Landscape

ler

Landscape (Rotated)

se

Portrait

ser
Specifies alternate tray. Available alternate trays are as follows.

0

Use printer settings

1

Display message

2

Feed from multipurpose feeder

3

Use nearest size (Adjust to fit)

4

Use larger size (Adjust to fit)

5

Use nearest size (No zoom)

6

Use larger size (No zoom)

Specifies feed separators from. Available feed separators from the following.

auto

AutoTray/Auto

1

1stTray/Tray 1 (Standard 250-sheet tray)

2

2ndTray/Tray 2 (Optional 550-sheet feeder)

off

Off
-Sp
Specifies printed separators.
Available only when the paper tray for separators is specified.

-Sb
Specifies Skip Blank Pages.

-Cm=mode
Specifies output color.
Available output colors are as follows.
c
             Color (CMYK)
k
             Black

-Pr=mode
Specifies print mode.
Available print modes are as follows.
hs
             High speed
hq
             High quality
sf
             Super fine

-Cc=mode
Specifies image types.
Available image types are as follows.
0
             Off
1
             Photo
2
sRGB
3

Standard/ Normal
4

Presentation
This option is available only for color printing and when entry data is RGB data.

-Gc=mode

Specifies RGB gamma correction.
Available RGB gamma corrections are as follows.

1.0

1.0

1.4

1.4

1.8

1.8

2.2

2.2

2.6

2.6

off

Off
This option is available only for color printing and when entry data is RGB data.

-Sc=mode

Specifies screen.
Available screens are as follows.

0

Fineness

1

Gradation
2

Auto

3

For Transparency

-Gg=mode

Specifies gray guaranteed.
Available gray guaranteed options are as follows.

on

   On

off

   Off

This option is available only for color printing.

-Ct

Specifies color transformation.
This option is available only for color printing.

-Br=mode

Specifies brightness adjustment.
Available brightness adjustment option values are as follows.

+5

   Bright 5

+4

   Bright 4

+3

   Bright 3

+2

   Bright 2

+1

   Bright 1
-1
Dark 1
-2
Dark 2
-3
Dark 3
-4
Dark 4
-5
Dark 5

-RGBc=mode
Specifies RGB color correction.
Available RGB color corrections are as follows.
10
Perceptual
11
Saturation
12
RelativeC
13
AbsoluteC
This option is available only for color printing and when entry data is RGB data.

-RGBPr=mode
Specifies RGB input profile.
Available RGB input profile option value are as follows.
0
sRGB

1

AdobeRGB

This option is available only for color printing and when entry data is RGB data.

-rgbtp=mode

Specifies RGB color temperature.

Available RGB color temperature option value are as follows.

5000

5000K

6000

6000K

9300

9300K

This option is available only for color printing and when entry data is RGB data.


Specifies adjustment value for color balance of each color/density.

Available adjustment values are as follows.

+3

Dark 3

+2

Dark 2

+1

Dark 1

0

Normal

-1

Light 1

-2
Light 2
-3

Light 3
-Cb

Option value must be specified in the following order:
Cyan low density, Cyan medium density, Cyan high density, Magenta low density, Magenta medium density, Magenta high density, Yellow low density, Yellow medium density, Yellow high density, Black low density, Black medium density, Black high density

If no value is specified, it is treated as "0" (Normal).

For example, if you want to specify "Light 2" for Cyan medium density, "Dark 3" for Yellow high density, and "Dark 2" for Black low density, it can be specified using either of the following:
-Cb=0:-2:0:0:0:0:0:0:+3:+2:0:0
-Cb=:-2:0:0:0:0:0:0:+3:+2:0:

-Hld=PrintType:UserID:Password:DocumentName

Secure Print
PrintType
store

Secure Print/Store Print
proof

Proof Print

UserID

Up to eight single-byte characters from 0x20 to 0x7E, except 0x20 " " (blank) and 0x3A":" (colon).

Password

Up to 12 single-byte characters from 0x30 to 0x39 (numeric characters).

DocumentName

Up to 12 single-byte characters from 0x20 to 0x7E, except 0x20 " " (blank) and 0x3A":" (colon).

Secure Print

-Hld=store:UserID:Password:DocumentName

-Hld=store:UserID:Password:
Store Print

- Hld=store:UserID::DocumentName
- Hld=store:UserID::

Proof Print

- Hld=proof:UserID::DocumentName
- Hld=proof:UserID::

**NOTICE:** Make sure you specify Secure Print only when you directly print data to a printer. Secure Print may not be available if you specify it when data need to be printed through another server or data need to be handled by another program such as PostScript files. Collate is automatically specified when you specify Proof Print.

-Jown= jobownername: Password Authentication Setting

Specifies job owner name and password for authentication.

- When only job owner name is specified (-Jown=jobownername:) (no password specified), authentication password is treated as not specified.
- When only password is specified (-Jown=:password) (no job owner name specified), login user name is used as job owner name. Entered password is used as authentication password.
- When neither of job owner name nor password is specified (-Jown=:), login user name is used as job owner name, and authentication password is treated as not specified.
- When a job owner name exceeds allowable character length, the extra characters are ignored.
- When an unacceptable character is specified for job owner name, "Unknown User" is used as job owner name.

**NOTE:** Characters acceptable for job owner name are alphanumeric characters and symbols, except for space and colon.

**NOTE:** Up to 32 characters are acceptable for job owner name.

- When an unacceptable character is specified for password, or when a specified password is not within the range of the allowable character length, the authentication password is treated as not specified.

**NOTE:** Only numbers are acceptable for password.

**NOTE:** Acceptable password length is between 4 and 12 characters.

Incomplete form of -Jown option is treated as no authentication setting being made. In such case, if authentication setting is made with the environmental variable, it is used as setting information.
Example

To output the displayed screen image to a file using the snapshot command and convert the file into the PostScript language program using the `sunras2ps2` command, type as follows.

```bash
% sunras2ps2 file.rs > file.ps
```

To output the displayed screen image to a file using the snapshot command, convert the file into the PostScript language program using the `sunras2ps2` command and output it to a printer, type as follows.

```bash
% sunras2ps2 file.rs | lp
```

Important

- When `-s` and `-S` are specified at the same time or when the same option is specified twice, the later setting will prevail.

- If the output size option (`-s`, `-S`) is not specified, scaling will be executed taking one pixel of the raster data as one pixel of the printer.

- If the print position option specifies a point beyond the printable area of the printer, data beyond the printable area will not be printed.

`tiff2ps2` (Linux/Solaris/HP-UX)

Format

```
```

Function

Reads TIFF data, converts it to the PostScript language program and writes to standard output. If the filename is not specified, the standard input will be taken as the command input. TIFF files with a pixel depth of 1, 4, 8, 24, and 32 bits can be specified.

There are four types of supported compression formats.

- Huffman compression (CCITT Group 3 transformed Huffman run length encoding)
- Fax-CCITT3 compression (facsimile-compatible CCITT Group 3)
- PackBits compression
- Non-compression

Even in the above compression format, the TIFF file that has multiple images in one file is not supported.

tiff2ps2 takes filename as having been created in 72 dpi and calculates the output size. Thus, to convert TIFF files created in other resolutions, specify the size option (`-s`, `-S`) explicitly for conversion.
**Option**

-d

Enables the short-edge binding feature. When it is specified, the printing direction or position will be adjusted and both sides of the paper printed so that the shorter edge of the pages can be bound. This option is available only when the optional duplexer is installed on the printer.

-D

Enables the long-edge binding feature. When it is specified, the printing direction or position will be adjusted and both sides of the paper printed so that the longer edge of the pages can be bound. This option is available only when the optional duplexer is installed on the printer.

-tray-input

Specifies the paper tray. A paper tray can be selected by directly specifying a tray or by specifying a paper size. When a paper size is specified, the tray loaded with paper of the specified size will be found and selected automatically.
The parameters for selecting a paper tray are as follows.

1

Feed paper from tray 1 (Standard 250-sheet tray).

2

Feed paper from tray 2 (Optional 550-sheet feeder).

A4

Feed paper from the tray loaded with A4 (210 x 297 mm).

A5
Feed paper from the tray loaded with A5 (148 x 210 mm).

B5
Feed paper from the tray loaded with B5 (182 x 257 mm).

LT
Feed paper from the tray loaded with Letter (8.5 x 11 inches).

FL
Feed paper from the tray loaded with Folio (8.5 x 13 inches).

LG
Feed paper from the tray loaded with Legal (8.5 x 14 inches).

EX
Feed paper from the tray loaded with Executive (7.25 x 10.5 inches).

MO
Feed paper from the tray loaded with Monarch (3.875 x 7.5 inches).

COM10
Feed paper from the tray loaded with Envelope #10 (4.125 x 9.5 inches).

DL
Feed paper from the tray loaded with DL (110 x 220 mm).

C5
Feed paper from the tray loaded with C5 (162 x 229 mm).

PC
Feed paper from the tray loaded with Japanese Postcard (100 x 148 mm).

Y2
Feed paper from the tray loaded with Youkei 2 (114 x 162 mm).

Y3
Feed paper from the tray loaded with Youkei 3 (98 x 148 mm).

Y4
Feed paper from the tray loaded with Youkei 4 (105 x 235 mm).

YT3
Feed paper from the tray loaded with Youchoukei 3 (120 x 235 mm).
Feed paper from the tray loaded with Choukei 3 (120 x 235 mm).

Feed paper from the tray loaded with MxNmm defined by users
Possible range specified:
- Width: 76.2 to 220.0 mm
- Length: 98.0 to 355.6 mm

Feed paper from the tray loaded with MxNinches defined by users
Possible range specified:
- Width: 3.00 to 8.66 inches
- Length: 3.86 to 14.0 inches

If this option is not specified or the tray specified is not available, feed paper from the default tray.

-t
Turns on the save toner mode for printing. The print result will be fainter than that of normal printing. In some cases, this option will be ignored.

-r
Rotates the image by 90° and uses the paper in the landscape orientation.

-n
Disables the addition of the showpage. It is used when files converted to the PostScript language program are merged with files created with other applications.

-l=left,bottom
Specifies the print position. Printing will be executed from the left and bottom of the page. The default is 0.25 inches for both left and bottom.

-s=width,height
Specifies the output size. Printing will be executed with the width and height in inches.

-S=width
Sets the width of the output size in inches. The height will be calculated automatically according to the width.
This function turns on the image enhancement function. In some cases, this option will be ignored.

-Nc=\texttt{copies}

Specifies the number of output copies (the value of \texttt{copies} must be a positive integer).

-CI

Specifies that printing be collated. If the copies option is not specified, this option will be ignored.

-Hd=\texttt{position:format}

Specifies the position to be output the user information as the header or footer. \texttt{position} specifies output position. But this option is available only for converting text files.

\texttt{ul}

Output on the upper left corner of the paper.

\texttt{ur}

Output on the upper right corner of the paper.

\texttt{dl}

Output on the lower left corner of the paper.

\texttt{dr}

Output on the lower right corner of the paper.

\texttt{format} specifies the contents and the order to output. This option is omissible. If this option is omitted, \texttt{uh} is specified as the default value.

\texttt{u}

User name

\texttt{h}

Host name

\texttt{t}

Date and time

If the output contents are specified as \texttt{tuh}, it is output as follows.

Date and Time User: \texttt{username} Host: \texttt{hostname}.

Specify these options as follows.

In the case that convert text file, output the host name following the user name on the upper right corner of the paper, output all pages.

(User name, Host name, all page output are default)

-Hd=ur

-Hd=ur:uh
Specify the font to print header and footer. European fonts the same as half size alphanumeric fonts can be specified. Helvetica is specified as default. If the wrong font is specified, default European font of the printer can be used. If header/footer output option is specified, the font specification of header/footer is ignored.

Specifies multipurpose feeder.

Specifies multipurpose feeder Paper Type. Available multipurpose feeder Paper Types are as follows.

- **B**
  - FinePaper/Bond/Plain Paper 2

- **BB**
  - FinePaperBack/Bond/Plain Paper 2 - Side 2

- **P**
  - Stationary/Plain/Plain Paper 1

- **PB**
  - StationaryBack/Plain/Plain Paper 1 - Side 2

- **R**
  - Recycled Paper

- **RB**
  - RecycledPaperBack/Recycled Paper - Side 2

- **H1**
  - ThickPaper/Heavyweight 1/Covers 1

- **H1B**
  - ThickPaperBack/Heavyweight 1/Covers 1 - Side 2

- **H2**
  - ThickPaper2/Heavyweight 2/Covers 2

- **H2B**
  - ThickPaper2Back/Heavyweight 2/Covers 2 - Side 2
OHP

  Transparency

L

  LabelPaper/Labels

C2

  Coated/Coated 2/Coated Paper 2

C2B

  Coated Back/Coated 2/Coated Paper 2- Side 2

C3

  Coated Thick/Coated 3/Coated Paper 3

C3B

  Coated Thick Back/Coated 3/Coated Paper 3- Side 2

JC


JCB


PC

  JapanesePostcard/Japanese Postcard

PCB


E

  Envelope

  If this option is not specified, multipurpose feeder Paper Type of the printer can be used.

-Mfo=mode

  Specifies orientation for multipurpose feeder.
  Available orientations for multipurpose feeder are as follows.

le

  Landscape

ler
Landscape (Rotated)

Portrait

Portrait (Rotated)

-Pon

Specifies alternate tray.
Available alternate trays are follows.

0

Use printer settings

1

Display message

2

Feed from multipurpose feeder

3

Use nearest size (Adjust to fit)

4

Use larger size (Adjust to fit)

5

Use nearest size (No zoom)

6

Use larger size (No zoom)

-St=mode

Specifies feed separators from.
Available feed separators from the following.

auto

AutoTray/Auto

1

1stTray/Tray 1 (Standard 250-sheet tray)
2nd Tray/Tray 2 (Optional 550-sheet feeder)

off

Off

-Sp

Specifies printed separators. Available only when the paper tray for separators is specified.

-Sb

Specifies Skip Blank Pages.

-Cm=mode

Specifies output color. Available output colors are as follows.

c

Color (CMYK)

k

Black

-Pr=mode

Specifies print mode. Available print modes are as follows.

hs

High speed

hq

High quality

sf

Super fine

-Cc=mode

Specifies image types. Available image types are as follows.

0
Off

1

Photo

2

sRGB

3

Standard/ Normal

4

Presentation

This option is available only for color printing and when entry data is RGB data.

-Gc=mode

Specifies RGB gamma correction.
Available RGB gamma corrections are as follows.

1.0

1.0

1.4

1.4

1.8

1.8

2.2

2.2

2.6

2.6

off

Off

This option is available only for color printing and when entry data is RGB data.

-Sc=mode

Specifies screen.
Available screens are as follows.
0
  Fineness
1
  Gradation
2
  Auto
3

For Transparency

-Gg=mode
  Specifies gray guaranteed.
  Available gray guaranteed options are as follows.
  on
    On
  off
    Off

  This option is available only for color printing.

-Ct
  Specifies color transformation.
  This option is available only for color printing.

-Br=mode
  Specifies brightness adjustment.
  Available brightness adjustment option value are as follows.
  +5
    Bright 5
  +4
    Bright 4
  +3
    Bright 3
  +2
Bright 2
+1

Bright 1
+0

Normal
-1

Dark 1
-2

Dark 2
-3

Dark 3
-4

Dark 4
-5

Dark 5

-\texttt{RGBc=mode}

Specifies RGB color correction.

Available RGB color corrections are as follows.

10

Perceptual

11

Saturation

12

RelativeC

13

AbsoluteC

This option is available only for color printing and when entry data is RGB data.

-\texttt{RGBPr=mode}
Specifies RGB input profile.

Available RGB input profile option value are as follows.

0
   sRGB
1
   AdobeRGB

This option is available only for color printing and when entry data is RGB data.

-RGBTp=mode

Specifies RGB color temperature.

Available RGB color temperature option value are as follows.

5000
   5000K
6000
   6000K
9300
   9300K

This option is available only for color printing and when entry data is RGB data.

-Cb=cyan-low:cyan-middle:cyan-high:magenta-low:magenta-middle:magenta-high:yellow-
low:yellow-middle:yellow high:black-low:black-middle:black-high

Specifies adjustment value for color balance of each color/density.

Available adjustment values are as follows.

+3
   Dark 3
+2
   Dark 2
+1
   Dark 1
0
   Normal
Option value must be specified in the following order:

Cyan low density, Cyan medium density, Cyan high density, Magenta low density, Magenta medium density, Magenta high density, Yellow low density, Yellow medium density, Yellow high density, Black low density, Black medium density, Black high density

If no value is specified, it is treated as "0" (Normal).

For example, if you want to specify "Light 2" for Cyan medium density, "Dark 3" for Yellow high density, and "Dark 2" for Black low density, it can be specified using either of the following:

-Cb=0:-2:0:0:0:0:0:+3:+2:0:0
-Cb=:-2::::::::+3:+2:0:

-Hld=PrintType:UserID:Password:DocumentName

Secure Print

PrintType

store

Secure Print/Store Print

proof

Proof Print

UserID

Up to eight single-byte characters from 0x20 to 0x7E, except 0x20 " " (blank) and 0x3A ":" (colon).

Password

Up to 12 single-byte characters from 0x30 to 0x39 (numeric characters).

DocumentName

Up to 12 single-byte characters from 0x20 to 0x7E, except 0x20 " " (blank) and 0x3A ":" (colon).
Secure Print

-Hld=store:UserID:Password:DocumentName

-Hld=store:UserID:Password:

Store Print

-Hld=store:UserID::DocumentName

-Hld=store:UserID::

Proof Print

-Hld=proof:UserID::DocumentName

-Hld=proof:UserID::

**NOTICE:** Make sure you specify Secure Print only when you directly print data to a printer. Secure Print may not be available if you specify it when data need to be printed through another server or data need to be handled by another program such as PostScript files. Collate is automatically specified when you specify Proof Print.

-Jown= jobownername: Password Authentication Setting

Specifies job owner name and password for authentication.

- When only job owner name is specified (-Jown=jobownername:) (no password specified), authentication password is treated as not specified.
- When only password is specified (-Jown=:password) (no job owner name specified), login user name is used as job owner name. Entered password is used as authentication password.
- When neither of job owner name nor password is specified (-Jown=:), login user name is used as job owner name, and authentication password is treated as not specified.
- When a job owner name exceeds allowable character length, the extra characters are ignored.
- When an unacceptable character is specified for job owner name, "Unknown User" is used as job owner name.

**NOTE:** Characters acceptable for job owner name are alphanumeric characters and symbols, except for space and colon.

**NOTE:** Up to 32 characters are acceptable for job owner name.

- When an unacceptable character is specified for password, or when a specified password is not within the range of the allowable character length, the authentication password is treated as not specified.

**NOTE:** Only numbers are acceptable for password.
NOTE: Acceptable password length is between 4 and 12 characters.

Incomplete form of -Jown option is treated as no authentication setting being made. In such case, if authentication setting is made with the environmental variable, it is used as setting information.

Example

To convert the TIFF image into the PostScript language program and output it to a file, type as follows.

% tiff2ps2 file.tiff > file1.ps

To output the TIFF image to a printer, type as follows.

% tiff2ps2 file.tiff | lpr (for Linux)
% tiff2ps2 file.tiff | lp (for Solaris/HP-UX)

Important

- When -s and -S are specified at the same time or when the same option is specified twice, the later setting will prevail.
- When the output size option (-s, -S) is not specified, scaling will be executed taking one pixel of the TIFF data as one pixel of the printer.
- If the print position option (-l left bottom) specifies a point beyond the printable area of the printer, data beyond the printable area will not be printed.

xwd2ps2 (Linux/Solaris/HP-UX)

Format


Function

Reads XWD data, converts it to the PostScript language program and writes to standard output. If the filename is not specified, the standard input will be taken as the command input. XWD files with a pixel depth of 1, 4, 8, 24, and 32 bits can be specified.
There are three types of supported compression formats.
The visual class is Static Gray and the pixel is 1 bit.
The visual class is Pseudo Color and the pixel is 4 bits or 8 bit. The image format is ZPixmap.
The visual class is True Color and the pixel is 24 bits or 32 bit. The image format is Zpixmap. xwd2ps2 takes filename as having been created in 72dpi and calculates the output size. Thus, to convert XWD files created in other resolutions, specify the size option (–s, –S) explicitly for conversion.

Option

–d

Enables the short-edge binding feature. When it is specified, the printing direction or position will be adjusted and both sides of the paper printed so that the shorter edge of the pages can be bound. This option is available only when the optional duplexer is installed on the printer.

–D

Enables the long-edge binding feature. When it is specified, the printing direction or position will be adjusted and both sides of the paper printed so that the longer edge of the pages can be bound. This option is available only when the optional duplexer is installed on the printer.

–itray-input

Specifies the paper tray. A paper tray can be selected by directly specifying a tray or by specifying a paper size. When a paper size is specified, the tray loaded with paper of the specified size will be found and selected automatically.
The parameters for selecting a paper tray are as follows.

1

Feed paper from tray 1 (Standard 250-sheet tray).

2

Feed paper from tray 2 (Optional 550-sheet feeder).
Feed paper from the tray loaded with A4 (210 x 297 mm).

A5
Feed paper from the tray loaded with A5 (148 x 210 mm).

B5
Feed paper from the tray loaded with B5 (182 x 257 mm).

LT
Feed paper from the tray loaded with Letter (8.5 x 11 inches).

FL
Feed paper from the tray loaded with Folio (8.5 x 13 inches).

LG
Feed paper from the tray loaded with Legal (8.5 x 14 inches).

EX
Feed paper from the tray loaded with Executive (7.25 x 10.5 inches).

MO
Feed paper from the tray loaded with Monarch (3.875 x 7.5 inches).

COM10
Feed paper from the tray loaded with Envelope #10 (4.125 x 9.5 inches).

DL
Feed paper from the tray loaded with DL (110 x 220 mm).

C5
Feed paper from the tray loaded with C5 (162 x 229 mm).

PC
Feed paper from the tray loaded with Japanese Postcard (100 x 148 mm).

Y2
Feed paper from the tray loaded with Youkei 2 (114 x 162 mm).

Y3
Feed paper from the tray loaded with Youkei 3 (98 x 148 mm).

Y4
Feed paper from the tray loaded with Youkei 4 (105 x 235 mm).
Feed paper from the tray loaded with Youchoukei 3 (120 x 235 mm).

Feed paper from the tray loaded with Choukei 3 (120 x 235 mm).

Feed paper from the tray loaded with MxN mm defined by users.
Possible range specified:
Width: 76.2 to 220.0 mm
Length: 98.0 to 355.6 mm

Feed paper from the tray loaded with MxN inches defined by users
Possible range specified:
Width: 3.00 to 8.66 inches
Length: 3.86 to 14.0 inches

If this option is not specified or the tray specified is not available, feed paper from the default tray.

-t
Turns on the save toner mode for printing. The print result will be fainter than that of normal printing. In some cases, this option will be ignored.

-r
Rotates the image by 90° and uses the paper in the landscape orientation

-n
Disables the addition of the showpage. It is used when files converted to the PostScript language program are merged with files created with other applications.

-l=left,bottom
Specifies the print position. Printing will be executed from the left and bottom of the page. The default is 0.25 inches for both left and bottom.

-s=width,height
Specifies the output size. Printing will be executed with the width and height in inches.

-S=width
Sets the width of the output size in inches. The height will be calculated automatically according to the width.
-E

This function turns on the image enhancement function. In some cases, this option will be ignored.

-Nc=copies

Specifies the number of output copies (the value of copies must be a positive integer).

-C1

Specifies that printing be collated. If the copies option is not specified, this option will be ignored.

-Hd=position:format

Specifies the position to be output the user information as the header or footer. position specifies output position. But this option is available only for converting text files.

ul

Output on the upper left corner of the paper.

ur

Output on the upper right corner of the paper.

dl

Output on the lower left corner of the paper.

dr

Output on the lower right corner of the paper.

format specifies the contents and the order to output. This option is omissible. If this option is omitted, uh is specified as the default value.

u

User name

h

Host name

t

Date and time

If the output contents are specified as tuh, it is output as follows.

Date and Time User: username Host: hostname.

-Hf=font

Specify the font to print header and footer. European fonts the same as half size alphanumeric fonts can be specified. Helvetica is specified as default.
If the wrong font is specified, default European font of the printer can be used. If header/footer output option is specified, the font specification of header/footer is ignored.

-MSI

Specifies multipurpose feeder.

-M=type

Specifies multipurpose feeder Paper Type. Available multipurpose feeder Paper Types are as follows.

B

FinePaper/Bond/Plain Paper 2

BB

FinePaperBack/Bond/Plain Paper 2 - Side 2

P

Stationary/Plain/Plain Paper 1

PB

StationaryBack/Plain/Plain Paper 1 - Side 2

R

Recycled Paper

RB

RecycledPaperBack/Recycled Paper - Side 2

H1

ThickPaper/Heavyweight 1/Covers 1

H1B

ThickPaperBack/Heavyweight 1/Covers 1 - Side 2

H2

ThickPaper2/Heavyweight 2/Covers 2

H2B

ThickPaper2Back/Heavyweight 2/Covers 2 - Side 2

OHP

Transparency
Label Paper/Labels

Coated/Coated 2/Coated Paper 2

Coated Back/Coated 2/Coated Paper 2-Side 2

Coated Thick/Coated 3/Coated Paper 3

Coated Thick Back/Coated 3/Coated Paper 3-Side 2


Japanese Postcard/Japanese Postcard


Envelope

If this option is not specified, multipurpose feeder Paper Type of the printer can be used.

-Mfo=mode

Specifies orientation for multipurpose feeder.
Available orientations for multipurpose feeder are as follows.

L Landscape

Lr Landscape (Rotated)

Se
-Pon

Specifies alternate tray. Available alternate trays are as follows.

0
Use printer settings

1
Display message

2
Feed from multipurpose feeder

3
Use nearest size (Adjust to fit)

4
Use larger size (Adjust to fit)

5
Use nearest size (No zoom)

6
Use larger size (No zoom)

-St=mode

Specifies feed separators from. Available feed separators from the following.

auto
AutoTray/Auto

1
1stTray/Tray 1 (Standard 250-sheet tray)

2
2ndTray/Tray 2 (Optional 550-sheet feeder)
- Sp
  Specifies printed separators.
  Available only when the paper tray for separators is specified.

- Sb
  Specifies Skip Blank Pages.

- Cm=mode
  Specifies output color.
  Available output colors are as follows.

  c
  Color (CMYK)

  k
  Black

- Pr=mode
  Specifies print mode.
  Available print modes are as follows.

  hs
  High speed

  hq
  High quality

  sf
  Super fine

- Cc=mode
  Specifies image types.
  Available image types are as follows.

  0
  Off

  1
Photo

2

sRGB

3

Standard/ Normal

4

Presentation

This option is available only for color printing and when entry data is RGB data.

-Gc=mode

Specifies RGB gamma correction.
Available RGB gamma corrections are as follows.

1.0

1.0

1.4

1.4

1.8

1.8

2.2

2.2

2.6

2.6

off

Off

This option is available only for color printing and when entry data is RGB data.

-Sc=mode

Specifies screen.
Available screens are as follows.

0

Fineness
Gradation

Auto

For Transparency

-Gg=mode

Specifies gray guaranteed. Available gray guaranteed options are as follows.

on

On

off

Off

This option is available only for color printing.

-Ct

Specifies color transformation. This option is available only for color printing.

-Br=mode

Specifies brightness adjustment. Available brightness adjustment option value are as follows.

+5

Bright 5

+4

Bright 4

+3

Bright 3

+2

Bright 2

+1
Bright 1
+0

Normal
-1

Dark 1
-2

Dark 2
-3

Dark 3
-4

Dark 4
-5

Dark 5

-\text{RGBc}=mode

Specifies RGB color correction.
Available RGB color corrections are as follows.
10
Perceptual
11
Saturation
12
RelativeC
13
AbsoluteC

This option is available only for color printing and when entry data is RGB data.

-\text{RGBPr}=mode

Specifies RGB input profile.
Available RGB input profile option value are as follows.
This option is available only for color printing and when entry data is RGB data.

-\texttt{sRGB}

-\texttt{AdobeRGB}

This option is available only for color printing and when entry data is RGB data.

-\texttt{-RGBTp=mode}

Specifies RGB color temperature.

Available RGB color temperature option value are as follows.

5000

5000K

6000

6000K

9300

9300K

This option is available only for color printing and when entry data is RGB data.


Specifies adjustment value for color balance of each color/density.

Available adjustment values are as follows.

+3

Dark 3

+2

Dark 2

+1

Dark 1

0

Normal

-1

Light 1
Light 2

Light 3

-Cb

Option value must be specified in the following order:

Cyan low density, Cyan medium density, Cyan high density, Magenta low density, Magenta medium density, Magenta high density, Yellow low density, Yellow medium density, Yellow high density, Black low density, Black medium density, Black high density

If no value is specified, it is treated as "0" (Normal).

For example, if you want to specify "Light 2" for Cyan medium density, "Dark 3" for Yellow high density, and "Dark 2" for Black low density, it can be specified using either of the following:

-Cb=0:-2:0:0:0:0:0:0:+3:+2:0:0
-Cb=:--2:---:---;++3;++2::

-Hld=PrintType:UserID:Password:DocumentName

Secure Print

PrintType

store

Secure Print/Store Print

proof

Proof Print

UserID

Up to eight single-byte characters from 0x20 to 0x7E, except 0x20 " " (blank) and 0x3A ":" (colon).

Password

Up to 12 single-byte characters from 0x30 to 0x39 (numeric characters).

DocumentName

Up to 12 single-byte characters from 0x20 to 0x7E, except 0x20 " " (blank) and 0x3A ":" (colon).

Secure Print

-Hld=store:UserID:Password:DocumentName
-Hld=store:UserID:Password:

Store Print

- Hld=store:UserID::DocumentName
- Hld=store:UserID::

Proof Print

- Hld=proof:UserID::DocumentName
- Hld=proof:UserID::

**NOTICE**: Make sure you specify Secure Print only when you directly print data to a printer. Secure Print may not be available if you specify it when data need to be printed through another server or data need to be handled by another program such as PostScript files. Collate is automatically specified when you specify Proof Print.

-Jown= jobownername: Password Authentication Setting

Specifies job owner name and password for authentication.

- When only job owner name is specified (-Jown=jobownername:) (no password specified), authentication password is treated as not specified.
- When only password is specified (-Jown=:password) (no job owner name specified), login user name is used as job owner name. Entered password is used as authentication password.
- When neither of job owner name nor password is specified (-Jown=:), login user name is used as job owner name, and authentication password is treated as not specified.
- When a job owner name exceeds allowable character length, the extra characters are ignored.
- When an unacceptable character is specified for job owner name, "Unknown User" is used as job owner name.

**NOTE**: Characters acceptable for job owner name are alphanumeric characters and symbols, except for space and colon.

**NOTE**: Up to 32 characters are acceptable for job owner name.

- When an unacceptable character is specified for password, or when a specified password is not within the range of the allowable character length, the authentication password is treated as not specified.

**NOTE**: Only numbers are acceptable for password.

**NOTE**: Acceptable password length is between 4 and 12 characters.

Incomplete form of -Jown option is treated as no authentication setting being made. In such case, if authentication setting is made with the environmental variable, it is used as setting information.
Example

To convert the XWD image into the PostScript language program and output it to a file, type as follows.

```
% xwd2ps2 file.xwd > file.ps
```

To output the XWD image to a printer, type as follows.

```
% xwd2ps2 file.xwd | lpr (for Linux)
% xwd2ps2 file.xwd | lp (for Solaris/HP-UX)
```

Important

- When `-s` and `-S` are specified at the same time or when the same option is specified twice, the later setting will prevail.
- When the output size option (`-s`, `-S`) is not specified, scaling will be executed taking one pixel of the TIFF data as one pixel of the printer.
- If the print position option (`-l` left bottom) specifies a point beyond the printable area of the printer, data beyond the printable area will not be printed.

**dellpsif (Linux)**

**Format**

```
/usr/local/dellbin3110/dellpsif -w width -l length -i indent -n login -h host accountfile
```

**Function**

If the first two characters of the input data are not `%!`, the dellpsif filter will convert it to the PostScript language program that can be output according to the paper size. If the first two characters of the input data are `%!`, it will be considered the PostScript language program and no data conversion will be executed. The following control codes are interpreted for the conversion of input data.

- **LF**
  - Line feed

- **FF**
  - Form feed

- **TAB**
The dellpsif is the hard link file of txt2ps2. The dellpsif filter will be used as the IF filter specified by /etc/printcap. The lpd daemon will specify the following command options and start up the dellpsif filter.

dellpsif -w width -l length -i indent -n login -h host accountfile

In addition, options usable by txt2ps2 can be specified by the /usr/local/dellbin3110/.dellpsdefault3110 file. With this option, detailed control can be achieved. However, if the input data are PostScript files, only the following options of txt2ps2 will become valid.

-d

Enables the short-edge binding feature. When it is specified, the printing direction or position will be adjusted and both sides of the paper printed so that the shorter edge of the pages can be bound. This option is available only when the optional duplexer is installed on the printer.

-D

Enables the long-edge binding feature. When it is specified, the printing direction or position will be adjusted and both sides of the paper printed so that the longer edge of the pages can be bound. This option is available only when the optional duplexer is installed on the printer.

-I tray-input

Specifies the paper tray. The parameters to be able to specify are the same as txt2ps2.

-t

Turns on the save toner mode for printing. The print result will be fainter than that of normal printing. In some cases, this option will be ignored.

-E

This function turns on the image enhancement function. In some cases, this option will be ignored.

-Nc=copies

Specifies the number of output copies (the value of copies must be a positive integer).
Specifies that printing be collated. If the copies option is not specified, this option will be ignored.

-\texttt{ps}

The input file will be processed as the PostScript file. If the file does not begin with \texttt{%!}, \texttt{%!} will be output to the beginning line. For files with \texttt{%!}, this option will be ignored.

-\texttt{MSI}

Specifies multipurpose feeder.

-\texttt{M=type}

Specifies multipurpose feeder Paper Type. If this option is not specified, multipurpose feeder Paper Type of the printer can be used.

-\texttt{Mfo=mode}

Specifies orientation for multipurpose feeder.

-\texttt{Pon}

Specifies alternate tray.

-\texttt{St=mode}

Specifies feed separators from.

-\texttt{Sp}

Specifies printed separators.

-\texttt{Sb}

Specifies Skip Blank Pages.

-\texttt{Cm=mode}

Specifies output color.

-\texttt{Pr=mode}

Specifies print mode.

-\texttt{Cc=mode}

Specifies image types.
This option is available only for color printing and when entry data is RGB data.

-Gc=mode

Specifies RGB gamma correction.
This option is available only for color printing and when entry data is RGB data.

-Sc=mode

Specifies screen.

-Gg=mode

Specifies gray guaranteed.
This option is available only for color printing.

-Ct

Specifies color transformation.
This option is available only for color printing.

-Br= mode

Specifies brightness adjustment.

-RGBc= mode

Specifies RGB color correction.
This option is available only for color printing and when entry data is RGB data.

-RGBPr= mode

Specifies RGB input profile.
This option is available only for color printing and when entry data is RGB data.

-RGBTp= mode

Specifies RGB color temperature.
This option is available only for color printing and when entry data is RGB data.


Specifies adjustment value for color balance of each color/density.

-Cb Option value must be specified in the following order:

Cyan low density, Cyan medium density, Cyan high density, Magenta low density, Magenta medium density, Magenta high density, Yellow low density, Yellow medium density, Yellow high density, Black low density, Black medium density, Black high density
If no value is specified, it is treated as "0" (Normal).

File

/usr/local/dellbin3110/.dellpsdefault3110
This is the default command option setting.

Important

- The dellpsif filter ignores the pw and pl entries of /etc/printcap. Thus, the pw and pl entries cannot be used to change the option of each paper size.
- If the same option is specified for PostScript files which already have added options, such as paper selection, it will be ignored.
- Use the -ps option only when a PostScript file that contains no %! at the beginning of the file is processed as the PostScript file. If a normal text file is input, it will not function correctly.

Precautions and Limitations

During Installation

Pay attention to the following points during the installation.

Solaris

- Use lpadmin command to register the default printer.

  # lpadmin -d PrinterName

- To inhibit the banner sheets output, change the value of nobanner=no to nobanner=yes that includes in the file corresponding to the printer name in /etc/lp/interfaces/.

- The printer registered by UX filter must not be changed by admintool.

- When Content types: postscript is displayed by typing lpstat -p printername -l, it's necessary to delete the printer and reinstall.

- To install UX filter into the default directory (/usr/local/dellbin3110), it's necessary to create /usr/local directory in advance.

HP-UX

- The printer to specify as an output printer must be registered in your system. To register an output
printer, use sam command and so on. See the HP-UX related manual for details.

- To install UX filter into the default directory (/usr/local/dellbin3110), it's necessary to create /usr/local directory in advance.

**Linux**

- To install UX filter into the default directory (/usr/local/dellbin3110), it's necessary to create /usr/local directory in advance.

**During Printing**

Pay attention to the following points during printing.

**Using lp/lpr Command (Linux/Solaris/HP-UX)**

- If an option is specified incorrectly, no error message will be output. If printing is not executed after the `lp` command is executed, activate each utility individually and error messages will be output. (Using Solaris, the error message is displayed on the screen. Using Linux, the error message is written into the error log file specified by printcap.)

- In text printing, the environmental variable `TXT2PS2OPTION` will be ignored.

- In text printing, if a BS code is found at the beginning of a line, the print position of the next character will be on the left of the beginning of the line.

- In text printing, when there are multiple tab codes in one line, the positions of tab may be off due to automatic line feed. If this happens, specify `l` or `w` option.

- In text printing, the number of columns specified by the `w` option does not reflect the number of characters actually printed. The actual number of single-byte characters to be printed is derived by deducting the output column position (out columns) specified by the `o` option from the number of columns specified by the `w` option.

- If the same option is specified, or if `s, S` are both specified, the one specified later will prevail.

- In printing images, if the print position option (1) specifies an area beyond the printable area of the printer, data beyond the printable area will not be printed. (Using Solaris, it's impossible to output images by `lp` command.)

**Using txt2ps2 (Linux/Solaris/HP-UX)**

- When the same option is specified twice, the later setting will prevail. As `TXT2PS2OPTION` is analyzed before the option of the command line, it is possible to temporarily modify the options already set in `TXT2PS2OPTION` by inputting at the command line.

- The default output of txt2ps2 cannot output the comment description (%%page:m n) of the page number. This is because the converted PostScript language program controls line feed and form feed. Thus, when the output of txt2ps2 is to be taken as the output of another application (psrev of
If a BS code is found at the beginning of a line, the print position of the next character will be on the left of the beginning of a line.

When there are multiple tab codes in one line, the positions of tab may be off due to automatic line feed. If this happens, specify the -l or -w option.

The number of columns specified by the -w option does not reflect the number of characters actually printed. The actual number of single-byte characters to be printed is derived by deducting the output column position (out columns) specified by the o option from the number of columns specified by the w option.

The -mg option cannot be specified when -w, -l, -o, and -L option are specified.

The start positions of margins of the margin command (-mg=u:b:r:l) are not set against the edge of paper. The margins are set against the printable area for paper allowed by the printer.

Use the -ps option only when a PostScript file that contains no %! at the beginning of the file is used as the PostScript file. If a normal text file is input, it will not function correctly.

To use the same options as those of the dellpsif filter by TXT2PS2OPTION, set the user's home directory in the environmental variable HOME. If the environmental variable HOME is not set up, the same options as those of the dellpsif filter cannot be used. (Linux)

Using sunras2ps2/tiff2ps2/xwd2ps2 (sunras2ps2 apply to Solaris only)

- If the same option is specified, or if s, S are both specified, the one specified later will prevail.
- If the size option (s, S) is not specified, scaling will be executed taking one pixel of the image data as one pixel of the printer.
- If the print position option (-l left bottom) specifies a point beyond the printable area of the printer, data beyond the printable area will not be printed.

Using tiff2ps2 (Linux/Solaris/HP-UX)

- There are four types of supported compression formats.
  Huffman compression (CCITT Group 3 transformed Huffman run length encoding)
  Fax-CCITT3 compression (facsimile-compatible CCITT Group 3)
  PackBits compression
  Non-compression

Even if the format is a supported format, the tiff that has multiple images in one file is not supported.

Using xwd2ps2 (Linux/Solaris/ HP-UX)

- There are three types of supported compression formats.
  The visual class is Static Gray and the pixel is 1 bit.
  The visual class is Pseudo Color and the pixel is 4 bits or 8 bit. The image format is Zpixmap.
  The visual class is True Color and the pixel is 24 bits. The image format is Zpixmap.
Using dellpsif (Linux)

- Use the `-ps` option only when a PostScript file that contains no `%!` at the beginning of the file is used as the PostScript file. If a normal text file is input, it will not function correctly.
- `-w`, `-l` option usually correspond to `pw`, `pl` entry of `/etc/printcap`. However, this UX filter ignore `pw`, `pl` entry of `/etc/printcap`. So, the option cannot be changed by each page size using `pw`, `pl` entry.

Printing PostScript Files (Linux/Solaris/ HP-UX)

- If same options for the PostScript file that contains options, such as paper size, are specified using dellpsif (Linux) or the `lp` command (Solaris/HP-UX), the specified option will be ignored.

Printing Image Files (Solaris)

- To print image files from Solaris the user cannot specify the image file directly with the `lp` command for printing. Make use of `sunras2ps2`, `tiff2ps2`, `xwd2ps2` and convert the file to a PostScript file. Output it using the `lp` command after the conversion.

```
% xwd2ps2 file.xwd | lp
```

The double-sided printing (Linux/ Solaris/ HP-UX)

- The printer without an optional duplexer is unable to do double-sided printing.

Header/footer Option (-Hd=position:format:page, -Hfheaderfont) (txt2ps2,sunras2ps2,tiff2ps2,xwd2ps2)

- If the paper size is not specified when using options, it outputs the header/footer at the position of A4-size paper. To specify the paper size at the same time to use header/footer option. (If the paper size for the PostScript file converted by using the option is specified by the option of `lp` command for example, the position of the header and footer cannot be changed.)
- The margin is specified automatically when the option is used. When the option to specify the margin is used at the same time, the value that is smaller than the value specified automatically as follows is ignored.

In case of text files

- Upper margin: 0.23 inch
- Lower margin: 0.06 inch
- Right margin: 0.03 inch
- Left margin: 0.09 inch

In case of images

- Lower margin: 0.3 inch
- When using the option, the number of lines and the number of columns specified are ignored. Also, it is impossible to specify landscape and 2-column.

- In case of the PostScript file, it happens that the printer doesn't output all pages despite that output all page is specified. In such a case, specify print the only top page.

- It's impossible to use `lp` command in Solaris.

**TBCPFilter (Solaris/Linux/HP-UX)**

- Make sure the TBCPFilter is available so the printer can specify the availability of the TBCPFilter.

**As for libtiff**

Copyright © 1988-1997 Sam Leffler


THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, EXPRESS, IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.
Printing With CUPS (Linux)

This section provides information for printing or setting up the printer driver with CUPS (Common UNIX Printing System) on Turbolinux 10 Desktop, RedHat ES 3/4 or SUSE 9.2/9.3.

- Operation on Turbolinux 10 Desktop or RedHat ES 3/4
- Operation on SUSE 9.2/9.3

Operation on Turbolinux 10 Desktop or RedHat ES 3/4

Setting Overview

Turbolinux 10 Desktop or RedHat ES 3/4:

1. Install the printer driver.
2. Set up the print queue.
3. Specify the default queue.
4. Specify the printing options.

Installing the Printer Driver

1. Double-click **Dell-Color-Laser-3110cn-x.x-x.noarch.rpm** in the *Drivers and Utilities* CD.
2. Type the administrator's password.
3. Click **Continue** in the *Completed System Preparation* window.
   Installation starts. When the installation is complete, the window is automatically closed.

Setting Up the Queue

To execute printing, you must set up the print queue on your workstation.

1. Select **Main Menu → Run Program**. Type `cupsconfig` and click **Run** in the *Run Program* window.
   The browser is activated and the **CUPS** window appears.

2. Click **Manage Printers**.

3. Click **Add Printer** at the bottom of the window.

4. Type `root` as the user name, and type the administrator's password.
5. Type the printer's name in the Name box in the Add New Printer window, and then click Continue. The Location and Description do not have to be specified.

6. Select LPD/LPR Host or Printer from Device menu, and then click Continue.

7. Type the printer's IP address in Device URI. Format: lpd://xxx.xxx.xxx.xxx (printer's IP address)

8. Select Dell from the Make menu, and then click Continue.

9. Select Dell™ Color Laser 3110cn... from the Model menu, and then click Continue. The message Printer xxx has been added successfully. appears.

The set up is complete.

When you have finished setting up the queue you can print jobs from the software program. Start the print job from the software program, and then specify the queue in the print dialog box.

However, sometimes you can only print from the default queue depending on the software program (for example Mozilla). In these cases, before you start printing, set queue you want to print to as the default queue. For information on specifying the default queue, see "Setting the Default Queue."

**Setting the Default Queue**

1. Select Main Menu → System Tools → Terminal.

2. Type the following command in the terminal window.

```
su
(Type the administrator's password)
lpadmin -d (The queue name)
```

**Specifying the Printing Options**

You can specify the printing options such as color mode or double-sided printing.

1. Select Main Menu → Run Program. Type cupsconfig and click Run in the Run Program window. The browser is activated and the CUPS window appears.

2. Click Manage Printers.

3. Click Configure Printer of the queue for which you want to specify the printing options.

4. Type root as the user name, and type the administrator's password.

5. Specify the required settings, and then click Continue. The message Printer xxx has been configured successfully. appears.
The setting is complete. Execute printing from the software program.

**Uninstalling the Printer Driver**

1. Select **Main Menu → System Tools → Terminal**.
2. Type the following command in the terminal window.
   
   ```
   su
   (Type the administrator's password)
   rpm -e Dell-Color-Laser-3110cn
   ```

   The printer driver is uninstalled.

**Operation on SUSE 9.2/9.3**

**Installing the Printer Driver**

1. Double-click **Dell-Color-Laser-3110cn-x.x-x.noarch.rpm** in the **Drivers and Utilities** CD.
2. Click **Install package with YaST**.
3. Type the administrator's password.
   Installation starts. When the installation is complete, the window is automatically closed.

**Setting Up the Queue**

To execute printing, you must set up the print queue on your workstation.

1. Select **Start Applications → System → YaST**.
2. Type the administrator's password.
   **YaST Control Center** is activated.
3. Select **Hardware** from **Printer**.
4. **Printer setup: Autodetected printers** is activated.
   For USB connections:
   a. Select **Dell Color Laser 3110cn on USB (//Dell/Color%20Laser%203110cn or /dev/usblp*)** as **Available are**, and then click **Configure....**
   b. Confirm the settings in **Edit configuration**, and then click **OK**.
For parallel connections:

a. Select Other (not detected) as Available are in Printers to configure, and then click Configure....

b. Select Parallel printer as Printer Type, and then click Next.

c. Click Next.

d. Set the name of the printer queue in Queue name, and type the queue name for printing in Name for printing. The Description of Printer and Location of Printer do not have to be specified.

e. Select the Do Local Filtering check box, and then click Next.

f. Select DELL in Select manufacturer. Select Color Laser 3110cn in Select Model, and then click Next.

g. Confirm the settings in Edit configuration, and then click OK.

For network connections:

a. Select Other (not detected) as Available are in Printers to configure, and then click Configure....

b. Select the Print via LPD-Style Network Server as Printer Type, and then click Next.

c. Type the printer's IP address in Host name of the printer server. And type the name of the printer queue in Name of the remote queue, and then click Next.

d. Set the name of the printer queue in Queue name, and type the queue name for printing in Name for printing. The Description of Printer and Location of Printer do not have to be specified.

e. Select the Do Local Filtering check box, and then click Next.

f. Select DELL as Select manufacturer. Select Color Laser 3110cn as Select Model, and then click Next.

g. Confirm the settings in Edit configuration, and then click OK.

5. Click Finish.

Printing From the Application Program

When you have finished setting up the queue you can print jobs from the application program. Start the print job from the application program, and then specify the queue in the print dialog box.

However, sometimes you can only print from the default queue depending on the application program (for
example Mozilla). In these cases, before you start printing, set queue you want to print to as the default queue. For information on specifying the default queue, see "Setting the Default Queue."

### Setting the Default Queue

1. To activate the **Printer setup: Autodetected printers**, do the following.
   a. Select **Start Applications → System → YaST**.

   b. Type the administrator's password. **YaST Control Center** is activated.

   c. Select **Hardware from Printer**.

2. **Printer setup: Autodetected printers** is activated.

3. Click **Change....**

4. Select the printer you want to set to default, and then click **Set as default**.

5. Click **Finish**.

### Specifying the Printing Options

You can specify the printing options such as color mode or double-sided printing.

1. Select **Start Applications → Internet → Web Browser**. The browser is activated.

2. Type `http://localhost:631/admin` in **Location**, and then press the <Enter> key.

3. Type `root` as the user name, and type the administrator's password. The **CUPS** window appears.

   **NOTE:** Set the password for authority as the printer administrator before setting the printer queue. If you have not set it, go to "Setting the Password for Authority as the Printer Administrator."

4. Click **Manage Printers**.

5. Specify the required settings, and then click **Continue**. The message **Printer xxx has been configured successfully.** appears.

The setting is complete. Execute printing from the application program.

### Setting the Password for Authority as the Printer Administrator
You must set the password for authority as the printer administrator to do operations as the printer administrator.

1. Select **Start Applications → System → Terminal → Konsole.**

2. Type the following command on the terminal window.

```
su
(Type the administrator's password.)
lppasswd -g sys -a root
(Type the password for authority as the printer administrator after the Enter password prompt.)
(Retype the password for authority as the printer administrator after the Enter password again prompt.)
```

**Uninstalling the Printer Driver**

1. Select **Start Applications → System → Terminal → Konsole.**

2. Type the following command on the terminal window.

```
su
(Type the administrator's password)
 rpm -e Dell-Color-Laser-3110cn
```

The printer driver is uninstalled.
Safety and Regulatory Information

Safety Information

⚠️ **CAUTION:** Read and follow all safety instructions in your Owner’s Manual prior to setting up and operating your printer.

Regulatory Information

Federal Communications Commission (FCC) Compliance Information Statement (US Only)

The Dell™ Color Laser Printer 3110cn has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

The FCC Class B limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult your point of purchase or service representative for additional suggestions.

The manufacturer is not responsible for any radio or television interference caused by using other than
recommended cables or by unauthorized changes or modifications to this equipment. Unauthorized changes or modifications could void the user’s authority to operate this equipment.

**NOTE:** To assure compliance with FCC regulations on electromagnetic interference for a Class A computing device, use a properly shielded and grounded CABLE. Use of a substitute cable not properly shielded and grounded may result in a violation of FCC regulations.

**FCC Identification Information**

The following information is provided on the device or devices covered in this document in compliance with FCC regulations:

- Model number: Dell™ Color Laser Printer 3110cn
- Company name:

Dell Inc.
One Dell Way
Round Rock, Texas 78682 USA
512-338-4400

**Industry Canada Compliance Statement**

This Class B digital apparatus meets all requirements of the Canadian Interference-Causing Equipment Regulations.

**Avis de Conformité aux Normes de l'industrie du Canada**

Cet appareil numérique de la classe B respecte toutes les exigences du Règlement sur le matériel brouilleur du Canada.

**European Community (EC) Directives Conformity**

This product has been determined to be in compliance with 73/23/EEC (Low Voltage Directive), 89/336/EEC (EMC Directive), and amendments of the European Union.

This product satisfies the Class B limits of EN 55022 and safety requirements of EN 60950.

**CE Notice (European Union)**

Marking by the symbol ⚡ indicates compliance of this Dell printer to the EMC Directive and the Low Voltage Directive of the European Union. Such marking is indicative that this Dell system meets the following
technical standards:


- EN 55024 - Information Technology Equipment - Immunity Characteristics - Limits and Methods of Measurement.

- EN 61000-3-2 - Electromagnetic Compatibility (EMC) - Part 3: Limits - Section 2: Limits for Harmonic Current Emissions (Equipment Input Current Up to and Including 16 A Per Phase).

- EN 61000-3-3 - Electromagnetic Compatibility (EMC) - Part 3: Limits - Section 3: Limitation of Voltage Fluctuations and Flicker in Low-Voltage Supply Systems for Equipment With Rated Current Up to and Including 16 A.

- EN 60950 - Safety of Information Technology Equipment.

**NOTE:** EN 55022 emissions requirements provide for two classifications:

- Class B is for typical domestic areas.

This Dell device is classified for use in a typical Class B domestic environment.

A Declaration of Conformity in accordance with the preceding directives and standards has been made and is on file at Dell Inc. Products Europe BV, Limerick, Ireland.

**CE Mark Notice**

This equipment complies with the essential requirements of the European Union Directive 1999/5/EC.
Información NOM (únicamente para México)

La información siguiente se proporciona en el dispositivo o en los dispositivos descritos en este documento, en cumplimiento con los requisitos de la Norma Oficial Mexicana (NOM):

<table>
<thead>
<tr>
<th>Exportador:</th>
<th>Dell Inc.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>One Dell Way</td>
</tr>
<tr>
<td></td>
<td>Round Rock, TX 78682</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Importador:</th>
<th>Dell Computer de México, S.A. de C.V.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Paseo de la Reforma 2620 - 11º Piso</td>
</tr>
<tr>
<td></td>
<td>Col. Lomas Altas</td>
</tr>
<tr>
<td></td>
<td>11950 México, D.F.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Enviar a:</th>
<th>Dell Computer de México, S.A. de C.V.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>al Cuidado de Kuehne &amp; Nagel de México S. de R.L.</td>
</tr>
<tr>
<td></td>
<td>Avenida Soles No. 55</td>
</tr>
<tr>
<td></td>
<td>Col. Peñón de los Baños</td>
</tr>
<tr>
<td></td>
<td>15520 México, D.F.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Número del modelo:</th>
<th>Dell Laser Printer 5100cn</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Tensión de alimentación:</th>
<th>110-127 VAC</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frecuencia:</td>
<td>50/60 Hz</td>
</tr>
<tr>
<td>Consumo de corriente:</td>
<td>11 A</td>
</tr>
</tbody>
</table>
Noise Emissions Levels

The following measurements were made in accordance with ISO 7779 and reported in conformance with ISO 9296.

<table>
<thead>
<tr>
<th></th>
<th>1-meter average sound power level, B</th>
</tr>
</thead>
<tbody>
<tr>
<td>Printing</td>
<td>Without option: 6.3B</td>
</tr>
<tr>
<td></td>
<td>With full option: 6.8B</td>
</tr>
<tr>
<td>Idling</td>
<td>4B</td>
</tr>
</tbody>
</table>

Laser Notice

The printer is certified in the U.S. to conform to the requirements of 21CFR, Chapter 1, Subchapter J for Class I (1) laser products, and elsewhere is certified as a Class I laser product conforming to the requirements of IEC 60825-1.

Class I laser products are not considered to be hazardous. The printer contains internally a Class IIIb (3b) laser that is nominally a 5 milliwatt gallium arsenide laser operating in the wavelength region of 770-795 nanometers. The laser system and printer are designed so there is never any human access to laser radiation above a Class I level during normal operation, user maintenance, or prescribed service condition.

Energy Star

ENERGY STAR® Compliance

Certain configurations of Dell printers comply with the requirements set forth by the Environmental Protection Agency (EPA) for energy-efficient printers. If the front panel of your printer bears the ENERGY STAR® Emblem, your original configuration complies with these requirements and all ENERGY STAR® power management features of the printer are enabled.

Any Dell printer bearing the ENERGY STAR® Emblem is certified to comply with EPA ENERGY STAR® requirements as configured when shipped by Dell. Any changes you make to this configuration (such as installing additional expansion cards or drives) may increase the printer’s power consumption beyond the limits set by the EPA’s ENERGY STAR® Computers program.

ENERGY STAR® Emblem
The EPA’s ENERGY STAR® Office Equipment program is a joint effort between the EPA and computer manufacturers to reduce air pollution by promoting energy-efficient computer products. The EPA estimates that use of ENERGY STAR® computer products can save computer users up to two billion dollars annually in electricity costs. In turn, this reduction in electricity usage can reduce emissions of carbon dioxide, the gas primarily responsible for the greenhouse effect, and sulfur dioxide and nitrogen oxides, the primary causes of acid rain.

You can also help reduce electricity usage and its side effects by turning off your computer when it is not in use for extended periods of time, particularly at night and on weekends.

**MSDS Materials for Dell Printer**

All MSDS materials for Dell Printers can be found at the following URL:
http://www1.us.dell.com/content/topics/global.aspx/corp/environment/en/prod_design?c=us&l=en&s=corp&~section=001
Appendix

- Dell Technical Support Policy
- Contacting Dell
- Warranty and Return Policy

Dell Technical Support Policy

Technician-assisted technical support requires the cooperation and participation of the customer in the troubleshooting process and provides for restoration of the operating system, software program and hardware drivers to the original default configuration as shipped from Dell, as well as the verification of appropriate functionality of the printer and all Dell-installed hardware. In addition to this technician assisted technical support, online technical support is available at Dell Support. Additional technical support options may be available for purchase.

Dell provides limited technical support for the printer and any Dell-installed software and peripherals. Support for third-party software and peripherals is provided by the original manufacturer, including those purchased and/or installed through Software & Peripherals (DellWare), ReadyWare, and Custom Factory Integration (CFI/DellPlus).

Contacting Dell

You can access Dell Support at [http://www.support.dell.com/](http://www.support.dell.com/). Select your region on the top page, and fill in the requested details to access help tools and information.

You can contact Dell electronically using the following addresses:

- **World Wide Web**
  - [http://www.dell.com/ap/](http://www.dell.com/ap/) (for Asian/Pacific countries only)
  - [http://www.euro.dell.com](http://www.euro.dell.com) (for Europe only)

- **Anonymous file transfer protocol (FTP)**
  - Log in as user: anonymous, and use your email address as your password.

- **Electronic Support Service**
  - mobile_support@us.dell.com
  - support@us.dell.com
  - apsupport@dell.com (for Asian/Pacific countries only)
  - support.euro.dell.com (for Europe only)

- **Electronic Quote Service**
  - apmarketing@dell.com (for Asian/Pacific countries only)
Warranty and Return Policy

Dell Computer Corporation ("Dell") manufactures its hardware products from parts and components that are new or equivalent to new in accordance with industry-standard practices. For information about the Dell warranty for your printer, see the Owner's Manual.